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Előszó

Előszó

e.
A szerző megismerkedik 
az olvasóval, felajánlja 
segítségét, s eegyüt 
indulnak tovább 
a Blender 3D
világában.

előszó



12

Üdvözöllek, kedves Olvasó! 

Nem sokat tudunk még egymásról: Mivel letöltöted ezt a 
könyvet, feltételezem, hogy kreatív, érdeklődő ember vagy. 
Lehet,  hogy  szeretnél  valami  látványos  dolgot  alkotni.
Érzéseidet,  gondolataidat  újszerűen  kifejezni;  esetleg  a 
technika érdekel, amivel életre tudod kelteni vizuális elkép-
zelésedet…

Az utóbbi egy évben azon dolgoztam, hogy megismertesse-
lek  egy  nagy  tudású,  professzionális  3D  alkalmazással.
A könyvvel, ami ebből a törekvésből született, megkísérlem 
elkerülni  az  enciklopédikus  tudálékosság  csapdáját.  Nem 
referenciaanyagot akartam írni, amiben minden informáci-
ót megtalálsz a Blenderről, hanem olyan feladatok, projek-
tek sorozatát kitalálni,  melyek egymásra épülve vezetnek 
tovább a készségek kialakulásáig. Mindig egy kicsivel töb-
bet  tudsz  meg  belőlük,  s  miközben  gyakorlod,  remélem 
nem csak egy program használatát, de egy szemléletet is 
elsajátítasz majd. 

Előszó
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Filmeket fogunk készíteni, nem is egyet. Hármat, négyet… 
De előte megismerkedhetsz egy viszonylag egyszerű ani -
mációs  műfajjal,  a  flmkészítés  három  nagy  szakaszával, 
majd magával a Blenderrel is, mire félelemmel teljes tiszte-
letel tekintenek az animáció világában. 

S bocsáss majd meg, ha valami kimaradt volna… Mert lesz 
modellezés,  de könyvem alapján biztosan nem tudod fel-
építeni az Országházat. Fogunk animálni, de nem élőlénye-
ket. Futatunk szimulációkat, belekóstolunk az utómunka-
folyamatokba, de a végén nem űreposzok kerülnek ki a ke-
zed alól, csak néhány flmecske.

Kezdőkönyv? Nem szégyellem kimondani: igen. De miköz-
ben felépíted virtuális világaidat, a sajátodról is új dolgokat 
tanulsz meg, s talán majd kicsit másképpen látod azt, amire 
eddig nem is fgyeltél.

Jómagam több mint tíz éve foglalkozom a Blenderrel. Ké-
szítetem vele animációs flmet, flmtrükköket, reklámani-
mációt és rajzflmes munkához 3D elemeket. Számítógépes 
grafkusként  is  tanár  maradtam.  Igyekszem  a  könyvben 
nem csak bemutatni, de megtanítani is a programot, s azon 
keresztül egy műfajjal megismertetni.

Hogyan olvasd ezt a könyvet? Bármilyen formában – szá-
mítógépen,  elektronikus  könyvolvasón,  táblagépen  vagy 
papíron –, de Blenderrel együt. 

Ez  az  ingyenes,  nyílt  forrású  szofver  gyorsan  fejlődik, 
ezért a könyv honlapjáról letölthető a kötet írásakor aktuá-
lis változata  Linux, MacOS és Windows operációs rendsze-
rekhez. Ez a Blender 2,78. Minden, a mellékletben megtalál-
ható állomány, kiegészítő ezzel kompatibilis. 

E gyors fejlesztés miat azt kérem tőled, egyelőre ne kísér -
letezz más verzióval, telepítsd ezt, és végig érteni fogod e 
kötet anyagát. 

Előszó
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Egyesületünknek,  s  nekem sincs kapacitásunk arra,  hogy 
minden jövőbeli verzióhoz újraszerkesszük ezt a könyvet, 
vagy a különbségekhez terméktámogatást nyújtsunk. Hisz-
szük viszont, hogy az a jártasság, amit egy programverzió-
ban elsajátítotál, a későbbi változtatásokhoz is elég alapot 
nyújt. Némi kutatással, önálló tanulással már te magad is 
tovább tudsz lépni.

A könyv melléklete sorszámozva van, ezekre fogok hivat-
kozni a feladatokban. Az ábrákon narancssárga keretekkel 
jelöltem a felhasználói felület azon elemeit, melyre a szö-
veg hivatkozik. 

A kötet végén található terjedelmesebb függelék olyan is-
mereteket tartalmaz, melyek egy-egy projektfeladat megol-
dása során lassítanák, vagy talán összezavarnák a munká-
dat, de a későbbi elmélyülést segítik, tudásodat mélyítik.

Kezdhetjük?...

Előszó
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1. Látvány-
animáció

1. Látványanimáció

1.
Ebben a fejezetben kiderül, 
mi az a látványanimáció,
hoegyan készül, és miért
éppen ezt a műfajt választotuk
a Blenderrel való ismerkedéshez.

látvány + 
animáció
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Motion Graphics

E könyvben a látványanimáció kifejezést alkalmazzuk majd 
mindarra  a  mozgóképi  műfajra,  melyet  angolul  motion
design, vaegy motion graphics  néven emlegetnek. Külföldön 
ismert  flmes  kifejezés,  de  a  hazai  szaknyelvben  sajnos 
nincs megfelelője. Mivel minden részműfajának célja a lát-
vány,  a  fgyelemfelkeltés,  sok  tépelődés  után látványani-
mációnak neveztem el ezt a műfajt.  Öt típusával biztosan 
találkoztál már:

• a logóanimáció, 
• a kísérleti animáció, 
• a főcím-animáció, 
• a reklámanimáció, 
• és a betűanimáció. 

1. Látványanimáció
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Logóanimáció ♦ A 20. század húszas–harmincas éveiben 
jelentek meg az olyan nagy flmgyártó cégek, mint a Fox, 
Paramount, Metro-Goldwyn-Mayer, Universal – moz-
góflmes „cégérei”, melyek megteremteték a logóanimáció 
műfaját. Ha manapság beülsz a moziba, a flmek előt tö -
megével láthatod a flmgyártó stúdiók és forgalmazók vizu-
ális azonosítóit.

Kísérleti animáció ♦ Ugyanebben az időben a pezsgő, kí-
sérletező képzőművészeti élet a flmvásznon is megjelent, 
elsősorban zeneileg inspirált világokat teremtve. 

Néhány kép Fischinger 1938-as Optikai költemény c. kisfilmjéből, melyet Liszt 
Ferenc Második magyar rapszódia c. művére készített.

Egyik  jellemző  személyisége  Oscar  Fischinger avantgárd 
animátor volt, aki zenei motívumok vizualizációjával fog-
lalkozot. Az animációs műfajban máig sok követője akad.

Főcím-animáció ♦ Ma már szinte elképzelhetetlen, hogy 
a fél  évszázaddal ezelőt a flmek egy hosszabb főcímmel  
kezdődtek. A néző az első öt percben nem látot mást, mint 
a flmben közreműködő személyek felsorolását. Saul Bass 
grafkus kreatív ötlete volt, hogy e hosszú főcímet  rajzfl-
mes stílusú animációkkal színesítete. Az  1950-es években 
ezzel megteremtete a főcím-animáció műfaját.

1. Látványanimáció

Képkockák Romy Tesei 
reklámanimációjából.
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Saul Bass főcíme az „Egy gyilkosság anatómiája” c. filmhez. Olyan rendezők 
filmjeihez  készített  bevezető  animációkat,  mint  Preminger,  Hitchkock, 
Kubrick, Scorsese.

Reklámanimáció ♦ Legtöbben a reklámanimációval azo-
nosítják a motion graphics műfaját. 

A televíziós hirdetések látványvilága az utóbbi évtizedek-
ben megtelt animációs efektusokkal. 

A vágyot, anyagi eszközeiddel elérhető boldogság fantasz-
tikus univerzumaiban minden csábít, repül, hívogat. 

Kötelező vizuális efektusok, 3D-s elemek, animáció,  utó-
munka. Jól fzető felhasználási lehetősége 3D tudásodnak. 
Az utóbbi időben főleg Dél-Amerikában használják reklám-
flmekhez a Blendert, de egyre inkább elterjed a kis, induló 
reklámstúdiók  elérhető  animációs,  flmtrükkös  és  utó-
munka-eszközeként.

1. Látványanimáció

Képkockák Romy Tesei 
reklámanimációjából.
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Betűanimáció  ♦  Kynetic typography vagy  lyric video  né-
ven is emlegetik ezt a betűanimációs műfajt, mely  éppen 
korunkban kerül refektorfénybe az interneten megosztot 
sok-sok zenei anyag szövegének vizualizációjával.

Katsiaryna Khimenets betűanimációja az Arctic Monkeys együttes dalára. 

A jó betűanimáció igazi „játék a betűkkel”, ahol az animá-
ció, a tér és az apróbb grafkai ötletek színházat játszanak 
az olvasóval, nézővel. 

1. Látványanimáció
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Mivel készül?

Aki egy kicsit is tájékozódot már a 3D-s világban, hamar  
felismeri  azokat  a  célprogramokat,  melyeknek neve  egy-
egy tevékenységhez kapcsolható az animáció, játékkészítés, 
speciális efektusok, szimuláció vagy éppen az építészeti vi-
zualizáció területein. 

A  látványanimáció  kapcsán többnyire  két  program nevét 
szokták emlegetni: Az egyik a Maxon Cinema 4D térbeli 
tervező  és  animációs  szofvere,  a  másik pedig  az  Adobe 
Afer Efects kompozitáló- és utómunkaprogramja. 

A Maxon Cinema 4D térbeli tervező és animációs program különösen kedvelt 
a látványanimációval foglalkozó alkotók körében

Senkivel nem szeretném elhitetni, hogy a  Blender minden 
területen  lekörözi  ezeket  az  alkalmazásokat,  csak  azért, 
mert nyílt forráskódú, közösségi fejlesztésű – míg a keres-
kedelmi szofvereket proftéhes gazemberek fejlesztik, akik 
a stúdiókon élősködnek. 

A  Cinema 4D és az  Afer Efects,  vagy más területeken a 
Maya, a  3D Studio Max,  Houdini vagy a  Nuke fantasztikus 
célprogramok,  nagy  szaktudást  igényelnek,  de  rendkívül 
termelékennyé teszik a munkát. 

1. Látványanimáció
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A reklám- és flmiparban az idő pénz, és mindenki képes 
nagyon sokat fzetni azért, hogy a munkája még több pénzt 
hozzon.

Az Adobe After Effects könnyen kezelhető utómunkaprogram, melynek kitűnő 
eszközei vannak látványanimációk készítésére.

Akkor most mi a látványanimáció?

Térgeometrikus alakzatok, mikro- és makrovilágok, techni-
kai  illusztrációk,  futurisztikus  megjelenés  – csak  néhány 
stílusjegy, melyekkel azonosítható a látványanimáció. 

Átekintetük a műfajait, jellegzetes eszközeit, de hogy le-
hetne összefoglalni, defniálni ezt a zsánert?

Rövid, fegyelemfelkeltő, 
illusztratív grafkai vaegy 
betűanimációó

1. Látványanimáció
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Komolyan, labdába rúghat itt a Blender?

Több mint tíz évvel ezelőt én is feltetem magamban a kér-
dést,  mert  érdekelt  a  3D  animáció:  Melyik  programmal 
kezdjem el az ismerkedést ezzel a területel? 

Akkoriban a  kereskedelmi,  professzionális  szofverek  kö-
zöt a Maya és a 3D Studio Max voltak látóteremben az al-
ternatívák. De nem nekem. 

Az általam használt síkgrafkai programokat sem mondhat-
nám olcsóknak, de ezek… minden lehetőségemen túl, egy-
szerűen anyagilag elérhetetlenek tűntek. 

A Blender felhasználói felülete Chris Kuhn helikoptermodelljével.

Lehetek volna nem becsületes alternatíváim, de valahogy 
mindig is viszolyogtam ezektől az utaktól – ahogy az autó-
feltörés és a fzetés nélkül az éteremből távozás sem az én 
műfajom. 

1. Látványanimáció
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Ebben az időben futot egy cikksorozat a 3D grafkáról az  
egyik szaklapban. Elkezdtem levelezni a szerzővel, aki azt 
ajánlota,  hogy próbáljam ki  a Blendert.  Modellezni,  ani-
málni, sőt játékot készíteni is lehet a segítségével. 

Letöltötem és  kinyomtatam a  felhasználói  kézikönyvet. 
Hamar rájötem, hogy amit a másik két program alapszol-
gáltatásairól olvastam, gyakorlatilag megegyeznek ennek a 
szofvernek a képességeivel. 

Így a Blender mellet döntötem…

Őszintén a 3D-világról

Manapság a 3D animáció és a speciális efektusok készítése 
területén is számos ember közös munkájának eredménye 
egy flm, kisflm vagy sorozat, akárcsak régen a rajzflm-
gyártásban. 

A stúdiókat olyan manufaktúraként kell elképzelni, ahol a 
művészek és technikusok egymás keze alá dolgozva tolják 
tovább a flm jeleneteit egy „gyártósoron”, melynek angol 
szakkifejezése a pipeline, azaz csővezeték.

Az Autodesk Maya programja kedvelt  alkalmazás az animátorok világában. 
Forrás: Flickr

1. Látványanimáció
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Amikor arról hallunk, hogy egy flmet Maya-val, 3D Studio 
Max-szel  vagy  Cinema 4D segítségével  készítetek,  szinte 
biztosak lehetünk abban, hogy e kereskedelmi programok 
gyártóinak  túlzó  reklámjába  botlotunk.  Az  ő  szokásuk, 
hogy egy-egy sikerflm refektorfényében kizárólagos esz-
közként villantsák meg saját megoldásaikat. Így aztán ki-
alakul egy olyan tévképzet, hogy animációt csak Maya-val, 
digitális játékokhoz modelleket  3D Studio Max-szel, látvá-
nyanimációt pedig kizárólag Cinema 4D-vel lehet tervezni. 

Az igazság az,  hogy ezek nagyon sokrétű professzionális 
minőségű,  kereskedelmileg forgalmazot programok , melye-
ket előszeretetel használnak a stúdiók.

De ne úgy képzeljük, hogy a Pixar, az ILM vagy a WETA 
műhelyeiben mindenki  Maya-t használ. Ezeknek a cégek-
nek kezdetektől megvannak a saját fejlesztésű programjaik, 
melyekkel igyekeznek lefedni munkafolyamataikat. 

Bizonyos részfeladatokra előszeretetel használnak az ani-
mációs  stúdiók  olyan  kiváló  kereskedelmi  programokat, 
mint a Maya, a Houdini, a ZBrush, máshol meg saját fejlesz-
téseiket illesztik a munkafolyamatba.

A  professzionális  megoldások  mellet léteznek  olyan  kis  
hobbiszofverek, melyek segítségével némi fogalmat alkot-
hatunk arról, hogyan dolgoznak a nagyok, de a kimenetük 
nem teszi őket alkalmassá arra, hogy professzionális mun-
kafolyamat részévé váljanak. 

De hova pozicionáljuk a Blendert ezen a paletán?...

1. Látványanimáció
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Akkor a Blender…

...hobbiszofver – gondolnánk. Hiszen ingyenes, nyílt for-
ráskódú, hatalmas rajongótáborral. 

Az igazság ellenben az, hogy a Blender a holland NeoGeo 
animációs stúdió saját fejlesztésű stúdióprogramja volt. 1994 
óta használták, de olyan sikeres let, hogy külön céget kel-
let létrehozniuk terméktámogatásra, terjesztésre.

2002-ben a Blendert forgalmazó NaN (Not a Number) cég 
mögül kihátráltak a befektetők, csődközeli állapotba került. 
Vezető fejlesztőjük,  Ton Roosendaal nem nyugodot bele a  
kialakult helyzetbe, létrehozot egy nonproft alapítványt,  
melynek első dolga a program kódjának kivásárlása volt. 

A befektetők tanácsa 100.000 eurót kért a program forrásá-
ért,  amit  egy  internetes  kampánnyal  7 hét  alat sikerült  
összegyűjteni. A Blender Foundation tulajdonába került 
programkódra azért adakoztak az emberek, mert szereték 
volna tovább használni a programot. Roosendaal a nyílt for-
rású modellben láta a szofver jövőjét – lelkes fejlesztők  
közös munkájában. Elnökségével, és jó szervezői készségé-
nek köszönhetően, a  Blender Foundation összefogta az 
új fejlesztők tevékenységét, már animációs stúdiót üzemel-
tet  Amszterdamban (Blender  Institute),  konferenciákat 
szervez, tudásbázist tart fenn (Blender Cloud), nyílt for-
rású flmes projekteken dolgozik (Open Movies). 

A Blender sok területen bizonyítot az utóbbi időben. Rend-
szeresen  hivatkoznak  rá,  mint  a  kereskedelmi  animációs 
programok nyílt forrású alternatívájára. Számon tartják a 
szakmában. Nagyszámú szakkönyv jelenik meg a használa-
táról. 

Több oktatással foglalkozó cégnek is megéri tréninganya-
gokat  fejleszteni  hozzá  –  elérte  azt  a  „kritikus  tömeget”, 
hogy komolyan veszik. 

Egy szépséghibája van: inegyenesó

1. Látványanimáció

Ton Roosendaal Blenderben 
készült digitális szobra (Patrick 
Malinguaggi alkotása)

Album a Blendert használó 
művészek munkáiból

Blender tréninganyag 
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Open Movies 

Nyílt forrású flmek. A Blender Alapítvány által létrehozott flmkészítési mo-
dell.  Ton Roosendaal ötlete volt,  hogy a Blender fejlődésének előremozdítára 
hozzanak létre olyan projekteket, melyek célja egy-egy kisflm elkészítése. 

A produkciós időszakban az Alapítvány anyagi és technikai háteret biztosít 
egy tucat alkotó közös stúdiómunkájához. Az elkészült flmek bárki által szaba-
don letölthetőek, de nem csak a flmek, hanem a produkciós fájlok is. 

Egy-egy flm elkészítése nem csak művészi feladat. A stúdióban programozók 
is dolgoznak, a művészek igényei szerinti új fejlesztéseken. Ezek mindig be-
épülnek a következő Blender-verzióba, így biztosítva a program céltudatos fej-
lődését. 

Az  open moviek nagy előnye, hogy bárhol jogdíjmentesen lejátszhatóak, így 
rengeteg műszaki szaküzlet és bevásárlóközpont alkalmazta ezeket televízióké-
szülékeik  működésének  bemutatására.  Az  interneten  számos  médiaoktató-
anyag készült, melyek e nyílt forrású flmekkel demonstrálják flmes szofvere-
ik tulajdonságait. Ezek után ugyanis nem kell senkinek jogdíjat fzetni. 

A következő oldalon a Blender fejlődésének e fontos állomásait mutatom be. 

Semmi közük a látványanimációhoz, de talán igazat adsz nekem, ezzel a prog-
rammal valóban PIXAR-minőségű flmek készíthetőek.

Szóval illik komolyan venni a Blendert…

1. Látványanimáció

A Blender Institute készülőfélben levő filmje, a 327-es ügynök
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Elephants Dream (2006)

A Blender Alapítvány első flmje.  Hét hónapig dolgoztak 
rajta,  s  az eredmény egy művészi,  mély, elgondolkodtató 
animációs flm let. A valóság, képzelet és félelemeink kér-
déseiről. A programozók átírták a Blender teljes karakter-
animációs rendszert, a renderelési tulajdonságokat jelentő-
sen  továbbfejleszteték,  s  ekkor  került  a  programba  egy 
csomópont-alapú kompozitáló (flmutómunka) alegység is.

elephantsdream.org

Big Buck Bunny (2008)

A következő kisflm egy állatmese, az együgyű nagy bak-
nyúlról, akit gonosz kis mókusok vegzálnak, míg megelége-
li,  és  Rambo  szerepében  megbosszulja  sérelmeit.  A  flm, 
rendezőjének morbid humora miat, nem éppen tündérme-
se,  de mindmáig ez a legsikeresebb nyílt  forrású alkotás.
A hátérben ismét  megfeszítet mérnöki  munka folyt:  új  
haj- és szőrrendszert hozzanak létre a kis állatkákhoz. Ezzel 
a rendszerrel nagyon szép természetbeni jeleneteket is al-
kotak. A flm érdekessége, hogy párhuzamosan egy számí-
tógépes játékot is készítetek belőle  Yo Frankie címmel. A 
játékban a flm fő gonosza fondorlatoskodik tovább idilli 
környezetben.

bigbuckbunny.org

Sintel (2010)

A negyedórás kisflm produkciós ideje egy év volt. Az epi-
kus történet egy magányos kamaszlányról szól, aki egy se-
besült kis sárkányt fogad be othonába. Amikor a kis lényt 
elrabolják tőle, életét arra teszi fel, hogy megkeresse barát-
ját. A flm erőssége a történetmesélés. A befejezés döbbe-

1. Látványanimáció
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netes meglepetést tartogat. Rendezője azóta már a PIXAR 
csapatában dolgozik. A műszaki cél a program új felhasz-
nálói felületének tökéletesítése, a szobrászeszközök imple-
mentálása, s a renderelés fejlesztése volt.

sintel.org

Tears of Steel (2012)

Az  előző  három  kisflm  stílusa  sorrendben:  művészflm, 
rajzflm, epikus fantasy.  Ton Roosendaal  a következő alko-
tással szerete volna a speciális efektusok terén fejleszteni 
a Blender programot. Eredeti elképzelése egy történet nél-
küli efektkavalkád, ahol mindent meg lehet mutatni, amit 
a Blenderrel a flmtrükkök terén elérhetünk Ezzel ellentét-
ben Az acél könnyei egy elgondolkodtató morális sci-fi let, 
élőszereplős  felvételek  és  3D  elemek  kompozitálásával. 
Közben  olyan  fejlesztések  kerültek  a  programba  mint  a 
mozgáskövetés,  mozgó  maszkok,  greenscreen  technika. 
Először it mutatkozot be a Blender új, fzikai alapú ren -
derelője.  Nem mellesleg  megalakult  a  Blender  flmstúdió 
Blender Institute néven Amsterdamban.

tearsofsteel.org

Cosmos Laundromat (2015)

A következő projekt  célja,  egy nagyjátékflm létrehozása 
volt, melynek jeleneteit a világ különböző, Blenderrel fog-
lalkozó stúdióiban készítenék el. Ennek pilot flmje volt ez 
a kis  epizód,  mely látványvilágában,  technikai  szintjében 
erősen emlékeztetet a PIXAR flmjeire. Főszereplője Frank, 
egy depressziós birka, aki egy elzárt szigeten él, és éppen 
úgy dönt, hogy eldobja az életét. „Égi” segítséget kap, aki 
megakadályozza az öngyilkosságot, és eljutatja egy másik 
létformába. A flm a Siggraph-on díjat is nyert. Érdekessége 

1. Látványanimáció
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a hiperrealisztikus  látvány.  A flm háterében kibontako-
zot egy új szolgáltatási modell – a Blender Cloud. Egyrészt 
egy támogatási rendszer, másrészt egy szolgáltatásháló.

gooseberry.blender.org

Caminandes

Közben a nagy projektek mellet elindult egy kis sorozat a  
buta  lámával  a  főszerepben.  A  helyzetkomikumra  épülő 
epizódokból már három is elkészült. A Big Buck Bunny be-
teg humorával szemben ezek nagyon aranyos történetek.

caminandes.com

Glass Half

Egy másik, különálló kisflm, ahol a cél a rajzflmes megje-
lenítés volt. Kis humoreszk egy képtárban játszódik, két fő-
szereplője a lelkes emocionális látogató és a sznob műértő. 

Technikai  érdekessége  az  OpenGL-alapú,  valósidejű  ren-
derelés volt. Remek kis darab, jó történetel.

cloud.blender.org/p/glass-half

1. Látványanimáció
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2. A filmes 
munkafolyamat

2. A filmes munkafolyamat

2.
Megismerkedünk az animációs
flmek készítésének műhelytitkaival.
Majd lelkesen létrehozzuk 
eegyszemélyes stúdiónkat.
 

a flmes
munkafolyamat
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A spontán zsebfilmezés halála

Az  utóbbi  néhány  évtizedben  sokak  számára  elérhetővé 
váltak a flmkészítés technikai eszközei. Kis kézi kamerák, 
számítógépek, programok.

Napjaink hobbivideósa az egész produkciós folyamatot át-
látja okostelefonja lyukkameráján keresztül, ahonnan kiér-
lelt művészi munkájának gyümölcseit pillanatok alat meg-
osztja a világgal. Közösségi oldalakon és videómegosztókon 
elárasztanak  bennünket  az  utca  emberének  értékteremtő 
alkotásai: a pofácskájára eső aranyos kiscicától a vloggerek 
által szerkesztet műsorokig. 

Vajon az utóbbi időben nem egyszerűsödtek a flmkészítés-
ről kialakult elgondolásaink? Nem tűnik úgy, mintha a fl-
mezés  egy instant  folyamat  lenne:  előkapjuk a  kamerát, 
felveszünk valamit, aztán már toljuk is a világhálóra?

Fotó: Eelke Dekker

A zsebkamerás flmezés amatőr műfaj,  aminek megvan a 
maga varázsa. Ha próbáltál már komolyabb kisflmet össze-
hozni, melynek történeti szála túlmutat a „nagypapa zab-
pelyhet reggelizik” mélységein, talán tudod, hogy a flmké-
szítés folyamata három részből áll. 

Kigondolom, leforgatom, megszerkesztem. S it még mindig  
csak az egyszemélyes „szerzői” flmekről beszélünk, melyet 

2. A filmes munkafolyamat
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nagyjából a család és néhány barát fog megnézni. Szeretet-
ből vagy szánalomból megosztani. 

Ma már akár speciális effektusokat is készíthetünk „házilag”. Lányok zöld hát-
tér előtt a Peace it Together filmes projektben.

Ha komolyodik a dolog, akkor a folyamat számot és sze-
mélyt vált:  Kigondoljuk, leforgatjuk, megszerkesztjük. Igen, 
az igazi flmkészítés közösségi tevékenység. 

Elég  költséges,  és  emiat szükségszerűen  tudatosnak,  és  
szervezetnek kell lennie.

Film kontra animáció

A flmkészítés munkafolyamata három nagyobb részből áll : 
Az  előkészítés (preprodukció), a  forgatás (produkció), és az 
utómunka (posztprodukció). Ha becsületesen végzed az elő-
készítést, az kihatással lesz a folytatásra, a forgatásra. Nem 
a helyszínen derül ki, hogy nincs is forgatási engedély; a 
színészek nem fognak összeveszni, mert századszor veszed 
fel velük velük ugyanazt a jelenetet; és minden kellék meg-
érkezik időben. Ha jól forgatál, nem kell digitális utómun-
kával eltüntetni a válságtanácskozás közben belógó mikro-
font, a bajvívás háterében tolató Trabantot. 

2. A filmes munkafolyamat
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Idáig a klasszikus flmkészítésről beszéltünk, nem az ani-
mációról. Miben különbözik a kető? 

Talán a legmarkánsabb különbség, hogy az animációnál fé-
lelmetesen  felértékelődik  az előkészítés  szerepe,  ugyanis 
minden,  ami  utána  jön,  elképesztően  időigényes.  Emiat 
költséges, s idő hiányában legtöbbször megismételhetetlen. 

Szóval egy jó előkészítés nagyon sok fejfájástól és fejlövés-
től megkímélhet bennünket. 

Pre...pro...prepro…prerodukció!

Ötlet ♦ Minden flm szíve az ötlet. A flm történetmesélés. 
Egy jó flm észrevétlenül bevon az alkotók által teremtet 
világba. Együt lélegzünk a szereplőkkel, konfiktusba ke -
veredünk, frusztrálódunk, küzdünk, túlélünk vagy megha-
lunk – egy picit, a szomorúságtól.

Alkotók a Big Buck Bunny c. nyílt forrású film előkészítési szakaszában. Folyik 
az ötletelés.

Sokféle flm van, de közös bennük, hogy csak akkor tudod 
megvalósítani, ha a flm ötlete értékes – s ez igaz az egysze-
mélyes flmekre is. Korábban azt mondtam, hogy a flmké-
szítés közösségi tevékenység, de it, a számítógépes animá-
ció műfajában találkozhatsz olyan alkotásokkal, melyekben 

2. A filmes munkafolyamat
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a rendező, a producer, a forgatókönyvíró, a karakterterve-
ző, az animátor, a takarító, de még a vágó is ugyanaz a sze-
mély.  Bár  számítógép sok ember monoton munkáját  he-
lyetesíti,  nem ritka,  hogy  az  eféle  egyszemélyes  flmek 
egy-két éven keresztül is készülnek. Jó ötlet nélkül ki ál-
dozná erre életének ilyen hosszú időszakát?

Csak egy feldobot ötletel nem kopogtathatsz be a produ-
cer ajtaján. Kell valami kézzelfogható anyag, ezt úgy hív-
juk, szinopszis1. Filmnovella, vagy ha így jobban tetszik: fo-
galmazás,  mely  még  nincs  részletesen  kidolgozva,  de  a 
döntéshozók láthatják, működik-e, életképes-e az ötleted.

A látványanimáció előkészítésében a szinopszis inkább le-
írás, az ötlet és a belőle kibontakozó látványvilág kibontá-
sa, mint egy történetvonal – de fgyeld meg később, akár 
egy  hangulatokból,  dominánsan  látványból  építkező  kis-
flmben is meg fogod találni a történetet…

Forgatókönyv ♦ Az előkészítő szakasz, a preprodukció kö-
vetkező lépése a forgatókönyvírás. A forgatókönyvet legin-
kább egy színdarab szövegkönyvéhez lehetne hasonlítani, 
ahol nem csak párbeszédek, de rövid rendezői utasítások is 
szerepelnek. Az írás során kibontakozik a forgatókönyvíró 
fejében a flm, annak minden jelenete, beállítása. A forgató-
1 Kivonat – latin.

2. A filmes munkafolyamat

Lucas Martell egyszemélyes 
animációs filmje 5 évig készült. 
Lejátszási ideje 6 perc...
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könyvírás tartalmi és formai követelményei az utóbbi száz 
évben megszilárdultak. Mivel mi egy olyan műfajt válasz-
totunk, ahol a látvány mondja el az üzenetet, ne erőlködj a 
forgatókönyvírással.  Látványanimációhoz  ugyanis  nem 
kell forgatókönyvet írnod, inkább képregényt rajzolnod…

Az Elephants Dream című, Blenderrel készült animációs film agyagból formált 
karaktertervei, s filmbeli megvalósulása (lent)

Látványterv ♦ Az animáció- és képregénykészítés folya-
mata ezen a ponton megegyezik: Még mielőt egy képkoc-
kát is rajzolnál, tudnod kell, hogyan néznek ki a szereplők, 
milyen helyszíneken játszanak, egyáltalán milyen stílusban 
szeretnéd megjeleníteni őket. 

2. A filmes munkafolyamat
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Vladiszlav Szolovjov Vjacseszlav Velikoredcsanin látványterve

Ha látványanimáción dolgozol, ez a lépés nem tűnik talán 
olyan fontosnak,  még sem kikerülhető.  Ha nem tervezel 
szereplőkkel, akkor a környezet a főszereplő. Lehet, hogy 
az animációs program lehetőségeivel játszva alakul ki az a 
világ, amely majd a flmben megjelenik. Ha nem vagy tu-
datos tervező, csak kísérletezel,  akkor a látványterveid is 
it jönnek létre. Ezeket oszd meg nyugodtan a megrendelő-
vel. Persze jó, ha az ember géptől függetlenül is tud vázla-
tolni – hagyományos technikával, de ha nem vagy maga-
biztos  a  klasszikus  eszközök  kezelésében,  használj 
illusztrációs- vagy festőprogramot2. 

David Revoy látványterve a Cosmos Laundromat c. kisfilmhez.

2 Elvontabb, geometrikus, absztrakt formákhoz ajánlom az Inkscape programot, 
digitális rajzhoz vagy festéshez pedig javasolt egy digitalizálótábla és a Krita 
festőprogram. Mindkető kiváló nyílt forrású grafkus alkalmazás, ami ingye -
nesen beszerezhető! [inkscape.hu; krita.org]

2. A filmes munkafolyamat
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Zeke Szabolcs storyboardja egy Debrecen várost bemutató animációs filmhez

Képes forgatókönyv ♦ Angol nyelvterületen  storyboard-
nak hívják, a némaflmek korában is használták, de ebben a 
formában a Walt Disney Stúdióban vált az előkészítés mun-
kaeszközévé.  A képes  forgatókönyv az  operatőr  vagy az 
animátor vizuális partitúrája, amelyben képregényszerűen, 
beállításról beállításra megrajzolják a jeleneteket. A képsor 
alat a  párbeszédeknek,  hangefektusoknak  is  van  helye.  
Így aztán egy olyan vizuális forgatókönyv keletkezik, mely 
maximálisan informatív vezérfonalul szolgál az animációs 
munkafolyamat során  annak  a  csapat  embernek,  akik 
együt dolgoznak a flmen. 

Előszinkron és zene ♦ A hagyományos flmek munkafo-
lyamatban az utómunka során történik a szinkron hozzá-
adása és flmzene felvétele. Az animációban szokatlan mó-
don  az  elejére  kerülnek  ezek  a  műveletek  –  ha  nem is 

2. A filmes munkafolyamat
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mindkető, de a beszéd mindenképp. Hogy miért? Képzelj 
el  egy hagyományos felvételt,  mondjuk egy párbeszédet. 
Nagyon ideális körülmények kellenek ahhoz, hogy a felvé-
telen a hang tökéletes legyen. Habár a hangmérnök min-
dent megtesz  ezért,  de  optimális  csak az utószinkronban 
lesz, amihez támpontnak használják a felvételeit. Animáci-
ónál viszont nem a semmihez, hanem a már meglevő hang-
hoz szinkronizáljuk a szereplők szájmozgását. Sőt, gyakran 
videofelvétel is készül a forgatókönyv párbeszédeit elmon-
dó színészekről, hiszen így a hang mellet a hozzá kapcsolt 
karakterük is megjelenhet az animációban.

Emo (Cas Jansen) és Proog (Tygo Gernandt) az Elephants Dream c. film szink-
ronhangjai. Balra Emo karaktere a Blenderben, jobbra Proog a filmben.

S mi a helyzet a zenével? Hosszabb animációs flmek bü-
dzséje megengedi, hogy zeneszerzőt alkalmazzanak. 

Jan Morgenstern sok Blenderrel készült filmnek volt a zeneszerzője.

De egy olyan rövid kis spotokhoz, mint amilyeneket mi is 
fogunk  készíteni,  legtöbbször  előre  megkomponált  zenét 

2. A filmes munkafolyamat
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használnak. Ahogy az előszinkronnál, ennél a fajta flmze-
nénél is nagy előny, ha a meglevő muzsika ritmusára ani-
málhatunk, ütemezhetjük a mozgásokat, történéseket.

Animatik  ♦ Az  animáció  nagyon  időigényes  technika. 
Nem tehetjük meg az animátorokkal, hogy néhány percet, 
sőt néhány másodpercet is feleslegesen dolgozzanak. Gon-
dolj csak bele, minden másodpercre 24 képkockát kell létre-
hozni – megrajzolni vagy a számítógéppel kiszámolni. Há-
rom plusz másodperc  72 felesleges képkocka, amit a vágó 
kegyetlenül lemetsz!

Hogyan  lehet  pontosan  ütemezni  így  egy  animációs  fl-
met? A flmesek fogják a hanganyagot és a storyboardot, s 
egy  flmvágó  programban összepakolják  egy  zenére  futó 
diavetítéssé. 

Képkocka  a  debreceni  animációs  reklámfilm animatikjából,  rendezte:  Zeke 
Szabolcs.

Ez az animatik. Ezzel az eljárással pontosan lehet ütemezni 
az animációt. Mindenki tudja majd, hogy a rá kiosztot be-
állítás vagy jelenet milyen hosszú lesz, s nagyjából hogyan 
néz ki. Ha látványanimáción dolgozol, ne hagyd ki ezt a lé-
pést. Rögtön látni fogod, működik-e minden megoldás a fl-
medben…

2. A filmes munkafolyamat
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Az animatik legtöbbször hagyományos állóképek egymás-
utánja, de használhatsz más technikákat is. Ahogy a pro-
dukciós folyamtban haladsz, az elkészült beállításokat, jele-
neteket vissza lehet ide írni, újra és újra fnomítva azt.

Ugyanazon jelenet a Big Buck Bunny c. nyílt forrású animációs filmből: 1) Ani-
matik. 2) Previz. 3) Blender animáció. 4) Végső képkocka.

Az animatik egyik formája az elővizualizáció (previz), vagy 
nyers animáció. It már 3D-ben dolgoznak, csak elnagyolt  
fgurákkal (proxy), melyeket később lecserélnek a felvétel-
ben.  A  previzben  kipróbálható  a  kamera  és  a  szereplők 
mozgása anélkül, hogy hosszú gépidőbe telne azok megje-
lenítése. It még minden olyan, mint egy Sims játékban…

Produkció!

Egy nagy animációs stúdióban a megvalósításnak, a pro-
dukciós folyamatnak az elkövetkezendőkben leírt szakasza-
it  külön  részlegek  végzik.  Ha  egyszemélyes  vállalatban 
gondolkodsz, fel kell készülnöd, hogy mindegyik művelet-
hez értened kell egy kicsit… nagyon.

Ezek a modellezés, anyagok és textúrák felvitele, a csonto-
zás, az animáció, a 3D efektusok és a renderelés.

2. A filmes munkafolyamat
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Modellezés ♦ Hát ezt is megértük! Kezdődik a forgatás. 
Először is elkészülnek azok a tárgyak és szereplők, amik és 
akik megjelennek a flmben.

Spiderman autója? Az árnyalt modell feletti hálóval láthatóvá válik, hogyan 
modellezték az alakzatot. (Forrás: blenderguru.com)

A könyvben megtanulunk majd néhány egyszerűbb model-
lezési módszert. Most elég csak annyit tudnod, hogy tech-
nikai jellegű modellekhez más módszerekkel nyúlunk mint 
organikus alakzatokhoz. Van, aki a hagyományosabb szob-
rászati technikákat kedveli. Ők akár agyagba is álmodhat-
ják az elképzeléseiket,  amit aztán lézerrel beszkennelnek, 
vagy sok oldalról lefényképeznek, s ebből generálnak egy 
nagyon  részletes  3D  modellt.  Aki  viszont  nem  szeretné 
agyaggal összekenni a kezét, szobrásztechnikát talál majd a 
Blenderben is. 

A szobrászkodással vagy szkenneléssel létrehozot model -
lek  túl  részletesek,  megterhelik  gépünk  erőforrásait.  A 
gyorsabb használat miat ezeket leegyszerűsítik.

Persze  modellezés  nélkül  is  lehet  modelleket  használni, 
ahogy a Tesco-ban is lehet halakat fogni, csak fzetni kell 
értük. Sok internetes kereskedés specializálódot arra, hogy 
a flmipart ellása jó minőségű modellekkel3. 

3 A blendswap.com-ról pl. havonta 20 Blender-modell tölthető le ingyenesen egy 
regisztráció után.

2. A filmes munkafolyamat
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Optikai tulajdonságok és textúrák ♦ Miután elkészültek 
a testek, hihetővé, valószerűvé kell tennünk azokat. Más-
más  fénytani  sajátosságai  vannak  a  szálcsiszolt  fémnek, 
porcelánnak, üvegnek, bársonynak, a villanykörtének és a 
bőrnek. Ezek az optikai tulajdonságok4 alkotják majd a test 
anyagát. 

Aztán domborzatot (faktúrát) és mintázatot (textúrát) ho-
zunk létre rajtuk, hogy ezzel is növeljük a valóságérzetüket 
– ezt nevezik textúrázásnak. Az egész olyan, mint egy tér-
képészeti probléma: hogyan lehet egy gömbre, emberfejre 
vagy egy nadrágra megfelelő mintázatot tenni úgy, hogy a 
minták síkbeliek? Ezt a földmérőknek való feladatot neve-
zik UV-zásnak. 

Optikai anyagtulajdonságok.

Senkiben nem szeretnék rossz emlékeket ébreszteni egyete-
mista éveiből: Az UV nem az utóvizsga rövidítése, sőt egy-
általán nem is rövidítés. Mivel az XYZ tengelyek a program 
térbeli kiterjedéseihez már foglaltak, az ABC-ben már csak 
az U és a V maradt, hogy ezeknek a testekre feszítet ké -
peknek a koordinátáit jellemezhessük.

Csontozás  ♦ Most már egészen valósághűek a szereplő-
ink,  csak  mozgatni  kell  őket.  Régebben  a  stop  motion  

4 Az angol szakirodalomban a nevük „shader”, azaz árnyaló. A Blender anyag-
ként hivatkozik rájuk (material).

2. A filmes munkafolyamat
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animációban5 alkalmazták ezt a technikát, melyet számító-
gépre  implementáltak.  A  bábokat  egy  acélcsontváz  köré 
építeték. Ezt a vázszerkezetet, melyet csuklói mentén sza-
badon lehetet forgatni, hívták armatúrának. A 3D animá-
cióban ugyanúgy hívjuk a  csontrendszert,  mellyel  defor-
máljuk  vagy  mozgatjuk  a  tárgyakat.  Valósághű  mozgás, 
például járás nincs megfelelően kidolgozot, ügyesen kap-
csolt armatúra nélkül. Ezzel oldják meg az arcjátékot, az iz-
mok által keltet deformációt is. 

Madárfigura csontozása Blenderben (Forrás: cgcookie.com)

Látványanimációinkban  legtöbbször  nem  kell  bonyolult 
csontrendszereket  létrehoznunk.  Egyszerűbb  tárgyakkal 
dolgozunk.

Animáció ♦ Megvannak a modelljeink, megfelelőek az op-
tikai és grafkus tulajdonságaik, mozgathatóak. Szinte min-
den készen áll arra, hogy elkezdjünk animálni. 

Röviden  hasonlítsuk  össze  a  klasszikus  és  számítógépes 
animáció technikáit. Az informatikában nem előzmény nél-
kül történnek a fejlesztések, sőt a legtöbb eljárást egyszerű-
en átvesszük előző korok gyakorlatából.

5 Stop motion, magyarul kockázás, ahol az animációt kockáról-kockára veték 
fel, miközben az animátor minden kocka után egy kicsit mozdítot a modellen.

2. A filmes munkafolyamat
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Klasszikus lépésanimáció (Forrás: marionettestudio.com)

A hagyományos rajzflmes technika: Rajzold meg a szerep-
lő mozgásának  kulcsmozdulatait (keyframe), majd e moz-
dulatok közöti fázisokat (inbetween). 

Mindezt egy alulról  átvilágítot asztalon,  hogyha az egy -
másra  rakot rajzokon  jól  látható  legyen  az  elmozdulás.  
Ezeket a rajzokat add tovább a kihúzóknak, akik a körvo-
nalakat átrajzolják celluloid lapokra (fóliára). Munkájukat 
ők is továbbadják a kifestőknek. 

Közben a mások elkészítik a hátereket.  Az operatőr kap 
egy  táblázatot  (dopesheet), melyen  folyamatában  jelölik, 
hogy melyik képkockán minek kell szerepelnie. Ő egy fe-
lülről jól megvilágítot asztal fölöti kamerával végigfény -
képezi a fázisokat. 

Az emberi szem tehetetlenségét becsapva a mozgóflmben 
másodpercenként 24 képkocka jelenik meg. A rajzflmben 
minden fázisról két képkocka készül, így a 12 mozgásfázis 
duplázvódik, tökéletes mozgás illúzióját keltve.

A bábflmeknél, gyurmaflmnél és egyéb  stop motion ani-
mációnál kicsit jobb helyzetben vagyunk, hiszen formálha-
tó szereplőink vannak. Fázisról-fázisra „csak” mozgatnunk 
kell, a rajzolási folyamatok megspórolhatóak. Ennek a gaz-

2. A filmes munkafolyamat
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daságos technológiának síkbeli változata a papírkivágásos 
(cutout) animáció.  Ebben kollázsszerűen kivágot foltokat  
mozgatnak. Jellemző példa a South Park sorozat. Ennek első 
epizódjait  hagyományos-,  későbbieket számítógépes tech-
nológiával készíteték. 

Glen Melenhorst síkanimációja Blenderben.

A klasszikus síkrajzflmes technológiák alternatívái (pl. bá-
banimáció) a tér és az idő problémáit igyekeztek orvosolni.

Mindaddig, míg proflból vagy szemből látjuk rajzflmünk 
szereplőit,  viszonylag gyorsan rajzolhatóak a mozgásfázi-
sok. De ha megrázzák a fejüket, elfordulnak, a korábbi raj-
zok  nem  újrafelhasználhatóak.  Az  átformálódó  alakok 
megrajzolásához több idő kell. 

Minden lépésben küzdünk ezzel: Az animáció a legidőigé-
nyesebb flmes műfaj. A hosszú folyamatok unalmasakká, 
néha idegőrlővé is válnak. Gépiesen másolatokat rajzolni, 
kihúzni vagy színmintából kifesteni az alakokat az első tíz-
ezer kocka után inkább hasonlít valamilyen állami büntető-
intézetben végzet javító-nevelő munkához, mint művésze-
ti tevékenységhez. 

2. A filmes munkafolyamat
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Aki készítet már hosszabb stop motion animációt, az tudja, 
milyen  unalmas  a  „picit  mozdítom,  lefényképezem…”  is-
métlődése. Szalagmunka ez, nem kreatív tevékenység!

Ezekre a problémára válasz – a számítógépes téranimáció. 
A virtuális térben levő objektumok bármely tengely körül 
forgathatóak, s ezek a mozgások könnyen leképezhetők. Az 
animátor a kulcskocka-rajzoló szerepében marad, az ideg-
őrlő fázisrajzokat a számítógép generálja.

Természetesen újabb és újabb technológiák jönnek,  hogy 
gyorsabbá és hatékonyabbá tegyék a hosszadalmas animá-
ciós munkát. A motion capture  rendszerekkel például ani-
máció  helyet egy  színész  mozgásának  adatait  rögzítik,  
majd ezt az adathalmazt hozzárendelik egy számítógépes 
fgurához. 

Gollam és a motion capture rendszerben mozgó Andy Serkis.

Az új technikának nagy szerep jut a számítógépes játék-
iparban, valamint a flmekhez készítet virtuális karakterek 
mozgatásánál. 

Karakteranimációnál  viszont  nem  nagyon  működik.  Az 
igazi animáció ugyanis nem hiperrealista, inkább hasonlít 
táncra vagy pantomimra, mint színjátékra.

2. A filmes munkafolyamat
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3D efektusok ♦ Nagy utat tetünk meg az első, egész es-
tés számítógépes animációs flmtől (Toy Story,  1995) mind-
máig. Ahogy tökéletesedet a technika, mindig látunk va -
lami újat, érdekeset, a valóság olyan elemét, amit korábban 
csak játékflmekben. Az első 3D-s flmeknél még elképzel-
hetetlen technikai teljesítmény let volna lobogó hajat, si -
mogatható szőrt vagy lágy redőkben leomló ruházatot ké-
szíteni. Ma már észrevétlen, természetes velejárója ezeknek 
a flmeknek – köszönhetően sok mérnök és fejlesztő mun-
kájának, akik a fzikai valóság elemeit a matematika nyel-
vére fordítják.

Vannak olyan efektusok, melyek az utómunka során ke-
rülnek a flmes anyagba. A produkciós szakaszban viszont 
csak azokkal foglalkoznak, melyek valamilyen interakcióba 
lépnek a szereplőkkel. 

Balra: Szilánkosra törő üvegen átfúródó golyó. Forrás: blenderguru.com. 
Fent: Haj a Blenderben.

A látványanimációkban gyakorta megjelennek fzikai szi-
mulációk: folyadék, füst, szél, ruhák, rugalmas testek, szi-
lánkos törések, ütközések. A könyvben mi is foglalkozunk 
majd ezekkel.

2. A filmes munkafolyamat
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Renderelés ♦ A produkciós részleg utolsó feladata a kép-
kockák kiszámítása. A számítógép – nevéhez híven – nem 
fog mást tenni, mint számolni és számolni, amilyen gyor-
san csak tud.  S habár gyorsan tud,  de a megfelelő ered-
mény eléréséhez néha percek, máskor órák kellenek. 

Gleb Alexandrov: Szöul 

A  képkockák  kiszámítását  renderelésnek6 hívjuk.  A  ren-
derelést  megelőzően  korrekten  bevilágítják  a  jelenetet, 
majd eldöntik, hogy egyben vagy rétegenként szeretnénk 
az utómunka-csapatnak továbbküldeni a képkockákat. Ha 
csak színkorrekcióra lesz szükség, lehetne akár a teljes ké-
pet egyszerre renderelni, de komolyabb munkáknál külön 
rétegekre  bontják  a  csúcsfényeket,  árnyékokat,  térbeli 
mélységinformációkat, tárgyakat, szereplőket. 

Az it befektetet többletenergia sokszorosan megtérül az  
utolsó szakaszban. Az utómunka során végzet korrekciók  
sokszorosan gyorsabbak,  mint  a  hosszadalmas renderelé-
sek, fnomítások és újrarenderelések.

A renderelés a leginkább számításigényes feladat. Célszerű 
külön gépek füzérén, ún.  renderfarmon végezni. A stúdiók 

6 Renderelés: eredeti jelentése az angolban árnyalás, vakolás. A flmesek leszá-
molásnak hívják, ami inkább kriminalisztikai fogalomnak hangzik. 

2. A filmes munkafolyamat
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saját farmjaikon, hálózatba kötöt sokmagos gépeken dol -
goznak. Egyéni alkotók interneten is hozzájutnak hasonló 
szolgáltatáshoz, vagy saját gépükön végzik azt. Nem flmet 
renderelnek, hanem képkockák sorozatát – szekvenciát. 

Ezzel véget is ért a produkciós szakasz.

Utómunka

Kompozitálás  ♦ Manapság egy jelenet gyakran kismillió 
összetevőből  áll :  lehet  benne  élő  felvétel  3D  modell,  s 
egyéb speciális efektus. Gyakran olyan flmekben is, ahol 
nem is gondolnánk. 

A CGI7 akkor működik a legjobban, ha észre sem lehet ven-
ni. Gondoljunk egy történelmi flmre, ahol a régi épületek 
ma már nem igazi díszletek. A színészek gyakran nem va-
lós terekben játszanak, hanem zöld vagy kék hátér előt, 

7 Computer-generated Imagery: számítógépen létrehozot képek.

2. A filmes munkafolyamat
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melyet eltüntetnek az utómunka során. Ezeknek az elemek-
nek az összemásolását végzik a kompozitálás során.

Francia fejlesztésű nyílt forrású kompozitáló program a Natron.

Kompozitálás  idején  sokféle  képjavító  eljárást  nagyon 
gyorsan el lehet végezni. A prof renderelés többrétegű ki -
menete lehetőséget ad széles határok közöt változtatásra.

S ebben a szakaszban adnak a képhez olyan efektusokat, 
melyek  az  atmoszféráját  adják  a  jelenetnek:  szálló  por, 
szikrák,  esőcseppek,  kamerában  megcsillanó  ellenfény, 
fényforrások körül megjelenő fényudvarok. De it történik  
a zöld vagy kék háterek vagy a nemkívánatos elemek el-
tüntetése, a kameramozgás stabilizálása is.

A látványanimáció készítése során nagyon fontos állomás 
a kompozitálás. A végső látvány tulajdonképpen it formá-
lódik meg. 

2. A filmes munkafolyamat
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Vágás  ♦ A flm jelenetein mindeddig  külön dolgoztunk, 
ideje összehordani, flmmé szerkeszteni az anyagokat. 

A vágást célszofverekkel végzik, melyek képesek ezeknek 
a jeleneteknek s az alatuk futó zenének, szinkronnak és 
zajoknak az együtes kezelésére. 

A vágás során nyeri el végső alakját a flm. Ha animációs 
flmet készítetél,  már nincs  olyan sok dolgod,  hiszen az 
előkészítő szakaszban az animatikkal már meghatároztad a 
vágások helyét, a flm ütemezését.

Többsávos vágás a Blenderben.

Gyakori,  hogy  it vagy  a  kompozitáláshoz  kapcsolódóan  
végzik a flm fényelését, azaz az egységes színezést. 

A vágóprogramból aztán újra rendereljük,  leszámoltatjuk 
az egész flmet, annak megfelelő változatokban, hogy hol 
lesz majd bemutatva. 

2. A filmes munkafolyamat
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Összegzés

Talán lehetet volna rövidebben bemutatni  a  flmkészítés  
folyamatait. 

Ha most kezdesz 3D animációval foglalkozni, nem alakítasz 
azonnal stúdiót,  nem veszel fel  szakképzet alkalmazota -
kat,  kikkel  azonnal le  lehetne fedni  az egész folyamatot. 
Kezdetben magadra leszel utalva. Szinte mindenhez neked 
kell értened, s ez talán egy kicsit ijesztő. 

A látványanimáció munkafolyamata, amint a leírásban ta-
pasztaltad, a teljes flmkészítési folyamatnál szűkebb. Meg-
kockáztatom:  egyszemélyes.  Kiváló  lehetőség kezdőknek, 
hogy valami látványosat alkossanak, a flmkészítés összes 
szervezési és közösségi nyűge nélkül. 

Ha megszereted, tovább fogsz lépni, s erre most már annyi-
féle lehetőséged lesz… 

Talán  nem  volt  haszontalan  megismerni,  miből  választ-
hatsz.

2. A filmes munkafolyamat
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3. A Blender 
kezelése

3. A Blender kezelése

3.
A Blender felhasználói felülete 
első látásra olyan ijesztő, mint a főnököd. 
Később rájössz, hoegy van néhány emberi
tulajdonsága. Végül a közös munkában
barátokká váltokó

 a Blender
kezelése
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Mire képes a Blender?

Miután megismerted a flmes munkafolyamatot, joggal kér-
dezheted, hova lehet ebben a Blendert pozicionálni? 

A legtöbb kereskedelmi 3D alkalmazás ugyanis a folyamat 
közepét, a produkciós szakaszt  célozza meg. Ritkán vannak 
az előkészítést vagy az utómunkát támogató eszközeik.

A Blender egy kis holland stúdióból indult. Tudjuk, a hol-
landok milyen takarékos, szorgalmas nép – teljes animáci-
ós rendszerüket is igyekeztek saját fejlesztésű szofverük-
kel megoldani. Ton Roosendaal, szerint a nagy stúdiók, ahol 
tömegével licencelik a programokat, a 3D világ jéghegyé-
nek csak a csúcsa. Rajtuk kívül is van élet. 

A Blender a kis stúdiókon szeretne segíteni megoldásaival. 
Ezért olyan mint a svájci bicska: teljes értékűen használha-
tó a produkciós szakaszban, de vannak az előkészítést és az 
utómunkát segítő eszközei is.

Egy programon – és nem csomagon – belül lehet modellez-
ni,  textúrázni,  csontozni,  fzikai  szimulációkat  végezni,

3. A Blender kezelése
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és renderelni. A Blender videoszerkesztőként is használha-
tó – ami nagyon jó szolgálatot tesz az animatik készítésé-
nél  és a végső vágásnál  is.  Utómunkához kompozitort  is 
tartalmaz.  Emellet saját  belső  játékmotorja  van,  amivel  
egyszerűbb játékokat fejleszthetünk. 

Eszközöket  ad  digitális  szobrászathoz,  élő  felvételekből 
mozgáskövetője  visszafejti  a  kamera  elhelyezkedését,  és 
mozgását, ezzel segíti valós és digitális tárgyak, szereplők 
egy flmen belüli megjelenítését. 

Mivel  Python  nyelven  bedolgozókat  (Add-on)  írhatunk 
hozzá, tetszőlegesen bővíthető.

Szóval minden egy helyen. Ingyen. Tetszik? Akkor…

…telepítsük. 

Telepítés, rendszerigény

Ha elakadnál a Blender telepítésében, a  Függelékben 
találsz segítséget Windows, Linux és Mac OS X rend-
szerekhez.

Milyen minimális gépigénye van a programnak? A szofver 
honlapja szerint kétmagos processzor, 2 GB RAM, három-
gombos egér, s egy belépőszintű videokártya, OpebGL 2.1-
es támogatással. Igen, jól lehet futatni egy átlagos gépen 
is.  Bizonyos bonyolultságig  megfelelően kezelhető,  de  az 
erőforrás-igényes  feladatnál  (renderelés,  szimuláció)  ké-
szülj fel lassulásra. 

Erős  hardveren ellenben stabil  működés,  gyönyörű valós 
idejű renderelés, sokszorosan gyorsabb produkciós render-
idő várható. 4–8 magos processzorral, 8–16 GB RAM-mal, 
SSD-vel,  két  monitorral  és  egy nagy memóriával  ellátot 
(4–8 GB) sok CUDA-magos nVidia videokártyával.

Ez egy prof program, meghálálja, ha „vassal” etetik…

3. A Blender kezelése
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Üdv a fedélzeten!

„A program felhasználói felülete könnyen átlátható, intuitív  
és pillanatok alat tanulható.”  – valahogy így kezdődne az 
Aknakereső vagy a Pasziánsz kézikönyv-bestseller. 

A Blender viszont: „Bonyolult, mint a női lélek, komor akár  
eegy saját útját járó westernhős, és sokrétű mint az ezer legelőt  
birtokló pásztorember.”

Komolyra fordítva a szót: Egy program, melyben a semmi-
ből világokat teremthetsz. A térnek három dimenziója van, 
az idő egyfelé halad, a fényforrások fotonokat bocsátanak 
ki, a testeknek mechanikai tulajdonságai lehetnek…

A valóság bonyolult, s amikor megpróbáljuk leírni, a művé-
szet vagy a tudomány nyelvét használjuk. Beszélned kell 
mindketőt, ha szépet, hiteleset szeretnél alkotni.

Lauren Rushing fényképe

Hogyan készült ez a fotó? Megfelelő szögben, természetes 
környezetben, kedvező időben, az úgynevezet arany órá -
ban fényképeztek. Ez a naplemente előti időszak. 

Ellenfény volt, ami kiemelte a modell sziluetjét és átvilágí-
tot a vízcseppeken. Kellékek: dunsztos üveg, víz, modell.  

3. A Blender kezelése
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Jól beállítot kamera: kis mélységélesség, gyors expozíció,  
némi derítés. Hirtelen mozdulat a megfelelő pillanatban. 

Esetleg elsőre összejöt sem jöt minden. Talán ő volt a har-
madik ázot modell… 

Hogyan lehetne mindezt 3D-ben reprodukálni? Némi ízelí-
tőt kapsz a könyvben arról, hogy nem is olyan egyszerű. A 
virtuális  térben  való  tervezés  folyamatát  csak  bizonyos 
mértékig tudjuk leegyszerűsíteni. Kezdetben úgy érzed ma-
gad, mintha egy repülőgép pilótafülkéjében ülnél – az ovis 
ballagásod után. Ne aggódj, biciklizni vagy radiátort szerel-
ni sem két nap alat tanul meg az ember!

A számítógépes tervezéshez, animációhoz vagy játékszer-
kesztéshez használt kereskedelmi és stúdióprogramok kissé 
másképp, de ugyanúgy bonyolultak, mint a Blender. 

Még nem a Blender. A Foundry MODO programja. Egyszerű, mint a faék? Nem 
mondanám. 

A 3D programok szépségversenyében hasonló felhasználói 
felületekkel  versenyezne  az  Autodesk  Maya,  3D  Studio 
MAX, Sofimage, a Lightwave, hogy csak a híresebbeket em-
lítsük…

3. A Blender kezelése
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A Blender felhasználói felülete produkciós munka közben.

Hogy fogódzókat találjunk, hasonlítsuk a Blendert más, el-
sősorban  síkgrafkai  programokhoz.  Olyan  nyílt  forrású 
szofverekre gondolok,  mint az  Inkscape,  a  Gimp,  a  Krita 
vagy a  Scribus,  de ide sorolhatóak azok a professzionális 
grafkai programok is,  mint a  CorelDraw,  a  Photoshop,  az
Illustrator  vagy az  InDesign. Mindegyikről megállapítható, 
hogy felhasználói felületük hasonlóan épül fel. 

Az Inkscape illusztrációs szoftver.

A felületek tetején a szokásos Menüsor (1), bal oldalán az 
Eszköztár (2),  jobb oldalán  Tulajdonság-panelek (3) fogják 
közre a Munkaterületet (4). 

3. A Blender kezelése

Menüsor (1)
Eszköztár (2)

Tulajdonság-panelek(3)

Munkaterület (4)
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Ha a számítógépes síkgrafka világából érkezel,  nem lesz 
nehéz megértened a Blender felületét, mert az alapfelépítés 
ugyanaz. 

Indítsd el a programot, ellenőrizd, amiről beszélek. A Mun-
katerület it is  középen foglal  helyet.  Ez egy mikrovilág:  
Egy sík, amely elválasztja az eget a földtől, egy táregy (koc-
ka),  mely  ennek  a  világnak  első  építőköve,  egy  lámpa, 
amely a megvilágításért felel, és a kamera, mely közvetíti e 
világnak az eseményeit.  Egyelőre ne nyúljunk semmihez, 
jobb a békesség!

A felhasználói felület bal oldalán az Eszköztár (Tool Shelf), 
ahol  a  leggyakrabban  használt  műveleteket,  a  testépítés 
eszközeit,  stb.  találod.  Egyelőre  ne  nyúljunk  semmihez, 
jobb a békesség!

3. A Blender kezelése

A Blender 
Eszköztára.
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A jobb oldali sáv láthatóan két részre van osztva. (Őszin-
tén: millió meg egy részre…) De elkülöníthető a tetején egy 
Átekintő (Outliner) ablak, amelyben beazonosíthatod a ka-
merát,  kockát  és  lámpát.  Ide  kerül  minden tárgy,  amit  a 
Munkaterületen létrehozol. 

Az alata levő  Tulajdonságok (Properties) ablakban végzed 
majd világod és szereplőinek fnomhangolását. Egyelőre ne 
nyúljunk semmihez. Tudod…

Az alsó terület azoknak lehet ismerős, akik látak már flm-
vágó vagy animációs programot.  Ez egy  Idővonal  (Time-
line), amely a negyedik dimenzióban való mozgásunkért fe-
lel.  Oké,  nem  olyan  prof időgép,  mint  a  flmekben,  de  
hasonló funkcionalitású. Egyelőre… 

…ne nyúljunk semmihez. Mert ha valamit nem értesz, meg-
mozdítasz,  nyomogatsz,  annak  az  általad  tervezet világ -
egyetemben beláthatatlan következményei lehetnek! It a  
sajátodban pedig annyi, hogy megértés nélkül folyamato-
san frusztrál, hogy nem működik majd a rendszer. S hajla-
mos leszel feladni az ügyet. 

3. A Blender kezelése
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Mivel  a  könyv  további  részében  úgy  megyünk  tovább, 
hogy valamit megértünk, aztán megtesszük, majd gyako-
roljuk, most elérkezet a nagy pillanat, amikor végre csiná-
lunk valamit!

Laptoptulajdonosok, figyelem!

A  következő  feladatban  a  számítógép  számbillentyűzetét 
(NumPad) fogjuk használni. Amennyiben ezt lespórolták a 
gépedről, kérlek lapozz a függelékhez, ahol segítek megol-
dani ezt a problémát.

Laptopokhoz külön beszerezhető kis kiegészítő a számbil-
lentyűzet, de a Blenderben találsz olcsóbb megoldást is!

3. A Blender kezelése
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4. 

Navigáció

4. Navigáció

4.
Megtanulunk mozogni 
a térben, majd elfáradva 
inkább csak nézelődünk.
Közben rájövünk, hoegy  az egér
és a billentyűzet is a Blender 
felhasználói felületéhez tartozik. 

 navigáció
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Térmozgások

Első feladatunkban hozzáértő autóbolondként körbeszaglá-
szunk egy igazi verdát.  Én a  Chevrolet Camaro-t választa-
nám. Néztem egyet neked a neten:  Használtan csak  15,5 
millió forint. Sok? Hat literes motorral? Oké, van it egy  
olcsóbb. Lópoli!8

A könyvvel együt kaptál egy feladatsort. Kérlek, ezt tömö-
rítsd ki, és keresd meg a  001_Chevrolet_camaro.blend állo-
mányt. Nyisd meg a File > Open paranccsal. A munkaterü-
leten remélem neked is megjelent egy szép sárga sportautó. 

A járműhöz közelíthetünk vagy atól távolabbra kerülünk 
az egér görgőjével. Kérlek, próbáld ki: Ha az egér görgőjét 
előre tolod, egészen az utastérbe is be tudsz nézni. Ha meg 
magad  felé  gördíted,  akkor  olyan  messze  távolodhatsz, 
hogy eltűnik az autó… 

8 Helyesen lowpoly, azaz alacsony poligonszámú. Viszonylag kevés lapból fel-
épülő modell. 

4. Navigáció
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Ez a görgő egyébként nyomógombként is működik. Ha le-
nyomod, s lenn tartva az egeret bármely irányba mozgatod, 
a kocsi megperdül – vele együt a tér is. A lenyomot kö -
zépső egérgomb tehát az egész teret mozdítja, járja körbe. 
Persze, ha előre-hátra tolod az egeret, akkor ne csodálkozz, 
hogy az autó alvázát vagy a tetejét látod. Fontos tudnod, 
ilyenkor nem a kocsi, hanem te állsz fejre, te mozogsz a tér 
minden irányába. Kis gyakorlással ugye vissza tudod hozni 
az eredeti nézetbe?

Van még egy fogás, ami hasznos lehet. Ha nem akarsz min-
dig  ringlispílt  játszani,  csak  egyszerűen arrébb szeretnéd 
mozgatni  a teret,  akkor nyomd le folyamatosan a SHIFT 
gombot, majd az egér középső gombjának lenn tartása mel-
let mozgasd az egeret. Figyelj a sorrendre! A SHIFT önma-
gában  lenn  tartható,  nem  történik  semmi.  Mindig  ezt 
nyomd le először, s tartsd a mozdulat végéig.

Az egész teret lehet így csúsztatni, mozgatni, vonszolni… 

4. Navigáció

A tér forgatása

A tér mozgatása

Tipp:
SHIFT+egérgörgő: függőleges gördítés.

CTRL+egérgörgő: vízszintes görgetés.
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Egérgörgővel tehát zoomolsz. Ha lenyomod, forog a tér. Ha 
SHIFT-tel együt nyomva mozgatod, akkor a képernyő sík-
jában mozdul.

Tengeri betegségre hajlamosabbaknak: A Blender a mun-
katerület közepét tekinti a tér forgáspontjának. Ha a teret 
– s az autót vele együt – elmozdítotad, akkor is. Egy-egy  
ilyen mozgatás után forogni szédítő élmény lesz.  Ha na-
gyon megbolondulna a térforgás, nyomd meg a billentyű-
zeted HOME gombját, ekkor a program megkeresi a látha-
tó objektumokat, s a képernyő közepére helyezi azokat.

Tengelyek

Ha még nem veszteted el a tájékozódókészségedet,  mint 
kezdő görkoris az üvegházban, akkor szeretném felhívni a 
fgyelmedet azokra a fx tengelyekre, melyek segíthetnek a 
tér érzékelésében.

Az autó éppen egy koordináta-rendszer közepén parkolt le, 
melynek a két tengelyét piros (X) és zöld (Y) színekkel jelzi 
a program. Kicsit nehéz meglátni ezeket, de ot kell lenniük 
a háló közepén. Az így meghatározot sík lesz a horizont,  
amelyhez tájolhatjuk a kompozícióinkat. 

A térnek három dimenziója,  kiterjedése,  tengelye van.  A 
program írói nem akarták a harmadik tengelyt, mint egy 
megvadult  gereblyét  kerülgetni,  ezért  munkatér  bal  alsó 
sarkában fnoman utaltak rá – ő sem veszet el. 

A kék (Z) tengelyt a többivel együt it látod, s ha a középső 
egérgombot lenyomva mozgatod az egeret, akkor ez a kis 
háromdimenziós  koordináta-rendszer  vele  együt forog  
majd. 

Érdemes egy kicsit memorizálni ezeket a tengelyhez tarto-
zó színkódokat.

4. Navigáció

Síkbeli és térbeli koordináta-rendszerek

Tipp:
A tengelyek színei megegyeznek az 

összeadó színkeverés alapszíneivel: 
R (red) = X, G (green) = Y, B (blue) = Z 

SHIFT +
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Fontos nézetek

Aki már találkozot bármikor is élete során tervrajzzal, tud-
ja,  hogy a  pontos  modellezés  szinte  kivitelezhetetlen,  ha 
olyan alapnézetekből nem tekinthetünk rá térre,  mint  az 
elölnézet, oldalnézet, felül- vagy alulnézet.

Ezeket a lehetőségeket a klaviatúránk számbillentyűzetéről 
érhetjük el legkönnyebben9.

Elölnézet: A számbillentyűzet (1)-es gombja.

Oldalnézet: A számbillentyűzet (3)-as gombja.

Felülnézet: A számbillentyűzet (7)-es gombja.

Ezekre  nagyon sokszor  szükségünk lesz,  úgyhogy tessék 
kérem gyakorolni!  Forgasd el  a teret  az egér görgőjével, 
majd az (1), (3) és (7) gombokkal találj vissza a klasszikus 
nézetekhez.

9 Ha laptopon dolgozol, és nincs számbillentyűzete (NumPad), lapozz a Függe-
lékhez, ahol megmutatom a megoldást. 

4. Navigáció

Monge-féle vetületek 
(felül-, elől- és oldalnézet)

3

1

7
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Ha a virtuális térben levő  kamera szemszögéből szeretnéd 
látni a később flmre kerülő felvételt, nyomd meg a (0) – 
nulla – gombot ugyanit, a számbillentyűzeten. 

Ebből  a  nézetből  bármikor  kibillentheted  az  autódat,  ha 
megnyomod az előbb említet elölnézet (1),  oldalnézet (3), 
felülnézet (7) gombokat, vagy egyszerűen csak az egér gör-
gőjének lenyomása után megmozdítod az egeret – elforga-
tod a teret.

Gyakoroljunk! A File > Open recent (legutóbbi megnyitása) 
menüparancs segítségével jelöld ki újra az eddig használt 
állományt: 001_Chevrolet_camaro.blend .

Nézd meg a kamera (0) nézőpontjából a jelenetet! Forgasd 
el a teret az egér görgőjének lenyomásával, hogy a kocsi 
tetejét  lásd!  Válts  elölnézetbe  (1),  majd  oldalnézetbe  (3). 
Próbáld ki a 4-es és 6-os számbillentyűket! Milyen mozgást 
eredményez, ha ezeket többször is megnyomod?

4. Navigáció

0
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Válts elölnézetbe (1), és próbáld ki a 2-es és 8-as gombokat! 
Teszteld ezeket a lehetőségeket felülnézetből (7) és kamera-
nézetből  is  (0).  Ne ijedj  meg,  ha az utóbbiban nem látsz 
semmi érdemlegeset…  

Kamera nézet (0) után próbáld ki a számbillentyűzet (–) és 
(+) gombjait, majd ezt ismételd meg (1), (3) és (7) nézetek-
ben. 

Mi történik, ha a három fő nézetben megnyomod a (9)-es 
gombot?

Hányinger? Szédülés? Alhasi fájdalom? Egyik sem? Akkor 
választhatsz, továbblépsz a következő leckére, vagy jelent-
kezel Dabasra mezőgazdasági pilótának…

4. Navigáció

Tipp:
Az (5)-ös gomb 

perspektivikus és izometrikus 
(mérnöki) nézet között vált.
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5. 

Transzformációk

5. Transzformációk

5.
Belekerülünk eegy autóverseny forgatagába,
ahol naegy szerepe lesz az egér jobb gombjának.
Megtanulunk táregyakat mozgatni és forgatni, 
majd eegyre árnyaltabbá válik a helyzet.

 transzformációk
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A Blender istálló autói

Az előző feladatban megtanultunk navigálni a térben. Min-
denestül  mozgatuk  az  egész  teret,  miközben  hozzá  sem 
nyúltunk a benne levő tárgyakhoz.

Biztosan  megfgyelted,  hogy  többnyire  kétféle  eszközt 
használtunk a program irányítására:  az egeret és a billen-
tyűzetet.

Képzelj  el  egy autóversenyt,  ahol  a  Blender csapat  autói 
hagyományos  – kormány-sebességváltó-pedálok  –  vezér-
lést használnak, míg a vetélytársak ugyanezeket a funkció-
kat a műszerfalon megjelenő menükkel, párbeszédpanelek 
segítségével érik el. 

A startjel után a Blenderes versenyzők felpörgetik a gázpe-
dállal a motorokat, majd a kuplungot felengedve kilőnek. 
Két lábuk a pedálokon táncol, kezük a kormányon és a seb-
váltón, miközben pár másodperc alat már 100 km/h sebes-
ség felet repesztenek. 

5. Transzformációk
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Az ellenfelek ugyanezeket a funkciókat menükkel, párbe-
szédpanelekkel érik el. Modern digitális gépeik műszerfa-
lán egy üzenet: „Kérem, nyomja meg a Start gombot!”. 

200 higany-milliméter  feleti vérnyomással  megérintik az  
említet vezérlőelemet. Ekkor egy menü jelenik meg: „Me-
lyik sebességfokozatba váltsunk? (1, 2, 3, 4, 5, R)” 

Az első tíz másodpercben több pilóta is fogadkozik, elmegy 
bencés szerzetesnek vagy sivatagi tevehajcsárnak, miután a 
hiper-szuper autók menürendszere a következő kérdések-
kel traktálja őket:  „Hányas fokozatba állítsuk a gázpedált?  
Hány fokkal  fordítsam el  a  kormányt?  Hány ° leegyen az  
utasfülke belső hőmérséklete?”

Vannak esetek, amikor a hagyományos felhasználói felületek gyorsabbak.

A Blender mindkét kezünkre számít, hogy a billentyűzetel 
és az egérrel felgyorsíthassa a munkánkat!

5. Transzformációk
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Vasárnap Mogyoródon

Most egy versenypálya alakú terepasztalon dolgozunk. Két 
fontos  transzformációt  tanulunk  majd:  a  mozgatást és  a 
forgatást, miközben megismerkedünk a rétegekkel is.

Nyisd  meg  a  002_autóverseny.blend állományt.  Gyorsan 
számold meg az autókat, miközben felülnézetbe váltasz (7). 
Nézd meg elölnézetből (1). Melyik használtautó-piac jut az 
eszedbe oldalnézetből (3)? 

Forgasd el a teret az egér görgőjének lenyomásával, majd 
fgyeld meg, mi történik, ha magad fele vagy a monitor irá-
nyába görgeted. 

Próbáld  az  egész  teret  elmozdítani  a  SHIFT+egérgörgő 
megnyomásával. Majd a HOME billentyűvel tekintsd át az 
összes kocsit.

Válassz ki egy neked tetsző négykerekűt! Ez a hagyomá-
nyos módon, bal egérgombbal nem fog menni. Csupán egy 
célkeresztet helyezel  át  vele – hogy mi ez,  és mire való, 
majd később megtudjuk. 

5. Transzformációk

Tipp:
Ez a zoomoló (közelítő/távolító) mozgás 

megoldható a Számbillentyűzet +/- 
gombjainak használatával is!
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A Blenderben a kijelölés a jobb egérgombbal történik.

Katints most egyet jobb egérgombbal bármely autóra, s egy 
narancssárga körvonal jelenik meg körülöte. Próbálj kije-
lölni más autókat is,  egymás után.  Végül állapodj meg a 
kedvencednél. 

A Blender – szakítva a Windows-os konvenciókkal – a kijelölést konzekvensen 
elválasztja az egyéb egérműveletektől. Ami először furcsa, később a modelle-
zés és animáció során sok bosszúságtól óv meg.

Ha megtaláltad az autót, amivel versenyezni fogsz, gurul-
junk le vele a pályára. A 3D ablak alján – az a munkaterü-
let, ahol az autóidat látod – találsz egy menüsort, amely né-
hány vezérlőelemet is tartalmaz. 

It helyezkednek el a Rétegek. Mint más programokban is, a 
Rétegek rendszerezésre  szolgáló  megoldást  nyújtanak,  se-
gítségükkel  jól  elkülöníthetővé  válnak  a  tárgycsoportok, 
amivel éppen dolgozunk. 

A rétegek alternatív terekként viselkednek. Húsz kis gom-
bocska közöt kapcsolgathatunk, hogy megjelenítsük eze -
ket. Most például a második réteg van bekapcsolva. It he-
lyezkednek el az autóink. 

5. Transzformációk

Tipp:
A kijelölés műveleténél csak kattints a 

jobb egérgombbal, de ne tartsd lenn azt. 
Végig nyomva ugyanis elmozdítja a 

tárgyat, ami később, a modellezésnél sok 
bosszúságot okozhat. 

A mozgatásra van egy másik művelet, 
amivel mindjárt foglalkozunk.

Tipp:
A Photoshoppal vagy GIMP-pel 

összehasonlítva nagyon szerény 
szolgáltatást nyújtanak a rétegek. 

Tárgyakat helyezhetünk el, 
mozgathatunk közöttük,

vagy tüntethetünk el éppen,
ha arra van szükségünk.
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Egy kis pöty jelzi, hogy vannak-e egyáltalán objektumok 
rajta. Látsz ilyet az első rétegen is, de nem aktív, így nem 
látható. Bal egérgombbal kapcsold be!

Íme, látszik már az autópálya, az autóink pedig eltűntek. 
Járd  körbe  a  tanult  egérmozdulatokkal  ezt  teret,  pályát, 
majd válts vissza a második, autós rétegre. 

Nézd meg, ki van-e jelölve jármű? Ha nem, a tanult mód-
szerrel – jobb egérgombbal – jelöld ki. Nyomd meg a (M) 
billentyűt,  s  a  felbukkanó  kis  panelen  –  Move  to  Layer  
(Mozgasd a másik rétegre) – jelöld meg az első réteget. Az 
autónk átmegy egy másik, alternatív valóságba. 

Kövessük mi is az ablak alján a megfelelő réteg kijelölésé-
vel.  Az  előbb  eltűnt  autó  az  első  réteg  pályájára  került. 

5. Transzformációk
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Menjünk vissza a második rétegre, majd transzportáljunk 
át még három autócskát az (M) gyorsbillentyűvel az első 
rétegre. 

Kicsit szokatlan a pályán az élet: Néhány autó a fűben virágokat keresgél, má-
sok a pályán vagy a pálya szélén állnak.

Mozgatás, forgatás

Két további gyorsbillentyűt fogunk használni, hogy szépen 
elrendezzük az autóinkat. 

Ehhez először menj felülnézetbe (7), majd jelöld ki az első 
autót, amit mozgatni szeretnél. A tárgyak gyors mozgatá-
sára a (G) – [Grab / megragadni] billentyűt használjuk. A 
(G) gyorsgomb megnyomását követően az egérrel bárhova 
elhelyezheted a kiskocsit. 

Hogy  megfelelő  helyzetbe  kerüljön,  alkalmazd  az  (R)
[Rotate / forgatás] gyorsgombot. Ezután az egér mozgatásá-
val az autót gyorsan elfordíthatod. 

Folytasd a gyakorlást még több autó átemelésével a rétegek 
közöt (M), mozgasd őket (G), majd forgasd is (R), hogy a  
végén egy mozgalmas kompozíciót kapjunk.

5. Transzformációk
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Figyelj  arra,  hogy  mindig  felülnézetben  végezd  ezeket  a 
műveleteket, különben furcsa baleseteknek lehetsz szemta-
núja.

Elkészült munkádat mentsd el egy általad választot néven  
(File > Save as), majd zárd be a programot.

5. Transzformációk
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Kitörés a szürke hétköznapokból

Ha a számítógépes játékok világából érkezel, biztosan zavar 
a Blender száraz megjelenése.  Szürke felhasználói felület, 
fakó színek a  munkaterület 3D ablakában.  Sehol  egy ár-
nyék, ellenfényben megcsillanó optika, lágy párán átvilágí-
tó  napsugár,  kedvesen  mosolygó  hoszteszlány.  Ennyire 
azért nem szomorú a helyzet, de tudnod kell, a valósághű 
megjelenítés elég erőforrás-igényes feladat. 

A  következőkben  3D  ablak  megjelenítési  lehetőségeivel 
foglalkozunk, s mellesleg tanulunk valamit a perspektívá-
ról is. Nyisd meg a korábban elmentet állományodat! 

Mivel a Blender emlékszik arra, hova mentetél, így elég, 
ha a  File > Open Recent (Legutóbbi megnyitása) menüpa-
ranccsal rákeresel az állományra.

A 3D Ablak alján levő menüsort használtuk már a Rétegek 
közöti átjárásra. Etől kicsit balra találod a  Viewport Sha-
ding (Nézet árnyalása) menüt, melyet az ikonjára való kat-
tintással tudsz felnyitni (lásd az alsó képen!).

Ebben a menüben – alulról felfele – dióhéjban a 3D grafika számítógépes meg-
jelenítésének története van összefoglalva.

5. Transzformációk
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Nosztalgiafaktor ♦ A múlt század '60-as éveitől beszélhe-
tünk  mai  értelemben számítógépes  grafkáról.  Kezdetben 
drótvázszerű rajzokat tudtak megjeleníteni az oszcilloszkóp 
vagy radar képernyőjéhez hasonló berendezéseken. Később 
a televízióhoz hasonló elven működő monitorokon egyre 
realisztikusabb képeket ábrázoltak.

Kép 1976-ból: Grafikus képernyő, de még drótvázszerű megjelenítéssel.

A magasabb szintre jutni sok fejlesztéssel és erősebb gé-
pekkel lehetet. Ahogy felfele haladsz az árnyalási menü-
ben, úgy válik egyre erőforrás-igényesebbé a megjelenítés. 
Gyakorta  vissza-vissza  fogunk  lépni  a  korábbi  szintekre, 
hogy azok gyorsaságát, vagy egyéb előnyeit kihasználjuk. 
A sebesség és az esztétikum ugyanis fordítotan arányosak 
a megjelenítés során. 

A  Bounding Box (Befoglaló doboz) például olyan alacsony 
minőségig absztrahál, hogy minden tárgy téglatestként je-
lenik meg. Nem sokra megyünk vele a gyakorlatban. 

Modellezésnél viszont sűrűn használjuk a Wireframe (drót-
váz) és a  Solid (tömör, homogén) árnyalásokat. Az előbbit 
láthatod a fenti képen. Az utóbbi pedig olyan egyszerű ár-
nyalás, mintha csak egy agyagtömböt látnál. Jellemzően a 
videokártyád állítja elő, s nem kell különösebben felpörög-
nie, hogy ilyen egyszerű képet generáljon.

5. Transzformációk

Bounding Box, Wireframe 
és Solid nézetek
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A következő kető tárgyalását most nem részletezem, felté-
telezve, hogy kipróbálod. Az anyagok optikai tulajdonsága-
inál, s a textúrázásnál később gyakran fogjuk használni. 

A legutolsó, a Rendered (valós idejű renderelés) nézet a leg-
izgalmasabb: belead apait-anyait. Talán még a számítógé-
ped hűtése is zajosabb lesz, jelezve a megnövekedet szá -
molási teljesítményt.

Ugyanazon jelenet: Balra Material, jobbra Rendered árnyalással. Az utóbbi au-
tóin önárnyékok, alattuk vetett árnyék, s a környezet is sokkal plasztikusabb.

Akkor gyakoroljunk egy kicsit!  Váltsd át a megjelenítést 
Solid (tömör)  nézetre.  Az  egér  görgőjének  lenyomásával 
forgasd meg a teret, majd ugyanezt tedd meg Rendered (va-
lós idejű renderelés) módban is. Melyik a gyorsabb, gördü-
lékenyebb? 

5. Transzformációk

A valós idejű renderelést itt
éppen a processzor végzi. Látható, 

hogy először elnagyolt, pixeles
a kép, majd egyre finomodik.



80

Nyilván  Solid módban, hiszen a videokártya OpenGL10 ár-
nyalásával  teszi  ezt.  Ugyanez  processzorral  kiszámítva 
(Rendered) szebb, pontosabb, de lassabb. Ez utóbbi inkább 
ellenőrzésre való: megmutatja, hogy a flmen vagy kiszá-
molt képen milyen látvány keletkezik.

Érdemes megjegyezni az alapértelmezett árnyalások 
váltására szolgáló gyorsbillentyűt. Ez a (Z). 

Modellezésnél legtöbbször a Wireframe és Solid árnyalások 
közöt váltogatunk. Ha valós idejű renderelésnél megnyo -
mod a (Z) billentyűt, akkor először drótvázat, másodszorra 
tömör nézetet  kapsz.  A Z-t  többször nyomkodva e  kető 
közöt válthatsz.  Ha úgy érzed,  bennragadtál,  s  szeretnél  
visszanézni a valós idejű renderelés által nyújtot látvány -
világhoz, nyomd meg a SHIFT+Z billentyűkombinációt. A 
SHIFT+Z-t  többször nyomva a  Solid (tömör)  és  Rendered 
(valós idejű renderelés) árnyalások közöt váltogatsz.

Gyakorlás ♦ Most kérlek menj vissza Solid (tömör) mód-
ba. Erre azért lesz szükség, mert ki szeretnénk jelölni egy 
kiskocsit, s bár ez mindegyik módban lehetséges, de valós 
idejű renderelésnél nem igazán látszik. Játsszuk azt, hogy 
ez a kocsi most átkerül egy másik alternatív valóságba (el-
kéri a barátod, vagy elviszi a szerelő). Jelöld ki az egyik au-
tót jobb egérgombbal, majd nyomd meg az (M) gombot, és 
a felkínált rétegek közül jelöld meg az ötödiket.

A pályáról  eltűnt az autó,  de a rétegkezelőn már látszik, 
hogy megjelent egy azonosítatlan tárgy. Jelöld it ki az ötö-
dik réteget, és íme, egy magányos autó az ötödiken… 

Válts  Wireframe (drótváz) nézetbe (Z), majd  Solid (tömör) 
módba (Z). Most nézd meg, hogyan árnyalja a képet a valós 
idejű  renderelés  (SHIFT+Z).  Melyik  módba  kerülsz,  ha 
megint SHIFT+Z-t nyomsz? 

10 Az  OpenGL (Open Graphics  Library) a  Silicon Graphics  cég által kifejlesz-
tet 1992-es szabvány. Olyan programozási felület, mellyel viszonylag egyszerű 
a grafkus kártya kezelése és a háromdimenziós grafka megjelenítése. Koráb-
ban a Silicon Grafcs gépei voltak az iparág vezető grafkus munkaállomásai.

5. Transzformációk
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Próbáld ki most az elől-, oldalt- és felülnézeteket (1, 3, 7). 
Ha nem látod a kocsit, az egér görgőjével távolodj…

Nézd meg többféle  árnyalással  ezeket  a nézeteket:  Wire-
frame, Solid, Rendered módban (felváltva használhatod a Z 
és a SHIFT+Z billentyűket). 

Mit kell tenned, ha ezt a képet szeretnéd látni a 3D 
nézetben?

• Milyen árnyalást látsz? (Wireframe/Solid/Rendered)

• Milyen nézetben látod a teret? (elől/oldalt/felül)

• Hol van? (A képen az X és Y tengelyeket látod. Melyik  
egyorsbillentyűvel lehetne az origó közelébe vinni? Ha 
más helyzetben van, mivel lehet elforgatni? Használd 
az R és G billentyűket.)

Hogyan állíthatod be a lenti nézetet?

• Gyorsbillentyűkkel… (Használd a Számbillentyűzetet, 
ot is a 4–6, 2–8 billentyűket.) Mi a (9) gomb hatása?

• Hasonló mozgások egérrel? Számodra melyik a 
könnyebb?  (Egér görgője közelítéshez, ugyanez le-
nyomva térforgás. SHIFT-tel lenyomva – a tér moz-
gatása.)

• Milyen árnyalása van az autónak? 
(Wireframe/Solid/Rendered)

5. Transzformációk
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Mi  történik,  ha  megnyomod a  Számbillentyűzet  (5) 
gombját?

Az eddigi kis Matchbox végre igazi autóvá vált. De mitől 
let igazibb most, mintha az előző nézetben?

Perspektívát kapot. Olyan let, ahogy a valóságban látjuk a 
tárgyakat: Párhuzamos oldalaikat meghosszabbítva ezek a 
vonalak valahol metszik egymást, ahogy a vasúti sínek a 
végtelenben „találkoznak”.

Ha ebben a Matchbox-nézetben a 3D ablakod bal felső sar-
kába pillantasz, akkor a következő szöveg olvasható:  User 
Ortho, míg perspektivikus nézetben a User Persp. 

5. Transzformációk
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Ábrázoló geometriában az ortogonális11 vetítés azt jelenti, 
hogy a tárgyat úgy rajzoljuk ki a képsíkra (most éppen a 
képernyőre), hogy az élein, csúcsain átfutó és a képernyőbe 
csapódó vetítősugarak merőlegesek a képernyőre.

A bal oldalon ezeket a vetítéseket hagyományos elöl-, ol-
dal- és felülnézetben látod.

Hogyan látjuk a fenti képen az autót? Próbáld befor-
gatni!

• Milyen az árnyalása? (Wireframe/Solid/Rendered)

• Perspektivikus vagy ortografkus? (Nézd meg a pár-
huzamos élek helyzetét.)

Végül térj vissza az első rétegre, és állítsd elő valami 
hasonló jelenetet!

11 Ortogonális – merőleges (görög). 

5. Transzformációk

Illusztráció: helveticamediuma.com
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Transzformációk 
2.

Transzformációk 2.

6.
Megtanuljuk, hoegyan lehet eegyszerre több táregyat 
kijelölni, s megismerkedünk eegy új transzformációval, 
az átméretezéssel. Próbáljuk ezeket a műveleteket a 
billentyűzetről egyakorolni, majd bekapcsoljuk a 
táregyak manipulátorait, amivel eegy kicsit könnyebben 
mennek a dolgok. 

 transzformációk 2. 
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Rendrakás a szobában

Következő feladat kevésbé epikus környezetben játszódik, 
de olvasóim számára talán ismerős tevékenység körül fo-
rog – ez a rendrakás. 

Béla bácsi nyugdíjas etológiaprofesszor12. Egész életét a pa-
pucsállatkák  társas  kapcsolatainak  tanulmányozására  ál-
dozta. Könyvespolcán egy sor kötetet ő maga írt, adot ki,  
és olvasot…

Felesége, Terka néni kérésére péntek este elvállalta, hogy 
míg nagyobbik fa és menye színházba mennek, a két kis  
fúunokára vigyázni fog. Ez let az eredménye.

A késő Kádár-kori lakótelepi lakás dolgozószobáján szokat-
lan rendezetlenség – tudományos nyelven entrópia – let 
úrrá. 

Segítsünk  Béla  bácsinak  a  rendrakásban!  Nyisd  meg  a 
003_rendrakás.blend állományt.

12 Etológia – az állatok viselkedéstana.

Transzformációk 2.

Ő nem Béla bácsi, hanem Konrad 
Lorenz, a modern etológia alapítója. 

Az etológusok hatvan év felett 
nagyon hasonlítanak egymásra, Béla 
bácsi szakasztott így néz ki, csak egy 

kicsit rövidebb a szakálla.
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Kicsit szokatlan kép fogad bennünket. Eddig egy 3D ablak-
ban dolgozunk, most it van kető. Balra  Material (anyag-
szerű), jobbra  Wireframe (drótváz) nézetben látjuk ugyan-
azt a szobát. Váltsd át a megjelölt helyen  Rendered (Valós 
idejű renderelés)  nézetre a jobb oldali ablakot!

Ortografkus vagy perspektivikus látványt látunk-e a bal ol-
dali ablakban? Ellenőrizd a párhuzamos éleket! Ha össze-
tartanak, akkor perspektivikus, ha nem, akkor ortografkus. 
(Segít még az ablak bal felső csücskében levő felirat is…)

Katints most a bal oldali ablakba, majd az egér mutatóját 
mozgasd a jobb oldali ablak fölé. Válts perspektívát az (5) 
gomb segítségével, közben erősen koncentrálj, hogy mind-
ez a bal ablakban történjen. 

Minden mentális erőfeszítésünk ellenére a Blender abban 
az ablakban vált perspektívát, ami felett van az egerünk, s 
nem  ot, ahova  kattintottunk –  ha  valóban  elmozgatad 
közben az egeret. 

Mindig az az ablak aktiválódik, amely felett az egér 
van.

Hagyd a jobb oldal felet az egeret, és az (5)-ös gombbal  
válts ortografkus nézetbe.

Transzformációk 2.
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Kezdhetjük a rendrakást? Oké, akkor váltsuk elölnézetbe a 
bal oldali 3D ablakot. 

A padlón találsz három kristálygömböt. Mindegyikbe szé-
pen belegravírozva egy-egy nemzetközi elismerés, mellyel 
Béla bácsit jutalmazta a kortárs tudomány. Eredeti helyük a 
jobb oldali függöny mellet a polc volt. Tedd oda vissza az  
egyiket!

Használd erre a bal ablak elölnézetét. Jelöld ki jobb egér-
gombbal az egyik gömböt, majd nyomd meg a (G) gombot, 
s vidd át a tárgyat a polcra. (Közben ne ijedj meg, ha azt lá-
tod, hogy a jobb ablakban, a szép renderelt képen a labda a 
levegőbe emelkedet, s mégsem a polcon kötöt ki.)

Ez teljesen természetes, hiszen most csak a magasságát vál-
toztatuk meg, viszont a szoba padlójához képest  felülné-
zetben ugyanot maradt… 

Transzformációk 2.

Puska: Az egér a bal ablak felett, a 
számbillentyűzeten nyomd az (1)-et.
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Válts most felülnézetbe (7) a bal ablakban, és a (G) gombbal 
tedd a tárgyat a polcra! Közben kövesd szemeddel a másik 
ablakban… Az Erő veled van!

Leellenőrizheted oldalnézetből is (3). Első küldetés teljesít-
ve. Nem egy szapora munka a rendrakás…

Hogy gyorsítsunk a folyamaton, a következő két labdacsot 
együt fogjuk kijelölni.

Több tárgyat is kijelölhetsz,  ha SHIFT-tet lenyomva 
jobb egérgombbal egymás után kattintasz rájuk.

Kezd megint elölnézetben (1).  SHIFT-tel jelöld ki egymás 
után a két földön fekvő kristálygömböt, és (G)-vel mozgasd 
őket a polc magasságába. 

Jobb klik     >     SHIFT+jobb klik

Most válts felülnézetbe (7), és mozgasd a két labdát együt, 
míg a közelebbi a polcra nem kerülnek. 

Transzformációk 2.
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Az emeléshez hasznos volt a közös kijelölés, de most vá-
lasszuk  le  a  második  labdát  –  egyszerűen  SHIFT  nélkül 
katint rá a jobb egérgombbal – majd mozgasd a polcig (G).

Béla bácsi pedantériáját kicsit zavarja, hogy kedvenc gye-
rekkori olvasmánya, a  Naegy indiánkönyv  négy kötete fer-
dén áll a polcon. Nosza, váltsunk felülnézetbe (7), jelöld ki 
SHIFT-tel mindegyiket, majd az (R) gomb segítségével for-
gasd a falra merőleges irányba. Azután SHIFT nélkül jelöld 
ki és mozgasd (G) egyenként a könyveket.

Szemtelen kölkei, lebuktatok! A könyvespolc alsó szintjé-
ről kandikál ki a befejező kötet, a Préri című indiánregény. 

Transzformációk 2.



90

Válts elölnézetbe (1), majd jelöld ki a kötetet, és mozgasd a 
polc szintjére.

Most forgassuk el (R) ebben a nézetben úgy, hogy az alsó 
széle érintkezzen a polc felszínével – ehhez persze mozgat-
ni is kell némileg (G). Válts felülnézetbe, és fejezd be a for-
gatást, elhelyezést.

Ha minden rendben ment, pihenésképpen nézz körül a te 
világodban. Reggel volt, amikor a elkezdted a feladatokat, 
lehet, hogy már beesteledet, a feleséged elment a barátnő-
jével moziba, a kutyád meg megete a konyhaasztalra kira-
kot vacsorádat.

Gyorsan mentsd le a állományt a File > Save As paranccsal 
féligrendben.blend néven.  Ideje  kicsit  pihenni.  De  nem a
Facebookkal! Ilyenkor érdemes megmozgatni a szemizma-
inkat (nézünk erre-arra, például a hűtőbe valami maradé-
kért), nyújtózz egyet, vagy gyakorold egy kicsit a rendra-
kást a valóságban. Szünet tíz percig. 

Aztán folytatódnak Béla bácsi kalandjai.

Transzformációk 2.
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Meghozták a laptopot

Csengetnek. Az ajtóban a csomagküldő szolgálat alkalma-
zotja egy kredencnyi nagyságú dobozzal. Ó, meghozták a 
múlt héten rendelt laptopot. Gyakoroljunk tovább!

A laptop a tizediken volt, onnan hozta vissza a küldönc. A 
tizedik réteget keresd meg az egyik 3D ablak alsó menüjé-
ben. Jelöld ki bal egérgombbal ezt a réteget, akkor látható-
vá  válik  a  csodamasina,  melyet  Béla  bácsi  akadémikusi 
nyugdíjából három év alat sikerült összespórolni. 

Lehet, hogy kicsit ügyeskednek kell a térforgatással, hogy 
mindkét ablakban jól látható legyen. Béla bácsi elképzeli a 
laptopot benn a dolgozószobájában.

Ehhez neked SHIFT-tel és bal egérgombbal együt kell kije-
lölnöd az egyes és a tízes réteget. A Blender konzekvens, 
ha több tárgy kijelölésére a SHIFT-et használtuk, akkor a 
rétegekhez is ez az eljárás alkalmazható.

Több réteg kijelölésével együtt látszanak azok a tárgyak, melyek az egyes ré-
tegeken előfordultak.

Transzformációk 2.
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Most vidd át a laptopot az első rétegre: a tárgy kijelölése 
után nyomjuk a (M) gombot. 

Most már nyugodtan visszamehetsz az első rétegre. A ré-
tegkezelőn látható, hogy eltűnt róla a tárgy.

Valami furcsa ezen a laptopon – gondolja Béla bácsi, meg-
magyarázhatatlanul rossz előérzetől gyötörve. Tedd fel az 
íróasztalra, hogy jobban tudjuk tanulmányozni. Elölnézet-
ben (1) megemeled, majd oldalnézetben (3) áthelyezed.

Béla bácsi ekkor jön rá, hogy nem is olyan rossz ez az aka-
démikusi nyugdíj, ha akkora laptopot sikerült belőle vásá-
rolni, mint egy régi falusi tűzhely, vagy ahogy falun mond-
ták:  sparhelt.  Nem  látszot ilyen  nagynak  a  webáruház  
fényképein, de így, az íróasztalon… hirtelen olyan túlmére-
tezetnek tűnik, mint egy templomi orgona. Az emlékirata-
it  szándékozik  begépelni,  nem  zsoltárokat.  Erre  viszont 
használhatatlan,  mert  a billentyűk olyan messze  vannak, 
hogy csak a cimbalom ütőjével érné el őket. 

Megkopogtatja: hőre zsugorodó műanyag. Öt perc az elekt-
romos sütőben megteszi majd a hatását! 

Transzformációk 2.
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It a virtuális világunkban új műveletel átméretezzük a gi-
gászi hordozható számítógépet. A mozgatás (Grab), s a for-
gatás (Rotate) mellet most tanuljuk meg újabb alaptransz-
formációt.

Átméretezni az (S) gyorsbillentyűvel tudod a tárgya-
kat.

Nyomd meg ezt a gombot, miután meggyőződtél, hogy ki-
jelölted a laptopot,  majd az egér mozgatásával változtasd 
megfelelő méretűre. Kis ügyeskedéssel (G, R, S) a megfelelő 
nézetekben (1, 3, 7) már helyére is kerül a csodamasina.

A szivarosdoboz és az okostelefon közé...

A biztonság kedvéért mentsük rá a féligrendben.blend állo-
mányra  a  mostani  állapotot.  Minden  programban  a 
CTRL+S a mentés gyorsbillentyűje. 

Ekkor a Blender megkérdezi, hogy valóban felülírod az ed-
digi állományt (Save Over?). Egy katintás – igen. Érdemes 
megjegyezni és gyakran használni ezután is.  A techniká-
nak nincs angyala…

Transzformációk 2.
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Béla bácsi székes mutatványa

Az agg akadémikust karácsonykor elviték az unokái az új 
Star Wars-flmre. Azóta is azon gondolkodik, hogyan lehet-
ne telekinézissel távolról mozgatni tárgyakat. Mivel a nagy 
laptop miat becsípődöt a dereka, a telekinézist Terka néni  
segítségével gyakorolja.

Az egér görgőjének lenyomásával forgasd a bal oldali  3D 
ablak terét úgy, hogy kényelmesen ráláss a székre, amit a 
helyére kell tenned.

Ha a kijelölés után kétszer megnyomod az (R) gom-
bot,  az  egér  mozgatásával  térben  szabadon  forog  a 
tárgy.

Ezzel az eljárással próbáld megfelelő helyzetbe forgatni a 
széket. Közben persze válthatsz nézeteket, az eredmény le-
gyen a fenti ábra elrendezése. (Használható gombok: R+R; 
R; G; 1; 3; 7.)

E  feladat  végén  pihenésképpen  szedd  össze  a  padlósző-
nyegről a könyveket, és rakd fel a könyvespolcra. 

Nagyon gyorsan fogsz haladni, ha kihasználod az (1, 3; 7) 
nézetekben rejlő előnyöket!

A megoldás után mentsd CTRL+S-sel az állományt.

Transzformációk 2.
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Manipulált függönycsere

A G, R, S gyorsbillentyűk nagyon hasznosak, és még 
sokféle  kontextusban előkerülnek,  de  a térben való 
fnom mozgásokhoz van egy kényelmesebb megoldás 
is: a manipulátor. 

Terka néni kicsit feledékeny. A nyári nagy mosások idején 
felcserélte  Béla  bácsi  függönyeit.  A kis  öreg zsörtölődöt 
egy darabig, majd visszaszerelte őket. Jelöld ki a bal oldali 
pink-lila függönyt, majd olvasd tovább a feladatot!

Nagyon sok 3D-s programban alkalmaznak a  manipuláto-
rokat (mozgató, forgató, átméretező fogantyúkat), melyeket 
a 3D ablak alján levő menüben, a fent jelzet ikon megnyo-
másával tudsz előcsalogatni.

A  mozgató manipulátor nyilait ugyanúgy színezik, mint a 
virtuális terünk tengelyeit: Pirossal az X, a zölddel az Y, a 
kékkel a Z tengely mentén mozoghatunk a térben. 

A  bal  egérgombbal  tudod  a  nyilak  végeit  megragadni. 
Ügyesen manőverezve cseréld ki egymással a két függönyt. 
Egyelőre ne törődj azzal, hogy nem megfelelő irányba for-
dulnak, hiszen azt majd egy másik manipulátorral mindjárt 
megoldjuk.

Transzformációk 2.

A manipulátorok bekapcsolása 
után választhatunk, hogy moz-

gatni, forgatni vagy átméretezni 
szeretnénk a segítségükkel.
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Apró szépséghiba: zászlók lettek a függönyökből…

Váltsuk  át  a  manipulátort  forgató  típusúra,  melynek  jele 
egy kis ív alakú ikon lenn, a 3D ablak menüsorában, a be-
kapcsolt manipulátorok közöt.

A színezésből rögtön látszik, hogy a piros és zöld karikák-
kal az X és Y vízszintes tengelyek körül, a kék manipulá-
torral pedig a Z függőleges tengely körül lehet forgatni. 

A tengelyt mindig képzeld oda, mintha az adot színű kerék 
biciklitengelye lenne… 

Transzformációk 2.
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A forgatáshoz használd a kék manipulátort. Ha nem érzed 
teljesen, hogy térben hogyan fordul, milyen messze van a 
faltól, párhuzamos-e vele, akkor válts át felülnézetbe (7), az 
biztos segíteni fog. 

A  falig  mozgatáshoz  használhatod  a  hagyományos  (G) 
gyorsbillentyűt, vagy visszaválthatsz a mozgató manipulá-
torra, ha úgy kényelmesebb.

Ha a helyére került, akkor jön a másik függöny. Annyi ta-
pasztalatunk már van, hogy a mozgató és a forgató mani-
pulátorokra lesz szükségünk. De nem lehetne-e mindketőt 
egyszerre megjeleníteni? Nem kellene közben átkapcsolni.

Erre is van megoldás. Mint a tárgyaknál és a rétegeknél ko-
rábban, a manipulátorok bekapcsolásánál is alkalmazható a 
SHIFT billentyű,  amivel  több kapcsoló ikon is  kijelölhető. 
Használd  most  ezt  a  mozgató  és  forgató manipulátorok 
ikonjain!  Sok  időt  megspórolsz  az  ilyenfajta  kombinált 
használatal.  Mentsd  el  gyorsan  CTRL+S  billentyűkkel  a 
munkádat.

Béla bácsi  szépérzékét  már csak a szőnyeg bántja.  Kicsit 
összement a mosásban. Váltsd át a manipulátorod átmére-
tező típusúra, és az Y (zöld) tengely mentén nyújtsd egy ki-
csit ki a szőnyeget. 

Munkádat  mármajdnemkész.blend néven  ments  a  File  > 
Save As menüparanccsal. 

Transzformációk 2.

A forgató manipulátorok
körüli fehér körrel a képernyő síkjában 

forgathatod az objektumokat.
Hatása ugyanaz, mint az (R) billentyűé.
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Gyakorlás kényszeres takarítóknak

Egymás közöt és őszintén: Én már ekkora rendrakással is  
megelégednék, de van olyan ismerősöm, aki addig takarít, 
amíg minden tökéletes nem lesz – azaz mindig. Nos, ha va-
laki  az  emberiség  ezen alcsoportjába  tartozik,  nézzen  be 
néha hozzám, szívesen látom, mondjuk hetente. Vagy gya-
korolja végig a következő részfeladatokat…

1. Az ötödik rétegen találsz néhány könyvet, amit 
a forgószél felkapott. Rakd vissza ezeket a pol-
cokra, fgyelve arra, hogy lesznek közöttük kis-
sé átméretezettek is!

2. Helyezd el a szőnyeget az íróasztal és a szék alá. 
Kapcsold be egyszerre mindegyik manipulátort. 
Változtass kicsit az arányain az átméretezés se-
gítségével!

3. Igazítsd meg a fali polcot: Nem teljesen vízszin-
tes.

Transzformációk 2.
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Terepasztal

A következő  feladatban megtanuljuk,  hogyan lehet 
kettőzni vagy éppen letörölni a tárgyakat, miközben 
egy aranyos terepasztalt fogunk összerakni.

Nyisd  meg  a  004_terepasztal.blend  állományt.  Először  a 
jobb felső ablak nézetét állítsd be  Rendered-re (valós idejű 
renderelés). Legkönnyebb, ha erre a SHIFT+Z kombinációt 
használod, miközben az adot ablak felet tartod az egered  
mutatóját. A kis ablakban való számítással nem erőlteted a 
gépedet, ugyanakkor van egy kedves kis monitorod, ahol 
mindig szép minőségben látod a végeredményt.

Lassan kialakul, hogy melyik transzformációs módszer jön 
be neked. Vannak, akik a gyorsbillentyűkre esküsznek, má-
sok a manipulátorokra. Én mindketőre. S ezt javaslom ne-
ked is, mert jól lehet kombinálni őket. 

Van, amikor a manipulátorok csak zavarnak, mert nem lá-
tunk rá tőlük a tárgyakra. Az elnagyoltabb komponálást in-
kább a gyorsbillentyűkkel, míg a pontosabb munkát mani-
pulátorokkal végezd. 

Akkor játsszunk egy kicsit! 

Transzformációk 2.
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Forgasd meg egy kicsit a teret, nézz körbe. Perspektivikus 
nézetben vagy, ez látszik az összetartó vonalakból. Válts fe-
lülnézetbe  (7),  s  hogy  ne  zavarjon  szerkesztés  közben  a 
perspektivikus torzulás, nyomd meg az (5)-ös gombot. El-
lenőrizd a bal felső sarokban, hogy ortografkus nézetben 
vagy (User Ortho).

Válaszd ki  a legnagyobb kanyart tartalmazó pályaelemet, 
majd  a  hagyományos  másolás/beillesztés (CTRL+C, 
CTRL+V) műveletek segítségével hozz létre egy másolatot. 
Számoljuk meg, hány műveletet kellet végezni?

1. CTRL+C-vel lemásolod a géped memóriájába. 
2. CTRL+V-vel beilleszteted onnan.
3. A mozgató manipulátorral arrébb viszed.

Most töröljük le a másolatot a DELETE gomb meg-
nyomásával!

Próbáljunk egy Blenderre jellemzőbb módszert:

1. SHIFT+D-vel Ketőzd (később Duplázásként is hivat-
kozunk rá), s azonnal továbbviheted a másolatot.

A másolás/beillesztés egy Blender-idegen módszer (a prog-
ram menüiben nem is találjuk meg alternatív parancsként). 

A Ketttőzés (SHIFT+D) nagyon gyorssá teszi a másolási 
műveleteket. A Blender hatékonysága pedig a gyorsa-
ságában van.

Hozz létre egy versenypályát ezekből a SHIFT+D-vel kető-
zöt elemekből. Ha (R)-rel felülnézetben fordítod őket, két  
módosító gombbal leheted fnomabbá ezt a mozgást:

• SHIFT-tel lelassítod, ezáltal pontosabbá teszed a 
forgatást.

• CTRL-lel pedig 5°-os fokozatokban fog tovább-
ugrani.

Transzformációk 2.
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Favonat

Utolsó  feladatunk  gyakorló  jellegű.  Nyisd  meg  hozzá  a 
005_favonat.blend állományt,  amely  tartalmaz  egy  hiper-
realisztikus ovisvonatot. 

A képernyőt négy nézetre osztotam: Ezek közül a bal felső 
ablakra állíts be valós idejű renderelést (Rendered). A többit 
belátásodra bízom. 

Gyorsbillentyűkkel  és  manipulátorokkal  is  dolgozhatsz. 
Természetesen  az  alkatrészek  duplázásával  (SHIFT+D) 
újabbakat hozhatsz létre. Építs a darabokból saját örömöd-
re egy másik vonatocskát! 

Transzformációk 2.
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7. 

Alapszintű 
modellezés

7. Alapszintű modellezés

7.
Ebben a leckében megismerkedünk a Blender 
alaptest-készletével, majd elkészítjük a brüsszeli 
Atomium arányos másolatát.
Közben tanulunk eegy kis paraméterezést, 
látványosabbá tesszük a modellezés folyamatát, 
és egyakoroljuk az ABC-t.

 

alapszintű 
modellezés



103

Hol is tartunk?

Az első fejezetben megismerkedtünk a látványanimáció fo-
galmával,  stílusaival.  Összeszámoltuk  a  zsebpénzünket, 
majd  egy  ingyenes  alternatíva  után  néztünk.  Ez  volt  a 
Blender, mellyel már számos komoly animációs flmet ké-
szítetek.  A  tény  felbátorítot bennünket,  hogy  érdemes  
foglalkozni a programmal. 

Vladiszlav Szolovjov és Vjacseszlav Velikoredcsanin látványanimációja

A második fejezetben bepillantást nyertünk az animációs 
flmkészítés folyamatába. Tudjuk már, hogy nagyfokú ter-
vezetséget,  sok időt igénylő csapatmunka. A látványani-
máció ezzel ellentétben akár egy személyben is művelhető. 
Kedvünk támadt ezzel a műfajjal elkezdeni karrierünket.

A harmadik fejezetben megtanultuk a Blender alapfogásait: 
a térben való tájékozódást, s olyan elemi transzformáció-
kat,  mint  a  mozgatás,  forgatás  vagy  átméretezés.  Bár  a 
gyorsbillentyűs módszer kezdetben fapadosnak tűnt, de a 
későbbi  munka  során  igazi  virtuóz  zongoristává  válunk, 
míg mások a „Boci, boci”-t pötyögik a menüikben. 

Eddig a feladatokhoz modelleket használtunk, most elérke-
zet a pillanat, hogy magad alkoss. 

Nem a semmiből persze. Van it egy-két dolog a Blender -
ben, melyekből egy kis sufnituninggal bármit összeállítha-
tunk. Ismerkedjünk meg a szerszámos polccal!

7. Alapszintű modellezés
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Primitív csendélet

Ebben a feladatban a Blender alaptest-készlete segít-
ségével  modellezünk.  Közben  megismerkedhetsz  az 
Eszköztárral (Tool Shelf), a 3D kurzorral és a Blender 
totemállatával – Suzanne-nal.

A Blender munkaterülete bár elsőre ijesztő, mégis ismerős 
lehet más grafkus programokból: balra az Eszköztár, jobb-
ra a Tulajdonságok-ablak, középen a Munkaterület, alul meg 
a  negyedik  dimenzió,  az  Idősáv.  Nyisd  meg  a  melléklet 
006_csendélet.blend állományát.  Indulj  el  a  Tool  Shelf-nek 
(szerszámos polc) nevezet bal oldali Eszköztártól. 

Eszköztár ♦ Az első fülön  (Tools) a három legfontosabb 
transzformáció, melyet nem csak gyorsbillentyűkkel (G, R, 
S) és manipulátorokkal, de ezekkel a gombokkal is el lehet 
érni. Minden egérmozgás a gomb megnyomása után indul. 
Végtelenítet a képernyő, ha kimész az egyik oldalon, visz-
szatérsz átellenben. Aki a másik két módszert ismeri és sze-
reti, talán kicsit körülményesnek találja majd, de azért pró-
báld  ki:  Az asztalon levő  kúpot  tedd le  a  padlóra,  majd 
kicsit igazítsd el, elforgatva a teret, hogy végül ne a talpán, 
hanem a palástján nyugodjon. A következő oldalon meg-
mutatom, hogyan…

7. Alapszintű modellezés
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A kúp talajtornázik – körülbelül így nézne ki a „kompozíció”-

A következő, gyakran használt fül az Eszköztáron a Create 
(Alkotás): It találod az alcímben említet primitíveket, azaz 
alaptesteket. 

Sorrendben: 
• síklap (plane), 
• kocka (Cube), 
• kör (Circle), 
• gömb (UV Shere), 
• ikozaéderből származtatot gömb (Ico Sphere), 
• henger (Cylider), 
• kúp (Cone), és 
• tórusz (Torus). 

Van még két bónusz, a rácsháló és Suzanne, a majom. Ő a 
Blender  beépítet próbamodellje,  egy bonyolultabb tárgy,  
amin pl. bevilágításokat, anyagokat, lehet kipróbálni.

Suzanne, a Blender kabalaállata – fényesre polírozva

7. Alapszintű modellezés

A Függelékben találsz egy 
leírást, mellyel kibővítheted 

ezeket az alaptesteket jó 
néhány extra objektummal.
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El a bútorral! ♦ Ha meguntad a régi bútoraidat, kis barká-
csolással átalakíthatod azokat. Cseréld le a négyzet alakú 
dohányzóasztalt kör formájúra, hengeres lábakkal!

Először jelöld ki az asztal lapját, és töröld a (DEL) billen-
tyűvel. Aztán egyenként a lábakat, ezeket pedig az (X) bil-
lentyűvel. 

Az (X) ugyanúgy viselkedik, mint a (DEL), azaz töröl, 
csak jobban kézre áll.

Mielőt elkezdenéd nyomkodni az alaptestek billentyűit, is-
merkedj meg a 3D kurzorral. 

A 3D kurzor helyén jönnek létre azok az alaptestek, 
melyeket az Eszköztárból kiválasztasz. 

Bal egérgombbal ez a célkereszt alakú mutató áthelyezhető. 
Elsőre talán nehéz lesz kergetni az éterben (javaslom a né-
zetváltásokat), később mutatok néhány fogást, ami segít a 
pontos pozicionálásban. Hozz létre egy hengert  (Cylinder)  
az eszköztár Create fülének alaptesteiből. 

A Z tengely mentén koronggá lapítjuk a hengert. SHIFT-tel 
jelöld ki a mozgató mellé az átméretező manipulátort is. Ha 
megtaláltad  a  megfelelő  arányt,  az  (S)  gyorsbillentyűvel 
minden irányba egyszerre nagyíthatod. Pontos pozicioná-
lásra pedig használd a nézeteket (1, CTRL+3, 7)  ortografii-
kus (5) nézetben.

7. Alapszintű modellezés

Mivel a csendélethez használt szoba 
fala az oldalnézetből (3) eltakarná a 

tárgyakat, CTRL+3 gyorsgombbal
az átellenes oldalról, 

akadálymentesen láthatod.
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Ugyanígy alkothatsz hengeres lábakat: Valahova bal egér-
gombbal tedd át a 3D kurzort, majd az Eszköztár > Create >  
Cylinder (henger) eszközével készítsd el az alaptestet, majd 
a  (Z)  tengely  mentén  a  kék  átméretező  manipulátorral 
nyújtsd asztallábbá.

Helyezd el  az első lábat megfelelő méretezés után (S)  az 
asztallap és a talaj közé, majd duplikáld, ketőzd a SHIFT+D 
gyorsbillentyűvel. Használhatod a nézeteket (1, CTRL+3, 7) 
a megfelelő elhelyezéshez.

Sima ügy ♦  Biztosan észreveted, hogy a csendéletünkön 
kétféle gömb alakú objektum van. Mindkető ugyanaz a tí-
pus,  úgynevezet UV  Sphere.  Az  Eszköztár  >  Tools fülén
a  Smooth/Flat gombokkal lehet a kijelölt testeket simítani 
(Smooth), vagy az eredeti, sokszöglapokkal határolt formá-
jába visszaalakítani (Flat).

Szabad az út egy izgalmas csendélet készítésére! Játssz egy 
kicsit a testekkel!

7. Alapszintű modellezés

Az UV Sphere arra utal,
hogy könnyű lenne téglalap alakú 

térképet készíteni róla.
Mivel a tér, amiben már dolgozunk 
lefoglalta az X, Y és Z tengelyeket, 

már csak az U-t és V-t használhatjuk e 
térkép belső tengelyeihez.
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Magyar Atom!

Üzenjük Brüsszelnek:  Van Maegyar Atom! Ebben a feladat-
ban  ugyanis  az  1958-as  brüsszeli  világkiállításra  készült 
építmény tökéletes másolatát hozzuk létre – magyar kivite-
lezőkkel. 

S mi vár még ránk? A modellezés során oly gyakran hasz-
nált  Solid (tömör) árnyalást felturbózzuk kissé, majd meg-
tanulunk néhány testet paraméterezni, s ennek segítségé-
vel az alapkészletből felépül a Maegyar Atom. 

Fotó: Wikipedia

Az  Atomium a belga főváros egyik nevezetessége. Olyan, 
mint  a  franciáknak az  Eifel-torony.  Ez  is  világkiállításra 
készült,  s  annyira  különleges  volt  a  látogatók  számára, 
hogy a város  vezetése  úgy döntöt, látványosságként to -
vább üzemelteti. A vas atomrácsát ábrázolja, hasonló lép-
tékben felnagyítva, mintha valaki egy porszemből Föld mé-
retű bolygót készítene.

Ha kicsit elfordítod a fejed, rögtön látható, hogy a gömbök 
egy kocka sarkain helyezkednek el, s egy bónusz labdacs 
van a kocka közepén. Ezután hengerekkel (csövekkel) ösz-
szekötjük a kocka éleit és a testátlóit. 

7. Alapszintű modellezés

Az Atomium méretei. 
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Előkészületek ♦ Indítsd el a Blendert. Most nem kell be-
tölteni külső állományt, hiszen te készíted a modellt.

Gyakorlásként – s azért, hogy jól érzékelhető legyen az a 
trükk,  amit  majd  a látvány fokozására alkalmazunk – az 
utolsó réteget kapcsold be, s ide helyezz el néhány alaptes-
tet. Próbáld ki ezeket a módszereket!

1. A bal  oldali  Eszköztár  >  Create gombjaival.  Figyelj 
arra, hogy a 3D kurzor helyén jönnek létre az objek-
tumok. A kurzort áthelyezheted a bal egérgombbal.

2. A 3D ablak alján levő menüsor Add (Hozzáad, létre-
hoz) menüjéből. 

3. A (SHIFT+A) gyorsbillentyűvel: a 3D ablak területén 
belül.  Az előző menüt kapod,  csak éppen ot, ahol  
éppen vagy.

És most jön a trükk. A 3D ablaknak van egy bónusz panelje 
az ablak jobb oldalán, amit eddig elrejtetek a szemed elől. 
Egyébként semmi különös nincs benne, bekapcsolható és 
kikapcsolható  az  (N)  billentyűvel,  vagy  az  ablak  alján  a 
View (Nézet) > Properties (Tulajdonságok) paranccsal. Kap-
csold be úgy, hogy a 3D ablakban tartod az egér mutatóját, 
és lenyomod az (N) gyorsbillentyűt.

7. Alapszintű modellezés

1. módszer

2. módszer

3. módszer
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A Blender legtöbb munkaablakához két „polc” tartozik.  Ezeket a (T)  és (N) 
gyorsbillentyűkkel, vagy az oldaléleken levő plusz gombokkal lehet kinyitni. 
Vigyázz, hogy ezt a Tulajdonságpanelt ne keverd össze a szintén jobbra levő 
Tulajdonságok-ablakkal!

Mivel a  Tulajdonságpanel elég magas,  kicsit  görgetni  kell 
lefele, hogy megtaláld ezt a beállítást, de megéri. A Shading 
(Árnyalás) szekcióban keress rá Matcap (Material capture – 
formázó anyag) jelölőnégyzetre.

Ezek közül az anyagok közül választhatsz. A Matcap első-
sorban digitális szobrászathoz használható, de lényegesen 
plasztikusabbá tudja tenni a modellezés folyamatát.

Biztos vagyok benne, hogy sokat kipróbálsz majd. Ezek a 
formázó anyagok csak a Solid (Tömör) módban működnek, 
s nincs szükség világításra sem a használatukhoz, mivel a 
bevilágítást és tükröződéseket is magukban foglalják. 

Végül állíts be egy ezüstösen tükröződő felületet, hiszen az 
Atomium modellezéséhez ez lesz a legstílusosabb.

7. Alapszintű modellezés

Talán egy padlásszobában 
készült ez a MatCap,

ahol még a fényképész
 ágya is látható ;-)
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A térrács modellezése ♦ Válts most vissza az első rétegre, 
töröld ki az ot található kockát (X), s kezdjük el a szerkesz-
tést. Ortografkus nézetben fogunk modellezni. Ez fontos, 
hiszen egy épületnek arányaiban ugyanúgy kell kinézni. 

Indítsunk felülnézetből (7).  Ellenőrizd:  ha a 3D ablak bal 
felső  sarkában a  „User  Ortho”  feliratot  látod,  akkor  már 
nem kell számolnod a perspektivikus torzítással.

Először is helyezd vissza a  3D kurzort a koordináta-rend-
szer középpontjába. Hogy mennyire sikerült, ezt ellenőriz-
heted  a  bal  oldali  Tulajdonságpanelen,  rögtön  az  előbbi 
Matcap beállítások felet. It minden értéket nullázz le, és a  
kurzor visszakerül az origóba. 

A sarkoknál levő atomokat összekötő csö-
vek átmérője 3 m (lásd a rajzon), hossza pe-
dig 29 m. A Blender alapmértékegysége is a 
méter, így nem kell bonyolult számításokat 
végezned.  Tizedrészére  kicsinyítjük  a  mo-
dellünket,  hogy  Maegyar  Atomunk  a  hátsó 
kertben is elférjen. 

A bal oldali  Eszköztár > Create > Cylinder gombjával hozz 
létre egy hengert. Felülnézetben csak egy kört látsz belőle, 
de még mielőt bármit is tennél, fgyeld meg, hogy az Esz-
köztár alsó harmadában bekapcsolódot egy  Add Cylinder  
nevű szekció, melyen most – és csak most – beállíthatod a 
pontos  paramétereket.  A  Radius (sugár)  értéket  állítsd 
0,1513-ra  úgy,  hogy  rákatintasz  az  értékadó  sávban  levő 
számra, s a billentyűzetről beírod ezt az értéket. A  Depth 
(magasság) értékét pedig írd át 2,9-re hasonlóképpen. 

Válts  elölnézetbe (1),  majd forgasd el  pontosan  90°-kal  a 
hengert. Ehhez nyomd meg az (R) gombot, és a CTRL lenn 
tartásával – mely  5°-os mozgásokra kényszerít – egészen 
pontosan véghezvihető ez a művelet. Ha készen vagy, válts 
felülnézetbe.

13 A cső átmérője 3 m, tehát sugara 1,5 m. Ennek a tized részét vesszük it.

7. Alapszintű modellezés
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Tedd le a 3D kurzort arra a helyre, ahol az egyik gömböt 
létrehozod majd. (Eszköztár > Create > UV Shpere) 

Az Eszköztár alján újra látod azt a szekciót, ahol beállítha-
tók a most készítet test pontos paraméterei. A  Size érték 
ebben az esetben a sugarat fogja jelenteni.  Állítsd  0,9-re. 
Ha nem megfelelő helyen van, mozdítsd el manipulátorral 
vagy a (G) gomb megnyomásával.

Igazi szféra helyet diszkógömböt kaptunk, de ezzel most  
ne törődj. Koncentráljunk a modellezésre! Szükségünk lesz 
még három gömbre, s három rúdra. 

Ketőzéssel (SHIFT+D) fogjuk ezeket létrehozni. A duplázás-
nak  is  nevezet művelet  a  nagy  előnye,  hogy  a  másolat  
azonnal létrejön, s szabadon mozgatható. Ami előnyt jelent 
a kötetlen modellezésnél, most kínlódás, hibalehetőség, ha 
pontosan szeretnénk szerkeszteni! Lehetne-e korlátozni a 
mozgásunkat,  hogy egyenesen haladjon a másolat? Igen.
A (SHIFT+D) kombináció után nyomd meg az (X) gombot, 
melynek  hatására  a  program  piros  színnel  meghúzza  a 
kényszerítet mozgásvonalat  –  az  X  tengely  irányában.  
Ugyanez a kényszer az Y és Z irányban is létrehozható, a 
megfelelő billentyűk lenyomásával.

7. Alapszintű modellezés
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Most  pihenésképpen  Ketőzd (SHIFT+D)  a  gömbök  közti 
rudat, majd forgasd (R) 90°-kal – a CTRL segítségével. Tedd 
a helyére, majd ketőzd (SHIFT+D), nyomd meg az (X) bil-
lentyűt (kényszerítés), majd mozgasd a másik gömbhöz.

A többi szinte ezeknek a mozdulatoknak a gyakorlása…

Jelöld  ki  a  bal  oldali  gömböt  jobb  egérgombbal,  majd 
SHIFT-tel jelöld hozzá a másikat is. Ketőzd ezt a rendszert 
(SHIFT+D), de vigyázz, mert a kényszerítés most Y irányú 
lesz (zöld tengely) – így megnyomjuk az (Y) gombot is.

A közötük lévő rudat most már ketőzéssel  és  Y irányú 
kényszerítéssel elkészítheted.

7. Alapszintű modellezés
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Térben elforgatva ezt kell kapnod. Ha nem stimmel valami 
(például nincsenek egy szintben a rudak a gömbökkel), a 
manipulátorokkal mindent a helyére igazíthatsz.

Polírozás ♦ Nem akartam megszakítani a vidám modelle-
zést, de most már zavaró, hogy négy diszkógömbünk van! 
Jelöld ki SHIFT-tel mindegyiket, majd az Eszköztár > Tools  
fülén keresd meg a Simítás (Smooth) gombot.

Építkezzünk tovább! ♦ Válts elölnézetbe (1). Válaszd ki a 
gömbök közöti rudat, ketőzd (SHIFT+D), majd forgasd el 
90°-kal (CTRL). Tedd a bal oldali gömb tetejére, majd  ket-
tőzd és X irányba kényszerítve mozdítsd a másik gömb fö-
lé. Déjà vu? Igen, csináltunk már valami hasonlót.

Jelöld ki együt a felső két rudat (jobb klikk + SHIFT). Válts 
oldalnézetbe  (3),  ketőzd a  rudakat  (SHIFT+D),  s  most  Y 
irányba kényszerítve mozgasd az üres gömbök tetejére.

7. Alapszintű modellezés
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Érdemes rápillantani művünkre térben is (bal oldali ábra). 

Tegyük fel a koronát! ♦ Az „alapok rendben”, a „falakat” 
is felhúztuk. A „tető” tulajdonképpen az alsó négy rúd és 
gömb másolata. A kijelöléshez most használd ezt a térbeli 
nézetet. 

Jobb  egérgombbal  jelöld  ki  az  első  gömböt,  majd  hozzá 
SHIFT-tel  többit.  Válts  elöl  (1)  vagy  oldalnézetbe  (3).
A Ketőzés (SHIFT+D) után most a függőleges, azaz Z ten-
gély  mentén  kényszerítsd  a  másolatok  mozgását.  Hopp, 
kész is van a kocka!

7. Alapszintű modellezés
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A kocka szíve ♦ Már majdnem kész- Még egy gömb hi-
ányzik a kristályrács közepéről, és a négy testátló. 

Kezdjük a gömbbel. Érdemes elölnézetből (1) az egyik sa-
rokgömböt ketőzni, majd szemmértékkel a rács közepére 
helyezni.  Aztán  válts  oldalnézetbe  (3),  így  látható,  hogy 
hova került valójában. Ha a magasság megfelelő, mozgasd 
az Y tengely mentén: mozgatógomb megnyomása (G) után 
az (Y) billentyűvel tengely menti mozgás.

A gömb másolása elölnézetből, igazítása oldalnézetből.

Testátlók ♦  Kezdjük  elölnézetből  (1).  Tedd  le  bal  egér-
gombbal a 3D kurzort egy üres területre, majd hozz létre 
egy új hengert az Eszköztár > Create > Cylinder gombjával. 

Mivel a Blender emlékezet a korábbi paraméterekre, ez a  
henger ugyanolyan lesz, mint amit eddig használtunk. Az 
öreg  Pitagorasz  tételével  kiszámolhatnánk,  mekkora  egy 
testátló irányú cső, de inkább megmondom. 

A Wikipédia azt írja ugyanis, hogy a középre mutató csö-
vek 23 méteresek. A középső gömb 18 méter, ehhez adjuk a 
két cső hosszát: 64 méter hosszú csővel megoldható…

Eddig is tizedére kicsinyítetük a modellt, tehát a paraméte-
rezésnél a rúd magassága legyen 6,4. 

Nincs más dolgod, mint elöl-, oldal-, felülnézetben (1, 3, 7) 
a helyére forgatni a testátlót.

7. Alapszintű modellezés
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Az utolsó lépések némi térszemléletel, nézetváltásokkal és 
apró logikával megoldhatóak. Lényeg, hogy egy-egy nézet-
ből  találd  meg  a  másik  keresztező  testátló  helyét,  majd 
Ketőzéssel (SHIFT+D) és forgatással (R) tedd oda.

A kijelölés ABC-je

A belga Atomium az egyik sarkán áll, emiat a három alsó  
gömb alátámasztást kapot, így let stabil a szerkezetű. Ál -
lítsuk mi is a sarkára a Maegyar Atomot, felhasználva a kö-
zös kijelölés lehetőségét és a nézeteket.

Fotó: Pixabay

7. Alapszintű modellezés
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Egyenként  kijelölni  a  Maegyar  Atomhoz  tartozó  testeket 
jobb egérgombbal lehet, miközben a SHIFT billentyűt nyo-
mod. 

Kilenc gömb, négy testátló, tizenkető oldalél = huszonöt  
test. Hétfőn mehetünk dokihoz az ínhüvely-gyulladásunk-
kal. Kell néhány szót ejtenem a Blender egyéb kijelölései-
ről,  vagy  jöjjön  a  pihentető  gipsz?  Oké,  előzzük  meg  a 
bajt… 

A ♦  Ha  a  3D  ablak  összes  tárgyát  ki  szeretnéd  jelölni, 
nyomd meg az (A) gombot. Ekkor a lámpa, a kamera is ki-
jelölésre kerül, ami nem igazán jó megoldás.

Az (A) gomb újbóli megnyomásával megszűnik az összes 
kijelölés. Olyan, mint egy kapcsoló…

B ♦  Border Select-nek (Keretes kijelölés)14 nevezzük azt a 
kiválasztást, amikor egy téglalappal körberajzoljuk a teste-
ket. Minden, amihez ez a téglalap hozzáér, kiválasztásra ke-
rül. Ennek is van egy gyorsbillentyűje, amit a Border szóról 
könnyű megjegyezni: (B). 

Próbáld csak ki: Először szüntess meg minden kijelölést az 
(A) gomb kapcsolószerű – egyszeri vagy kétszeri – meg-
nyomásával, majd nyomd meg a (B)-t, és rajzold körbe egy 
keretel azt, amit kiválasztani szeretnél.

14 A síkgrafkai programokban ezt gumikeretnek nevezik.

7. Alapszintű modellezés
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C ♦  Circle Select (Kör alakú kijelölés) olyan, mintha egy 
ecsetfejjel  lemeszelnéd  azokat  a  tárgyakat,  melyeket  el 
akarsz különíteni. Használd a (C) betűt hozzá.

Amikor befejezted, az ESC billentyűvel tudod elhagyni ezt 
a kijelölési módot. Ha közben forgatnod kell a testet, lépj ki 
így,  majd  újra  nyomd a  (C)-t.  A  később  kijelölt  tárgyak 
hozzáadódnak a kijelöléshez. Ha kicsi az ecsetfej, az egér 
görgőjének forgatásával átméretezheted.

A Blender kijelölési lehetőségeit könnyen megjegyez-
heted az ABC betűiről. 

• (A) – All, azaz minden.
• (B) – Border, azaz keret.
• (C) – Circle, azaz kör.

Jelöld ki a  Maegyar Atomot, majd elöl- (1) és oldalnézetben 
(3) forgasd az élére. Elkészült munkádat mentsd le magad-
nak. Mondjak rá gyorsbillentyűt?15

15 CTRL+S. Ez hasznos lehet, hiszen más programok is így használják a mentést.

7. Alapszintű modellezés

A Blender kiválasztási ABC-jét 
megtalálod menüként a 3D 
ablak alsó menüsorában, a 

Select menüpontnál.
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8. 
Az 

első animáció

8. Az első animáció

8.
Első animációs feladatunkban tanulunk 
valamicskét a vonatkoztatási rendszerekről,
az animáció alapmechanizmusairól, s közben 
szétrobbantunk eegy acélkristályt.

 

az első
animáció
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Maghasadás a barackosban

Előző feladatunkban a Blender alapszintű modellező eszkö-
zeivel foglalkoztunk. Az élet nem olyan egyszerű, mond-
hatnánk, hogy ezekből a primitív testekből össze lehetne 
mindent rakni. 

Az élet nem, de a látványanimáció igen. Sokat dolgoztunk a 
Maegyar Atommal, pedig alig bonyolultabb, mint gyermek-
korunk kreatív építőkészlete. Most eljöt az idő, amikor fel-
dereng a magyar maghasadás hajnala – este a székelyeknél.

Remélem,  jól  sikerült  a  kristálymodelled.  Amennyiben 
nem, lapozz vissza az előző feladatra, s néhány óra múlva 
találkozunk… Na jó, bevallom, van egy előkészítet fájlom…

Nyisd  meg  a  mellékletből  a  007_maegyaratom.blend állo-
mányt.  Van ennek a modellnek néhány hibája,  ami nem 
igazán látszik, amikor minden csillog-villog…

8. Az első animáció
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Állítsd át a jobb oldali Properties panelen a formázó anyagot 
(Matcap) erre a vörösagyag színűre. Vizsgáld meg a model-
len a rudakat, minden a helyén van-e? 

Bizony, ez a modell egy kicsit szétcsúszott...

Próbáld az egyik rudat visszatologatni a helyére a manipu-
látor mozgató fogantyúival! Elég nagy kínlódás… 

Eleddig nagyon fgyeltünk arra, hogy a tér koordinátaten-
gelyei szerinti alapnézetekben szerkesszünk. Ám ezt a mo-
dellt a csúcsára állítotuk. Nincs tengellyel párhuzamos al-
kotóeleme.  Hogy  a  kicsúszot rudakat  a  manipulátor  
segítségével vissza tudd illeszteni, sokat kell forgatni a te-
ret. Most nem segítenek a nézetek, lehetetlen megfelelően 
rálátni ezekre a kis eltérésekre.

8. Az első animáció
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Globális problémákra lokális megoldás ♦ A tér, amihez 
most  igazodnod  kell  globális  tér,  mely  saját  koordináta-
rendszerrel rendelkezik. A jobbra és balra, előre és hátra, a 
fel  és  le  a  tér  minden  lakója  számára  ugyanazt  jelenti.
A középen elhelyezkedő koordináta-rendszerhez viszonyí-
tunk  mindent.  Egy  ilyen  térben,  ha  a  tüzérségi  irányító 
megjelöl egy pontot, akkor a lövegkezelőknek kutyaköte-
lességük oda lőni. Ebben a térben semmi értelme ilyen kife-
jezéseket mondani: „Feje tetejére állt a világ.” „Vigyázz, jön 
a fal!” A világ mindig ugyanúgy áll, a fal felé meg én köze-
ledem – mondja a külső szemlélő, aki e világ origójából fii-
gyeli az  eseményeket.  A  testek  manipulátorai  ugyanúgy 
állnak, mint a térbeli koordináta-rendszer, bármelyik test-
nél is vizsgáljuk azt.

De létezik egy másik világkép – nevezzük lokális térnek –, 
melyben másképp érzékelünk.  Itt egy-egy tárgyhoz kötő-
dik a saját vonatkoztatási rendszere. Mint a hülye útörő, 
aki bármerre is áll, előte van észak, háta mögöt dél. 

Furcsa,  individuális nézőpont? Pedig sokszor praktikusan 
használható. 

Például egészen jól lehet benne este oldalra fekve olvasni. 
Szabálytartó ember ülve olvas. A lokális, ha elfárad elfekte-
ti a könyvet. 

8. Az első animáció
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A nemzetközi űrállomáson sakkozó űrhajósok is ezt a loká-
lis teret használják, amikor hozzánk képest fejtetőn sakkoz-
nak. De ha jól belegondolunk, mi is lokális terekben élünk 
a Föld felszínén: Hasonlítsd csak az ausztrál ember mozgá-
sait a tiedhez…

Ugrás a lokális térbe ♦ Nézzük meg, segít-e a modelle-
zésben  nekünk,  ha  globális  térből  lokálisba  kapcsolunk! 
Ot, ahol eddig a manipulátorokat  aktiváltad,  állítsd át  a  
menüt Global-ról Local-ra.

Különböző tárgyakat megérintve most már a saját szemé-
lyes terükhöz kapcsolt koordináta-rendszereket láthatsz. 

Próbáld csak ki a rudak igazgatását! Drasztikusan csökken-
ni fog a szöszöléssel, igazítgatással eltöltöt idő. Járd körbe  
a modellt és javítsd ki a hibákat!

8. Az első animáció
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Animáció

S most jön egy fogás, melynek nemsokára, az első animáci-
ónk készítése közben nagy jelentősége lesz. Zavard össze a 
gömbök koordináta-rendszereit! 

Miután ellenőrizted, hogy Local-ra vannak állítva a szemé-
lyes terek, a forgató manipulátorokkal vagy az (R) gyorsbil-
lentyű kétszeri  megnyomásával  össze-vissza kell  forgatni 
azokat. 

Sok minden nem látszik majd a gömbökön, hiszen a fényes 
felületükön  semmiféle  jellegzetesség,  amivel  azonosíthat-
nánk, merre is néznek, de a hozzájuk kapcsolt koordináta-
rendszerek megmutatják majd tereik egymáshoz nem iga-
zodó elhelyezkedését…

Kijelölés ♦ Emlékszel talán a kijelölés ABC-jére… (A)-val 
minden kijelölhető, ugyanakkor minden kijelölés megszün-
tethető. Próbáld ki! 

(B)-vel keretel választhatod ki az objektumokat. Mi törté-
nik, ha újra (A) gombot nyomsz? (C)-vel pedig egy kör ala-
kú ecsetel végzed a kijelölést,  majd az akció után (ESC) 
gombbal térsz vissza a normális életbe.  Jelöld ki most az 
összes objektumot a neked tetsző módszerrel!

8. Az első animáció
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Ha ez megtörtént, egy narancssárga kontúr vete körbe az 
egész csapatot, s felkészült a Maegyar Atom – s remélem, te 
is – az első nagy animációra.

De miért csináltuk azt a sok hókuszpókuszt az előbb a Lo-
kális terekkel? Nos, gondolj a Maegyar Atomot alkotó objek-
tumokra úgy, mint egy csapat színészre, akiket te instru-
álsz.  Ha a  római  légiót  kell  játszani  a  Légió  mindhalálig 
című  Hollywood-i  flmben,  akkor  Globális  koordináta-
rendszerben kell  mozogniuk.  Magyarul  mindenki  ugyan-
úgy mozog, ahogy a rendező dirigál. 

Lokális koordináta-rendszerekkel viszont mindenki arrafelé 
indul el, amerre éppen a saját tere irányítja. 

Globális térben mindenki előre néz, s a  „lépés indulj !” pa-
rancsra előre indul a légió. Egymáshoz képest rendezetlen 
lokális terekben mindenki másfele néz, és az  „oszolj !” pa-
ranccsal elindul az orra után.

A forgatás elején megkérdezi az operatőr, hogy hány má-
sodpercnyi  anyagot  forgatunk.  Legyen  mondjuk  négy.
4 × 24 képkocka = 96. Ennyi flmet kell befűznünk. Kérlek, 
ezt állítsd be az idővonal alati End értéknél. 

Látni fogod, hogy az idővonal aktív (világosszürke) területe 
lecsökkent. A  Start érték a jelenet kezdő-, az  End pedig a 
záróképkockája. Figyeljük csak a rendezői utasítást: 

„Eegy logóanimációt készítünk a Maegyar Atom átadó ünnepsé-
gére. A tér minden irányából jövő gömbök, pálcikák eegyszer  
csak a Maegyar Atommá állnak össze. Fiúk, ezt kéne megcsi-
nálni. Tessék!”

Az operatőr kiakad: „It van eegy jó modell, főnök, amit elő -
ször szétbarmolunk, aztán megint pontosan összerakunk?”

8. Az első animáció
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Rövid duzzogás után rájön a megoldásra:  „Oké, akkor for-
dítva  fűzöm  be  a  flmet.  Kezdünk  a  precízen  összerakot  
atomrácsnál,  majd elküldünk mindenkit  a dolgára.  Ha ezt  
normális irányba játsszuk le, akkor a minden irányból érkező  
darabkák a szemünk látára keresik meg a helyüket, s állnak  
össze a kristályráccsá. Zseniális ! Naegy vaegy Főnök!”

Húzd most az időmutatót – ami egy függőleges zöld vonal 
az Idősávon – az utolsó, 96. képkockához. 

Nem is olyan könnyű kézzel beállítani… Az időmutató be-
leszaladhat a sötétszürke, inaktív területbe. Pontos beállí-
táshoz használd a billentyűzeted jobbra-balra nyilait, vagy 
a pillanatnyi idő beviteli mezőjét, amit a fenti képen beke-
reteztem. 

Az  Eszköztár negyedik füle az animációs beállításoké. El-
lenőrizd,  hogy  minden  objektum  ki  van-e  jelölve,  majd 
érintsd meg az  Insert (Beszúrás) gombot. Ezzel egy  kulcs-
kockát (Keyframe) tudsz beszúrni, azaz a program emlékez-
ni fog rá, hol voltak ezek a tárgyak abban a pillanatban. 

Ne ijedj meg: A megjelenő menüből válaszd egyszerűen az 
első, a Location (hely) parancsot. 

8. Az első animáció
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Választhatnánk még a Rotation (forgás) vagy Scale (átmére-
tezés) parancsot is. Nekünk most elég, ha mindent a helyé-
re tudunk tenni, ne bonyolítsuk feleslegesen az életet.

Most menj vissza az 1. képkockára, fogd meg az egyik moz-
gató manipulátor végét, és kezd el húzni a kép széléig. Köz-
ben minden tárgy mozgásvonala megjelenik azzal a szín-
nel, amilyen manipulátorral éppen mozgatsz. 

Ha a tárgyak nagy része kívül került már a  3D ablakon, 
nyomd meg az Eszköztár > Animation fül > Insert gombot, s 
a helyi menüből válaszd újra a Location (Hely) parancsot. A 
program most megjegyzi ezt a szétdobált állapotot.

8. Az első animáció
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Mi történt? Minden tárgy a saját rendszere irányában kez-
det elmozdulni, és széteset a Maegyar Atom. Megmondtuk 
a Blendernek, emlékezzen erre a pillanatra is. S most jön 
az, amire a számítógépet kitalálták: A program kiszámítja, 
hogy a két helyzet közöt hogyan mozogtak a tárgyak…

Hogy mi let az eredmény, ezt te is megnézheted, ha az Idő-
mutatót elmozdítod, vagy lejátszod az animációt az  Idővo-
nal alati vezérlőelemekkel.

Az első animációdat mentsd le: elsoanimaciom.blend néven.

8. Az első animáció
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9. 

Főcímanimáció

9. Főcímanimáció

9.
Ebben a feladatban két klasszikus 
találkozik a Blender virtuális terében: 
Kölcsey Ferenc és George Lucas. 
Megtanulunk a betűkkel dolgozni 
eegy főcímanimáció apropóján.

 

főcímanimáció
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Bús düledékeiden...

A nagy elődöktől mindig lehet tanulni, s hacsak abban a 
tévhitben  nem leledzünk,  hogy az  Univerzum konkrétan 
miatunk jöt létre, érdemes is. 

Új szereplőnk a betű, mely már annyit  tet az emberiség  
kultúrájáért,  hogy egy kis szívességet még igazán kérhe-
tünk tőle.

Nyisd meg 008_főcím.blend állományt. A (SHIFT+A) billen-
tyűkombinációval keresd meg az Add (Hozzáad) menüből a 
Text (Szöveg) parancsot. Ezt fogod látni:

Ez a  szöveg egyelőre  ugyanúgy viselkedik mint  bármely 
más tárgy.  Azaz mozgatható,  forgatható,  méretezhető,  de 
nekem egy  sablonszöveg  látán  nem ez  jut  eszembe.  Át 
akarom írni! Lecserélni! Módosítani!

Ehhez néhány szót kell szólnom a Blender tárgykezelésé-
ről. Kérlek, pillants le a 3D ablak alsó menüsorára.

Object Mode (Tárgymód) a Blender alapbeállítása.  Itt  dol-
goztunk eddig – mozgatuk, forgatuk, méreteztük a teste-
ket. Edit Mode-ban (Szerkesztőmód) viszont nem csak a he-
lyük,  helyzetük  vagy  a  nagyságuk,  de  a  formájuk  is 
megváltoztatható.  Milyen  tulajdonságot  változtathatunk, 
szerkeszthetünk a betűknél? 

Magát a szöveget. Abból látod, hogy  Szerkesztőmódra vál-
totál, hogy egy szövegkurzor jelenik meg a betűk után.

9. Főcímanimáció
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Töröld le a „Text” példaszöveget és írd be az alábbit ponto-
san, betű szerint.

Közben persze kell  egy ENTER-t ütnöd az első szó után. 
Nem, nem gépeltem-e el a második szót. Diákkorom ked-
venc űreposzát szeretném felhasználni a magyar vers nép-
szerűsítésére. 

Kölcsey Ferenc: Huszt c. versét fogjuk a Csillagok háború-
ja főcímére animálni. 

A sorozat minden egyes epizódja így kezdődik: 

1. „Réges rég egy messzi-messzi galaxisban…
2. STAR WARS sorozatfőcím.
3. Az epizód címe.
4. Bevezető szöveg.

Ebből mi az első szöveget elhagyjuk, csak a többivel foglal-
kozunk.

9. Főcímanimáció
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STAR WERS ♦ Már beírtad a sorozatcímet. De ennek it 
balra valami különleges betűtípusa lehet, ami annyira nem 
hasonlít a Blender beépítet fontkészletére, mint Amerika  
kapitány Buga Jakabra. 

A Blender alapbetűjét több szempontból sem ajánlom hasz-
nálatra: A készítők két magyar betűt kifelejtetek belőle, az 
„ő”-t és az „ű”-t. Rengeteg bosszúságot okozhatna, ha nem 
lennénk eleve igényesek, s nem fogadnánk meg az elején: 
mindig egyedi betűtípusokat alkalmazzunk.16

Ha te is beírtad ezt a nemzeti példaszöveget, kérlek, töröld 
vissza úgy, hogy csak a „STAR WERS” maradjon, majd a 
TAB billentyűvel térj vissza Object Mode-ra (Tárgymód).

A Blenderben az Object és Edit mód közötti váltáshoz 
a TAB billentyűt használjuk.

Mindeddig nem szenteltünk különösebb fgyelmet a prog-
ram jobb oldalán elhelyezkedő  Properties (Tulajdonságok) 
ablaknak. 

A név ismerős lehet, hiszen a 3D ablaknak is volt egy saját 
Properties panelje, ahol például a Matcap tulajdonságot be-
állíthatad. De nagyon fgyelj, a kető nem ugyanaz!

Ennél általánosabb hatáskörű eszköz, melynek fejlécén ta-
lálsz egy gombsort. It keresd meg az „F” ikonnal jelölt Font 
(Betűtípus) gombot, ami láthatóvá teszi a bal oldali képen 
levő beállításokat. 

16 Nagyon sok amatőr flm használja ugyanezt a betűtípust, mely Blenderrel ké-
szült. Legyünk igényesek, alkalmazzuk ennél tudatosabban a betűket!

9. Főcímanimáció
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Keresd meg it a Font mezőben levő Regular (Normál) betű-
változatot, s katints a kis megnyitás ikonra.

A  Blender  fájlböngészője  segítségével  töltsd  be  a  felirat 
alapbetűtípusaként  a  009_StarJediHollow.tf betűtípust  a 
mellékletből. 

Kis  fnomításokat  végezzünk  a  szövegen!  A  Paragraph
(Bekezdés) mezőben az  Align (Igazítás) lehetőségei közöt 
válaszd a középre igazítást  (Center).  A  Spacing  (Távolság) 
beállításoknál  a  Betűköz (Leter)  legyen  0,95;  a  Sorköz 
(Line) pedig 0,6.

Az eredmény nem tökéletes, a betűk nem záródnak rende-
sen, de amit ki lehet hozni ebből a betűtípusból, azt kihoz-
tuk. 

Nem leszünk mindig ennyire felületesek, de most nem az a 
célunk,  hogy távolabb kerüljünk a témánktól.  Folytassuk 
inkább magával a verssel.

9. Főcímanimáció
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WERS mindenkinek ♦ Helyezd el bal egérgombbal a 3D 
kurzort a cím alá, majd a (SHIFT+A) billentyűkombináció-
val hozz létre egy újabb szöveget (Text). A (TAB) billentyű-
vel válts Edit Mode-ba (Szerkesztőmód). Töröld le a betűket.

Másolás/beillesztés műveletel, vagy egyszerű átírással he-
lyezd el  a  vers  szövegét  a  Blenderben.  Újra  szembesülni 
fogysz az alapbetűtípus hiányosságaival. 

TAB-bal  válts  vissza  Object  Mode-ba (Tárgymód).  Majd a 
jobb oldali Properties ablakban keress rá a Font tulajdonsá-
gokra. 

A  Font mezőben töltsd be a  Melléklet 010_LibreFranklin-
SemiBold.otf  betűtípusát.

A betűtípus most már korrekt, formára is hasonlít a flm-
ben alkalmazot betűkhöz. 

9. Főcímanimáció

KÖLCSEY FERENC: HUSZT

Bús düledékeiden, Husztnak 
romvára megállék; Csend vala, 
felleg alól szállt fel az éjjeli hold.

Szél kele most, mint sír szele kél; 
s a csarnok elontott Oszlopi közt 
lebegő rémalak inte felém.

És mond: Honfi, mit ér epedő 
kebel e romok ormán? Régi kor 
árnya felé visszamerengni mit ér?

Messze jövendővel komolyan 
vess öszve jelenkort; Hass, 
alkoss, gyarapíts: s a haza fényre 
derűl!
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A flm eredeti szövegigazítása sorkizárt, ami it megfelel a  
Paragraph > Horizontal Alighment > Justify beállításnak. 

Ahhoz, hogy a bal oldali képhez hasonlóan nézzen ki a szö-
veg, neked kell beállítanod a szövegdoboz (Text Boxes) mé-
retét. Az ábrán jeleztem, hol.

Mivel automatikus szóelválasztás nincs a rendszerben, ne-
ked kell beavatkoznod egyes versszakoknál.

Válts  kameranézetbe  (0).  Mozdítsd  el  a  manipulátorral  a 
vers  szövegét,  majd  (S)  gyorsbillentyűvel  méretezd  úgy, 
hogy a sor szélessége megegyezzen a képsík – a kamerában 
látható kép – alsó oldalának szélességével. 

9. Főcímanimáció
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Jelöld ki a vers szövegét, majd a (SHIFT+Z) billentyűkom-
binációval, vagy a 3D ablak alsó menüsorában válts valós 
idejű renderelésre.

Át kellene színezni a betűket…

A betűk anyagtulajdonságai ♦ A következő lépésben be 
kell állítanod a szövegek optikai tulajdonságait. Milyen köl-
csönhatásba léphet az anyag a fénnyel? 

• Fényforrásként viselkedik, akárcsak a nap, a villany-
körte, a gyertya vagy a neon.

• Visszaveri a fényt. 

• Elnyeli vagy átengedi a fényt.

Keresd meg a Properties (Tulajdonságok) ablakban a Mate-
rial (Anyag) gombot. Kérj egy új anyagot. Nevezd el „Sár-
gá”-nak, majd állítsd be a színét az elnevezésnek megfelelő-
en.  A  színminta  felet látod,  hogy  ez  az  anyag  Difuse  
(difúz)  típusú,  azaz  szabálytalanul  veri  vissza  a  rá  eső 
fényt. Akár a legtöbb tárgy a környezetünkben. Ez nem túl 
látványos. Állítsd át ezt az értéket  Emission-re (fénykibo-
csátás), mindjárt megoldódik a probléma. A szöveg diszkré-
ten világít. 

9. Főcímanimáció
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Ugyanezt a színt kell  alkalmaznunk a „STAR WERS” fel-
iratra is. Nyomd meg a (SHIFT+Z) billentyűt úgy, hogy az 
egér mutatója a  3D ablak felet legyen, így kikapcsolod a  
valós idejű renderelést, viszont ebben a módban kijelölhe-
tőek a tárgyak. 

Jobb egérgombbal katints a „STAR WERS” feliratra. Most 
ne hozz létre új anyagot, hanem a gomb melleti ikonnal  
válaszd ki a meglevő „Sárga” nevű anyagot.

Mozgások előkészítése ♦ Nézz bele az egyik  Star Wars 
flm kezdetébe, és látni fogod, hogy nem is olyan egyértel-
mű, milyen mozgásokat végeznek a szövegek. 

A főcím ugyanis a képmező közepe felé tűnik el, míg a be-
vezető szöveg mintha egy láthatatlan síkon siklana végig. 

9. Főcímanimáció
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Ennek enyészpontja – az a pont, ahova a perspektíva kö-
vetkeztében a párhuzamosok összefutnak – a flmekben ki-
csivel a képkocka fölé kerül. 

A Baljós árnyak c. film bevezető képkockáján látható perspektíva.

Kezdjük először a szöveg beállításával. Maga a vers jó he-
lyen van, nyugodtan mozoghat az alapsíkban. Hogy más-
hol tűnjön el, döntsd meg egy kicsit a kamerát. 

Ehhez válts vissza SHIFT+Z-vel Solid (tömör) nézetre. Tedd 
láthatóvá a 3D ablak Properties (Tulajdonságok) paneljét. 

Ellenőrizd,  hogy  kameranézetben  vagy-e  (0)!  Jobb  egér-
gombbal a kamera szélére katintva jelöld ki azt, és a bal ol-
dali  Tulajdonságok panel Rotation (Forgatás) menüjében az 
első vízszintes tengely menti forgást állítsd 70°-ra. Ha most 
a zöld manipulátorral előre mozgatod a verset, megfelelő 
perspektívában tűnik el a kép tetején.

9. Főcímanimáció

Properties panel: (N) gomb, 
vagy az ablak alján levő 

menüből View > Properties. 
Esetleg a 3D ablak

jobb felső oldalán a kis „+” 
gombra való kattintással.
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Mivel a STAR WERS feliratnak egészen máshol – a kép kö-
zepén – van az eltűnési pontja, ennek másféle mozgást kell 
adnunk.

Ha a kamera közepén tűnik el a felirat, akkor síkja párhu-
zamos  a  kamera  képsíkjával.  Ugyanúgy  kell  elforgatni, 
mint a kamerát,  ugyanazzal az értékkel.  Most jelöld ki a 
feliratot,  majd  a  bal  oldali  Tulajdonságok-panel Rotation 
(Forgatás) menüjében az X vízszintes tengely menti elfor-
dulását állítsd 70°-ra.

Hogyan  lehetne  kényelmesen  mozgatni  ezt  a  feliratot, 
hogy végig a kamerába nézzen, miközben távolodik? Cél-
szerű it is globális koordinátarendszerből lokálisra váltani.

Zárásul néhány szempont az animációhoz…

9. Főcímanimáció
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Az animáció

Először egy kis meglepetés ♦ Ha van hangszóró vagy 
fülhallgató a gépedhez kötve, az Idősáv alat indíts egy le -
játszást. Elrejtetem egy kis zenét az állományban… 

Ha végig szeretnéd hallgatni, állítsd 576-ra a záró képkoc-
kát. Ez lehet az animáció hossza is. (24 másodperc).

A főcím mozgatása ♦ Lokális koordinátarendszerre állí-
tot manipulátorral mozgasd a főcímet a kamera mögé. 

It lásd el egy  Location típusú kulcskockával  (Eszköztár >  
Animaton > Keyframes), majd az időben távolodva mozgasd 
át, és oda is kulcsolj.

A vers mozgatása ♦ Figyeld meg, hol kell belépnie a szö-
vegnek, oda tégy kulcskockát, és valahova, jóval a flm zá-
rása után – igen, túlszaladhatsz az idősávon.  Solid (tömör) 
nézetben teszteld az animációt. 

9. Főcímanimáció
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Javítgatás ♦  Az  animáció  folyamata  nagyon  hasonlít  a 
zene vagy tánc tanulásához. Vagy a flmfelvételhez. Egy-
egy darabot sokszor kell próbálni, vagy újraforgatni, míg 
tűrhető produkcióval állhatsz elő. Nem lehet it sem meg -
spórolni a gyakorlást,  kísérletezést.  De hol lehet javítani, 
ha egy-egy kulcskocka nem megfelelő helyre került? 

Ehhez a munkához van egy előre programozot képernyőel-
rendezés (Screen Layout), mely a fenti ábrán látható, felső 
menüből érhető el. Ebben találod a  Dopesheet (Kulcstábla) 
elnevezésű  ablakot,  ahol  jobb egérgombbal  kijelölhetőek, 
(G) gombbal mozgathatóak a kis rombuszokkal jelölt kulcs-
kockák. 

9. Főcímanimáció
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Meddig  jutottunk  el? ♦  Lehet,  hogy  sok  próbálkozás 
után  sem  leszel  teljesen  elégedet az  animációddal.  Van  
ugyanis egy-két trükk, ami még vár rád ebben a könyvben. 
A lecke végére  Solid (tömör) nézetben már egész tűrhető 
animációt tudsz futatni, de még nem látod a flmes kime-
netet. Nem baj, egyelőre ennyi fért bele…

9. Főcímanimáció
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10. 

Sakk

10. Sakk

10.
Most a modellezésbe és anyagtulajdonságok
tervezésébe kóstolsz bele.
Miközben eegy modern sakk-készleten dolgozunk,
megismerkedsz a csomópontokkal. 

 

sakk
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A következő feladatban egy modern sakktáblát fogunk ké-
szíteni,  bábukkal  együt. Az  inspirációt  Lanier Graham 
1966-os  design  sakk-készlete  adta.  Különlegessége,  hogy 
tangram-szerűen  egymásba  illeszkedő  elemekből  áll,  így 
nagyon egyszerű összecsomagolni. 

Először  a  sakkfgurák szerkesztésével  foglalkozunk,  majd 
beállítjuk anyagtulajdonságukat, végül készítünk egy 8×8-
as táblát a kis csapatnak.

Gyalog ♦  Nevezzük  így:  gyalog.  Ha  megállapodhatunk 
most, hogy nem a Dózsa György-féle parasztfelkelést fog-
juk  modellezni.  Ő a  hadsereg legegyszerűbb katonája.  A 
hősies Kocka. Elkészítésénél fgyelünk a méretezésére, ezért 
már a létrejöténél paraméterezzük. Ha így teszünk, min-
den később létrehozot kocka ebben a méretben kezdi pá -
lyafutását.

Nyisd  meg  a  Blendert,  és  jobb  egérgombbal  jelöld  ki  a 
program által biztosítot kockát. Ismétlésként, s hogy „tisz-
ta lappal” kezdjünk, a (DEL) vagy (X) billentyűvel töröld.
A bal oldali Eszköztár > Create füléről kérj egy új kockát. A 
frissen felbukkanó gyalog méretét még azon melegében ál-
lítsd be a panelen: A Radius érték legyen 0.5. 

Ezzel két dolgot értél el : A kockád 0.5 egység sugarú, azaz 
1 egység átmérőjű (értsd sugár alat a bele írható kör suga-
rát) ; másrészt minden kocka eztán ugyanilyen méretű lesz.

10. Sakk
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Bástya ♦ Tedd félre a gyalogot. Figyelj arra, hogy a tár-
gyak mindig a 3D kurzor helyén jönnek majd létre. Az Esz-
köztárról kérj még egy kockát. Válts elölnézetre (1), nyomd 
meg az (5) gombot, hogy ortografkus nézetbe kerüljön, és 
helyezd az X (piros) tengely fölé.

Most is bemutatlak Editnek. Ő a Szerkesztőmód17. 

Eddig Object Mode-ban (Tárgymód) voltunk, ahol előkészí-
tetük,  majd  transzformáltuk a  tárgyakat.  Ha komolyabb 
szerkesztésekre kívánod használni a Blendert, az Edit Mode 
megismerése nélkülözhetetlen. Edit Mode-ban ugyanis nem 
csak tologatni, forgatni vagy nyomorgatni tudod a tárgya-
kat –  hanem formálni is! 

Edit Mode-ba kétféleképpen kerülhetsz. (TAB) gyorsbillen-
tyűvel. Ez a CAPS LOCK feleti gomb, amit táblázatszerű  
szerkesztésre használunk máshol. Ezt érdemes megtanulni, 
mert nagyon gyakran fogod használni. Ha nem jut eszedbe, 
vagy ellenőrizni akarod, hogy éppen melyik módban vagy, 
akkor a 3D ablak alján a menüvel is tudsz váltani.

S most készülj fel rá, hogy egy kicsit máshogy fogod látni a 
valóságot. Oké, ehhez lapozni is kell…

17  to edit : szerkeszteni (angol)

10. Sakk
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Amikor ugyanis belépsz Edit-módba, valami ilyet látsz. Na-
rancssárgán izzik az egész kocka, meg a kopár szik sarja. Ez 
a kijelölés színe. Emlékszel a kijelölési ABC-re? Az (A) bil-
lentyű  mint  egy  kapcsoló:  mindent  kijelöl  vagy  semmit 
sem… Nyomd meg az (A)-t és eltűnik ez ez édes kis pír a  
kockáról.

Ennek a kockának van 8 csúcsa, 12 éle és 6 lapja. Hogy lesz 
belőle bástya? Ha a tetejét – a fedőlapját – megfogod, és 
felfele húzod úgy, hogy kétszer akkora legyen.

Alapállapotban csak csúcsokat tudsz kijelölni,  válts át  az 
alsó menüsoron a lapokra (Face Select), majd jelöld ki jobb 
egérgombbal a kocka felső lapját. Válts elölnézetbe (1) és 
húzd fel ezt a lapot addig, míg pontosan  2 egység magas 
nem lesz a bástya. Ha elkészültél, forgasd meg egy kicsit 
térben, majd (TAB) billentyűvel válts vissza  Object Mode-
ba. Ez azért fontos, mert ha Szerkesztőmódban (Edit Mode) 
maradnál, a következő test, amit létrehozol, gyakorlatilag 
hozzáadódna az előzőhöz. 

Object Mode-ban létrehozott testek különállóak,  Edit  
Mode-ban viszont geometriailag hozzáadódnak ahhoz 
a testhez, mely mellett létrehozod őket. Akkor is, ha 
nincs közös részük. 

Talán  egy  olyan  építőanyag-bolthoz  lehetne  hasonlítani 
ezt, ahol, amíg nézelődsz (Object Mode) különálló tárgyakat 
látsz (csempék, falazóanyagok, járólapok, nyílászárók). On-
nantól viszont, ha az eladópulthoz hordatsz néhányat ezek-
ből, és kifzeted, ezek együt a már tieid (Edit Mode). Min-
den  Edit  Mode-ban  létrehozot „árucikk”  hozzáadódik  a  
számládhoz, s ha valamit otfelejtenél, utánad is viszik. 

Kellemetlen következményekkel jár a fgyelmetlenségünk, 
ha különálló tárgyakat akarunk létrehozni, s Edit Mode-ban 
maradunk: Az eredetileg it utoljára módosítot tárgyhoz  
kötődik, vele egy geometriai rendszert alkot a következő. 

10. Sakk
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Onnan veszed észre, hogy benn ragadtál Edit Mode-ban, ha 
egy másik testnek is látod a szerkezetét. 

Huszár ♦ Erős absztrakció után így alakul:  huszár–nye-
reg–szék. Told el a bástyát a gyalog mellé, hogy legyen he-
lyed. Készíts megint egy kockát Object Mode-ban, válts elöl-
nézetbe, és helyezd az X tengely fölé, ahogy korábban is!

Válts Edit Mode-ba (TAB). A bal oldali képhez hasonló kis-
széket kell készíteni. Ehhez először felosztjuk, szétvagdos-
suk a kockát,  majd a felső lapjának két négyzetét felfele 
húzzuk. 

Figyeld  meg,  ahogy  Edit  Mode-ban átalakult  a  bal  oldali 
Eszköztár, s keresd meg it a Tools fülön ezt a panelt. Ellen-
őrizd, hogy minden lapját kijelölted-e a kockának. A panel-
ről használd a Subdivide (Felosztás) gombot, amely az aláb-
bi módon részekre osztja a lapokat.

Nyomd meg az (A) gombot, ami a  kijelölés (mindent/sem-
mit) kapcsolója. Jelöld ki a kocka két felső lapját a SHIFT és 
jobb egérgomb segítségével, ahogy a bal oldali ábrán látod.

10. Sakk

Mit csináljunk mégis, ha benn ragadt 
egy test Edit Mode-ban, és sziámi 

ikrévé vált egy másiknak? 
Edit Mode-ban  szüntesd meg az 

összes kijelölést  (A). Vidd az egeret
a leválasztandó tárgy közelébe, s 
nyomd meg az (L) billentyűt. Azt 
fogod látni, hogy a tárgy, amit le 

akarsz választani, kijelölésre került. 
Nyomd meg a (P) gombot, ez a 

Separate, azaz elkülönít/leválaszt 
utasítás, amivel ezután önálló 

objektumként kezelheted.
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A manipulátorral húzd felfele ezeket a lapokat. Sajnos így 
csak eldeformálódikt az alakzat. CTRL+Z-vel vonjuk vissza 
ezt a lépésünket. 

Továbbra is legyen kijelölve a két lap, de most az Extrude 
Region (Terület kihúzása) gombot – vagy az (E) gyorsbil-
lentyűt – nyomd meg az Eszköztáron. Az egér mozgatásá-
val azonnal formálódik a kisszék-huszár. Bal egérgombbal 
katints, ha készen vagy. Finomabb beállításhoz használd az 
elöl- (1) vagy oldalnézetet (2). Ilyenkor elég csak a manipu-
látort mozgatni, nem kell újra kihúzni.

Futó ♦ Válts vissza  Object Mode-ba (TAB). Hozz létre egy 
újabb kockát, helyezd rá a nézetek segítségével a síkra. Edit  
Mode-ban az alsó menüsoron válaszd az éleket. Jelöld ki a 
fedőlap hátsó élét, majd manipulátorral húzd a helyére. Ké-
szen is vagy…

10. Sakk
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Vezér  ♦ Válts vissza  Object Mode-ba (TAB), és duplázd a 
korábbi  bástyát  (SHIFT+D).  Kapcsolj  át  Edit  Mode-ba 
(TAB). Jelöld ki a test fedőlapját, majd a bal oldali  Eszköz-
tár Tools fülén végezd el a lap felosztását (Subdivide). 

Ezután válts  az  alsó  menün élek  kijelölésére.  Jobb  egér-
gombbal és SHIFT-tel jelöld meg a fedőlap egyik középső 
élét. Mozdítsd lefele!

Király ♦ (TAB)-bal menj át Object Mode-ba. (SHIFT+D)-vel 
ketőzd a vezért. Válts vissza Edit Mode-ba, fogd meg a kö-
zépső élet, és mozgasd felfele.

•••

Elkészültünk a készlet minden mintapéldányával. Mielőt a 
másolatokat elkészítenéd, hozd létre a sakktáblát!

10. Sakk
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Gordiuszi csomópontszerkesztő

A feladat első része azoknak szólt, akik komolyan model-
lezni szeretnének. A Blender alaptest-készlete olyan, mint 
egy építőkocka-játék.  Tekints  e primitív alakzatokra úgy, 
mint kiinduló formákra, melyeket a létrehozást követően 
Szerkesztőmódban (Edit Mode) fnomítunk, formálunk még. 

Mi pedig először is csináljunk rendet, mielőt a sakktáblát  
létrehoznánk! A sakkbábuk prototípusait egyenként küldd 
át a második rétegre (M). 

Helyezd  el  a  3D  kurzort a  koordinátarendszer  közepére. 
Hozz létre egy síkot (Plane) – a változatosság kedvéért – a 
(SHIFT+A) gyorsbillentyűvel.

A 3D ablak feleti menüsorban válaszd ki a Cycles rendere-
lő motort. A könyv további részében ezzel a képmegjelení-
tő eljárással dolgozunk, mellyel fotorealisztikus eredményt 
érhetünk el,  s képes a videokártyánkat is bevonni a ren-
derelésbe. 

Az előző feladatban is használtuk már, de csak alapbeállítá-
sait. Most egy kicsit tovább megyünk.

10. Sakk

A Függelékben találsz 
néhány ötletet modellezéshez.

A Függelékben találsz 
néhány ötletet modellezéshez.
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1. A Blender felső menüsorában, rögtön a menüparan-
csok  után  találod  a  képernyő-elrendezések  (Screen 
Layout) legördülő menüjét. Mindeddig Default-, azaz 
alaphelyzetben volt. Váltsd át  Compositing-ra. Ez az 
elrendezés  a  program utómunka-folyamatait  támo-
gatja. De nekünk most nagyon jó, átekinthető mun-
kakörnyezetet biztosít az anyagok optikai tulajdonsá-
gainak beállításához.

2. A lekicsinyítet, jobb alsó 3D ablakon állítsd be a va-
lós idejű renderelést (SHIFT+Z). Vagy így…

10. Sakk
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3. Harmadik  lépésben  nézzük  meg  a  felső,  úgyneve-
zet Csomópontszerkesztő ablak menüsorát. 

Az első  három gomb:  utómunka-,  textúra-  és  anyagtulaj-
donság-szerkesztő. Válaszd ki a harmadik gombot. Ő felelős 
a  tárgyak  optikai  tulajdonságaiért.  Nyomd  meg  a  New 
gombot, amellyel egy új anyagot rendelsz a síkhoz.

Új anyag keletkezett a Csomópontszerkesztőn. 

Mi adtuk a világnak a drótos-dugdosós telefonközpont öt-
letét18.  Aztán valami hasonlót  használtak az elektronikus 
zenében is a moduláris szintetizátoroknál…

S annyira bevált ez a kapcsolótáblás módszer, hogy renge-
teg 3D és utómunka-szofver használja manapság. 

18 Puskás Tivadar (1878).

10. Sakk

A Puskás-féle telefonközpont. Jobbra: 
Moduláris szintetizátort

utánzó szoftver.
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A képen levő két dobozt csomópontoknak nevezzük, olyan értelemben, ahol 
utak, útvonalak futnak össze.

De mi is ennek a rendszernek a logikája? Két csomópontot 
látsz. Ezeknek, mint kis műszereknek a bal oldalán beme-
neti, jobb oldalán kimeneti csatlakozók vannak. Ha vannak. 

Ebben az elrendezésben például a bal oldali modul, csomó-
pont egy olyan objektum, ami leír egy szabályt:  az adot 
testről hoegyan verődik vissza a fény.  A  Difuse jelentése – 
szórt visszaverődés. 

Ezek olyan anyagok, melyek bár visszaverik a fényt, de fe-
lületük nem tükörsima. Mikroszkóppal megvizsgálva, mint-
ha ezernyi, különböző irányba mutató elemi tükröcske al-
kotná a felszínüket.

Mint egy idegen táj – a diffúz anyagok felszíne, melyekről szabálytalanul verő-
dik vissza a fény.

Figyeld meg, mi történik, ha a Difúz csomópont Color érté-
két  megváltoztatod!  Katints  egyszerűen  az  előte levő  
színmintára,  majd  válassz  egy  színt.  Mit  látsz  a  síkon, 
melyre hatással van rá ez a művelet?

10. Sakk
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A sík elkékült.  De hogyan kerültek ide a bábuk? Bekap-
csoltam a második réteget is (SHIFT)-tel, hogy mindkető 
látsszon. Elsőn a sík, másodikon a bábuk. Tégy te is így…

A „folyamatábra” jelentése. 

• Bal  oldali  doboz,  csomópont:  A tárgy a  kék  színű 
fényt rendezetlenül (difúz) veri vissza. 

• Jobb oldali csomópont: Ezt a „szabályt” rákapcsoltuk 
a  Material  Output (az  anyag  kimenő  tulajdonsága) 
Surface (felület)  csatlakozójára,  biztosítva,  hogy  az 
anyag felülete valóban így viselkedjen. 

Most fogd meg kérlek it, a Surface csatlakozónál a drótot, 
és emeld ki bal egérgombbal a csatlakozóból.

A felület elfeketedik, mert nem kap semmilyen szabályt a 
fénnyel kapcsolatos viselkedésére.

10. Sakk
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Fűzd vissza az előbb kihúzot drótot úgy, hogy a bal oldali  
árnyalási csomópont kimenetét összekötöd a Material Out-
put csomópont Surface bemenetével.

Difúz anyagok a valóságban a textilek, falapok, pa-
pír, fal, stb. Ezek, habár visszaverik a fény egy részét, 
mégsem készíthetünk belőlük tükröt, mert szabályta-
lanul teszik ezt.

Textúra készítése ♦ Az anyagok többnyire nem homogén 
a színűek, hanem valamilyen mintázat helyezkedik el raj-
tuk. Próbáld csak ki! A felső,  csomópontszerkesztő ablak 
menüjéből  válaszd  az  Add  >  Texture  >  Checker  Texture 
(mintázat > sakkminta) parancsokat.

Bal egérgombbal rakd le az új csomópontot, ami egy sakk-
tábla-szerű  mintát,  textúrát  hoz  létre  a  felületen.  Ehhez 
persze össze kell kötni a két Color csatlakozót, és íme…
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Most állítsd be a legelső, mintázatot defniáló doboz értéke-
it a következőképpen: A mintázat két színe legyen fehér és 
fekete, a Scale (Mérték) pedig 8. 

Az eredmény: 8 × 8-as sakkminta, a megszokot színekkel.  
Próbáld ki, mi lenne, ha a Scale értéknek más számot írnál? 
A Scale érték az oldal felosztását jelenti. Vissza a sakkra!

A bábuk textúrázása ♦ Vidd a bal alsó 3D ablakra az ege-
redet, nyomd meg a (SHIFT+Z) gombokat. A  tömör nézet 
nem túl látványos, de legalább kijelölhetőek a tárgyak.

Jobb egérgombbal mutass rá a huszárra,  majd nézd meg, 
hogy a felső,  Csomópontszerkesztő ablakban látsz-e valami 
változást.  Ne rémülj meg, ha eltűnt az előző csomópont-
rendszer. Az a sakktáblához tartozot, ennek a kisszéknek 
pedig még nincs semmilyen anyagbeállítása. 
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Nyugodtan próbáld ki, ha jobb egérgombbal a síkra katin-
tasz, akkor visszatér a munkád, amit a sakktábla beállításá-
nál végeztél, és visszaváltva a kisszékre – újfent eltűnik.

Készítsünk a huszárnak is egy csomópontrendszert! A ko-
rábbi módon, a Csomópontszerkesztő ablak alján.

Miután megjelent a szokásos Difuse – Material Output cso-
mópontpár,  szaladj  vissza  3D ablakhoz  az  egereddel,  állj 
meg felete, és nyomd meg a (SHIFT+Z) kombinációt a va-
lós idejű rendereléshez. Ezután menj vissza a  Csomópont-
szerkesztőbe, és hasonlóan ahhoz, ahogy korábban a sakk-
táblánál, adj hozzá a rendszerhez egy textúra-csomópontot.

Ehhez használhatod a (SHIFT+A) billentyűkkel  behívható 
Add menüt, ami az alsó menüből is elérhető: Add > Texture  
> Image Texture.  Korábban innen a sakkmintát  választot-
tuk, de hülyén nézne ki a huszár kockás pizsamában.

Ezt kéne összehozni. A logikája pedig: az első doboz betölt 
egy képet, annak mintázatát átadja a difúz anyagnak, ez 
pedig kényszeríti  az  utolsó  dobozkát,  hogy vegye komo-
lyan, valóban felületet szeretnénk belőle készíteni.
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Azt biztosan észrevetted, hogy 
a csomópontrendszereket a 
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alapállapotban egy 
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helyén ne egy fekete folt 
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anyagot lehet, a textúrát nem 
fűzheted direkt a kimenetbe. 
Jó darabig Shader és Texture 

típusú csomópontokkal 
dolgozunk majd a könyvben.
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De amíg nem töltesz be képet, addig a huszárod másodfokú 
égési sérüléseket szenved – ez a Blender fgyelmeztető szí-
ne olyan esetre, amikor valami hiányzik…

Katints az  Image Texture (képmintázat)  csomópont  Open 
gombjára, és töltsd be a leckéhez tartozó 011_vilagos_fa.jpg 
bitképet.

E logikai rendben a mintázat nagyon sápatag. Mintha még 
valami hiányozna, s talán nem haragszol meg, ha azt mon-
dom, a térképészeti tudás. Nem mindegy ugyanis, ezt a „tér-
képet”, „kelmét” vagy „kárpitot”, mihez hasonlíthatjuk ezt a 
bitképet, hogyan feszítjük rá a testre. Ehhez kell még egy 
csomópont, amit az Input csomók közöt fogsz megtalálni.

Ezután így néz ki a csomópontrendszerünk. A Texture Co-
ordinate Generated (generált) kivezetését küldd a következő 
csomópont bemenetére, ilyenkor a szofver generálja, hoz-
za létre a legjobb megoldást.

Az eredmény szerény, mégis már látszik a fa erezete. Ha 
ennél szebbre vágysz – márpedig mért ne –, akkor próbáld 
ki az Image Texture csomópont harmadik legördülő menü-
jét. Választhatsz, a  Flat/Cube/Sphere/Tube beállítások közül 
melyik a legjobb…

10. Sakk
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Ezek egyébként a mintázat ráfeszítésének módját befolyá-
solják, mintha  síkra, kockára, gömbre vagy  hengerpalástra 
vetítenéd a textúrát.

Nekem egyébként a  Box  (kocka) típusú jöt be legjobban.  
De van még egy kis hiányérzetem.

Világosságot! ♦ Elég spórolósan bántunk eddig a fények-
kel.  A gyönyörűen berendezet szoba semmit sem ér,  ha  
nincs méltó megvilágítása. 

A fenti képernyőképnek megfelelően állítsd át a bal alsó 
ablakot 3D nézetre. 

Jelöld ki jobb egérgombbal az ot már láthatóvá váló lám -
pát,  és  fenn,  a  Csomópontszerkesztő ablakban pipáld ki  a 
Use Nodes jelölőnézetet. 
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Bal oldalon tömör nézetben 
kijelölhetőek a tárgyak. Fenn 

pedig ugyanazzal a csomópont-
alapú logikával állíthatod a 

lámpák fényét, mint az anyagokét.
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A  lámpa  színét  kicsit  sárgábbra,  melegebbre  állítotam. 
Erőssége alapértékét (Strenght) pedig 500-ra.

Fogunk ennél szebb bevilágításokkal is dolgozni, de egyelő-
re csak egy kicsit látni szeretnénk a műhelyben, ahol dol-
gozunk.

Mozgathatod kicsit ezt a lámpát a bal alsó ablakban a ma-
nipulátorokkal. A jobb oldalon a Blender Tulajdonságok ab-
lakában (Properties) pedig beállíthatod a fényforrás nagysá-
gát (Size), amivel puhább, szórt árnyékok jönnek létre.
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A jobb oldali Tulajdonságok 
ablakban (Properties) beállítható a 

kijelölt tárgy sokféle paramétere. 
Ha lámpát jelölsz ki, akkor annak 

ikonja jelenik meg az ablak tetején.
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Optikai  tulajdonságok keverése  ♦ A valóság legtöbb-
ször  nem annyira  egyszerű,  mint  a  hasábfa.  Egy  szépen 
megmunkált anyag felületét például lakkal kezeljük, hogy 
tartósabb, biztonságosabb legyen.

A képen látható padló deszkái részben szabálytalanul,  részben szabályosan 
verik vissza a fénysugarakat. 

A faanyag difúz módon veri vissza a fénysugarakat, a rá 
került lakk viszont részleges tükröző felületként működik.

A  Csomópontszerkesztő Add menüjéből,  az  Add  >  Shader  
menüpont segítségével helyeztem el még kétféle, az anyag 
optikai tulajdonságát markánsan meghatározó csomópon-
tot. Ezeket ugyanot találod, mint a Difuse típusú anyagot. 
A  Glossy  (fényes,  sima)  úgy  működik,  mint  a  tükör.  Az 
Emission (fényforrás) pedig mint az elnevezése sugallja…
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Diffúz, tükröző és fénykibocsátó shaderek.

Próbáld ki  egymás után a  huszáron ezeket  a  shadereket. 
Külön-külön  kösd  rá  a  famintázatot  meghatározó  Image 
Texture csomópont Color kimenetét a Difuse, Glossy,  majd 
az Emission csomópontok Color bemenetére. 

Mindig csak eggyel kísérletezz! Aztán húzd tovább a vá-
lasztot anyagtulajdonság kimenetéből a drótot a  Material  
Output csomópont Surface (felület) bemenetére. 

A Diffuse és Glossy shaderek (anyagok) Roughness értéke a felület érdességét 
szabályozza. A Glossy  Roughness = 0 például a tökéletesen tükröző felület.

Shader – magyarul árnyaló. Meghatározza az anyag fő 
optikai tulajdonságát. 

10. Sakk



164

Vannak esetek, amikor egyszerre több tulajdonsága lehet a 
tárgyaknak. Ilyen a korábban említet lakkozot fa, vagy az  
üvegpohár, mely átlátszó, ugyanakkor szabályosan vissza-
veri a környezetből jövő fénysugarak egy részét. 

Ilyen esetekre találtak ki a shaderek közöt található  Mix 
Shadert. It keresd: SHIFT+A > Add > Shader > Mix Shader. 

Ha  rávezeted  a  másik  két  shader kimenetét,  akkor  a 
Fac[tor] értékkel  keverheted  a  kétféle  optikai  viselkedés 
mértékét.

A tábla megfelelő méretezése után helyezd el  a bábukat, 
majd  Ketőzd (SHIFT+D) annyi példányban, ahogy egyéb-
ként a sakktáblán elhelyezkednek.

Ha már egy bábut sikerült beállítani, és nem szeretnéd a 
többinél  elölről  kezdeni,  akkor  húzd  rá  egyszerűen  az 
anyagtulajdonságát a többire.
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Egy tárgy anyagtulajdonsága 
átvihető más objektumokra is.
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Az ellenfél  ♦  Készítsd el az ellenfél bábuit. Dolgozhatsz 
úgy, hogy SHIFT-tel egyenként kijelölöd a világos játékos 
bábuit. Felülnézetbe váltasz (7), majd (SHIFT+D)-vel kető-
zöd az egész csapatot. Aztán (R)-rel 180°-kal elforgatod.

Klasszikus békeharcos felállás vagy polgárháború? Minden bábunak ugyanaz 
az anyagtulajdonsága…

Csináljunk egy kis rendet az anyagok közöt! A tervezés  
során nagyon sokféle anyaggal dolgozunk, ezeknek rendre 
Material ; Material.001; Material.002 neveket ad a program. 
Eligazodni nehéz rajtuk, ráadásul a korábbi kíváncsi pró-
bálkozások eredményei is ot maradnak a Blender anyagke-
zelőjében. Jelölj ki egy bábut, és nézd meg, hogy nevezte el 
a program a  Csomópontszerkesztő ablak alján levő menü-
sorban! 

Nevezd át ezt az anyagot „Fehér vitézek”-re. Ugyanígy mu-
tass rá a sakktáblára, és nevezd át az anyagát.
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Jelölj ki egy bábut a leendő sötét oldalról. Nagyon fontos, 
hogy most ne kezd el átalakítani a felete levő csomópont-
rendszert, mert a  „Fehér vitézek” anyagot alakítod át, ami 
minden bábunál identitászavart fog előidézni. 

Az anyagkezelő + gombjával építhetsz új anyagot.

Nevezd el gyorsan a fekete bábuk anyagtulajdonságát „Sö-
tét  lovagokra”,  majd  építs  fel  a  korábbi  anyag mintájára 
egy hasonló összeállítást. 

Gyakorlásnak  sem rossz,  de  arra  fgyelj,  hogy  az  Image 
Texture csomópontba most ne a világos, hanem a  012_so-
tet_fa.jpg állományt töltsd be.
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Természetesen  egy  bábu  átalakítása  után  egyszerűen  rá-
húztam az „Sötét lovagok” anyagot a többire.

A csatatér ♦ Alant a sakktábla átalakítására látsz egy cso-
mópontrendszert. Jobbról balra olvasva: 

A kimenetre egy difúz (1) anyag kerül, melynek sakktábla 
(2) mintája van. A tábla mintázatába a kétféle fatextúrát (3–
4) vezetük, melyek helyes generálását a Texture Coordinate 
(5) csomópont segíti.
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A tábla intarzia jellegét azzal  erősítetem, hogy az egyik 
textúra Flat, a másik Box típusú vetítést kapot, így egészen 
más irányúak letek a faerezetek.

A világítást kicsit fnomíthatod még, hogy ne legyen eny-
nyire komor a sötét oldal.

A bal alsó 3D ablakban töröld ki az eddigi fényforrást, és a 
(SHIFT+A) billentyűkkel keress egy  Area (derítőlámpa) tí-
pusút.  Ezeknek  nagy  felületen  sugározzák  a  fényt,  ami 
szép, puha árnyékokat eredményez.
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Egy fotóstúdió belülről. A képen két softbox típusú derítőlámpa is található. 
Forrás: Pixabay

Area típusú lámpákkal nagyon szépen bevilágítható a tér, 
de ehhez még kicsit babrálnod kell a beállításait. 

A lámpa alakját állítsd Square-re (négyzet), majd a méretét 
(Size)  10-re,  ami  egy  hatalmas,  szórt  fényű  lámpatestet 
eredményez. Majd kísérletezz a  Streght (erősség) értékkel, 
fgyelembe véve azt a tényt, hogy a távolság növekedtével 
négyzetes  arányban (azaz  kissé  drasztikusan)  csökken az 
egységnyi felületre eső fényerő.
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Én ezeket a „tárgyfotókat” 
készítettem a sakk-készletemről. 

Néhány leckével arrébb majd te is 
megismered azokat a trükköket, 

melyeket alkalmaztam a 
beállításoknál: mélységélesség, 

háttér, renderelési paraméterek.
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11.
A kedves olvasó elkészíti első
flmjét, ami eegy szokatlan nézőpontú,
Facebook-ready, macskás videó lesz.
Közben a modellezéstől a renderelésig mindent 
megtanul. A macskákróló
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Barkácsoljunk televíziót!

Feladatunkban  modellezünk  egy  síkképernyős  televíziót, 
készítünk hozzá egy szép stúdióháteret, bevilágítjuk a jele-
netet, majd leflmezzük azt. Közben megtanulunk néhány 
modellező  technikát,  megoldjuk  azt  a  dilemmát,  hogyan 
kerülhet  egy  testre  több  anyag,  vacakolunk  egy  kicsit  a 
mélységélességgel, és mellékesen megtanulunk flmet for-
gatni. Ha valaki még a macskákra is kíváncsi, irány a kert!

A síklap méretezése ♦ Indítsd el a Blendert, majd töröld 
ki a tér közepéről a kockát. (SHIFT+A) segítségével hívd elő 
az  Add menüt.  Add > Mesh > Plane paranccsal készíts egy 
síkot. Nyomd meg az (N) billentyűt, hogy a 3D ablak jobb 
oldalán láthatóvá váljon az ablakhoz tartozó  Tulajdonság- 
panel.  Ezt a síkot szeretnénk most egy 16 : 9 -es arányú 
monitorrá  formálni.  Állítsd  be  a  panelen  a  Dimensions
(Kiterjedések) mezőben a balra lent látható értékeket.

Most válts át  Edit Mode-ba (Szerkesztőmód) a TAB billen-
tyű vagy az alsó menüsor segítségével.

11. Cicavízió
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A képernyő formálása ♦  Szerkesztőmódban a menüsor-
ban tudsz váltani csúcs (Vertex), él (Edge) és lap (Face) kö-
zöt. Állítsd  be  a  lapok  kijelölését,  jobb  egérgombbal  
érintsd meg, azaz jelöld ki a sík tetejét. 

Emlékszel a bal oldali Eszköztár (Tool Shelf)  > Tools > Ext-
rude lehetőségére? Ezzel  húztunk ki  korábban lapokat,  s 
most arra használjuk, hogy térbeli vastagságot adjunk en-
nek a lapos kis síknak. Ha eltévednél, tudd, hogy honnan 
keresheted kis ezt az eljárást. De mivel olyan sokszor hasz-
náljuk modellezés közben, tanuld meg, hogy az (E) gomb-
bal lehet extrudálni, azaz kihúzni a térben lapokat. Próbáld 
ki: Lapot kijelöl, (E), aztán már mozgathatod is az egeret. 

Egy másik, gyakran használt eljárás az Inset Faces (Lap be-
rakása – intarzia), amivel egy sima lapra tudsz ajtót, abla-
kot elhelyezni. Én most egy kicsit eltúloztam a bal oldali 
ábrán, hogy lásd a működését. Ha a kijelölt lapon megnyo-
mod az (I) gyorsbillentyűt, nagyon kényelmesen formálha-
tod a káván belüli képernyőrészt.
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Ha most kíváncsiságból visszaváltanál TAB-bal Táregymódba 
(Object  Mode),  akkor  minden  erőfeszítésed  ellenére  egy 
sima fedlapot látsz.  A képernyőt kicsit beljebb kell  tolni. 
Úgyhogy TAB-bal gyorsan vissza Editkéhez.

Az Extrude (Kihúzás) művelet nem csak kifele működik. A 
kihúzás ellentéte behúzás lenne (kösz).  Ezt  ugyanúgy,  az 
(E) billentyű segítségével végezheted. Íme…

Most fordítsd át a készüléket a hátlapjára, és ot alakíts ki  
egy kis dobozkát az elektronikának, csatlakozóknak. 

(I) – amivel egy lapot raksz be, (E) – amivel kihúzod a tér-
be. (S) – amivel az utoljára kijelölt lapot átméretezed. Ilyen 
egyszerű…
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Közben bekapcsoltam a mi 
kedves Matcap árnyalónkat 

a 3D ablak Tulajdonság- 
panelén. Ott, ahol az előbb 
beállítottuk a sík méreteit. 

Nekem sokat segít, ha 
plasztikusabban látom az 

anyagot modellezés közben.
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Talp ♦  A forgolódástól megszédülve válts elölnézetre (1), 
jelöld ki a televízió feléd eső lapját, majd alkalmazd it is az  
(I) – Inset Faces – műveletet. (Sárgával szörnyítetem…)

Vigyázz, tartsd a fenti arányt a berakot lap méretezésénél!  
Most ugyanis ezt a lapot  vízszintesen kell átméreteznünk. 
Legszemléletesebben talán a manipulátorral lehet megolda-
ni: A 3D ablak alsó menüsorában SHIFT billentyűvel a je-
löld  hozzá  a  mozgató  manipulátorhoz  az  átméretezőt  is, 
majd húzd össze vízszintesen ezt a lapot.

(E)  billentyűvel  húzd ki:  ez lesz a kis állvány tartórúdja. 
Húzd ki még egyszer (E),  majd (S)-sel  kezd el nagyítani. 
Egy csonka gúla lesz a talp, amit a méretező manipuláto-
rokkal mindenképpen formálj olyan formájúra, hogy meg-
tartsa a készüléket. 

Kész a tévé, lehet hívni a szomszédot meccset nézni!

11. Cicavízió
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Felületkezelés

Egy nyers modellel nem sok mindent lehet kezdeni, legfő-
képpen nem valóságos televízióként eladni. A következő lé-
pésben beállíthatod a nyers modell anyagtulajdonságait. 

Válts vissza Táregymódba (Object Mode) a TAB billentyűvel, 
és forgasd meg egy kicsit az elkészült modellt. 

A 3D ablak jobb felső csücskében találsz egy fülecskét. Bal 
egérgombbal  határozott  mozdulattal mozgasd  lefele.  Jó 
esetben két, egymás felet elhelyezkedő  3D ablak keletke-
zet. Ha nem sikerült, s mégis balra mozdult, akkor a kis  
sarkot mozdítsd visszafele, amíg egy nagy nyilat nem látsz. 
Ekkor katints rá arra az ablakra,  amivel össze szeretnéd 
vonni. Bővebb magyarázat a Függelékben. 

A felső ablak bal alsó csücskében katints az ablakválasztó  
ikonra (, s a lenyíló menüből válaszd a Node Editor (Csomó-
pontszerkesztő) parancsot. A fenti elrendezést kaptad.

11. Cicavízió
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Hogy megjeleníthesd, ami készül, a Blender felső menüso-
rában renderelő motorként válaszd a Cycles Render opciót. 
A  munkaterület  alsó  ablakában  állítsd  be  a  valós  idejű 
renderelést (SHIFT+Z). Elég sápatag a televíziónk…

A Blender jobb oldali Tulajdonságok-ablakában válaszd ki a 
Material (anyag) ikont. It, helyben is beállíthatóak az opti-
kai tulajdonságok. A panelen kérj egy új anyagot, nevezd 
át  dupla katintással  „Feketé”-re,  majd a színét  állítsd be 
erre a színre. Vizsgáld meg a Csomópontszerkesztő ablakot! 
A beállításaiddal egy időben ugyanis a Blender létrehozta a  
megfelelő csomópontokat. 

Mivel műanyagról van szó, szeretnénk egy kis csillogást a 
difúz visszaverődés mellé.

A  Csomópontszerkesztő ablak  alján  levő  menüben  keresd 
meg az Add > Shader > Glossy BSDF csomópontot, majd az 
Add > Shader > Mix shader-t. Építsd fel a fenti rendszert, 
majd teszteld, milyen Fac[tor] beállításnál lesz megfelelő.
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Képernyő ♦  Told  most  az  egeredet  az  alsó  3D ablakra. 
Nyomd meg egymás után az (N), majd a (T) gombokat. Ez-
zel eltünteted a 3D ablak Tulajdonságok és Eszköztár panel-
jeit. A fel szabadult helyet keté fogjuk osztani.

A  3D ablak jobb felső sarkát határozot mozdulatal húzd  
balra.  Ezzel  újabb  3D  ablakocska  nyílik  a  jobb  oldalon, 
mely Tömör (Solid) nézetben van, míg a bal oldalon marad 
a valós idejű renderelésen. Helyezd az egeredet a jobb alsó 
ablakra,  majd TAB billentyűvel  menj  át  Szerkesztőmódba 
(Edit Mode).

A tárgyak többsége – ugyanúgy,  mint  a  valóságban – a 
Blenderben is többféle anyagból állhat. Most egy új optikai 
tulajdonságot rendelünk a képernyő lapjához. Jelöld ki jobb 
egérgombbal ezt a téglalapot. 
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Első lépésként nyomd meg a (+) gombot a televízióhoz tar-
tozó anyagtár jobb felső sarkában. A képen látható, hogy 
ide gyűjthetőek egy testhez rendelt anyagok.

Egy új, üres anyag keletkezet, de még nem sokat ér, amíg 
nem defniálod, mit is szeretnénk ot látni. Nyomd meg a  
New gombot, amivel egy új anyag jön létre. Rögtön nevezd 
is át a bal oldali képnek megfelelően. 

Tulajdonképpen  bármennyi  anyagot  létrehozhatnánk  it 
egymás alat, de  egyik sem látható addig,  amíg az  adot  
laphoz hozzá nem rendeled az Assign gombbal. Voilá!

Gondolom, nem villanyoz fel  a műsor.  Vegyük kezelésbe 
ezt difúz anyagot! 

Egy működő képernyő fényt bocsát ki. Anyagtulajdonságát 
állítsd  át  Difuse-ról  (Szórt)  Emission-re  (Fényforrás).  A 
képernyő rögtön felfénylik. Finomítsuk a beállításokat Cso-
mópontszerkesztőben!

Add > Texture > Image Texture csomópontot köss az Emissi-
on fényforrás-csomópont bemenetére. Nyisd meg ebben a 
014_tevemusor.mp4 állományt. Majd, hogy látsszon is vala-
mi, az Add > Input > Texture Coordinate csomópontal vezé-
reld a megjelenítését. És…

...It egy cica. Mivel ez egy videó fájl, nézzük meg, mit ke -
res ő a műsorban. Most ugyanis hiába tologatod az idővo-
nalon az időmutatót, a cica lefagyot. Amiat van, mert a  
csomópont nem olvassa be automatikusan a flm hosszát.
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Ezt állítsd 250-re a Frames értéknél. Pipáld be az Auto Ref-
resh jelölőnégyzetet, ha azt akarod, hogy a látvány változ-
zon az idő haladtával. 

Húzd ki a csomópont bemenetéből a vezetéket, hogy újra-
generálja  a  flmet  a  másik csomópont,  majd dugd vissza 
oda. 

Végül helyezz egy Add > Color > RGB Curves típusú csomó-
pontot a kép és az emisszió közé. A négy gombocska jelen-
tése:  C  –  Color (az  egész  kép  fényessége  változtatható).
R-G-B – a vörös, zöld és kék összetevőkkel színezheted át a 
flmet.

Állítsuk a talpára ♦ Mivel a tévét a Blender alapsíkjában 
terveztük, ideje talpra állítani. A jobb alsó 3D ablakban én 
közben Material-ra, azaz anyagmegjelenítésre állítotam az 
ablak árnyalását. 
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Válts  Object Mode-ra a TAB billentyűvel. Felülnézetből (7) 
kicsinyítsd a televíziót (S).  Szeretnénk 90°-kal elfordítani a 
piros, azaz X tengely mentén. 

Mit  szólnál  egy  Blenderre  jellemző  billentyűkombináció-
hoz? (R) > (X) > 90 > ENTER. Láss csodát, ezt a gépeléssort 
így értelmezte: Fordulj az X tengely szerint 90°-otó

Helyezd a  síkra a  televíziót.  Ebben segítségedre  lehet  az 
elölnézet (1) ortografkus módban (5). Én már csak az ered-
ményt mutatom perspektivikus megjelenítéssel.

Elkészültünk a berendezéssel.  De van még munka a kör-
nyezet kialakításával.

Környezetismeret

Végezünk egy kísérletet! Első leckénket úgy kezdtük, hogy 
minimál világunknak három kötelező eleme van: a tárgy, 
amit megjelenítünk a flmen, a kamera, ami fényképezi, és 
a lámpa, ami fényt ad, hogy lássunk. Most töröld ki a fény-
képezés legfontosabb elemét, a fényforrást. A lámpát kije-
lölve  (DEL)  vagy  (X)  gombot  nyomhatsz,  majd  erősítsd 
meg a szándékodat. Mi történt?! Pedig én kikapcsoltam…
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Meglepő a tapasztalat: Fény nélkül is látunk. Hol it a csa -
lás? A fényforrás eltüntetésével maradt még valami, amivel 
eddig nem számoltál, és ez a környezet, a jelenetet körülve-
vő világ.  Innen ugyanis  még érkeznek fénysugarak,  bár-
mennyire is borús az a szürke szín, mely a program alapbe-
állítása. 

A készülék hátlapja teljes környezeti fényerőn, majd nulla megvilágításnál.

A Blender jobb oldali Tulajdonságok (Properties) ablakában 
keresd meg a World (Világ) beállító ikont, melynek óvodai 
jele  egy  kis  földgömb.  It találsz  egy  Color színmintát, 
melyre kattintva próbáld ki a fenti két szélső értéket.

Az eddig szerényen megbújó környezetnek nagyon sok kö-
ze van a bevilágításhoz. Állítsd vissza megint középszürké-
re,  majd  nyomd  meg  felette  levő  a  Use  Nodes  gombot.
A Blenderben ugyanis nem csak az anyagokat és fényeket, 
de a világot csomópontokkal is tudjuk vezérelni.

Valószínűleg nem fogod rögtön látni a világ csomópontjait, 
hiszen eddig csak anyagokkal  dolgoztunk.  Keresd  meg a 
Csomópontszerkesztő alján a Világ-ikont. Így már jó lesz.
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A Csomópontszerkesztő és a jobb oldali Tulajdonságok ablak 
szépen együttműködik. Amit az egyikben elkészítünk, az a 
másikban is megváltozik. 

Próbáljuk csak ki: A  Tulajdonságok ablak  Surface (Felület) 
mezője megfelel a  Csomópontszerkesztő World Output cso-
mópontja Surface bemenetének.

Jelzi is, hogy ott már van egy bemeneti beállítás – hozzá-
kapcsoltuk a Background csomópontot. Ennek Color értéke 
ellenőrizhető  mindkét  helyen:  egy  középszürke  színfolt 
jobbra  a  Tulajdonság-ablakban  és  fenn  a  Csomópontszer-
kesztő Background csomóján. 

A  jobb  oldali  Tulajdonságok-ablak Color mezőjében  látsz 
egy pöttyel  jelölt  szabad gombot.  Ha ezt  megnyomod,  a 
menüből válaszd a Sky Texture (égbolt) opciót.

Mi történt? A jobb oldali  Tulajdonságok-ablakban megje-
lent a Color értéknél ez a beállítás. 

De a Csomópontszerkesztő is kiegészült egy új,  Sky Texture 
típusú csomóponttal. Nézd meg a következő oldalon.
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De a leglátványosabb különbség a macska körül látszik, va-
lós idejű renderelésnél. 

Az éggömböt jelképező kis labdacsot simogatva változnak 
a fényviszonyok, a Turbidity értékkel légköri szóródást (pá-
rát), a Ground Aldebo-val pedig a talaj fényvisszaverődését 
szabályozhatod. 

A labdacs feletti legördülőben pedig az ég létrehozásának 
matematikai algoritmusát. 

Persze ez most egy aranyos játéknak tűnik. Mellékesen vi-
szont valós környezetnek megfelelő bevilágítási modellt hoz-
tunk  létre.  S  habár  televíziót  nem  a  tundrán  bóklászva 
szoktunk nézni, mégis ez az égi modell szépen színezi majd 
a stúdióhátteret, amit nemsokára megalkotunk.

Én végül egy szép selymes környezeti fénynél állapodtam 
meg,  melynek beállításait  a  Csomópontszerkesztő dobozá-
ban itt balra mutatom. Nem elvárás, ajánlás.
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Háttéranyag ♦ Nemsokára jön az animáció, de ezt meg-
előzően oldjuk meg, hogy ne a légkörben lebegjen ez a jobb 
sorsra érdemes televízió.

Stúdióháttér elhelyezése. Fontos, hogy ne legyen törés, hajtás az anyagon, így 
szép színátmenetek jönnek majd létre. (Forrás: photo-studio-for-rent.com)

3D programokban nem kell  vagyonokat kiadni egy ilyen 
tartós hátérre. Hozz létre egy síkot a televízió tappancsa 
alat, majd TAB-bal menj át Szerkesztőmódba (Edit Mode).

Közben azért egy pillantást vessünk a valós idejű rendere-
léssel árnyalt ablakra: Az ég nagyon szépen színezi a síkot. 
A képernyőről pedig sárgás fény vetül rá. 
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Edit Mode-ban az ablak alsó menüjében keresd meg az Élek 
kijelölését (Edge Select), majd jobb egérgombbal jelöld ki a 
sík tévé mögöti hátsó élét. Válts most oldalnézetbe (3) és  
ortografkus módba (5). Nyomd meg az (E) gombot, és húzd 
ki nagyjából  45°-ban a síkot az ábrának megfelelően,  kat-
tints bal egérgombbal a művelet végén, majd ismételd né-
hányszor, hogy oldalnézetben az alábbi alakzatot kapd.

A művelet végén válts vissza Object Mode-ba (Tárgymód) a 
TAB  billentyűvel,  majd  a  piros  méretező  manipulátorral 
változtasd meg a hátérernyő szélességét.

Közben nyomd meg a (T) gombot, mellyel a 3D ablak Esz-
köztárát (Tool Shelf) újra bekapcsolod. It keresd meg az el-
ső fülön a Shading > Smooth gombot, és ezzel simítsd le a 
vásznat,  hogy  ne  legyenek  rajta  törések.  Vizsgáld  meg 
munkád eredményét a másik ablak valós idejű renderelése 
segítségével.
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Én még igazgatam egy kicsit a  Csomópontszerkesztőben a 
labdacsot, ennek megfelelően a hátér besötétedet, s job-
ban érvényesül a képernyő. Csak próbaképpen nézd meg, 
mi történik, ha kihúzod a felső ábrán a World Output beme-
neti csatlakozóját a felső képen megjelölt helyen?

Kísérteties…  Toljuk  vissza  a  csatlakozót  a  konnektorba, 
nem horrort forgatunk.
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Fények, kamera! Tessék!

Most, hogy újra „felkapcsoltad az eget”, az előbbi drámai 
hatású képernyő-világítás hirtelen olyan szegényessé vált. 
Kicsit  növelnünk kell  a  fényerőn.  Keressük meg ehhez a 
„távkapcsolót”! 

Jelöld ki a jobb alsó 3D ablakban a képernyőt, a Tulajdonsá-
gok-ablakban,  a  jobb  oldalon  válts  a  Világbeállításokról 
Anyagbeállításokra. Jelöld ki a készülék kétféle anyaga kö-
zül a „Képernyő”-t, majd kezdd el növelni a Strenght (Erős-
ség) értéket, ellenőrizve hatását a másik ablakban.

Én 2-ig mertem, utána megint jöt a horror, a macska sze -
mei is beégtek, a vászon meg majdnem meggyulladt a kép-
ernyőből áradó fénytől.

Hogy egy kicsit színezzem a vásznat, elhelyeztem még két 
lámpát (SHIFT+A) > Lamp > Point, melyek közül az egyiket 
diszkréten kékre, a másikat enyhén lilára színeztem. A fé-
nyek beállításánál próbáltam elkerülni a túlzásokat, a gics-
csességet. A jelenet ne úgy nézzen ki, mintha egy sztriptíz-
bárban veték volna fel. Van még egy  Area  (Derítőlámpa) 
típusú világítótest a tévé mögöt, amit a vászonra irányí -
totam, szintén enyhe kék világítással. 
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A fényvetőernyő nagyságát a Size értékkel szabályozhatod. 
Alakja célszerűen Square (Négyzet).

Mivel a lámpák árnyékai zavaróak voltak a képernyő mö-
göti térben,  mindhárom  lámpának  kikapcsoltam  az  ár -
nyékvetését (Cast Shadow). 

De mit csinál a kameraman? ♦ 

„Hé, János, a srácok már rég bevilágítoták a jelenetet ! Vége  
a kávézásnak! Gyere!”

„Oké, Főnök, hoegy csináljuk?”

„Úegy képzeltem, hoegy a kamerát a tévé fölé tennénk, onnan  
kezded a felvételt. Majd óvatosan a tévé elé kerülsz, üegyelve  
arra,  hoegy eegy pillanatra se  tűnjön el  a  képről  a  televízió.  
Menni fog?”

„3D-ben? Viccelsz? Simán!”

Igen,  ami  a  valóságban  elég  nehéz  mutatvány,  abban 
megint segítségünkre siet a technika. Van ugyanis egy le-
hetőség,  amivel  a  kamerának  megparancsolhatjuk,  hogy 
mindig a televízióra nézzen.

Először jelöld ki a kamerát jobb egérgombbal, majd a tele-
víziót a SHIFT segítségével. Most nagyon fontos a sorrend. 
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Nem mindegy, hogy a kamera fordul a képernyő fele, vagy 
fordítva. 

Az  ablak  alsó  menüjéből  az  Object  >  Track  >  Track  To  
Constraint (vagy  gyorsbillentyűvel  CTRL+T)  paranccsal 
kötheted össze ezt a két tárgyat, innentől a kamera – töké-
letes biztonsági eszközként – a képernyőt követi. 

Akkor is, ha a képernyőt közben máshova teszik, vagy a 
kamerát mozgatod. 

A bal alsó ablakban válts kamera nézetre (0), a jobb alsó ab-
lakban pedig (G) billentyűvel vagy manipulátorokkal moz-
gasd  meg a  kamerát.  Jöhet  az  animáció?  Oké,  de  előte 
piszkáljuk még kicsit a kamerát.

Mélységélesség ♦ Amikor a szemeddel ráfókuszálsz vala-
mire, az előte és mögöte levő tárgyak kissé homályosab -
ban jelennek meg. Ez a hatás teszi nagyon széppé a makro-
objektívvel készült képeket. 

Matteo Paciotti fotója. Balra: Jayhan Sim makrofelvétele. 

A Blender kamerája viszonylag könnyen beállítható, hogy 
ezzel a mélységérzetet segítő efektussal még valósághűbb 
felvételeket készíthessünk.
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A kamerák objektívjén a fényrekesz, a blende kitágításával 
nem csak a fényerőt, hanem ezt a hatást is növelhetjük, így 
nagyobb lesz a mélységi elmosódás. 

A szemünk is ezen az elven működik – hiszen az írisz, a 
szivárványhártya a blende biológiai megfelelője –, a szem-
vizsgálatok előti csepegtetéssel kitágult pupillánkkal már  
nem látjuk élesen a tárgyakat, minden elhomályosodik. A 
blende (angolul  aperture) tágításával növelhető a mélységi 
elmosódás.

Jelöld ki a kamerát, majd a Tulajdonságok-ablakban válts át 
a  kis  kamera-ikonra.  A  legalsó  mező  a  mélységélesség 
(Depth of Field), ahol az Aperture mezőben befolyásolhatod 
a fényrekesz nagyságát. Ha kicsit is elállítod ezt a Size érté-
ket, úgy fogod magad érezni, mintha a szemedbe csepegtet-
nének. A kamera elveszti a fókuszát.

Hogy megtalálja, mire is kell fókuszálnia, a  Focus beviteli 
mezőjében elhelyezet kis pipetával érintsd meg a képer -
nyőt. Kissé eltúlozva, az elmosást nagy értékre állítva kicsit 
furcsa lesz az eredmény.

Ilyenkor ugyanis a tárgy – jelen esetben a televízió – kö-
zéppontja adja a fókuszpontot, ami elég elnagyoltá teszi a 
beállításunkat.
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Finomabb, interaktívabb beállításhoz a következő gyakorla-
tot sajátítsd el : A jobb oldali 3D-ablakban helyezz el egy 
úgynevezet üres objektumot,  ami a leképezés során nem, 
csak a szerkesztő ablakban látszik. Ennek neve  Empty. Az 
Add menüből: (SHIFT+A) > Empty > Plane Axes (Tengelyek). 

(S)-sel nagyíthatod ezt a láthatatlan tárgyat. Most már az 
Empty közepe lesz a fókuszpont. Jelöld ki a kamerát, majd 
annak alsó, Depth of Field  paneljén az előzőhöz hasonlóan 
érintsd meg a Focus mező pipetájával az üres objektumot. 

Felkészülés a felvételre ♦ A fókuszpontot biztosító üres 
objektum közepét (Empty) helyezd el a televízió tetején. Se-
gít ebben az oldalnézet (3), ortografkus módban (5). Fogd 
meg a kamerát, és menj a készülék fölé úgy, hogy bal oldali 
nézetből láss arra rá. Nem könnyű, de a következő oldalon 
segítek…
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Ha csak a manipulátorokkal irányítod a kamerát, nagyon 
szép lekövető mozgást kapsz.  Persze fgyelj arra is,  hogy 
valóban jó-e a mélységélesség beállítása, inkább most állít-
suk be, mint egy órás flmrenderelés után derüljön ki. Ná-
lam ezek  letek a  nyerő  értékek,  de  ízlések,  pofonok (és 
mélységélességek is különbözőek). Gyakorolj, próbálkozz!

Végre, animáció ♦ Most mutatnék valami olyat, amivel a 
következő Oscaron simán leradírozod a PIXAR-t  animáci-
ós kisflm kategóriában. Jó, legyünk realisták: Életünk első 
kisflmjei  tele  lesznek  még  esetlenségekkel,  amit  mások 
évekig gyakoroltak, ebből a szakácskönyvből sem tudod le-
főzni öt perc alat. De alkotni jó, úgyhogy kezdjük el!
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Az első kockán (ellenőrizd az Idővonalon, hogy ot vagy-
e!) a készülék fölöt vagyunk. Menj a bal oldali 3D ablakra, 
s válts oldalnézetbe (3). 

Nyomd meg az (I) billentyűt és a felbukkanó menüből vá-
laszd  a  Location (Hely)  típusú  kulcsot.  Emlékszel,  ugye, 
hogy ezzel  egy kulcskockát  jelöltünk meg a szofverben, 
amellyel tudatuk a géppel, hogy ezzel a beállítással kezd-
jük az animációt.

Most az idővonalon told át az időmutatót az 50. képkockára 
(ez nagyjából 2 másodperc). A kamerát vízszintesen balra 
mozgasd úgy, hogy olyan messze kerüljön a kezdőpontól, 
mint amilyen magasan áll a kamera.
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Helyezz el egy Location típusú kulcskockát  (I). Most menj 
át az idővonalon a 100. képkockára.

A  kék,  függőleges  manipulátorral  mozgasd  függőlegesen 
lefele a kamerát úgy, hogy éppen szemben álljon a televízi-
óval.  (I) > Location. Kész is. Most már a flm végéig  (250. 
képkocka) hagyjuk a nézőt, hogy a cica mozgását fgyelje.
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Renderelés

A nehezén túl vagy. Most jön még egy kis macera. Olyan, 
mint amikor a régi időkben átküldték a laborba a flmet, s 
egy nap múlva láthaták csak a vetítőszobában. 

Rövidítsük  ezt  az  időt?  Oké,  megbeszéltük.  A  biztonság 
kedvéért  mentsd  (CTRL+S)  az  eddigi  munkádat.  Nézzük 
meg, van-e a gépedben egy erős videokártya!

Nyisd meg a Blender tetején levő főmenüből a  File > User  
Preferences (Felhasználói beállítások) párbeszédpanelt.  En-
nek az utolsó,  System (Rendszer) menüjében keresd meg a 
Compute Device (Számoló eszköz) mezőt. Ha találsz it egy 
CUDA vagy Open CL feliratot, ezt állítsd be. Alata kivá -
lasztható a grafkus kártyád neve.

Ha it csak a CPU-t (központi processzor) tudod beállítani,  
akkor a Blender valamilyen oknál fogva nem képes kikül-
deni a számításokat a grafkus kártyádra. Ennek több oka 
lehet, a megoldást keresd e könyv Függelékében. 

Aki nem talál grafkus gyorsítást, az se szomorkodjon. Re-
ménykedj, hogy a processzorod szépen, gyorsan és hűvö-
sen számol majd.
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Zárd  be  a  panelt  és  nézzük  meg  a  Blender  legtöbbször 
használt renderelő beállításait.

A Blender jobb oldali Tulajdonságok-ablakát ma már sokat 
használtuk. Ennek első ikonja a renderelés.  Nézzünk egy 
alapbeállítást,  amivel  viszonylag  gyorsan  elkészül  a  fl-
münk – bocsánat, a te flmed.

Render > Device: Ha beállítotad korábban, és a Blender-
rel együttműködik a grafkus kártyád, állítsd it GPU Com-
pute-ra (a grafkus kártya számol).

Dimensions > Resolution:::: 25%-ot írj be, ez a Full HD ne-
gyed része, 480 × 270 pixel. Első flmnek most elég.

Output: It állítsd be, hova mentse az elkészült állományt.  
A kis mappa ikonnal elnavigálhatsz oda. 

Alata találsz egy legördülőt, melynek alapbeállítása: PNG. 
Ha így hagyod, nem flmet, hanem képregényt fogsz készí-
teni, azaz állóképek sorozatát. Állítsd H.264-re, ez egy na-
gyon szépen tömörítő videóformátum.

Sampling:  It kapcsold  be  a  Setings  >  Seed mögöti kis  
órát és a Samples > Render értéket állítsd 50 – 200 közöttire. 

Az órácska minden képre más képzajt generál, hogy ne le-
gyen olyan a flmed, mintha egy karcos üvegen keresztül 
néznéd. 

Az utóbbi a mintavételezés számát adja meg a renderelés 
során, azazhogy meddig fnomítsa a szofver a képet.
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A Render gombbal egy képkockán ellenőrizheted a gyorsa-
ságot és minőséget. 

Végezzünk egy gyors számítást: 

25%-os  képméretnél,  50-es  mintavétellel  nagyjából  2  má-
sodperc alat elkészül egy képkocka. Akkor a flm:

2 × 250 = 500 másodperc, azaz kicsit több, mint 8 perc lesz 
a renderidő. Egy teafőzés.

100-as mintavétellel 3 másodpercet dolgozik.

3 × 250 = 750 másodpec, azaz 12,5 perc. Egy fél keresztrejt-
vény.

200-as mintavételnél már 21 perc. Ugyanezen beállítással, 
de FULL HD-ben (1920 × 1080 px) 3 óra 45 perc. 

Végezd el te is a saját processzorodnak vagy grafkus kár-
tyának megfelelő számításokat, majd ezek után az Anima-
tion gombbal indítsd el a renderelést. 

Közben menj el teázni, sportolni, vagy nézd meg szeretei-
det…
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Az animáció ára

Gondolkodtál-e már azon, miért olyan sikeres létrejöte óta 
az animáció műfaja? Valami olyasmit lehet vele kifejezni, 
amit a valóságban nehéz, vagy egyenesen lehetetlen. Bár 
vannak  kameráink,  amelyek  másodpercenként  ezer  kép-
kockánál nagyobb sebességre képesek, a legszebb lassítot 
felvételek animációval készülnek, ahol minden kis részecs-
két, cseppet, szilánkot képesek vagyunk kontrollálni, a jele-
netet szépen bevilágítani, és bármely nézőpontból felvenni. 

Pisztolygolyó áttöri az üveget. Animációs oktatóanyag: blenderguru.com

A tökéletesség ára az idő.  Az animációk rengeteg előkészí-
téssel, fnomítással készülnek. Az animátor nagy tapaszta-
latú, nagy tudású szakember. Olykor fzikusnak, olykor szí-
nésznek, olykor baletművésznek érzi magát. 

A  következő  jelentben  leflmezünk  egy  egyszerű  golyót, 
amint balról belép a látóterünkbe, majd a képsík másik fe-
lén lassuló mozgással megáll. Egyszerű, mindennapi moz-
gás: a szatyorból kigördülő narancs, a reggeli után elguruló 
gyógyszer, a McDrive előt megálló úthenger.
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A jelenet előkészítése

Indítsd  el  a  Blendert.  Mielőt bármibe  is  belekezdenél,  a  
program felső  menüsorának közepén válaszd ki  a  Cycles  
Render-t, hogy a lehető legvalóságosabb képalkotással dol-
gozzunk.

Tüntesd el a kockát (DEL vagy X), majd ugyanezen a he-
lyen hozz létre az Add menü segítségével (SHIFT+A) egy sí-
kot (Plane) és egy gömböt (UV Sphere). 

A program persze nem találhatja ki a gondolatainkat. Síkon 
guruló golyó helyet egy pengét nyelt diszkógömböt kap -
tunk. A golyót először is simítsd a bal oldali  Eszköztár >
Tools paneljén a Smooth gombbal. Most nyomd meg az (N) 
gombot,  ami  a  3D ablak  helyi  Tulajdonság-paneljét  hívja 
elő. 
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Nem összetévesztendő a Blender jobb oldali Tulajdonságok-
ablakával, ahol pl. a renderelést, anyagtulajdonságokat ál-
líthatjuk be.

Jelöld ki a labdacsot, majd a 3D ablakhoz tartozó, jobb olda-
li panelen a Transform > Location (Elhelyezkedés) mezőben 
a függőleges, azaz Z értéket állítsd 1-re. A labda most már a 
sík tetején áll. Jelöld ki az alata levő síkot és nagyítsd (S)  
az ábrának megfelelően.

A kamera elhelyezése ♦ Jelöld ki a kamerát, majd ugyan-
ezen  a  Tulajdonság-panelen  nulláz  le  minden  Location 
(Hely) értéket. Szépen, egymás után… Néha fárasztó műve-
let  egyenként  ugyanarra  beállítani  több mező értékét.  A 
Rotation (Forgás) értéket emiatt úgy állítsd be, hogy az ege-
ret lenyomott bal egérgombbal húzd végig, lefele a három 
számbeviteli mezőn. Így egy beírással megúszod az egész 
műveletet.  Ezzel a kamerát visszaküldted az origóba. Egy 
kicsit szomorúan néz lefele…
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Most állítsd be ugyanit az X tengely menti elfordulást 90°-
ra,  majd a  zöld és  a kék mozgató manipulátorokkal  told 
abba a helyzetbe, amit it a képen látsz.

Körülbelül  ide,  a sík szélére kell  helyezni a kamerát.  Vá-
laszd ki most a  Screen Layout (Képernyő-elrendezések) le-
gördülő menüben Animation parancsot. 

Hasonló elrendezést kapsz, mint a fenti képen. A zölddel 
jelölt ablakrészen látod majd a kulcskockákat (Dope Sheet), 
a lila ablakon a mozgásgörbéket. Vidd az egeret a pirossal 
színezet jobb  felső  kis  3D  ablakra,  majd  állítsd  be 
(SHIFT+Z)-vel, hogy valós időben, a legjobb renderelt ké-
pet lássuk a jelenetünkről.
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A középen levő 3D ablakot is állítsd be kamera-nézetre (0).

Ellenőrizd, hogy az első képkockán vagy-e, majd ebben a 
nézetben a piros mozgató manipulátorral  vidd ki balra a 
kamera látóteréből a labdát. Nyomd meg az (I) gombot, és 
állíts be egy Location (Hely) típusú kulcskockát a gömbhöz, 
erre az időpillanatra.

Most az  Idősávon időutazzunk át a  75. képkockára.  Moz-
dítsd el a labdát, és állíts be egy hasonló kulcsképkockát.

Az Idősáv időmutatóját tologatva jól látható, hogy a szoft-
ver a két kulcs közöt kiszámítota a fázisokat, s létrejöt az  
animáció. 

Vessünk egy pillantást a program két új ablakára! A bal 
felső Kulcstábla (Dope Sheet)  ablakban láthatod az animá-
ció kulcsait. It ugyanúgy megjelenik az Időmutató, aminek 
elmozdításával it is mozoghatsz az időben. 

Az alata levő  Animációs görbék (Graph Editor)  ablakban 
látható,  hogy  milyen  interpolációt,  köztes  számításokat 
végzet a program. Most ez egy elnyújtot S alakú piros vo-
nal. Mivel piros, könnyen következtethetsz, hogy az X ten-
gely menti mozgást jelenti.
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Futasd le többször is az animációt.  Talán téged is zavar, 
hogy a mozgás  befejezése  után (75.  kocka)  nem történik 
gyakorlatilag semmi (250. kocka). Szűkítsd a flm hosszát 
száz képkockára! Négy másodperc körüli animáció – kibír-
ható. Kezdjük el tesztelni a flmecskét! 

Állítsd be a renderelést úgy, hogy ne őszül bele, míg ezt a 
száz képkockát leszámolja a program.

A renderelés beállításai ♦ Első nekifutásra biztosan nem 
kell nekünk Full HD felbontásban  (1920 ×1080) flmet ké-
szíteni. A teszt idejére állítsd be ennek negyed részét.

A flm kimeneti formátuma (Output) legyen a  H.264 AVI, 
mely  helytakarékosan  fogja  tömöríteni  az  anyagot.
A Sampling (mintavételezés) mezőben a  Render értéket ál-
lítsd 30-ra.  A Seed melleti kis órácskát megnyomva pedig 
elérheted, hogy a képzaj folyamatosan változzon.

Az  Animation (vagy  CTRL+F12) gomb  megnyomásával 
képkockánként kiszámítja a gép a flmet. Ez nálam egy erős 
videokártyával majdnem másfél perc volt. 

Az  elkészült  videót  vissazjátszhatod  a  Blender  legfelső 
Render  menüjének  segítségével:  Render  >  Play  Rendered 
Animation.  Első  flmnek  elmegy.  De  animációs  fesztivált 
nem nyerünk vele.
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De még mielőt azt gondolnánk, hogy a program gombnyo-
másra mindent megold helyetünk, tárjuk fel az animáci-
ónk hibáit. Néha akkor derülnek ki ezek, ha időben elnyújt-
va a mozgást, lelassítjuk azt. 

A flm hosszát állítsd át 200 képkockára, majd menj ennek 
végére az idősávon.

A bal  felső  Kulcstábla (Dope  Sheet)  ablakban jobb egér-
gombbal jelöld ki a  Location sávban azt a kulcskockát (kis 
sárga rombusz), mely eddig a 75. képkockához volt rendel-
ve.  Nyomd meg a (G) gombot,  majd az egér segítségével 
mozgasd ezt a kulcsot a 200. képkockára.

Elárulom:  ezért  sulykoltam eddig  a  gyorsbillentyű-
ket. Ezt a mozgatást a  Kulcstáblában csak így lehet 
megoldani.  A Blender  egységesen,  mindenhol  a  (G) 
gyorsbillentyűvel mozgat!

A középső ablakban még benn ragadt egy renderelés. Vidd 
az  egeredet  az  ablakra,  majd  az  ESC  billentyűvel  állítsd 
vissza a 3D ablak korábbi, előnézeti állapotát.
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Végig  renderelhetnénk  megint  a  flmet,  de  a  képkockák 
számának duplázásával elért közel kétszer akkora render-
idő már nem játék. Vannak ilyen esetre kiskapuk a Blen-
derben. Lehet másféle árnyalással –  drótváz, tömör, stb. –, 
csak az animáció tesztelésére futatni próbarendert. A mi-
nőség romlása mellet még jól tanulmányozható az animá-
ció – a számolási idő jelentős csökkentésével.  Különösen 
komplex  felvételeknél  nem  mindegy,  hogy  nyerünk-e  a 
próbálgatási, ellenőrzési szakaszban időt. 

OpenGL render ♦ A Blender 3D ablakában szinte minden 
esetben a videokártya OpenGL megjelenítését használjuk, 
amely egy univerzális eszközkészlete az alacsony szintű 3D 
ábrázolásnak.  A  Blender  felső  menüjében  keresd  meg  a 
Render > OpenGL Render Animation parancsot. Tapasztalod 
majd, hogy töredékidő alat elkészül az animáció.

Futasd megint a renderelt videót a  Play Rendered Anima-
tion menüparanccsal.

Mit látsz a mozgáson? A végével talán ki lennénk békülve, 
de az eleje? Olyan, mintha beóvatoskodna a labda a jelent-
be, majd amikor végre felgyorsul, csökken a sebessége és 
megáll. Miért? Nézz rá bal alsó Mozgásgörbe-ablakra.

Hogyan értelmezzük ezt a grafkont?
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Mozgásgörbék  ♦  A  piros  grafkon  az  X  tengely  menti 
mozgást mutatja az idő függvényében. Ezen a számegyene-
sen valahol a –10 érték felől érkezik a labda. Az elején ki-
csi, de egyre nagyobb távolságokat tesz meg – tehát gyor-
sul –, aztán egyenletesen halad, majd a végén lelassul. 

Nos,  ez a mozgás a legtermészetesebb,  hiszen így műkö-
dünk:  elindulunk,  felgyorsulunk utazósebességre,  majd  a 
cél előt lassítunk, s megállunk. De it némi zavart okoz ez  
az egyszerű mozgás. Miért? 

Pontosan a mozgás jellege miat. Nem látjuk az okát a go-
lyónál, miért óvatoskodik be a látóterünkbe. A labdák, kö-
vek, golyók ugyanis nem rendelkeznek belső meghajtással, 
tehát valamilyen külső erőnek kell gyorsítania, hogy ezt a 
mozgást produkálja. 

A  hölgy  karlendítés  közben  felgyorsította  a  bowling-golyót,  ami  a  pályán 
egyenletes sebességgel halad tovább az ütközésig. (Forrás: Pixabay)

Ez a külső erő lehetne egy ütközés másik testel, vagy a do-
bó, gurító karja. De most zavaró, hogy nem látjuk azt a tes-
tet, ami gyorsítja. 
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Mivel a Blender többféle interpolációs19 módszert ismer, kí-
sérletezzünk ezekkel, talán fnomítható a mozgáskép.

A  Mozgásgörbe-szerkesztő (Graph  Editor)  ablakban  jobb 
egérgombbal jelöld ki a piros színű függvény első csomó-
pontját.  Az interpolációt  uegyanis  mindig  az  adot szakasz  
kezdőpontjában tudjuk beállítani. Ekkor elmondjuk a prog-
ramnak, hogy etől a pontól kezdve a következő csomó-
pontig milyen mozgást várnánk tőle.  Ezek a csomópontok  
eegyébként megeegyeznek a kulcskockákkal. Ezen a pillanatok-
ban és helyeken változik lényegesen az animáció.

A  Mozgásgörbe-szerkesztő  alsó menüjéből a  Key > Interpo-
lation  Mode  (kulcs  >  a  közelítés  módja)  parancs  mögöt 
megnyíló táblázatból választhatsz mozgásformát. 

19 Az interpoláció matematikai közelítő módszer,  amely egy függvény nem is-
mert értékeire az ismert értékek alapján ad közelítést. (Wikipédia)
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Leggyorsabban egyébként a (T) gyorsbillentyűvel lehet az interpolációs táblá-
zatot a Mozgásgörbe-szerkesztőben előcsalogatni.

Biztosan felismered, hogy a táblázatban felajánlot mozgás-
grafkonok közül a  Bézier az eddig alapbeállításként hasz-
nált  „S” alakú (gyorsul-egyenletes-lassul)  függvény.  Vizs-
gáljuk meg a többit is!

Egyenes  vonalú  egyenletes  mozgás,  és  a  többiek  ♦
Válaszd a Linear parancsot az interpolációs lehetőségek kö-
zül (fenti képen). Ekkor a tárgy egyenlő idők alat egyenlő  
utakat tesz meg, azaz sebessége állandó. Ilyen az az autó, 
mely  felgyorsult  már  az  utazósebességére.  Ha  egyedül 
hagynánk,  a  súrlódás,  a  légellenállás  vagy  egy fa  előbb-
utóbb lefékezné. Az autópályán viszont, egyenes szakaszon 
elég csak ugyanúgy nyomni a gázt.

Ha a motor akkora erőt fejt ki, mint ahogy a súrlódás és a közegellenállás 
együttesen fékezi a gépkocsit, akkor az egyenletesen halad tovább. 
(Fotó: Pixabay)
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Végezz egy gyors próbarenderelést! Az eddig ismert mó-
don választhatod a Blender főmenüjét:  Render > OpenGL 
Render Animation, vagy a  3D ablak alsó menüjének végén 
levő  két  kis  ikont.  Közülük  a  fényképezőgép állóképet,  a 
csapó mozgóképet renderel – OpenGL árnyalással.

A két ikon menübeli megfelelői: OpenGL Render Image (kép), OpenGL Render 
Animation (film).

Futasd a renderelés eredményét a főmenü  Render > Play 
Rendered Animation parancsával. Milyen let? 

Nekem  eltűnt  az  araszoló  mozgás  az  elejéről,  szépen, 
egyenletesen halad a golyó, aztán a végén kezdi elölről. 

Igazából nem tudjuk meg, mi történt vele a végén, mert a 
lejátszó  végtelenített  flmet vetít.  Jó  lenne  látni  még né-
hány másodpercet, miután megáll. Rossz tehát az időzítés: 
nincs a végén megnyugvás, várakozás.

Menj  az  Idősávon a  150.  képkockára,  majd a  Kulcstáblán 
(Dope Sheet),  a  bal  felső ablakban már korábban kijelölt 
utolsó kulcsképkockát a (G) gyorsbillentyűvel húzd vissza 
ugyanide, a 150. kockára – most éppen ot áll ennek az ab-
laknak az időmutatója is.

Rendereld újra a jelenetet: kis csapó ikon a 3D ablak alján. 
Nos, mit látsz?

Kimarad a lassulás a jelenetből… Olyan,  mintha a végén 
megzökkenne. 
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Mi az, ami egyik pillanatról a másikra le tud állítani egy 
golyót? Egy hatalmas ellenállás – fal, vagy valami hasonló. 
Hogy értelmezi a néző most az animációdat? A labda egy 
hatalmas láthatatlan falnak ütközöt, és tragikus hirtelen -
séggel megállt. S it veszti el megint a hitelességét. Magya-
rázhatod, hogy a rendezői szándék szerint egy erőtér vagy 
szépen tisztítot kirakatüveg fékezte le a tárgyat – csak mi,  
nézők vagyunk műveletlenek, hogy ezt felismerjük…

Rendezői kommentár helyet próbáljunk ki még néhány in-
terpolációt! 

Előre mondom, ezek többségére nem most, inkább a jövő-
ben lesz szükséged, de nagyon tanulságos tapasztalatokat 
gyűjthetsz róluk. Csak néhány példa:

• Constant: Minden átmenet nélkül teleportál.
• Bounce: Patogó labda.
• Elastic : Becsapódó nyíl.

Ezt a táblázatot a (T) gyorsbillentyűvel hívhatod elő. Pró-
bálkozhatsz még más függvényekkel is.  De a végén talán 
egyetértesz velem, hogy egyik beépítet interpoláció sem  
igazán illik a mi kis egyszerű jelenetünkhöz. Sőt, a középső 
oszlop  mintha  egyenesen  a  paródiája  lenne  annak,  amit 
szeretnénk! Az Easing egyébként csillapítást jelent. 

Alapbeállításban szinte mindegyik görbe az első szakasz-
ban visszafogja,  a végére begyorsítja a golyócskát.  De jó 
lenne, ha éppen ennek a fordítotját látnánk. Megoldjuk.
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Ezek közül a beépítet mozgásgörbék közül sajnos  csak a 
Bézier változtatható,  a  többi  előre  csomagolt  „szériaárú”. 
Megoldhatnánk ezzel is a problémát, de több vesződséggel 
járna.  Válaszd  inkább  a  középső  oszlop  legelső  mozgás-
függványát (Sinusoidal). Mutatok egy módszert, hogyan le-
het ezt a mozgásformát megfordítani: Ha egy kicsit keres-
gélsz  a  Mozgásgörbe-ablak az  alsó  menüjében,  a  Key  > 
Easing  Type (a  csillapítás  típusa)  parancsnál  beállítható, 
hogy ne a mozgás elején  (Ease In),  hanem a végén csilla-
podjon (Ease Out). 

Nagyon szép szabályos megállás jön létre. Joggal kérdezed: 
Ilyen nehéz fnomítani egy mozgást? Ahhoz képest, hogy 
egy éven keresztül tanulunk menni, fél évig táncolni, éve-
ket  baletozni,  nos,  ez  a  kis  animációs  próbálkozás  talán 
nem is olyan fájdalmas (10 perc).

Végső simítások ♦ A kísérletezés során 200-ra növeltük a 
képkockák számát (ami nagyjából 8 másodperc), hogy las-
sítot felvételen tanulmányozzuk a mozgást. Mivel nem űr-
felvételekről van szó, most állítsd vissza az Idősávon 100-ra 
a képsor záró értékét.

Igazítsd vissza a Kulcstáblán (Dope Sheet) a 75.  képkocká-
hoz azt a kulcsot, ami felelős a golyó megállásáért.
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Érdemes a most a próbarendert OpenGL helyet végső for-
májában létrehozni. Inkább szánjuk rá azt a néhány percet, 
de szép legyen az eredmény… Használd a Blender főmenü-
jét renderelésre!

Figyelmesen  megvizsgálva  az  elkészült  flmet,  azt  látjuk, 
hogy az a pontszerű fényforrás, amivel eddig dolgoztunk, a 
távolabb levő golyó alat nagyobb, a közelebbivel kisebb ár-
nyékot vet. 

Miért zavaró ez? Mert a tudatunk rögtön keresne ot egy  
világító  testet,  és  nem  talál.  Egyenletes  árnyékot  a  Sun 
(Nap) típusú lámpák vetnek.

Jelöld ki a lámpát a  3D ablakban, majd a  Tulajdonságok-
ablak lámpabeállításainál változtasd Sun típusúra. 

Az ilyesféle lámpák jellegzetessége, hogy bárhova helyezve 
azokat, ugyanúgy világítanak meg mindent, a beesési szö-
güknek megfelelő szép hosszú árnyékot adva. 
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Már csak két apró beállítás a végső renderelésig: 
• Jó lenne valami szebb környezeti bevilágítás a szürke 

égbolt helyet.
• Adjunk egy kis mélységélességet a flmhez.

Mindkető ismétlés, de a Blender bonyolultságához mérten 
nem árt többször is ismételve elsajátítanunk a használatát.

A jobb oldali Tulajdonságok-ablak Világ gombjára katintva 
használjuk  a  csomópontrendszert  (Use  Nodes).  Most  nem 
nézzük  meg,  milyen  szép  csomópontok  keletkeznek.  In-
kább állítsuk be gyorsan a környezeti bevilágítást.

A horizont éle elvehető némi mélységélességgel. A  Tulaj-
donságok-ablak kamerabeállításainál. 

Ehhez jelöld ki a kamerát! A Fókusz mező pipetájával mu-
tass rá a gömbre, majd az  Aperture > Size értékét kezd el 
növelni. 
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Jó  tanácsok a  rendereléshez  ♦  Mivel  korábban beállí-
totad a flm típusát (H.264 kodekkel tömörítet AVI),  ezt  
már nem kell változtatnod. Azért nézd meg, hogy a hátér-
táron hova kerül majd a flm…

A Dimensions > Resolution mezőben állíts be 50%-ot. 

A  Sampling (mintavételezés)  mezőben  kapcsold  be  a  kis 
órát. A renderelést állítsd 100-as mintavételre.

Ha készen vagy a  rendereléssel, 
futasd a flmet a Blender főme-
nüjéből, ahogy korábban a próba-
renderekkel megteted azt.

Aztán keresd meg a hátértáron, 
hova került az animáció. 

Fontos, hogy nem a gép menti ide vagy oda, te állítod be, 
hogy hova kerüljön!
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13. 

Begurulunk 2.

13. Begurulunk 2.

13.
Az előző animáció során eegy keegyes csalással éltünk: 
Nem tudjuk megkülönböztetni a padlón csúszó 
labdát a padlón gurulótól, ha nincs rajta mintázató
A következő feladatban leszó
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Guruló labda

Ennél  a  feladatnál  már  nagyobb  önállóságot  kapsz.  Egy 
csomó dolgot az eddig tanultak alapján kell megoldanod, 
de segítségül adok néhány támpontot.

Készítsd el a labdát, a síkot, a világot az előző feladathoz 
hasonlóan. A labdát simítsd, a síkot nagyítsd, a világnak le-
gyen ég típusú bevilágítása. A jelenetben alkalmazot lám-
pát töröld ki. Helyezd el a kamerát az előzőekhez hasonló-
an. A flm legyen 100 képkocka hosszúságú.

A labda mintázata ♦ Emlékszel még a Cicavíziós feladat-
ra? A készüléknek kétféle anyagtulajdonsága is volt: egy a 
burkolatnak, egy fényesebb a képernyőnek. Ezt az ötletet 
szeretnénk most a labda kialakításánál is alkalmazni. 

Jelöld ki a labdát. A fő anyagának színe legyen sötétkék. Ez 
egy normál, difúz anyag. Nevezd el „Kék”-nek. Az anyag-
panel jobb felső sarkában levő + gombbal jelezd, hogy lesz 
még egy anyag a testen, majd a New gombot megnyomva 
ezt is nevezd át „Neon”-ra. Ne Difuse, hanem Emission tí-
pusú legyen. Most folytassuk  Szerkesztőmódban (TAB).  A 
(Z) billentyűvel drótvázként jelenik meg a tárgy. Az elölné-
zet (1) és az ortografkus nézet (5) gombokkal biztosíthatod, 
hogy az alsó ábrához hasonlóan látsszon a labda. Válts át 
oldallap-megjelenítésre. (A) gombbal töröld a kijelöléseket.

A (B) gombbal, azaz keretes kijelöléssel jelöld meg a gömb 
egyenlítő feleti, és az alati lapjait.
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Az Anyagtulajdonság panelen az Assign gombbal rendeld a 
„Neon” típusú világító anyagot ehhez a területhez. TAB-bal 
térj vissza Tárgymódba, és ellenőrizd valós idejű rendere-
léssel az eredményt. Célszerű Animációs elrendezésre válta-
ni. Ennek jobb felső ablakában (SHIFT+Z)-vel, azaz valós 
idejű rendereléssel ellenőrizheted az anyagokat.

Az animáció ♦ A labdát told most jobbra a látótéren kívül 
úgy, hogy az alja a koordináta-rendszer egyik beosztásán 
legyen. A feladatod, hogy a golyó egyenes vonalú, egyenle-
tes mozgással menjen át képernyőn. 

Nem csúszva,  hanem forogva!  Ez  azt  jelenti,  hogy  nem 
csak  hely (Location),  hanem  elfordulás (Rotation)  típusú 
kulcsokkal kell mozgatnunk a gömböt. A labdát kijelölve 
állíts be egy (I) > LocRot típusú kulcskockát. Most matekoz-
zunk egy kicsit : Ha egyet fordul a golyó, akkor a kerülete 
végiggördül a síkon. De milyen hosszan? 

Ez az érintkező kör kerületének képletével számolható: 

K = 2 × r × π. 

Mivel ennek a gömbnek a sugara 1 egység:

K = 2 × 1 × 3,14 = 6,28
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Tehát  körülbelül  6,3  eegységnyivel kell balra vinni  a tárgyat, 
hogy forgó mozgásnak lássunk a mozgását.

Ehhez érdemes elölnézetbe (1), majd perspektíváról ortog-
rafkus nézetre (5) váltani. 

Menj a 75. képkockához. Mozdítsd el 6,3 egységnyit balra a 
labdát. 

Ha ebben az állapotában készítenénk el az animációt, a fe-
hér öves labda egyszerűen végigcsúszna a talajon. 

Ne felejtsük elforgatni! Ehhez kapcsold be a  3D ablak Tu-
lajdonságpaneljét (N).

Valami furcsaság van a Location (hely) és Rotation (forgás) 
mezőkben. 

Az eddig szürke számbeviteli mezők bezöldültek. Ez csak 
egy jelzés arra, hogy ez a két mező már részt vesz az ani-
mációban, kulcskockákat kapot.
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Kezdjük el forgatni az óramutató járásával ellentétes irány-
ba a gömböt (R). Figyeld meg közben, hogy a Rotation me-
zőben melyik érték változik és hogyan?

Majdnem derékszögben elforgatva az Y tengely mentén jel-
zi a program a rotációt, méghozzá negatív előjellel. Egy tel-
jes  fordulat  így  –360°  lesz.  Írd  át  a  Rotation >  Y értékét
–360°-ra. Majd tedd az egér mutatóját a  3D ablak fölé. A 
precíz  beállítások  után  szúrjunk  be  egy  LocRot típusú 
kulcskockát (I). Ha rendben van, az eddig zöld hely, és for-
gás mezők besárgultak, azaz kulcsértéket vetek fel.

Közben a Kulcstábla és Mozgásgörbe ablakokban is van né-
mi változás. Az utóbbinál két markáns mozgásgörbe rajzo-
lódot ki. Egy piros és egy zöld. A piros már az előző fel -
adatból is ismerős, a labda mozgását írja le. 

A függvény éppen a tükörképe az előző feladatban  látott-
nak. Ugye nem lepődsz meg? Most nem balról (–), hanem 
jobbról (+) érkezik a golyó. Az is látható, hogy ez a mozgás 
tipikusan a „gyorsul-egyenletes-lassul” típusú alapbeállítás. 
Jelöld ki a mozgás kezdőpontját és a (T) gyorsbillentyűvel 
alakítsd lineárissá.
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Vajon ez a – most már lineárissá – alakítot piros mozgás -
görbe  vezérli  a  labda  forgását  is?  Hogy  ezt  eldönthesd, 
nyisd le  a  Mozgásgörbe-ablak bal  oldalán a  LocRot felirat 
előti kis háromszöggel az összes mozgásgörbét. 

Puf. Hat van. Végignézve őket a következőre jöhetsz rá:

• Az  X-Y-Z  Location típusúak  a  három 
tengelyen való mozgásért,  X-Y-Z Euler  
Rotation pedig a tengelyek menti forgá-
sért felelősek.

• A piros X Location görbe irányítja a lab-
da mozgatását.

• A hirtelenzöld  Y Euler Rotation pedig a 
forgását. 

Ez utóbbit alig lehet észrevenni, de ha erre az 
Y  Euler  Rotation csatornára  katintasz  bal 
egérgombbal, már szembetűnő. 

Az egér görgőjével és az ablak átméretezésé-
vel az is láthatóvá válik, hogy ez a görbe le-
megy egészen –360-ig, amíg a labda befejezi a 
körbefordulását. 

Alig látható,  de ez is  egy elnyújtot S alakú  
görbe, azaz „gyorsul-egyenletes-lassul” típusú. 

De  mi  ennek  a  következménye  a  mozgásra 
nézve? 
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Állítsd be a  3D ablakot  Material (anyag) típusú megjelení-
tésre. Láthatóvá válik a labdán levő úszóöv, de nem lassul 
le annyira a megjelenítés, mint a valós idejű renderelésnél.

Futasd az animációt! Látható, hogy a forgás nincs szink-
ronban a haladással. A végén mintha csúszna is a labda…

Borzasztó,  mennyi mindenen múlik,  hogy szép és hű le-
gyen egy ilyen vacak kis mozgás… Elkerülhetetlen, hogy a 
forgatás rebellis görbéjét is kiegyenesítsük!

Próbáld jobb egérgombbal eltalálni a zöld forgásgörbe kez-
dőpontját. Ez nem is olyan egyszerű, hiszen van még ot 
vagy öt görbe, amibe beleakadhatunk. Ezeket a függvénye-
ket program Csatornáknak (Channel) nevezi. Valószínűleg 
a többcsatornás hangszerkesztés analógiájára.
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A  Mozgásgörbe-szerkesztő bal  oldalsávja  kezeli  ezeket  a 
„csatornákat”. Ha csak egyet szeretnél kiválasztani, először 
csukd be a LocRot előti kis szemecskét. Ez ugyanis minden 
„hangsávot”,  mozgásgörbét  eltüntet.  Aztán nyisd ki  az  Y 
Euler Rotation előti szemet, így könnyebb lesz eltalálni a  
forgásvezérlő görbe kezdőpontját. 

A (T) interpolációs táblázatal állíts be erre is lineáris moz-
gást.  Teszteld az animációt a  3D ablakban. Esetleg futass 
egy gyors OpenGL próbarendert20. 

A  Végtelenbe,  és  tovább  ♦  Az  animációnk  működik, 
nagyjából a képmező közepéig. Ekkor tragikus hirtelenség-
gel leragad a gömb. 

Ne csodálkozz,  hiszen emlékszel  – nagyon nagy erő kell 
ahhoz,  hogy  egy egyenletesen mozgó testet  egy pillanat 
alat tökéletesen megállítson. A rendező viszont azt szeret-
né, ha a golyó tovább mozogna, ahogy eddig – egyenlete-
sen. Három lehetőséged van:

• A 150. képkockánál megint 6,3 egységgel balra tolod 
a labdát, s most már –720°-ra állítod az elfordulását, 
hiszen addigra már ketőt pördül. It újra elhelyezel  
egy kulcsot, és reménykedsz, hogy kiértél a képme-
zőből. Szubjektív vélemény: Egy-kétszer ezt megten-
ném, de hússzor már nem. Nem és nem!

• Fogod a mozgás- és forgásgörbéket, s egymás után 
beállítod úgy, hogy a végpontjuk kétszer akkora tá-
volságra kerüljön a függőleges tengelyen, s szögük 
pedig  ne  változzon.  Magyarul  egyszerűen  tovább 
húznád  ezeket  az  egyeneseket,  kétszer,  háromszor 
meghosszabbítva. Szubjektív: Ezt a mozgásgörbével 
egész könnyű megtenni,  mert it nincsenek akkora  
távolságok.  De  mit  csinálsz  a  forgásgörbével,  ami 
olyan mélyre  bukot, hogy csak speciális  búvárfel -

20 Ne felejtsd el a renderelés alapbeállításait a Tulajdonságok ablak első gombján. 
(Full HD 25%-a, a renderelés helye, H.264, stb.)
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szerelésben merülhetsz utána. Hol a határ? Mi bizto-
sítja, hogy szemre pontosak leszünk? 

• Keresel valamit a Blenderben, amit kitaláltak erre… 
Jó lenne ugyanis, ha a második megoldást nem te vé-
geznéd el, nem te húznád, illesztenéd tovább a görbé-
ket,  hanem a  program gondoskodna róla.  Ebbe már 
más is belefutot. Igen, van megoldás.

Kezdjük a mozgásgörbével, melyet az X Location csatornán 
jelölhetsz  ki,  ha  kinyitod  ennek  szemecskéjét!  Akár  a 
kezdő-, akár a végpontot választod ki, a program képes ext-
rapolálni, általánosítani az eddigi mozgásból…

A  Mozgásgörbe-ablak (Graph  Editor)  alsó  menüjében  a 
Channel  >  Extrapolation  Mode  >  Linear  Extrapolation pa-
rancs a múlt és a jövő irányába is kiszámítja, hogyan moz-
got és hogyan fog tovább haladni a labda.

Futasd  az  animációt  vagy  végezz  egy  próbarendert… 
Hupsz, olyan, mintha jégre futottunk volna…

Extrapolálnunk kell a forgásgörbét is, hogy tovább forog-
jon a labda! 
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A forgásgörbe nagyon-nagyon távolról, mielőtt általánosítanánk, folyamatos-
sá tennénk a mozgást…

Jelöld  ki  a  zöld  görbe  egyik  pontját,  majd  a  Channel  >
Extrapolation Mode > Linear Extrapolation  paranccsal ter-
jeszd ki az időben a labda forgó mozgását,

Most már a labda is forog a világ kezdetétől, annak végéig…

Utolsó simítások  ♦ Apró hibánk maradt az időzítésben: 
100  képkocka  nem lesz  elég  ahhoz,  hogy  végigfusson  a 
képmezőn a labda. Az Idősávon (Timeline) mozgasd az idő-
mutatót addig, míg kényelmesen elhagyja a golyó a képme-
zőt – a bal oldalon. Módosítsd így a flm hosszát. Most már 
jöhet a végső renderelés!
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A mélység szépsége

Gyors  eredményekhez  szokot világunkban  furcsa  talán,  
hogy ennyit vacakolunk a legegyszerűbbnek tűnő dolgok-
kal – mint az előző két feladatban egy-egy szimpla animá-
cióval. 

Megszoktuk,  hogy  csak  megnyomunk  néhány  virtuális 
gombot az okostelefonunkon, s mindjárt mienk a világ. 

Kutatók, mérnökök, művészek ezrei dolgoznak azon, hogy 
egyre inkább belelássanak a valóság törvényszerűségeibe. 

Soha nem fogom értékelni ezt a világot, ha nem értem meg 
annak mélységeit. Az élet, a mozgás, az animáció, ha elmé-
lyedsz benne, már nem is olyan kézenfekvő…

Vajon mennyi időbe telne, ha a hetedikre felvivő lif auto -
matikáját nekünk kellene kifejleszteni? 

Néha a legegyszerűbb dolgok megvalósítása elől is megfu-
tamodunk. Vagy félelemmel teljes csodálatal nézünk a ki-
vételes emberekre. Kutatókra, mérnökökre, művészekre.

Pedig  az  ő  teljesítményük  szinte  semmi  ahhoz  képest, 
ahogy a valóság működik. 

Amikor  mozogsz,  jársz,  talán  ilyen  görbékkel  vezérli  az 
idegrendszered mozgásaidat. 

Valami  hatalmas,  szinte  földöntúli  logika  működik  ben-
nünk, melyet ma a legnagyobb kutatók, tudósok és mérnö-
kök próbálnak utánozni. 

Minden csodálatom annak, aki ezt létrehozta…

Ha elvesztenéd a lendületed, gondolj erre: 

Ennek a kis világnak, ami a Blenderben a kezed alat fejlő -
dik, te vaegy az Alkotója.

13. Begurulunk 2.



228

Gyakorló feladatok

A következő lapokon az elmélyítést, gyakorlást segítő 
feladatokat találsz – egy-egy ötlettel.  Ne felejtsd el, 
hogy gyakorlás nélkül pillanatok alatt elveszíted az 
eddig megszerzett  tudásodat.  A feladatokhoz persze 
mindig kapsz egy kis segítséget… Jó munkát!

Függőlegesen pattogó labda

Magasról leesik egy labda, ami az alata levő síkba ütközve 
még  néhányszor,  egyre  kisebb  intenzitással,  függőleges 
helyzetben patog. Vigyázz nagyon, a két ábra nem egy to-
vapatogó labda mozgását ábrázolja!  It csak a Z,  azaz a  
függőleges tengely mentén történik elmozdulás.

13. Begurulunk 2.
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Tovapattogó labda

Valaki oldalról berúgta a stúdióba a labdát, ami tovapatog, 
majd megáll. 

Először készítsd el – az előző feladathoz hasonlóan – az 
egy helyben patogó labdát. Majd az utolsó kulcskockánál 
mozgasd el vízszintesen, és kulcsold újra. 

Location típusú kulcsokkal dolgozz!

13. Begurulunk 2.
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Összeütköző golyók

Egy egyenletesen haladó golyó nekiütközik egy másiknak, 
átadva a lendületét neki. 

A  piros  golyó  mozgásgörbéje.  Egyenletesen  halad,  majd 
hirtelen (az ütközéstől) megáll.

A kék golyó mozgásgörbéje. Egy darabig egyenletesen ha-
lad, majd lelassul. 
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Prés alatt átsurranó golyó

Készíts egy prést (egyszerű henger), mely le-föl mozog, mi-
közben egy golyó épségben átiszkol alata.

A bekeretezet rész a prés elemi mozgása. Le-fel. Ezt kell  
extrapolálnod.

Mivel it nem lineáris extrapolációt kell alkalmaznod, hasz-
náld a következő beállítást: Make Cyclic (Ismétlődés).

13. Begurulunk 2.
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14. 

Bevilágítás

14. Bevilágítás

14.
Most a fényekkel játszunk. Megismered a fotózásban 
alkalmazot stúdió-világításokat. Használsz majd 
virtuális és természetes fényforrásokat. Belelátsz a 
Cycles renderelő fénykezelési modelljeibe, s 
megtudod, mi az a HDRI.

 

bevilágítás
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A fény

Eddig rábíztuk a környezetre, az égre, hogy szórt fényével 
közel  tökéletesen  megvilágítsa  kezdetleges  szereplőinket. 
Olcsó megoldás, ha a fényképész kirángatja műterméből a 
modellt az utcára. Kikerül egy problémát. Most ismerked-
jünk meg a bevilágítás fortélyaival.

Nyisd meg a  015_bevilagitas.blend állományt a melléklet-
ből. A három ablakos felosztásban bal alsó ablakára állíts 
be valós idejű renderelést (SHIFT+Z). Puf, lecsapta a bizto-
sítékot! Miért van sötétség? Valaki intézkedjen már!

Rodin Gondolkodóját láthatod baltával faragott változatban. (Blendswap)

A Gondolkodót  Rodin  eredetileg  „A Pokol  kapuja”  című 
művéhez tervezte, ami végső formájában befejezetlen ma-
radt. Alakjai, mint a Gondolkodó,  a Csók önálló művek let-
tek. A pályázatot eredetileg egy új múzeum építésére írták 
ki, ami végül nem készült el. Rodin mindig-mindig tökéle-
tesítete művét,  egészen  1917-ben bekövetkezet haláláig.
E balszerencse kíséri most a valós idejű renderelésünket?

Az igazság az, hogy a világ sötét. Ahogy ezt a jobb oldali 
Tulajdonságok-ablak világbeállításain (World) láthatod. 

14. Bevilágítás
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Eddigi  feladatainkban  megszoktuk,  hogy  a  Világ  szürke 
vagy égszínű hátere szórt fényével megvilágítja a tárgya-
inkat. Ma nem adatik meg ez a luxus… Van valakinél egy 
zseblámpa, vagy legalább egy gyertya?

Pontszerű fényforrás ♦ Igen, ilyen a gyertya vagy a vil-
lanykörte.  Fényét  minden  irányba  sugározza.  Helyezz  el 
egy ilyen pontfényt a jobb alsó 3D ablakban (SHIFT+A).

Készíts egy síkot a szobor alá a következőképpen: Nyomd 
meg a (SHIFT+C) kombinációt, ami az origóba visszahelye-
zi a 3D kurzort. Ez megfelelő hely a sík számára. Nagyítsd 
hatalmasra (S), hogy jól lássuk a fényforrás viselkedését!

A pontlámpából sugár irányba távozik a fény. Mivel it fe -
lületeket átszúró sugarakról van szó, a fény nem fordítot 
arányban csökken a távolság növekedtével, hanem 1/r2 sze-
rint,  azaz  négyzetesen  fordítot arányban.  Magyarul  na -
gyon. Drasztikusan. Ez a helyzet a tábortűznél: pár méter-
rel arrébb már a sötétségben várakoznak a farkasok. 
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A lámpát narancssárgára 
színeztem, és az erősségét 

1000-re állítottam.

Fehér ívekkel jeleztem azt a két, 
egyenlő nagyságú felületet, 

melyekkel mérhetjük a rajtuk 
áthaladó fénymennyiséget. 

Bár itt vonalakat metszenek a 
fénysugarak, síkok esetén

36 / 144 = 1 / 4 arányt kapnánk. 
Kétszer akkora távolságra
tehát nem a fele, hanem a 

negyede lesz az egységre eső 
fénysugarak száma.
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Milyen árnyékot  vet  egy  pontszerű  fényforrás?  Az  atól 
függ, mennyire pontszerű. A bal oldali képen a Size (méret) 
értéket nullára állítotam. Ennek az eredménye a sok éles 
árnyék. A felső ábrán ugyanez 0,329 értékkel, fnomabban. 

Hárompontos bevilágítás ♦ Ez egy klasszikus műtermi 
elrendezés, melyet most kipróbálunk három pontlámpával.

A  sárgás  fényű  lámpának  nagyságát  úgy  állítotam  be, 
hogy szép, puha árnyékai legyenek (Size: 2). Egészen drá-
mai hatása van ennek az úgynevezet főfénynek. Éles, kont-
rasztos képet kapsz. 

SHIFT+D-vel  ketőzd  a  lámpát,  mozgasd  el  átellenben, 
messzebbre, mint a főfény. Színezd kékesre, kapcsold ki az 
árnyékát, és helyezd messzebbre.

14. Bevilágítás

A valós idejű renderelés minősége a 
Tulajdonságok ablak első paneljén

a Preview (Előnézet) mezőben 
állítható. Ha erős processzorod 

vagy kártyád van,állítsd nagyobbra!
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Ennek a fénynek az a feladata, hogy a korábban önárnyék-
ba kerülő felületeket derítse, ezért derítőfénynek nevezzük. 
Hogy ne legyen olyan erős, én messzebbre tetem, de csök-
kentheted a fényerejét a Strength értékkel is.

A harmadik lámpát a szobor mögé kell helyezned, átellen-
ben a kamerával. Ezt  ellenfénynek nevezzük. A funkciója, 
hogy kiemelje a tárgy, vagy személy sziluettjét, fényesebb 
kontúrokat  rajzolva rá.  Különösen szép hatása van,  ha a 
hajat világítja meg. Viszonylag gyenge és közel van a szo-
borhoz. Ha nem vigyázol, ez a fehéres fény eltünteti a szo-
bor árnyékát, ami egy furcsa, lebegő hatást ad a súlyos mű-
tárgynak. 
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Balra:  Túl  erős  ellenfény,  ami  eltünteti  a  szobor  árnyékát.  Fent:  Ellenfény 
megvalósítása reflektorral.

Spotlámpa,  refektor ♦  A  pontlámpák  nagy  hátránya, 
hogyha  terelni,  irányítani  akarod  a  fényüket,  elég  sokat 
kell  trükközni  velük – oda is  világítanak,  ahol  nem elő-
nyös. Ha ilyen problémáid vannak, használj refektort (Spot  
Lamp).

Balra: A pontlámpát átalakítottuk Spot-típusúra (reflektor).  Érdemes bekap-
csolni az előnézetet (Preview) a Tulajdonságok-ablakban. A Size értékkel a te-
relt fénysugarak szögét, a Blend-del pedig a fénykör élességét változtathatod. 
Ha látni szeretnéd tömör (Solid) nézetben a fénykúpot, tégy egy pipát a Show 
Cone elé.

Az összes lámpádat alakítsd refektorokká, majd így vilá-
gítsd be a szobrot!
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Az előző oldalon látható bevilágítás a jobb ablakban tömör (Solid) árnyalással, 
Matcap bekapcsolásával. Jobbról a főfény, balról a derítőfény, hátulról az el-
lenfény – reflektorokkal.

Derítőlámpa ♦ A hárompontos bevilágítás egyik szakkife-
jezése a volt a derítőfény. A következő lámpatípus a derítő-
lámpa (Area Lamp) vagy derítőernyő, idegen szóval sofbox. 

Ali Bindawood az unokaöccsét fényképezte le stúdióvilá-
gítással. Nem használt ellenfényt – ez látható lenne a fú 
haján. A szemében viszont megfgyelhetőek a fotós lámpái. 
A két softbox közül a bal oldali – téglalap alakú – a főfény. 
Mivel nagy kiterjedésű, szép, puha szélű árnyékot vetett, 
amit egy ernyő alakú lámpával derített a jobb oldalon.
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A nagy kiterjedésű lámpák előnyei: az egyenletes bevilágí-
tás, és a szép, puha árnyékok. Ezeknek a derítőlámpáknak 
(Area Lamp) a  3D munkafolyamatban nagy előnye,  hogy 
használatukkal csökkentheted a renderelés hibáinak száma, 
amiről majd később részletesebben írok.

A hárompontos bevilágítás megvalósítása, ahol a főfény és a derítőfény is de-
rítőlámpa (Area Lamp). Ellenfény marad a reflektor (Spot Lamp).

Próbáld ki te is a derítőlámpákkal a bevilágítást. Nagyon 
fontos ennek a típusnak a Size (méret) értéke, hiszen ez be-
folyásolja a felület nagyságát.

14. Bevilágítás
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A derítőlámpák (Area Lamp) alakja lehet négyzet vagy tég-
lalap  (Square/Rectangle).  Könnyebb bánni az előzővel,  hi-
szen a téglalapnak két oldalát kell megadni, s ha szükséges, 
változtatni. 

A méret növelésével csökken a fajlagos fényerő, hiszen na-
gyobb területről indul ki ugyanaz a fénymennyiség.

A fenti kép bevilágításánál a derítőfény is vetet árnyékot,  
azaz bekapcsolva hagytam mindkét derítőlámpa Cast Sha-
dow (árnyékvetés) tulajdonságát.

Ha  az  volt  az  előbbi  gyakorlatokban  az  érzésed,  mintha 
fénnyel festenél, igazad van. Szándékosan  eltúloztuk a fé-
nyeinket, hogy a kubista szobor bevilágítása ne nyűg, ha-
nem egy izgalmas festészeti feladat legyen. 

Hogy miért ugráltunk látszólag össze-vissza a lámpák típu-
sai közöt, azt csak most szeretném elárulni. 

A  korábbiakban  használt  lámpák  –  pontszerű  fényforrás,  
refektor, derítőlámpa – belső terek bevilágítására használ-
hatóak. Ami most jön, az a külső helyszíneknél használha-
tó.
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Napfény-lámpa ♦ Kedves csillagunk, a Nap fényét utá-
nozzuk ezzel a lámpatípussal (Sun Lamp). Mivel jellegzete-
sen kültéri fényforrás, felesleges három pontos bevilágítás-
hoz használni. Az ellenfényt kitöröltem, s az eddig kékes 
színű derítőfényt erejét drasztikusan csökkentetem, színét 
pedig a fehér fele vitem el. Próbáld ki te is!

A napfény sajátossága,  hogy drasztikusan erős.  Ahogy a 
beállításainál látod, nagyságrendekkel kisebbre kell venni, 
mint az eddigi lámpák fényét. A másik érdekes tulajdonság, 
hogy bárhova teheted a lámpát, csak a beesési szögtől függ 
az árnyékhatás.  Ez a fényforrás ugyanis  a nagyon távoli 
fényforrást utánozza,  melynek sugarai  egymáshoz képest 
gyakorlatilag  párhuzamosak.  Derült  időben  éles  árnyéka 
van a napnak, ezt a Size (méret) érték viszonylag alacsony 
beállításával érheted el.

Hemi ♦ Van még egy lámpa. A Cycles renderelő nem támo-
gatja ezt a típust. A régi Blender Renderben egy szórt fényt 
utánzó lámpa volt, amely a borús éghez hasonlóan, árnyék 
nélkül világítot meg mindent. A  Cycles  renderelőbe nem 
implementálták, mivel a Világ, az ég fényszórása szimulálja 
ezt a hatást. Ha mégis használnád, a Napfény-lámpához ha-
sonlóan fog működni, nagyon éles árnyékokkal.
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Bevilágítás valós tárgyakkal

Feltűnt neked a bevilágításnál, hogy a valós idejű rendere-
lésnél  nem látszotak a fényforrások ???? Ha nem, forogj egy 
kicsit körbe, és fgyeld meg, hogy  ezek a lámpák virtuáli-
sak, csak hatásuk van, önmagukban nem jeleníthetőek meg 
úgy,  mint  a  neon vagy gyertya.  Érdekes  módon,  ha egy 
tükröző  felületen  látod  őket,  mégis  láthatóvá  válnak.
Próbáld csak ki: Tégy egy Nurbs Sphere típusú gömböt a je-
lenetbe  (SHIFT+A > Surface > Nurbs Shpere).  Ez egy geo-
metriailag pontos felület. Nem olyan darabos jószág, mint 
amit eddig látál (UV Sphere).

Jelöld ki ezt a gömböt. Állíts be egy új, Glossy (tükör) típu-
sú anyagtulajdonságot! Látod-e a lámpákat a gömb tükör-
felületén? Hemi kivételével bármely lámpa láthatóvá válik!
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Az előző oldalon egy napfény-típusú lámpa, most két derítőlámpa látszik a tü-
körben. 

Pontlámpa és derítőlámpa ♦ Tüntesd el az összes lámpát 
(DEL  vagy  X)  a  jelenetből.  Készíts  az  előbbihez  hasonló 
gömböt, de a következő anyagtulajdonságokkal:

A Cycles renderelő nagy előnye, hogy összességében fzikai 
törvények alapján működik. 

A  régebbi  Blender  Render úgynevezet Biased  (előfeltevé-
sekkel dolgozó) képmegjelenítővolt. Ez azt jelenti, hogy a 
valóságot utánozni próbálta csak. 

Nem a fény valós viselkedését követe, csak ravasz utánza-
ta volt a valóságnak. Az idők folyamán egyre több eljárást 
építetek  bele,  egyre  bonyolultabb  let. Ezekkel  újabb  és  
újabb lehetőségek nyíltak meg a képmegjelenítésben. 
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Ennek köszönhetően persze nagyon gyorsan működöt, de 
megjelenítésében mindig volt valami furcsa, nem egészen 
valóságos.

A Cycles  Unbiased (előfeltevés  nélküli)  renderelő.  Sokkal 
közelebb van a fény fzikai viselkedéséhez, emiat realiszti -
kusabb az általa megjelenítet kép. Ennek köszönhetően lá-
tod a valós táregyakból készítet, fzikai fényforrásokat.

Kicsinyítsd le a világító gömböt, majd készíts egy derítőer-
nyőt síkból: SHIFT+A > Mesh > Plane. Ez egy egyszerű lap, 
melyet térbeli forgatással (R-R) irányíthatsz rá a szoborra. 

Több probléma is adódot: A gömb kicsinyíté-
sével csökkent a fényereje. Ezt könnyen kor-
rigálhatod a Strenght érték magasabbra állítá-
sával.  A  kicsi  tárgy  nagy  fényerőn  viszont 
valami  döbbenetes  képzajt  eredményez.  Az 
algoritmusnak nagyon sok időre,  és  sok-sok 
újramintavételezésre  van  szüksége  ahhoz, 
hogy viszonylag tűrhető képet produkáljon. 

A fenti  képeken 500-szor  futott  végig  a  renderelő  algorit-
mus, és így is tele van bizonytalansággal. A bal oldali több 
mint 11000 mintavétellel készült. Konklúzió: minél kisebb a 
fizikai fényforrás, annál bizonytalanabb, zajosabb képre szá-
míthatsz. Ugyanez nem jelentkezik a derítősíknál…
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Készíts két világító síklap segítségével kétpontos bevilágí-
tást. A főfény legyen markánsabb, kisebb síkkal hozd létre. 
A derítőfény lehet nagyobb felületű. Nálam például az át-
méretező manipulátorral készítet, hosszú téglalap.

Szórt fényű fényforrások ♦ Az alábbi képeken csak né-
hány ötlet. Portréfotózásban gyakran alkalmazzák a körva-
kut, melynek jellegzetes tükröződése van. It egy világító  
tórusz helyetesíti. Alata négyzetes armatúrák.
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Bevilágítás Világ-beállításokkal

Tisztítsd meg a jelenetet a fényforrásoktól, töröld az össze-
set. A  Tulajdonságok-ablakban keresd meg a  Világbeállítás 
földgolyó alakú ikonját. Kérj egy új környezetet, melynek 
színét állítsd fehérre. A Csomópontszerkesztőn keresd meg a 
Világ-ikont, s látod majd a felépülő rendszert.

Szép, puha, szórt fény érkezik mindenhonnan, a hatása is 
olyan, mintha fnoman tónusoztuk volna a szobrot.

Most próbáld beállítani a következőt: Katints a Color szín-
mezőjének jobb oldalán található pontocskára, ami valójá-
ban  egy  csatlakozó.  Válaszd  ki  a  felkínált  menüből  a
Checker Texture (sakkminta) parancsot, majd színezd át a 
világos és sötét mezőket.

Ugyanez a rendszer épül fel a Csomópontszerkesztőben.
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Nagyon elvetemültnek kell  lenni,  aki ilyen bohócháteret 
tervez  a  flmjébe.  Csak azt  szeretem volna  megmutatni, 
nem csak az ég-mintázat (Sky Texture) állítható it be.

Ég-mintázat  ♦  Korábbi  feladatainkban  már  találkoztál 
vele. Nem csak azért szeretem, mert a segítségével köny-
nyen, gyorsan lehet egészen szép bevilágításokat létrehoz-
ni. A másik nagy előnye, hogy változtatható, s ez a változás 
animálható.  Alkalmas napfelkelték,  naplementék vagy az 
idő múlását kifejező felvételek készítésére.

Kétféle  matematikai  modell  közül  lehet  választani.  A.  J.  
Preetham a Utah-i egyetem kutatója.  1999-ben dolgozta ki 
modelljét.  Lukáš Hošek és  Alexander Wilkie a prágai egye-
tem munkatársai. 2012-ben, a Siggraph konferencián mu-
taták be új eljárásukat. Azóta minkét modellt implemen-
tálták a legtöbb 3D programba.
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A paraméterek közöt olyan értékeket találsz, mint a Turbi-
dity (szóródás,  homályosság),  amellyel  a  légkör  szórását 
növelheted. A  Ground Abedo (talaj-fényvisszaverődés) pe-
dig a földről az égre visszavert fénymennyiséget szabályoz-
za. Magas Ground Abedo értéke van például a havas tájnak. 
A Strenght értékkel az általános fényerőt állíthatod be.

A fény útjai ♦ A renderelés minőségét sokféle tényező be-
folyásolhatja, ezért it, az ég szimulációjánál pillantsunk rá 
felületesen a  Tulajdonságok-ablak renderelési beállításaira. 
Ezekkel a későbbiekben részletesebben is foglalkozunk.

Néha ugyanis az égből jövő szórt fény ködössé, alacsony 
kontrasztúvá teheti a képeinket. Ha mindenhonnan érkez-
nek fénysugarak, eltűnnek a markáns árnyékok, ráadásul 
növekszik a renderidő is.

Hány különbséget találsz a két képen? Balra a direkt bevilágítás, jobbra a glo-
bális bevilágítási modellt alkalmaztam.

A két tesztjelenet közül az első azt a szintet tükrözi, ahol a 
3D grafka a múlt század  '80-as éveiben volt. Lassabb gé-
pek, fejletlenebb algoritmusok. A fény közvetlenül megvi-
lágítva a tárgyakat a szemünkbe érkezik (Direct Light). 

A  második,  ún.  globális  megvilágítási  modellben  a  sze-
münkbe jutnak azok a sugarak is, amelyek már visszapat-
tantak más tárgyakról (Global Illumination). 

14. Bevilágítás
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A második modell olyan, mintha a difúz labdacsok fény-
forrásokként viselkednének, pedig csak a róluk visszavert 
fénnyel derítik a környezetet. Figyeld meg, hogy a kocka 
egyik lapja pirosabb, a másik pedig sárgább – annak meg-
felelően, amelyik difúz gömbhöz közelebb voltak. 

Egyértelműen valóságosabb a második modell, de bizonyos 
helyzetekben gondot okozhat. Most is, a szobor bevilágítá-
sánál. Próbáld kis te is a jelenetben ezeket a beállításokat. 

E  bevilágítási  modellek  megtalálhatóak  a  Tulajdonságok-
ablak renderelési beállításainál. Vizsgáld meg a Light Paths 
(Fényútvonalak) mezőt. Állítsd  Full Global Illumination-ra.

Magas Turbidity (Szóródás) értékkel az égmodellben, s né-
mi fényerősítéssel mintha egy téli, ködös reggelen lennénk. 

A fenti hatást a túl tökéletes globális bevilágítás okozza. Az 
egész ég egy hatalmas derítőernyő, mely szétszórja a Nap 
sugarait. 
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Full Global Illumination bevilágítási modellben a paraméte-
rekkel pazarlóan bánik a program. Legalább hármat, legfel-
jebb  128-at  patannak  (Bounces)  a  fénysugarak,  melyek 
közveteten érkeznek a szemünkbe. Ha átnézed a többi me-
zőt,  megerősödik  a  véleményünk,  hogy  olyan  az  egész, 
mintha  fotonok kavalkádjával  árasztanánk el  a  jelenetet, 
melyek önfeledten patognak, míg a szemünkbe nem érnek. 

Állítsd  most  Direct  Light-ra  (közvetlen  megvilágítás),  ha 
markánsabb, kontrastosabb képet szeretnél. 

A változást nem látod rögtön, csak akkor, ha az előnézeti 
képet az egér görgőjének megnyomásával kissé elfordítod, 
ilyenkor reagál a program, s újraszámolja a képet.

A paraméterek táblázatában látható, hogy nem lustálkodik 
ekkor sem a renderelés. A direkt megvilágítás minimalizál-
ja a fényvisszaverődések számát, de nem csökkenti annyi-
ra, hogy az zavaró legyen. Az indirekt, más tárgyakról visz-
szaverődő fénysugarak éppen nyolcat patannak (Bounces). 
De a számolási sebesség nő, a renderidő csökken, és kont-
rasztosabb lesz a kép.

Ezzel persze nem azt akartam mondani, hogy a direkt meg-
világítás minden esetben jobb. Csak számolj ezekkel a mo-
dellekkel, ha tudatosan akarsz a fényekkel bánni.
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Bevilágítás HDRI képpel

Manapság mindenki készít fényképeket – ha nem fényké-
pezőgéppel,  akkor  az  okostelefonjával.  Nem  minden  ké-
pünkkel  nyernénk  a  National  Geographic fotóversenyén. 
Sokféle hibalehetőség adódik, ami azt bizonyítja, hogy né-
mi tapasztalat, és tudás is kell a fotózáshoz, nem elég drága 
gépet venni. 

Az egyik jellegzetes probléma azokkal a képekkel van, ahol 
nagyon nagy különbségek vannak a környezet fényeiben. 

Gyakori, hogy az ég kiég, fehérré, színtelenné válik, a sötét 
részek pedig bebuknak. 

Ugyanilyen probléma az éjszakai fényképezés eltűnő rész-
letek, vagy a beégő fények. 

Az alábbi kép lehetet volna olyan értelmezhetetlen, mint a 
mellete levő.

(Forrás: Pixabay)

Nézzük meg, milyen trükkökkel lehet növelni a képek di-
namikatartományát!
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(Képek forrása: Wikipédia)

Állványról,  háromféle  expozícióval  készítetek  képeket, 
melyeket egy képfeldolgozó szofverrel egyetlen, hatalmas 
dinamikatartományú képpé alakítotak. 

A normál színes kép, amit a telefonod JPG formátumban 
készít, 3 × 8 bites árnyalati terjedelmű. 256 vörös, 256 zöld, 
256 kék árnyalatot tartalmaz. 

A fenti módszerrel így készült kép viszont 3 × 32 bites, azaz 
csatornánként  nem  256,  hanem  4429449674296 (több  mint  
négymilliárd) árnyalatot tartalmaz. 

Ezek a képek .HDR vagy .EXR kiterjesztésűek [HDRI (High 
Dynamic Range Imaging – naegy dinamikatartományú képal-
kotás], és gyakorta használják őket valós és virtuális sze-
replők egy flmben való megjelenítéséhez. 

Az eljárás röviden: 

A helyszínen, ahol az élőszereplős felvétel készül lefényké-
peznek egy tükröződő és egy difúz felületű gömböt. 

Ezután a tükörgömb segítségével elkészítik a HDRI képet, 
többször lefényképezve azt.
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Az így elkészült, nagy dinamikatartományú képet elhelye-
zik a 3D szofver világában, mellyel bevilágítják a jelenetet. 

(Fotó: CG Talk fórum)

A programban leellenőrzik, hogy a virtuális tükör- és difúz 
gömbök  ugyanúgy  jelennek-e  meg.  Amennyiben  igen,  a 
szofver biztosítja, hogy tökéletes megvilágítás és árnyék-
vetés legyen a virtuális tárgyakon. 

Ezt fogjuk mi is megvalósítani a Blenderben. Töröld ki az 
eddigi  Világ-beállításokat  a  jobb  oldali  Tulajdonságok-
ablakban. 

Kérj egy új világot – ó, ha csak így menne –, és a  Color 
színbeviteli mező végén levő pötyöcskét megnyomva vá-
laszd a menüből az Enviroment Texture (Környezeti mintá-
zat) parancsot.
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A világunk pinkbe borult:  fgyelmeztet  a  program,  hogy 
még nincs  betöltöt képünk.  Nyisd meg a  mellékletből  a  
016_studio021.hdr állományt, és nézzük meg az eredményt.

Ha körbejárod a teret, láthatod, hogy egy fotóstúdió világí-
tását feszítete a program a Világ háterére. 

A jelenetben elhelyeztem egy difúz és egy tükröződő göm-
böt, hogy jól látható legyen a környezet. Ha ilyen szép, raj-
zos megvilágítást szeretnél, a renderelési beállítások fényút-
vonalainál (Light Paths) állítsd direkt megvilágításra (Direct  
Light). Körbeforgatva a teret láthatod, hogy nem csak a fo-
tókon megjelenő fényforrásokat,  hanem azok által  vetet 
árnyékokat is korrekten jeleníti meg a program.

Még  egy  HDRI  képet  találsz,  ez  egy  külső  helyszín: 
017_termeszet.hdr. Töltsd be az előző helyére.
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Összegzés  ♦ A 3D programok fénykezelése  elsőre  talán 
ijesztőnek tűnt. Mostanra megérteted, hogyan jutotunk el 
a gyertyafényt utánzó pontszerű fényforrástól a profk által 
használt nagy dinamikájú bevilágításig. 

Használtunk  közben  virtuális  és  fzikai  fényforrásokat, 
szembesültünk egy-két renderelési problémával, és a végén 
rátaláltunk egy olyan módszerre, aminek eredménye – kis 
ráfordítással nagyon szép bevilágítás. 

Ez  utóbbi,  a  HDRI-megvilágítás  a  3D-technika  jelenlegi 
csúcsa. Ilyen képeket ingyenesen is összevadászhatsz az in-
ternetről. 

Miután  megoldotad  ezeket  a  feladatokat,  regisztrálj  a 
blendswap.com oldalon. Havonta húsz,  mások által ingye-
nes  használatra  felajánlot Blender-állományhoz  juthatsz  
hozzá. Keress néhány izgalmas modellt, majd világítsd be 
azokat!

További jó próbálkozást!
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15. 

Metacseppek

15. Metacseppek

15.
Van eegy különleges alaptest a Blenderben, ami 
átalakulásra, változásra képes. Miközben vele, és a 
fényekkel játszadozunk, létrejön eegy látványterv,
mely az alapja lesz eegy animációnak. Megtanulunk 
objektumokat hierarchiába szervezni, átélesíteni és 
renderelni.

 

metacseppek
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Metaball

Új testfajtával ismerkedünk, ez a metacsepp, vagy angol ne-
vén metaball. Ha ezekre a testekre úgy gondolsz, mint a hi-
ganycseppekre, könnyen megértheted működésüket. 

A  higany  az  egyetlen  szobahőmérsékleten  is  folyékony 
fém.  Részecskéi  közöt aránylag  nagy  az  összetartó  erő,  
emiat szinte gömb alakú cseppekbe húzódik össze. 

Ugyanazon metacsepp-rendszer kétféle nézőpontból és bevilágítással

Ha egymás felé közelítjük a szétört hőmérő, vagy a tégely-
ből kiömlő higany cseppecskéit, a nagy vonzóerő kölcsönö-
sen a másik irányába deformálja azokat, addig a pillanatig, 
amikor hirtelen összekapcsolódnak. 

A számítógépes flmtrükk történetének fontos mérföldköve 
volt  a  Terminator  2. epizódja,  ahol  a  jövőből  visszajövő 
gyilkos robot szinte elpusztíthatatlan volt, higanyszerű kis 
cseppekké eset szét, majd újraegyesült.

15. Metacseppek



258

A múlt század ‘70-es éveinek végén James F. Blinn, a számí-
tógépes grafkai megjelenítés egyik útörője, együt dolgo -
zot Carl Sagan-nal. A  Kozmosz című tévésorozat néhány 
speciális efektusát bízták rá. Ennek egyik epizódja a DNS-
ről szólt. Blinn ennek vizualizálására hozot létre olyan szá-
mítógépes  objektumokat,  melyek organikusan kapcsolód-
tak egymásba, akárcsak az DNS-t alkotó molekulák. 

A fzikában a töltöt részecskék elektromos mezeje defor -
málódik hasonlóan, ha egymás közelébe kerülnek.

A metacseppekkel molekulák – vagy olyan anyagok, mint 
a higany – utánozhatók, de kitűnő eszköz leveleken megje-
lenő harmat, súlytalanság állapotában lebegő, mozgó víz-
buborékok megjelenítéséhez is. Alkalmazzák absztrakt, or-
ganikus formák modellezésére, de még logótervezésben is. 

A környezet előkészítése ♦ Egy megfelelő görbületel el-
látot hátérsíkot fogunk készíteni, melyen szépen oszlanak 
el a bevilágítás fényei. Korábban dolgoztunk már ezzel.

Indulj ki egy síkból. Válts  Szerkesztőmódra  (Edit Mode) a 
TAB billentyűvel. 

A létrehozás  után a  síkon a  csúcspontokat  (Vertex)  lehet 
szerkeszteni. Van egy kézreálló billentyűkombináció, mely-
lyel  nagyon gyorsan,  mindenféle  keresgélés  nélkül  tudsz 
váltani csúcspont, él és lap között, ez a (CTRL+TAB).

15. Metacseppek

Blinn és az általa 
alkotott DNS-modell.
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Jelöld ki a sík kamerával átellenes élét, válts oldalnézetbe 
(3) és ortografkus módba (5). Végezz több kihúzást (E).

Kapcsold  be  a  méretező  manipulátort  a  mozgató  mellé 
(SHIFT) a 3D ablak alsó menüsorában, és változtasd meg a 
hátérvászon szélességét. Az alapértelmezet kamera most  
nem jó szögben lát rá a síkra. Jelöld ki ezt, és nyomd meg a 
következő két billentyűkombinációt:

• (ALT+G): A (G) gomb a mozgatásért felelős. Ha ALT-
tal  együt nyomod,  elfelejti,  lenullázza az origóhoz  
viszonyítot távolságokat.

• (ALT+R): Az (R) gombbal forgatható az objektum. Ez 
a billentyűpár törli a forgásokat.

Ha a kamera az origóban lefele néz, válts oldalnézetbe és a 
(G) és (R) gombokkal helyezd át az ábrának megfelelően.

Bevilágítás  ♦ Egy lámpa eredetileg is  volt  a jelenetben. 
Alakítsd át Area típusúra. Legyen téglalap (Rectangle) ala-
kú, így karakteresebbek a tükröződések. 

Méretei:  Size X = 3;  Size Y  = 5. Erőssége 500. Színe fnom 
narancssárga. Ketőzd ezt a lámpát (SHIFT+D). Vedd vissza 
300-ra a másolat erősségét, és némi kékes fényt adj a színé-
hez. Hátér, fények, kamera… Elkészültünk a környezetel.

15. Metacseppek
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Metacseppek ♦ Az első csepp önmagában nem túl izgal-
mas jelenség. Az Eszköztár Create fülén, vagy az Add menü 
segítségével hozhatod létre: (SHIFT+A) > Metaball > Ball.

A  csepp  az  őt  körülvevő  kör  kijelölésével  mozgatható, 
igény szerint méretezhető. 

Én a szokásos, háromablakos elrendezésemben dolgozom, 
ahol a felső ablak a  Csomópontszerkesztő (Node Editor),  a 
bal alsó egy 3D ablak, melyet valós idejű renderelésre állí-
totam, a jobb alsó hasonló, de tömör (Solid) nézetben.

Állítsd be a gömb optikai anyagtulajdonságát kőolajhoz ha-
sonlóra. Tükröző (Glossy) felületű, mélyszürke színű. Ezzel 
már kipróbálható a bevilágítás, habár a forma még kissé el-
nagyolt… Ennek oka, hogy a  metacseppeknek nagyobb az 
erőforrásigénye,  amivel  takarékoskodni  igyekszik  a
program. Saját géped teljesítményére tekintetel állítsd be a 
felbontás (Resolution) mezőben az  előnézet, és a  renderelés 
értékeit. Minél kisebb az érték, annál szebb a megjelenítés.

15. Metacseppek
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Egy magányos metacseppen még nem látszik,  mennyivel 
érdekesebben viselkedik mint egy UV Sphere típusú gömb. 
(SHIFT+D)-vel ketőzd, majd a másolatot a körülöte levő  
kör segítségével mozgasd.  Ha a cseppek egymás közelébe 
kerülnek, a fellépő vonzóerő hidat képez közötük. 

Dönci mozog ♦ Leendő közös flmünkben Dönci, az amorf 
amőba fog néhány komótos  tornamutatványt  végezni.  A 
környezetét, és az őt körülvevő részleteket úgy alakítjuk ki, 
mintha egy mikrovilág része lenne – egy űrállomás belteré-
ben magában rugózó buborék, vagy egy folyadékban lebe-
gő olajcsepp lenne.

Készíts még két másolatot az eredeti cseppről (SHIFT+D), 
melyeket  különböző nézetekből  mozgass (G)  és  méretezz 
(S) át. Így lesz négy, a körülötük levő körökkel egyenként 
kijelölhető objektum. 

Az általam választot zene,  melyre különböző nézetekből  
leforgatva összevágjuk majd a flmet, 1260 kocka hosszúsá-
gú (53 másodperc). Egy-egy snit 200–300 képkocka terje -
delmű lesz.  Öt ilyen snitből  áll majd a kisflm, így az ani-
máció hosszának választhatunk 300 képkockát, amit most 
gyorsan állíts is az idővonalon.
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Az első képkockánál jelöld 
ki  mind a  négy metacsep-
pet a kör alakú fogantyúk 
és a SHIFT gomb segítségé-
vel. Fontos, hogy ezeket je-
löld  ki  és  ne  a  cseppeket, 
melyekre,  ha  jobb  egér-
gombbal  katintanál,  az 
egész amőba aktiválódik.

Állíts be erre a négy objek-
tumra  egy  kulcskockát  (I), 
mely legyen Location (hely) 
típusú.  Most  menj  az  idővonalon  a 300.  képkockához. 
Egyenként rendezd át a cseppeket, amilyen végállapotban 
szeretnéd látni őket. Nem kell sokat mozgatni, de határo-
zotan  legyen  más  alakú  Dönci.  Most  megint  jelöld  ki 
együt őket. Kulcskocka beállítása (I), ugyanúgy hely típu -
sú legyen, ahogy az előbb. Nézd meg az animációt az idő-
tengely segítségével. 

Gömböcskék, parentolás  ♦ Dönci nem az egyetlen sze-
replő a  felvételen.  Körülveszik őt  különböző méretű ma-
szatkák,  melyek mint  folyadékban,  tovasodródnak.  Mivel 
ezek  a  szemcsék  nem  találkoznak  közvetlenül  Döncivel, 
nem kell deformálódniuk. Elég egyszerű gömbökből létre-
hoznunk őket.
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Hogy ne akadj bele az egyre bonyolódó jelenetünk tárgyai-
ba, menj át a második rétegre, és ot készítsd el az alábbi el-
rendezést:

A  gömböcskék  tökéletes  geometriai  felületek:  Add  >
Surface  >  Nurbs  Surface.  Ezeket  kicsinyítsd  le  különböző 
méretekre, és rendezd el a tér minden irányában. 

Középen helyezz el egy üres objektumot. A típusa, formája 
legyen különböző  atól,  amit  eddig használtunk:  Arrows,  
azaz nyilak. Most következik egy olyan művelet, amely na-
gyon hasonlít  más programok  csoportosítás eljárására.  It 
viszont nem csoportot, hanem hierarchiát hozunk létre az 
objektumok közöt. 

15. Metacseppek
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Tegyük fel, hogy ez az üres objektum  (Empty) lesz a ma-
szatkák középpontja.  Hozzá  kötjük  majd  az  összes  többi 
gömböcskét – egy szülő-egyermek típusú kapcsolatal. 

Olyan ez,  mint  a  gyerekpóráz:  A  szülőt (Empty)  követik 
majd a gyerekek (gömböcskék), akik egymáshoz képest el-
mozdulhatnak. A módszer nagy előnye, hogy csak az üres 
objektumot (ami nem látszik renderelés során) kell animál-
ni, az ő mozgását utánozza minden hozzá csatolt objektum.

E kapcsolat létrehozásánál nagyon kell fgyelned a sorrend-
re: Mindig az alárendelt (child) objektummal kezd. Jelöld ki 
az egyik gömböcskét, majd SHIFT-tel és jobb egérgombbal 
jelöld hozzá az üres objektumot. Nyomd meg a (CTRL+P) 
billentyűzetkombinációt, majd a felbukkanó menüből (Set 
Parent To – szülő beállítása) válaszd az Object opciót. Ekkor 
egy szaggatot vonal jelenik meg a két objektum közöt. 
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Figyeld meg a viselkedését: Ha az üres objektumot (szülő) 
mozgatod,  követi  a  gyerek.  Ha  a  gömböcskét  (egyermek), 
nem követi a szülő. Végezd el a következő öt objektummal 
is a parentolást. Ne menj tovább, míg be nem gyakorlod!

(A) billentyűvel tüntesd el a kijelölést minden tárgyról, for-
gasd úgy a teret, hogy gumikeretel (B) több objektumot is 
kiválaszthass. SHIFT-tel jelöld hozzá a gömböcskékhez az 
üres objektumot. Nyomd meg a (CTRL+P) kombinációt. 

Ha maradt még gömb, tüntesd el a kijelölést (A). Látod már, 
mely maszatkák csatlakoznak az üres objektumhoz ezzek a 
kapcsolatal. Fogasd a teret, míg gumikeretel jól hozzáférsz 
az árván maradt objektumokhoz, majd ismételd meg az el-
járást addig, míg minden gömböcske kötődik az Emptyhez.

Ha elkészültél,  jelöld ki  az üres objektumot,  kapcsold be 
együt az első és a második réteget a SHIFT segítségével,  
majd helyezd el ezt az üres objektumot Dönci belsejében.

Ha az Emptyt kicsinyíted, minden hozzá kapcsolt tárgynak 
csökken a mérete. 

Ha egyenként szeretnéd állítani vagy mozgatni a gömböcs-
kéket,  megteheted,  hiszen  az  nem  változtatja  a  többiek 
helyzetét.
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Mélységélesség ♦ A szokot módon állíthatod a mélység-
élességet:  Helyezz  el  egy  másik  üres  objektumot  (Plain 
Axes), majd a kamerát kijelölve állítsd be ezt az objektumot 
a fókusznak. Vigyázz, ez már a második üres objektum! A 
program  Empty.001 névre  kereszteli.  Ne  téveszd  össze  a 
gömböket vezérlő objektummal!

A fényrekesz – fotós kifejezéssel blende – méretét az Aper-
ture > Size mezőben állíthatod. Minél nagyobb ennek érté-
ke, annál kisebb a mélységélesség, azaz nagyobb az  elmo-
sódottság a fókusz előt és után. 

A blende nagysága mellet érdemes állítani az alakját is. A  
fényképezőgép objektívjében levő lamellák száma határoz-
za meg a rekesz alakját – ami megfelel az emberi szem pu-
pillájának. Ezzel befolyásolhatod az elmosot foltok alakját.
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A gömböcskék animációja ♦ Jelöld ki a gömböcskékhez 
kapcsolt üres objektumot. Az idővonal 1. képkockájához ál-
líts be (I) egy  Rotation típusú kulcskockát. Majd a menj a 
300. kockára, (R+R) segítségével forgasd szabadon térben a 
gömbhalmazst, és ide is helyezz kulcskockát.

Az animációk fnomítása  ♦ A Blender a legtermészete-
sebb interpolációt állítja be az összes mozgásgörbéhez, s ez 
az S alakú  egyorsul-eegyenletes-lassul típusú mozgás. Ez tör-
tént most is. Az animációnkkal viszont egy folytonos sod-
ródást szeretnénk érzékeltetni.  Nem most és nem a ked-
vünkért mozdult  meg a rendszer,  s  a felvétel végén nem 
kell megállnia. Egyenletes mozgásra lesz szükségünk.

Váltsd át a felső ablakot  Mozgásgörbe-szerkesztőre (Graph 
Editor),  jelöld  ki  (A)  billentyűvel  az összes  csomópontot, 
ami a görbéken van, majd a (T) gombot megnyomva vá-
laszd a lineáris interpolációt (Linear) . 

Ugyanezt tedd meg az összes animált objektummal: a néegy 
metacseppel is !

15. Metacseppek
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Átélesítés

Nagyon  erőteljes  alaptulajdonsága  a  Blendernek,  hogy 
szinte mindent animálhatunk. A mozgás és forgás mellet a 
tárgy nagyságát, de ha úgy hozza a kedvünk, a fényforrá-
sok fényerejét vagy az anyagok színét is. 

Azzal,  hogy  korábban  készítetél  egy  üres  objektumot, 
melyre a kamera most fókuszál, a kezedbe került egy esz-
köz, mellyel könnyen-gyorsan változtathatod, hova élesíted 
a kamerát. Csak arrébb kell rakni az Empty-t.

Kisflmünkben, ahol környezet sodródik, lebeg, lassan for-
málódik, az átélesítés sem lehet etől elütő – pillanatszerű, 
túl gyors, vagy zaklatot. 

Menj  a  jelenet  elejére,  és  keress  egy gömböcskét,  amely 
legközelebb van a kamerához. Igazítsd ide az üres objektu-
mot, mellyel vezérled a kamera élességi tartományát.

Állíts be egy kulcskockát (I), mely legyen  hely (Location) 
típusú. 

Most helyezd át az időmutatót az Idővonalon a 150. kocká-
hoz, és mozgasd az üres objektumot Döncihez. It is szúrj  
be egy kulcskockát (I).
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Renderelés

Van egy 300 képkockás animációd, mely most már csak a 
renderelésre vár: Döncit alkotó négy metacsepp és a göm-
böcskék  mozognak,  a  kamera  átélesít.  Nincs  más  hátra, 
mint elkészíteni a flmet. Fontos mentened az állományt!

Remélem, hogy eddig a modellezés és az animáció során 
nem volt semmi probléma a rendszereddel. Tudom, a valós 
idejű renderelés néha kicsit visszafogta, de ezt leszámítva a 
Blenderhez  eleddig nem kellet szuperszámítógépet  hasz -
nálni. De most… Oké, nem kell a családi vagyonodat gép-
cserére költened, de arra számíts, hogy meghatározó ténye-
ző  lesz  a  renderelés szempontjából  a  számítógéped  pro-
cesszora, vagy a grafkus kártyája. Innentől kezdve érezni 
fogod,  hogy  a te  időd az  elsődleges  fzetőeszköz,  mellyel 
tervezned, gazdálkodnod kell. 

Fussuk át a Tulajdonságok-ablak renderelési beállításait!

Eszköz (Device)   ♦ Amennyiben a Blender felhasználói 
beállításaiban sikerült megtalálnod a saját grafkus kártyá-
dat (lásd Függelék f.), it választhatsz a processzor és a gra-
fkus kártya közöt. 

A renderelés műveleti ideje látható az elkészült kép feletti Time mezőben.

Készíts állóképes tesztrendereket, melyik dolgozik gyorsab-
ban.  Elég  egy katintás  a  Render gombon,  vagy az  (F12) 
gyorsbillentyű.
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Méret (Dimensions)  ♦ Korábban a Full  HD méret 25%-
ával dolgoztunk. Ez 480 × 270 pixel, ami nem valami nagy 
méret. A Blender alapbeállítása elsősorban próbarenderelé-
sekhez a fél Full HD, azaz 960 × 540 px. Készüljön ezekkel a 
paraméterekkel a flmünk, ha bírja a géped, ha nem, vedd 
vissza 25%-ra.

Időmenedzsment ♦ Az előző oldalon levő renderelt képet 
nagyjából 5 másodperc alat számítota ki a gépem. Ha a  
felvétel 300 képkockából áll, teljes számolási ideje:

5 másodperc × 300 kocka = 1500 másodperc

Ez 1500/60 = 25 perc renderidő. Egy 12 és fél másodperces 
kis  snitért.  Egy  öt  snitből  álló  kisflm kb.  két  óra  alat 
renderelhető ebben a felbontásban… 

Számolj te is utána a saját gépeden, mire számíthatsz!

A renderelés sebességét még nagyon sokféle tényező befo-
lyásolhatja, ahogy azt a későbbiekben látni fogod…

Hova? (Output) ♦ It határozhatod meg, hogy hova hozza 
létre a program a renderelés eredményét, s milyen formá-
tumban tegye azt. Nagyon tudatosnak kell lenned: ha rosz-
szul állítod be a célmappát, előfordulhat, hogy felülírod egy 
korábbi  renderelésed eredményét,  s  a program még csak 
nem is szól…

Az  Output panelen egy alapbeállítást látsz, nyomd meg a 
beviteli mező mögöti kis mappa ikont. Rendszertől függő-
en menj abba a mappába, ahova a renderelsz majd.

Accept gombbal fogadd el ezt a helyet.
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Formátum ♦ A flm állóképek sorozata. Régen egy cellu-
loidszalagra,  tekercsre  veték  fel  ezt  a  képsorozatot.  Ma 
már elektronikusan tároljuk. A renderelés során a követke-
ző ökölszabályt alkalmazzuk: 

• Ha flm készül  a  nyersanyagból,  azaz később szer-
keszteni  (vágni)  fogjuk,  vagy  utómunkát  végzünk 
rajta,  akkor képek sorozataként rendereljük  (image 
sequence).

• Ha csak mutatóba lesz,  megosztjuk vagy elküldjük 
valakinek, ilyenkor válasszunk videoformátumot. 

Nálam az a gyakorlat alakult ki, hogy egy átlagos 3D jele-
net rendereléséhez  PNG formátumot használok. Ez  veszte-
ségmentesen tömörítet képek sorozata.

Ha sok utómunka lesz, főleg színek tekintetében, akkor a 
nagy színmélységű Radience HDR-t használom.

Ha egyszerre több réteget is kell renderelni, akkor  Open-
EXR Multilayer-t. Ez utóbbi ketővel elég nagy állományok 
jönnek létre, úgyhogy csak óvatosan.

Választható kimeneti formátumok. Az első két oszlop kép, a harmadik videó. 

Videók közül vannak tömörítet és tömörítés nélküli for -
mátumok. Ha AVI Raw-ban mentesz, veszteségmentes lesz 
az állomány, de kétnaponta le kell szaladnod a sarki fűsze-
reshez újabb hátértárat venni. Ha Xvid vagy AVI JPEG kó-
dolású állományt hozol létre, szépen tömörítet, de utófel -
dolgozásra alkalmatlan állományt kapsz. 
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Tömörítet formátum vágása, utófeldolgozás után az utó -
munkaszofver újra renderelést végez, ami veszteséggel jár. 
Ezt nevezzük generációs veszteségnek.

Van-e arany középút? Ha mindenáron kompromisszumot 
kell hozni, az talán a H.264 lehet. Ezzel tömörítenek a Blu-
ray lemezeken, a  Youtube-on, egyéb streamelt vagy meg-
osztot videókban. Nagyon jó képminőségű tömörítő algo -
ritmusa már állóképek szintjén egy színtérváltással, később 
a kockák közöti átmenetekben újra tömörít. Az eredmény 
gyakran megkülönböztethetetlen az eredetitől. 

Ha csak vágásra küldöd a nyersanyagot, vagy nem sok utó-
munkát szenved, még ez a formátum is ajánlható, de ne fe-
lejtsük el, a tömörítés miat veszít az eredeti információból.

Képsor ♦ De térjünk vissza arra a kérdésre, miért célszerű 
képsort létrehozni? A renderelés időigényes tevékenység. 
Képzeljük el, hogy egy 5–8 órás számolási folyamat köze-
pén túlmelegszik a processzorod és leáll a gép, esetleg le-
csapja  a  biztosítékot  anyósod  a  porszívózás  során,  vagy 
programhiba  következtében  lefagy  az  éppen  renderelő 
szofver. Mi történik ekkor egy félig elkészült videofájllal? 

Félig sem készül  el.  Tönkremegy. S egy képsorral? Elké-
szült 300-ból 120 képkocka. A baj elhárítása után folytatod 
a renderelést a 121. kockától.

121 – 300-ig beállított képkocka-tartomány.

Hogy rövidre zárjuk ezt a diskurzust, állíts be kimenetnek 
PNG formátumot, RGB színtérrel,  8 bit-es csatornánkénti 
színmélységgel.

A következő szakaszban már azt is meg fogod érteni, ho-
gyan hozza létre a program a képkockákat, s ennek opti-
mális beállításával milyen minőségnövekedést érhetsz el.
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Mintavételezés (Sampling)  ♦ It állíthatod be,  hányszor 
néz rá a kamera a virtuális világra. Fenn a hegyekben ücsö-
rögsz egy faházban. Sötét éjszaka van. Mintha zajt hallanál 
kintről… Óvatosan egy zseblámpával egy pillanatra kivilá-
gítasz. Ezt a képet látod. Mi van rajta? 

Mintha valaki egy láncot rázna… Lehet, hogy egy pap ló-
bálja a füstölőt, vagy egy járókelő próbálja kis kedvencét 
hazahúzni a teraszról. 

Hogy megbizonyosodj az igazságról, elkezdesz pásztázni a 
zseblámpáddal. 

Az már biztos,  hogy nem pap.  Talán egy konditeremben 
gyúr valaki, vagy egy szép rabnőt kell kimenteni a szultán 
fogságából? Biztosan nagyobb motivációval fogsz bele az 
újabb pásztázásba, nagyobb mintavételezésbe! 

A renderelő algoritmus hasonló módon dolgozik: A minta-
vételezés  számának megfelelő  sűrűségben végigpásztázza 
a jelenetet, s próbál egyre pontosabb információt kinyerni 
abból, amit a virtuális térben lát. 

Ha alacsony a mintavételezés, a kép tele lesz bizonytalan-
sággal, zajjal, esetleg hibás információval. 

Emlékszel, az alacsony mintavételezésű képről mit gondol-
tál?… Villogtassunk tovább a zseblámpánkkal.
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Uh, ciki lett volna plébános úrnak szólítani a sötétben lóbáló alakot… 

Sok idő, míg tisztán megbizonyosodunk arról, ami odakint, 
a kamerán kívül, a virtuális térben zajlik, de minél nagyobb 
a mintavételezés, annál szebb eredményt kapsz.

(Fotó: Pixabay)

A minőségi kép viszont sok időt emészt fel, ami a flmké-
szítésnél  kritikus  pont.  A  renderelés  Sampling  panelén 
csökkentsd annyira a mintavételszámot, hogy minimálisan 
legyen csak zajos a kép. A  Seed érték mögöti kis óra be-
kapcsolásával minden kockán más zaj keletkezik, így nem 
lesz olyan a flm, mintha egy karcos üvegen keresztül néz-
néd.

Nyomd meg az  Animation gombot, és keress a renderelés 
végéig más elfoglaltságot. Az eredmény flmként visszanéz-
hető. ( Play rendered Animation.)
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16. 

Animatik

16. Animatik

16.
Az előző feladatban teremtetünk eegy mikrovilágot 
néhány cseppecskéből. Leghosszabb flmünk 
túlszárnyalta a tíz másodpercetó Hm, it az ideje, 
hoegy valami naegyobb volumenű dologba vágjunk! Mit 
szólnál eegy majdnem eegy perces alkotáshoz?ó
Ennek készítjük el a próbaflmjét. 

 

animatik
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A film előkészítése

Így, hogy már beavatást nyertél a Blender kezelésébe, vala-
melyest a modellezésbe, a testek optikai anyagtulajdonsá-
gaira  is  van  rálátásod,  képes  vagy  szépen  bevilágítani  a 
környezetet, jól áll a virtuális kamera a kezedben, sőt már 
az  animáció  sem ismeretlen  terület  előted  –  nos,  ideje, 
hogy elkészítsd első igazi flmedet.

Látod már, hogy a 3D animáció nem egyszerű dolog, mun-
kafolyamatai időigényesek. Megszerzet tudásunk után az  
idő a legértékesebb valutánk, ezért a jó előkészítés most is 
aranyat ér. Persze egy alig hatvan másodperces kisflmhez 
nem kell összehívni egy 200 fős stábot. Egyszerűsége miat 
a munkafolyamat jó néhány elemét kihagyhatod. Fussunk 
végig a szükséges műveleteken!

Ötlet ♦ A korábbi feladatban megalkotot mikrovilág olyan 
inspirálólag hatot ránk, hogy ennek miliőjében szeretnénk 
leforgatni a flmet. 

Milyen hangulatot kell továbbvinnünk? Lebegés, sodródás, 
közelképek apró tárgyakról, élőlényekről, anyagokról. Kis 
mélységélesség, anyagában tükröződő felületek. 
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Látvány ♦ Az előző flmecske környezetében játszadozva 
könnyen rátalálhatunk néhány alakzatra, ami ilyen közel-
ségben hasonlóképpen izgalmas látvány, mint a metacsep-
pek. Mi jut eszedbe az alábbi képről? Plankton, moszat, ví-
rus? Mindegyik? Egyik sem? Nekünk most jó lesz.

Zene ♦ A természetflmeknél és a látványanimációnál  is 
kulcsfontosságú a zene stílusa, hangulata. Nyisd meg a gé-
peden  a  018_bensound-beterdays.wav állományt  valami-
lyen médialejátszóval.  Hallgasd  meg többször  is,  elálmo-
dozva felete, hagyd, hogy a képzeleted képeket fessen a 
zene hangulatára. A hang lesz meghatározó a hangulatflm 
felépítésében, az vezet bennünket a flm szerkezetének fel-
építésében. 

Hogyan tudnánk láthatóvá tenni a hangot? A Blender nem 
audioszerkesztő  program,  de  kitűnő  eszköz  lehet  az  elő-
munkálatok során a  flm ütemezésének tervezésében.  In-
dítsd el a programot!

Már korábban látad,  hogy vannak a Blenderben „beége-
tet” képernyő-elrendezések, melyek segítségedre lehetnek 
a munkafolyamat különböző állomásainál. A Blender főme-
nüjében találod ezeket, s  most válaszd ki a  Video Editing 
(videoszerkesztő) lehetőséget!
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Így néz ki a Blender videoszerkesztő ablakelrendezése. Há-
rom fő ablakában szinte megegyezik bármely komolyabb 
többsávos videoeditorral.

Összehasonlítva például az Adobe Premiere Pro szofverével, 
szinte teljes az egyezés: Balra fenn efektezni tudod, jobbra 
fenn megnézheted a flmet, alul középen pedig a videó- és 
hangsávokat szerkesztheted.

Csak annak lesz kényelmes a Blenderben flmet vágni, aki a 
többi műveletet, a Blender sajátságos gyorsgomb-vezérlésű 
transzformációit is megtanulta. 

Még nem flmvágásra, hanem a vágás előti ütemezés elő-
készítésére, és az animatik megjelenítésére használjuk most 
a programot.
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A Video Sequence Editor (Sávszerkesztő) alsó menüjében az 
Add > Sound  menüparanccsal  keressük meg a  bensound-
beterdays.wav hangállományt.

Hogy „lássuk a  hangot”,  ugyanezen menü View >  Wave-
form Drawing > Waveforms On parancsával jelenítsük meg 
a hullámformát. 

Játszd le a felvételt. Kicsit több, mint 10 másodpercig hall-
gathatod,  azután  újrakezdi  a  program.  Ne  ijedj  meg!  A 
Blender nem valami shareware program. Nem kell  bank-
kártya-számot  megadni,  hogy  teljes  értékűen  működjön. 
Az idősáv alat látható, hogy 250 kocka hosszúságra van  
beállítva, eddig hajlandó lejátszani a zenét. 

Húzd a zöld időmutatót a  Sávszerkesztőben a hangfelvétel 
végéig. Állítsd a flm végét 1260 képkockára (kb. 52 mp). 

16. Animatik



280

Most már a felvétel végéig lejátszható a zene. Hallgasd meg 
újra, s fgyeld meg: ahol hangerő-növekedés van a felvétel-
ben, ot a hullámforma is kiszélesedik, növekszik a kitérése, 
szakszóval amplitúdója. 

Az első  szakaszban  kissé  erősödő  zúgás.  Ezután  minden 
szakaszt gitár vezet be. Összesen öt ilyen szakasz van, cél-
szerű ezeket a programban is megjelölni ún. markerekkel.

A jelölők (marker) elhelyezése a Marker > Add Marker me-
nüparanccsal  történik.  Gyorsbillentyűje  az  (M).  Ezt  már 
használtuk rétegek közöti átvitelre, de a Blenderben más-
más ablakban eltérő funkciókat láthatnak el ugyanazok a 
billentyűk.

A markerek az Idősávon is megjelennek, ha az egér görgő-
jével megfelelő nagyításban látsz rá arra.

Ezek a  kis  jelek segítenek bennünket  a  flmvágásban,  az 
egymást követő snitek megfelelő ütemezésében.

Alakíts ki egy mappát erre a munkára (mikrovilag), majd 
mentsd oda vagas.blend néven ezt az állományt. 

Ebben a Blender-fájlban fogjuk elkészíteni az animatikot, s 
később magát a flmet is. 
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Animatik

Egyszerűen  megfogalmazva  egy  zenére  futó  diavetítés, 
mellyel kipróbálhatjuk a flm ütemezését még az elkészítés 
előt. Elhelyeztem öt korábban renderelt képet a melléklet-
ben:

• 019_bubik.jpg; 
• 020_butyok.jpg; 
• 021_ebiborz.jpg; 
• 022_tuske.jpg; 
• 023_virus.jpg. 

Menj  a  Sávszerkesztő  időmutatójával  az  1.  képkockára, 
majd ennek alsó menüjéből az Add > Image paranccsal ke-
ress rá 019_bubik.jpg képecskére. 

Elkészült videó híján ez fogja helyetesíteni a flmfelvételt.

A kép mint flmfelvétel (klip) a második sávra került.
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Nagyjából egy másodpercig látszik csak. Nyomd meg a le-
játszás gombot vagy húzd el az időmutatót. Az első zenei 
témát ez a másodpercnyi anyag nem fedi le. Sebaj, ki lehet 
nyújtani időben! 

Látsz a lila sávon egy bemeneti és egy kimeneti háromszö-
get.  Jelöld  ki  jobb  egérgombbal  az  utóbbit,  majd  nyomd 
meg a jó öreg (G) gyorsbillentyűt. Mozdítsd el a következő 
markerig!

Futasd a „flm” elejét! Tudom, tudom… kissé statikus, de 
nem thrillert forgatunk… Most mozgasd valahova a máso-
dik snit területére az időmutatót, a két marker közé. Hívd  
be hasonlóan az 021_ebiborz.jpg képet. Az időmutató mellé 
kerül a második klip.

Jobb egérgombbal jelöld meg az elejét, majd (G)-vel moz-
dítsd el balra, aztán a végét jobbra a következő markerig.
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A program segít az elhelyezésben. Miközben (G)-vel moz-
gatod, mutatja, hányadik képkockánál jársz. Ha belefutnál 
a másik klipbe, az elpirul.

A sávszerkesztőt a középső egérgomb lenyomásával moz-
gathatod,  görgetéssel  a  nagyítását  változtathatod.  Menj 
most  a  harmadik  szakaszhoz,  a  harmadik  és  a  negyedik 
marker közöt valahova.

Nyisd meg az operációs rendszer fájlkezelőjét, és egyszerű-
en húzd át ebből a Blender  Sávszerkesztőjére a kiszemelt 
022_tuske.jpg állományt. 

Eddig a klipeket a két végükön nyújtotuk, úgy mozogtak, 
mint az araszolóhernyók. Magát a klipet is lehet mozgatni: 
ha jobb egérgombbal a lila sáv közepére katintasz, s utána 
nyomod meg a (G) gombot. Mozgasd a bal oldali markerig. 
Azután a korábbi módszerrel jelöld ki a végét és húzd (G)-
vel a jobb oldali markerig.

Most már csak két klipet – 023_virus.jpg és 020_butyok.jpg 
kell elhelyezned – azzal a módszerrel, ami neked tetszik.

Futasd le a flmet! Előfordulhat, hogy akadozik, nem meg-
felelő a frissítése. Célszerű most gyorsan renderelni ezt az 
animatikot. Ezzel a próbarenderrel egy valós tervezési fo-
lyamat során ilyenkor egyeztethetsz a megrendelővel vagy 
a stúdió más munkatársaival, hogy jó-e az időzítés.
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Renderelés ♦ Az első problémánk: hova, hogyan rendere-
lünk… A  Blender  videoszerkesztőjében  ugyanis  eltűnt  a  
szokásos Tulajdonságok-ablak. 

Renderelhetünk vaktában a Blender bal felső főmenüjéből,. 
Ennek annyi értelme van, mint elsütni egy ágyút, nagyjá-
ból sehova sem célozva. Amellet, hogy egy kiskamasznak 
ez is jó poén, fogalmad sem lesz, hol köt ki majd a felvétel.

Oszd kétfelé inkább a Videoszerkesztő jobb felső monitorab-
lakát:  Húzd balra az ablak felső sarkát. Az így létrehozot 
új képernyőrészt állítsd  Properties  (Tulajdonságok) típusú-
ra. Így már könnyebb beállítani a renderelést.

Most ne képsort, hanem egy H.264-es tömörítésű AVI állo-
mányt hozz létre,  mely hangot is  tartalmaz.  Vigyázz,  ezt 
külön kell beállítanod, az  Audio Codec mezőben. Ha elké-
szültél a beállításokkal, (CTRL+S)-sel mentsd az animatik-
állományt, aztán indulhat a számolás az  Animation gomb 
aktiválásával. A következő leckében folytatjuk…
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17. 

Mikrovilágok

17. Mikrovilágok

17.
A tervezet kisflm öt jelenetének elkészítését, 
animációját végezzük. Közben megtanulsz néhány 
modellezési eljárást, s a egyakorlatban is 
kipróbálhatod a Blender módosítórendszerét. 
A lecke végén flmet vágunk és forgalmazunk.

 

mikrovilágok
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A film jelenetei

Rend a lelke mindennek ♦ A flmes szaknyelvben snittt-
nek (beállítás) nevezzük a flm legkisebb egységét, amit egy 
kameraállásból, -mozgásból veszünk fel. A jelenet egymás-
sal összetartozó beállítások sorozata, melyek egy tartalmi 
egységet alkotnak. 

Ebben a flmecskében öt szereplő életét mutatjuk be abban 
egy  mikrovilágban,  melyet  a  korábbiakban  létrehoztunk. 
Az öt jelenet pontosan egy-egy snitből (beállításból) áll. Ez 
tehát az abszolút minimum. Az alig egy perces videó előké-
szítéséhez  ki  kell  alakítanunk  egy  mapparendszert,  ahol 
megtalálod az egyes animációk renderelt állományait, s az 
animációs fájlokat is. 

A  fő  mappa  legyen  a  korábban  létrehozot mikrovilag, 
ebbe kerüljenek azok a mappák, ahova a jeleneteket ren-
derejük. (01jelenet, 02jelenet, ó, stb.)

Másold be a mikrovilag mappába a könyv mellékletéből a 
024_kornyezet.blend  állományt.  Nyisd  meg  a  Blenderrel, 
majd ugyanide a File > Save Copy paranccsal ments öt állo-
mányt  01jelenet.blend, 02jelenet.blend, 03jelenet.blendó, stb. 
néven. 

Ez a parancs a meglevő állományból több másolatot tud ké-
szíteni. Most nyisd meg az így előkészítet 01jelenet.blend 
állományt. 
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Bubik

Az első jelenet szerkesztése nem lesz nehéz, hiszen az előző 
leckében már dolgoztál metacseppekkel. Most két  metato-
jással készítsd el az animációt (Metaball > Ellipsoid), mely-
hez csak néhány szempontot szeretnék adni. 

• A jelenet hossza legyen 300 képkocka.

• A metatojások lassan mozogjanak, olvadjanak egybe, 
vagy ütközzenek.

• Játszhatsz egy kicsit a kamera élességi pontjával is. 

• Kapcsold  be  SHIFT-tel  a  második  réteget,  amin az 
előző feladatban már animált sodródó kis gömböcök 
vannak.

A metatojások anyagtulajdonságát nem kell újra felépíte-
ned.  Bár  megtehetnéd,  hogy  emlékezetből  elkészíted,  de 
sokkal egyszerűbb, ha előkeresed.

Mivel a második rétegen vannak „Bubi” anyagtípusú göm-
böcskék, ezeknek optikai tulajdonságait beállíthatod az új 
objektumunkra is.

Végezz  állóképekkel  próbarenderelést,  számold  ki,  hogy 
300 képkocka renderelése összesen mennyi időt emészt fel, 
s ennek függvényében 50%-os vagy 25%-os képméret-csök-
kentéssel  dolgozz.  Figyelj  arra,  hogy  ezt  a  képméretet 
tartsd a többi jelenetnél is!  Ha készen vagy a beállítások-
kal, PNG képszekvenciaként mentsd művedet a  01jelenet 
mappába.
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Ebiborz

Található-e ilyen ebihalszerű lény az  Eszköztár alaptestei 
közöt? Ha  a  válaszunk  nem  –  nagy  valószínűséggel  a  
Blender alkotói erre a lényre éppen nem gondoltak –  akkor 
keresned kell egy alapformát, amiből kis fáradsággal kiala-
kítható.

A  feladathoz  nyisd  meg  az  általad  korábban  előkészí-
tet 02.jelenet.blend állományt. Növeld a két alsó ablak ma-
gasságát úgy,  hogy a vízszintesen érintkező oldalakat  el-
mozdítod.  Fontos,  hogy  a  jobb  alsó  3D ablak elég  nagy 
legyen ahhoz, hogy kényelmesen elérd az  Eszköztár (Tool 
Shelf) minden szolgáltatását. A bal alsó ablakot pedig ál-
lítsd valós idejű renderelésre (SHIFT+Z).

Hozz  létre  egy kockát,  majd  válts  Szerkesztőmódba (Edit 
Mode) a TAB billentyűvel. Az  Eszköztár Subdivide paran-
csával oszd fel a kockát, de rögtön állítsd azt is, hogy a fel-
osztás ne egy, hanem két vágással történjen.
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Most válts lapkijelölő (Face) módba: (CTRL+TAB) gyorsbil-
lentyűvel, vagy az ablak alsó menüjében.

Jelöld ki jobb egérgombbal a kocka bal oldali lapjának kö-
zépső négyzetét, majd (E) gyorsbillentyűvel húzd ki balra.

Kissé darabos formánk inkább hasonlít  Tor kalapácsához, 
mint a modellezés során vágyot ebihalhoz, de valahol el  
kell  kezdeni.  Válts  vissza  Táregymódba  (Object  Mode)  a 
(TAB) billentyű használatával.

Igazítsd, méretezd úgy, hogy a kamera látóterébe kerüljön, 
állítsd rá az élességet az üres objektummal. (Z) billentyűvel 
állítsd tömör (Solid) módba a modell árnyalását.
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Ellenőrizd, hogy bénácska ebihal-utánzatunk kijelölt álla-
potban van-e, majd keresd meg a Tulajdonságok-ablak mó-
dosítók (Modifers) ikonját, ami egy kis csavarkulcs.

Érintsd meg az Add Modifer menüt. A felbukkanó, zavarba 
ejtően  sokszínű  menüben  pontosan  ötven  parancs  van 
négy oszlopba rendezve. Keresd meg a Subdivision Surface 
(felosztásos simítás) menüpontot. Hogy kicsit plasztikusab-
bá tegyem az eredményt,  bekapcsoltam az egyik  MatCap 
árnyalást a tömör nézetben.

Más programokhoz hasonlóan a Blenderben is alkalmazha-
tunk  módosítókat, melyeket azért találtak ki, hogy bonyo-
lult  modellezési  műveletek  nélkül  változtathass  egy-egy 
tárgyon.

A  módosítók alapflozófája: úgy formálni a tárgyat, hogy 
az bármikor visszaállítható legyen eredeti formájába. Mivel 
még foglalkozunk e témával részletesebben, most nem fej-
tem ki, ez mennyire jó dolog lesz számunkra. 
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Most éppen annyira, hogy ebből a kalapácsból, mint befog-
laló formából gyorsan lehet ebihalat hajtogatni. Mert hát 
valami ilyesmiről van it szó, ez a módosító egyfajta felosz-
tással  próbál  egy  görbítet felületet  feszíteni  az  eredeti  
alapformán belül.

Balra a módszer kitalálói Edwin Catmull, aki a Pixar elnöke, 
és James Henry Clark, a Silicon Graphics akkori alapítója. A 
fenti képen pedig egy kocka e módszer szerinti felosztásos 
simítása.

Szerkesztőmódban  (TAB) látható, hogy az eredeti testháló 
egyfajta állványzathoz hasonlóan funkcionál. Mintha a sa-
rokpontjaihoz kötnénk, feszítenénk egy rugalmas anyagot, 
mely a felületi feszültségénél fogva összehúzódik.

A felosztást lehet fnomítani  módosító panel  Subdivisions 
(felosztások) mezőjében. Ennek kiszámítása rendesen meg-
terheli  a  processzorunkat.  Érdemes az  előnézet (View) és 
renderelés (Render) értékeket is 3-ra beállítani. 
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Erősebb processzor egészen 6-os értékig bírja, de ha vissza-
váltod  Táregymódba (TAB) a  3D ablakot,  s megnyomod az 
Eszköztáron a Smooth (simítás) gombot, akkor lassulás nél-
kül is nagyon szép eredményt érünk el.

Mi  különbözteti  meg  az  élő  ebihalat  a  megboldogultól? 
Természetesen a mozgás. Hullámzó hastáncot kell járni a 
kis  teremtménynek.  Ehhez  egy  másik  módosítót  haszná-
lunk, melyet  Wave-nek (hullámzás) hívnak. Ezt is az  Add 
Modifer legördülő menü segítségével állíthatod be. 

A módosítók nagy előnye, hogy egymással kombinálva le-
het alkalmazni őket. Ha most elkezded futatni az animáci-
ót,  jól látható az időbeli  hatása,  mely harmonikus rezgő-
mozgásként  tovaterjed  a  testen.  A  fenti  paraméterekkel 
szép, méltóságteljes mozgást állíthatsz elő.
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Néhány tanács az animáció felépítéséhez:

• A jelenet hossza legyen it is 300 képkocka.

• Az ebihal ne csak egy helyben hullámozzon, hanem 
haladjon is a képernyőn balról jobbra.

• Állítsd be „Bubi”-ra az ebial anyagtulajdonságát, az 
előző jelenethez hasonlóan.

• Kapcsold  be  SHIFT-tel  a  második  réteget,  amin az 
előző feladatban már animált sodródó kis gömböcök 
vannak.

• Figyelj arra, hogy ha korábban 25%-os vagy 50%-os 
arányos csökkentést alkalmaztál a renderelés során, 
azt it is ugyanúgy állítsd be.

• Ha készen vagy a beállításokkal, PNG képszekvenci-
aként  mentsd  művedet  a  02jelenet mappába.  Na-
gyon  fgyelj,  hiszen  ezeket  a  külön-külön  gyűjtöt 
képsorokat fogjuk a végén egy flmmé összevágni.

Készülj  fel  megint  egy  hasonló  hosszúságú renderelésre, 
ami jó alkalom arra, hogy kicsit félretedd a könyvet. 

Ha készen vagy, az új jelenetben újra  módosítókat  fogunk 
alkalmazni.
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Tüske

A következő jelenetben egy folyamatosan változó alakzatot 
készítünk.  Nyisd  meg  a  korábban  előkészítet 03jele-
net.blend állományt,  készíts egy kockát,  melyet a kamera 
helyzetéhez képest kicsit forgass meg a térben, majd alkal-
mazd rá a Cast (öntvény) módosítót.

Ha ennek Cast Type mezőjében megnézed, háromféle „ön-
tőformát” használhatsz: gömb, henger és kocka. Hagyjuk 
most a Sphere (gömb) beállításon. Kezeljük úgy most ezt a 
kockát, mintha folyékony fémből lenne, amit hasonló alak-
zatokba  öntögetünk.  Azaz  átformáljuk:  kockából  például 
gömb alakúvá. Normális esetben a Factor (érték) beállításá-
val ennek meg kéne történnie, de így meg sem mozdul. A 
Cast módosító  algoritmusa ugyanis a testek  vertexei,  azaz 
csúcspontjai, térpontjai szerint végzi az átalakítást, és ebből 
most nagyon kevés, szám szerint nyolc van.

Menj át Edit Mode-ba (TAB), és az Eszköztár Subdivide pa-
rancsával oszd fel egyszer a test lapjait.  Ha visszatérsz a 
(TAB)-bal Object Mode-ba, már látszik valami változás, mi-
közben a Factor értéket –10 és +10 közöt változtatod. Nyil-
ván nem az a célunk, hogy adventi ünnepséget rendezzünk 
a mikrobáknak, így ne elégedjünk meg ezzel a betlehemi 
csillaggal. Folytassuk megint Szerkesztőmódban (TAB).
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Ha Szerkesztőmódban megnyomod a (W) gombot, a felbuk-
kanó menüből gyorsan kiválaszthatod a  Subdivide (felosz-
tás) parancsot. A képen látható részletességgel már igazán 
látványos eredménye lesz a Cast módosítónak.

Középen látható a kocka Factor = 0 értékkel. Negatív számokra tüskecsillag, 
ennek ellentétével gömb vagy szeder formájúvá alakul. 

Ahhoz, hogy ilyen szép, lesimítot eredményt kapj, még két 
korábbi, általad már ismert trükköt kell bevetned. Az egyik 
a  simítás (Smooth), amit az  Eszköztárban találsz. Eredmé-
nyét láthatod a felső képen. Ez a darabosság azonban nem 
alternatíva. Vesd be még a  Subdivision Surface (felosztásos 
simítás) módosítót is.
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Ha azt szeretnéd, hogy az idő haladtával megváltozzon az 
eredeti kockád alakja, menj az egereddel a Factor érték szö-
vegbeviteli mezőjére, majd nyomd meg az (I) gombot, ami-
vel kulcskockát rendelsz a beállításhoz. 

Ha a Factor értékhez kulcskockát állítasz, ez megjelenik az 
Idővonalon,  a  Kulcstáblán (Dope  Sheet),  a  Mozgásgörbe-
szerkesztőn (Graph Editor) is. Ez ellenőrizhető, ha a munka-
terület felső ablakát Csomópontszerkesztőről átállítod ezek-
re a típusú ablakokra.

Ha egy értékmezőben, mint it a Factor értéknél, animációs 
változás van, akkor a mező bezöldül. Ha éppen kulcskocká-
nál jársz az időben, akkor sárga lesz a színe.

Készíts animációt, melyben változik a kockád alakja a Cast 
módosító segítségével. Az eredményt a szokásos hosszban, 
formában rendereld a 03jelenet mappába. 

Ne felejtsd el bekapcsolni a második réteget sem!

Újabb pihenés. Már csak két jelenet van hátra.
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Vírus

Az  jelenethez  újabb  környezet-állományt  kell  betöltened 
04jelenet.blend néven.  A  lenti  képen  két  ikozaéder,  azaz 
húsz háromszögből felépülő szabályos test látható. A belső 
tömör, míg a külső mintha lécekből vagy drótokból lenne 
összeszerkesztve. Mindketőt módosítókkal készítetem.

Ha ikozaédert szeretnél létrehozni, használd az  Add menü 
(SHIFT+A) Ico Sphere parancsát. Rögtön az elkészítés után 
állítsd vissza az eszköztáron a Subdivisions (felosztás) para-
métert 1-re. Ez a test alapesetben gömböt utánoz, de „gene-
tikailag” egy ikozaéderből eredeztethető. 

Rögtön ketőzd a (SHIFT+D), de vigyázz arra, hogy ne moz-
dítsd el a ketőződés helyéről,  hanem ENTER-rel zárd le a 
műveletet,  még mielőt az egérrel  elmozdítanád a  testet!  
Most ugyanezen helyen az (S) billentyűvel nagyítsd fel a 
másodpéldányt.

Te persze a két ikozaéder közül csak a külsőt látod, de mindjárt megmutatom, 
hogy lehet ilyen drótvázat létrehozni, minek a belsejében látszik a másik.
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Igen, erre a problémára kitaláltak egy módosítót. Ezek álta-
lában úgy kerülnek be a programba, hogy valamelyik terü-
leten szükség mutatkozik a használatukra. Egy-egy model-
len meg szeretnénk mutatni  a  felépítését,  a  test  geomet-
riáját – ilyenkor nagyon hasznos ez az eszköz.

Jelöld tehát ki a külső ikozaédert, majd keresd meg a Wire-
frame (drótváz) módosítót. 

A Módosító panelen a Tickness értékkel tudod változtatni a 
drótváz vastagságát. 

Ha a formát megtaláltad, állítsd be a belső és külső ikozaé-
derek anyagtulajdonságát.

17. Mikrovilágok



299

Jelöld ki a kisebbet, majd a felső,  Csomópontszerkesztő ab-
lak alján levő menüből hívd elő a „Bubi” anyagtulajdonsá-
got,  melyet  korábban  már  beállítotunk  más  tárgyakhoz. 
Ezt persze nem csak it, a Csomópontszerkesztőben, hanem 
jobb oldalon, a Tulajdonságok-ablakban is beállíthatod.

Most célozd meg a drótvázat, és kérj egy új anyagot a Cso-
mópontszerkesztőben.

Ez egy fénytörés típusú csomópont, melyet az  Add > Sha-
der > Refraction menüből hívhatsz elő. Az anyag eltéríti a 
rajta áthaladó fény útját. A szín választásánál a HSV szín-
térre váltva állítsd vissza az S (Saturation – telítetség) érté-
ket, hogy ne műanyagszerűen rikító, hanem az élővilágra 
jellemző, visszafogotabb színt kapj.
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Végül még egy kicsi módosítást eszközöljünk a belső ikoza-
éderen. A természetben ugyanis nagyon ritka, hogy vala-
minek teljesen szabályos, egyenes élei lennének.

Sokkal szebbek lesznek ennek a testnek a tükröződései, ha 
kissé lesarkítjuk az éleit. Vessünk be a Bevel (sarok) módo-
sítót. Ennek beállításaival már magad is megbirkózol.

Animáció előt a két testet parentold egymáshoz úgy, hogy 
a  belsőt  jelöld  ki  először,  majd  SHIFT-tel  a  drótkeretet. 
Használd a (CTRL+P) billentyűkombinációt. 
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Elég így csak a külső objektumot mozgatni, azt követi majd 
a belső is. 

Animáció-ötletek  ♦ A  vírus  lassan  sodródjon,  közben 
forduljon el. Engedd látatni a belső objektum oldallapjain 
megcsillanó fényeket.

Mindenben pedig kövesd a korábbi paramétereket, mielőt 
az animáció negyedik jelenetét rendereled.

Újabb esély a pihenésre az utolsó jelenet előt. 

17. Mikrovilágok



302

Bütyök 

Mikrovilágunk utolsó szereplője ez a kis zselés állagú zsák-
lény.  Készítéséhez töltsd be az általad előkészítet utolsó,  
05jelenet.blend állományodat.

Az előző jelenetben egy Ico Shere-t egyszerűsítetünk húsz 
oldalú ikozaéderré. Most induljunk valami hasonló alakzat-
ból, és növesszünk rá tüskéket. Mivel ehhez még nem talál-
ták fel a módosítót, meg kell elégednünk a saját gyártású 
modellezéssel. 

Kezdjük hát egy Ico Sphere (ikozaéder alapú gömb) létreho-
zásával. Gyorsan válts át Szerkesztőmódba (TAB).

(CTRL+TAB)-bal válts oldalkijelölésre. Minden oldalt sugár 
irányban egyedileg ki kell húznunk  (Extrude), hogy kiala-
kuljanak a bütykök. 
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Kipróbálhatod  ehhez  az  (E)  gyorsgombot,  de  meglátod, 
nem elképzeléseid szerint húzza majd ki  a lapokat.  Tedd 
meg  azért,  hibáiból  tanul  az  ember.  (CTRL+Z)-vel  vond 
vissza a változtatást.

Helyete használd az (ALT+E) kombinációt.  Ezzel  először  
megkérdezi, mit is szeretnél. Válasszuk az Individual Faces 
(egyedi  lapok)  lehetőséget,  és  húzzuk  ki  az  oldallapokat
nagyon-nagyon messze. Nem kell megijedni, a cél az, hogy 
minél kisebbek legyenek ezek a távolítással. 

Katints  a  művelet  végén  bal  egérgombbal.  Most  az  (S) 
gombbal kezdd el a középpont fele kicsinyíteni, a képen lát-
ható nagyságig.

Botond buzogánya nyél nélkül. 
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Most  újra  alkalmazdaz  egyedi  lapokkal  való  kihúzást: 
(ALT+E) > Individual Faces. Körülbelül ilyen eredménnyel. 
Térj vissza Táregymódba (TAB). 

Talán most tudod értékelni a módosítókat. Mivel nem volt 
erre eddig megoldás, az előző percekben magunknak kel-
let modellezni egy tüsilabdát. 

Ezt a mérges, éles szegélyű gömbhalat lássuk el egy Subdi-
vision Surfaces (felosztásos simítás) típusú módosítóval.

A tökéletes simításhoz használd az  Eszköztár > Shading >  
Smooth parancsát.

Most már csak megfelelő anyagtulajdonság kell,  hogy ne 
gipszöntvénynek,  hanem mikroszkopikus  állatkának néz-
zék a teremtményünket.
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Rövid kísérletezés után én a Glass (üveg) típusú shadert vá-
lasztotam.

Az animáció és renderelés hasonlóan előkészíthető, mint a 
korábbi jeleneteknél. 

Ha készen vagy ezzel, akkor már csak a végső vágás marad, 
ami – a korábbi előkészítésnek hála – pillanatok alat elké-
szíthető.
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A film vágása

A jelenetek forgatásával készen vagyunk. A jelenetek kép-
kockáit tartalmazó mappa tele van, összesen 1500 képkoc-
kányi renderelt anyaggal. 

A  Mikrovilag mappából  nyisd  meg  a  vagas.blend állo-
mányt, melyben korábban az animatikot elkészítetük.

Mentsd  más  néven  az  állományt  (pl.  vegsovagas.blend), 
majd töröld ki (X vagy DEL) a „flmsávokat”, melyeknek a 
helyére beillesztjük a végleges képsorokat.

Mivel korábban a markerekkel előkészítetük a flm végső 
vágását, már nem lesz gond ezen beállító képek elvesztése. 

Menj az első képkockához az Idővonalon. Az Add > Image 
paranccsal tudsz képsort elhelyezni a hang feleti sávon.

Keress rá a  01rendereles  mappára, és nyomd meg az (A) 
gombot, hogy minden képet kijelölj az átvételhez. Az Add 
Image Strip gombbal, mi a jobb felső sarokban van, helyezd 
el a videoszerkesztőbe az első mappában levő képsort.
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Ne ijedj meg, hogy az első snit túllóg a markeren, hiszen  
ez volt a legrövidebb, bevezető, zenei rész. 

Tulajdonképpen mindenhol egy kicsit túlterveztük a felvé-
telt,  hogy  legyen  lehetőségünk  nagyobb  anyagot  vágni. 
Amíg nem vagyunk igazán prof animátorok, némi túlfor -
gatással  lehet  biztosítani,  hogy  legyen  mozgásterünk  a 
szerkesztésben. 

Ugyanígy  hívd  be  a  többi  mappából  is  a  képsorokat.  A 
Blender igyekszik úgy elhelyezni őket, hogy ne ütközzenek 
ugyanazon sávon.  Természetesen a  (G)  gombbal  bárhova 
áthelyezheted,  nem csak ugyanazon sávon,  de sávok kö-
zöt is. 

S most már saját érzéked szerint fejezd be a vágást.  Ot, 
ahol a felvételek hosszát át kell állítanod, jelöld ki a snit 
elejét vagy végét jelző kis nyilacskát, és a (G) gombbal vál-
toztasd meg azok elhelyezkedését. Ha egy egész a flmcsí-
kot akarsz mozgatni, akkor a közepére katints.

Ha készen vagy,  rendereld a  végleges  flmet,  amit  vágás 
után nagyon gyorsan el fog végezni a program. 

Gratulálok! Ez volt az első igazi látványanimációs flmed.
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Tanulni, tanulni...

Nem  vagyunk  születet zsenik.  Minden  alkotás  mögöt  
hosszú  évek  tudatos  vagy  akaratlan  tanulása  van.  Ez  az 
igazság. Nem a semmiből alkotunk. S ez nagyon felszabadí-
tó lehet annak, aki mindig a  naegy ötletre  vár, de az sosem 
érkezik…

Amikor kiszemelek magamnak egy műfajt, melyben alkot-
ni szeretnék, számos kiváló, inspiráló felvételt gyűjtök ösz-
sze. Hála a videomegosztóknak (Vimeo, Youtube), nem kell 
mindent beszerezni, letölteni. Ezen médiumok sokféle szol-
gáltatása közt találsz gyűjtemények, válogatások szerkesz-
tésére szolgáló lehetőséget.

Egyik kedvenc lelőhelyem, a Vimeo.

Fontos szempontom a kiválasztás. Mi az, ami miat egyik  
vagy másik flm mellet döntötem? Figyelem, mivel érin -
tetek meg ezek az alkotások. Refektálok, miért  választot-
tam éppen ezt vagy azt. A látvány, a technika, vagy zenei 
ötlet varázsolt el? A legfontosabb kérdés talán mégis a mi-
liő… Milyen világot építet fel az alkotó? Hogyan vont be  
engem abba? 

Ha elég sok flmet néztél, már meg tudod különböztetni a 
látványanimáció stílusait,  zsánereit.  S erre szükséged lesz 
akkor, ha már te is alkotsz.
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Stefan Grimm technikai ihletésű látványanimációja (Forrás: Béhance)

Előző flmed például egy mikrovilágot mutatot be. A fenti  
képen egy felhasználói  felület  látszik.  Így  első  ránézésre 
nem lehet tudni, hogy weblap, játék, applikáció, esetleg egy 
tudományos-fantasztikus flmből származó képkocka.

Nos,  ez valamiféle futurisztikus,  holografkus felület.  Őse 
talán a vadászrepülőkön alkalmazot HUD (Head-up Disp-
lay), amely a pilóták elé vetítete azokat az adatokat, me-
lyekre éppen szükségük volt.

Ha már felfedezted a  stílust,  megvan az atmoszféra,  ele-
mezned kell a részleteket. Az alkalmazot tárgyakat, trük -
köket. Ilyenkor én például darabjaira szedem a flmet. Újra-
és újra megnézem egy-egy részletét, igyekszem felfedezni 
azokat a technikai eljárásokat, amivel éltek. 
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S igen, legtöbbször felteszem magamnak a kérdést,  vajon 
én el tudnám-e készíteni, s ha igen, hoegyanó

A korábbi képeken például van 

• egy alapháló (négyzetrács) ;

• néhány lekerekítet végű, nyomógombként funkcio -
náló téglalap;

• körívek mintázatokkal;

• egy hengerpalást;

• feliratok.

Ilyen futurisztikus felhasználói felületeket bűvölnek a  Kü-
lönvélemény c.  flmben,  a  Vasember  második  részében,  a 
Star Trekben, a Végjátékban, a Prometheus-ban – hogy csak 
néhányat említsek az utóbbi évek flmterméséből. A dolog 
benn van a levegőben…

Őszintén,  holnap reggel  bele  tudsz nézni  úgy a  tükörbe, 
hogy te még nem terveztél futurisztikus, holografkus inter-
fészt? Naná, hogy nem!

Kezdhetjük?...
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The Grid – a Rács

Az első számítógépes nemzedék meghatározó élménye volt 
a Tron c. flm, mely arról szólt, hogy egy programozó bejut 
a számítógép világába. Az 1982-es flm folytatása majdnem 
harminc évvel később készült el, melyben a programozó fa 
az apját keresi ugyanit. A Rácson. Ahol az első fénymotor-
párbajokat játszotuk. 

A Tron: Örökség főszereplői a Rácson. Rossz nyelvek szerint a filmet Balaton-
arácson forgatták. 

Futurisztikus felhasználói felületünk alapsíkját,  a digitális 
világ  kockás  papírját  fogjuk  elkészíteni  a  Blenderben  az 
Array (sor, tömb) módosító segítségével.

Az  Array módosító megsokszorozza a kijelölt tárgyat. Ha 
az egy fa, fasor lesz belőle. Ha egy léc, akkor kerítés. 
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Az alaptárgy elkészítése ♦ Hozz létre egy új állományt, 
majd  töröld  le  az  alapkockát.  Helyezz  el  egy  rácsot:  
SHIFT+A > Grid. Most menj át Szerkesztőmódba (TAB).

Nyomd meg a (W) gombot, és a Specials menü első elemére 
katintva oszd fel újra a rácsot. De!… Nagyon fgyelj, mert 
ilyenkor lehet még paraméterezni a felosztást: Állíts be az 
Eszköztáron dupla vágást (Number of Cuts = 2).

Így az eredetileg 9 × 9-es rácsot 27 × 27-esre alakítotuk. 
Nem számmisztika: Szeretném, ha lenne középső oszlopa 
és sora ennek a rácsnak, tehát páratlan számú oldal kell. 

Válts most lapkijelölő módba (CTRL+TAB).

18. Módosítók
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Jelöld ki kereszt alakban a középső sort és oszlopot! Erre 
több módszert is ajánlhatok. 

Emlékszel a Blender kijelölési ABC-jére? Használd a (B) ki-
jelölést  (gumikeret).  Rajzolj vele egy téglalapot a középső 
oszlopra. Mindent lapot megjelöl, amit érint. Ha ugyanígy 
kijelölöd a középső sort, akkor azt hozzáadja.

Gyakorlásként nyomd meg most az (A) gombot, mely a egy 
„kapcsoló” – vagy mindent, vagy semmit se jelöl ki. Eltűnik 
az összes aktivált lap. Tudsz-e más módszert?

SHIFT-tel  egyenként  jelölgetnéd  a  lapokat?  Kínzásnak 
megfelel, de inkább maradjunk barátok. A (C), azaz  Circle 
típusú kijelöléstől is megkímélnélek. Annak ellenére, hogy 
az egér görgőjével állíthatod a kijelölőecset nagyságát, ke-
vés ember tudja kézremegés nélkül végigfesteni a keresztet.

A  gyors  módszer  a  következő:  A  négyzetrács  középső 
négyzetén  (SHIFT+ALT)  gombokat  megnyomva  katints 
jobb egérgombbal a két egymás melleti oldalélére. 

Ezt a módszert egyébként arra találták ki, hogy körkörösen 
ki tudjanak jelölni egy laphoz csatlakozó más lapok soroza-
tát – úgy, mint a földgömbön a délkört.
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Megvan a kereszt alakú kijelölés alapja, folytathatjuk en-
nek formázását.

SHIFT-tel jelöld hozzá azokat, melyek a középső lap csú-
csaival érintkeznek. Ezt az alakzatot szeretnénk meghagy-
ni. S kitörölni a felesleges, lapokat. De hogyan lehetne el-
tüntetni ezeket? 

Megfordíthatod a kijelölést a  3D ablak alján levő  Select >  
Inverse menüparanccsal. Utána nyomd meg a (DEL) vagy 
(X) gombot, és válaszd a lapok (Faces) lehetőséget.

A közepén kicsit megerősítet kereszt elkészült. Felesleges  
Szerkesztőmódban maradnunk.  (TAB)-bal  válts  vissza 
Táregymódba. 
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Ez a kereszt lesz az alapeleme egy sorozatnak, amit a négy-
zetrácshoz létrehozunk. A módosítók  Generate oszlopában 
találod meg az Array Modifer-t. A következő feladatokban 
elég sokat fogjuk használni.

Sorakozó! ♦ A másolatok számát állítsd 30-ra, a relatív el-
tolást pedig 1.1-re. Így elválnak egymástól az elemek. 

Ha négyzetrácsot szeretnél, ugyanerre az alapformára még 
egy  módosítót  kell  alkalmaznod,  mely  nem X,  hanem Y 
irányba sokszorozza az elemeket.

Balra a második sorkészítő módosító (Array Modifer) beállí-
tásai. A Relative Ofset (viszonylagos eltolás) első értéke az 
X-irányú, míg a második az Y-irányú eltolásért felelős.

Kicsinyítsd le és helyezd át a rácsrendszert a koordináta-
rendszer közepére!
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Színezés ♦ A világban nem lesznek segédfények, maguk a 
tárgyak fognak világítani, ahogy egy becsületes hologram-
hoz illik. Töröld ki a lámpát! Majd a Tulajdonságok-ablak-
ban  állítsd  feketére  a  világ  hátérszínét.  Oszd  fel  úgy  a 
munkaterületet, hogy legyen egy viszonylag kicsi ablakod, 
ahol valós időben nézheted az eredményt,  aztán egy na-
gyobb, ahol modellezhetsz, végül egy, melyben az anyago-
kat  felépíted  majd.  Az  első  kető 3D  ablak,  a  harmadik 
Node Editor (Csomópontszerkesztő).

Jelöld ki a rácsozatot. Hozz létre egy új anyagot a Csomó-
pontszerkesztőben „Rács” néven. Töröld le a difúz anyagtu-
lajdonságot és az Add > Shader > Emission menüparanccsal 
készíts egy kissé türkizes árnyalatú, világító anyagot.

Végre felfénylik a rács… 

Uh, most látom csak, valamit elfelejtetem! 
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Bocs, tényleg… Azt szeretem volna, ha minden kereszt kö-
zepén még egy kis lyukacska is lenne. Valahol látam ha-
sonlót, és ez most jobban tetszene. 

Mielőt kitörölnéd és újraszerkesztenéd az egészet, vagy azt 
gondolnád, ebben a könyvben aztán bármit faksznizhat a 
szerző – csak azt akarom megmutatni, hogy egy ilyen visz-
szamenőleges változtatás is szépen végigfut a rendszeren. 
A módosítók hűségesen követik az eredeti objektum geo-
metriájában bekövetkező változásokat.

Szóval nem kell új modellt kreálni. Elég, ha kijelölöd a rá-
csozatot, majd visszatérsz  Szerkesztőmódba (TAB). A féle-
lem, hogy az egész „katonai temetőt” meg kell majd változ-
tatnod,  egyenként  belevésve  a  keresztekbe  a  kis  hiányt, 
alaptalan. Ilyenkor ugyanis csak az eredeti objektum szer-
keszthető.

Nagyíts rá felülnézetből erre az elemre. Jelöld ki a közepén 
elhelyezkedő lapocskát, és töröld ki (X | Del). Amikor rá-
kérdez, hogy mit, válaszd a Faces (lapok) parancsot. 

Íme az új sorminta. Ezzel több dolgunk nem lesz, tedd át az 
egész rácsrendszert a tizedik rétegre (M). 

Mentsd a munkádat modositok001.blend néven. Bármi köz-
bejöhet:  A Blender lefagy, törökök megjelennek Mohács-
nál, Paks ideiglenesen leáll. Ne vesszen el a munkád!

Folytasd az első rétegen!
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Körív készítése

Azt már látad, hogy egy tárgyra akár többféle módosító is 
alkalmazható. Ezt a lehetőséget fogjuk felhasználni az aláb-
bi körív elkészítéséhez. Talán nem is gondolnád, hogy ez a 
test négyszöglapokból áll…

Nyomd  meg  a  (SHIFT+C)  billentyűzetkombinációt,  ami 
visszahelyezi a 3D kurzort a tengelyek metszéspontjába, az 
origóba. 

Hozz létre it egy kör alakú görbét:  SHIFT+A > Curve >  
Circle. Görbe típusú objektummal még nem találkoztál. Ha-
marjában csak annyit, hogy gyakran használjuk ezeket más 
testek irányítására, vagy deformálására. Térben csak akkor 
látszanak, ha síkidommá alakítod őket.  Jelen esetben egy 
lyukas körvonal, ami renderelésnél sem hagy nyomot. 

Növeld a kétszeresére a következő módszerrel: Nyomd meg 
az (S) billentyűt, majd a „2” számot, és a végén ENTER-rel 
zárd a műveletet.

Hozz létre ugyanit egy síklapot (Add > Mesh > Plane). En-
nek nagyságát csökkentsd az egy tized részére, ugyanazzal 
az eljárással, ahogy a kört nagyítotad: Nyomd meg az (S) 
billentyűt,  majd  a  számbillentyűzeten  írd  be  0.1 –  aztán 
zárd ENTER-rel. (Blenderben tizedesjelként pontot és vesz-
szőt  is  használhatsz…)  Alkalmazz  egy  Array (sor)  típusú 
módosítót, ahol a másolatok számát növel nagyjából 40-re. 

Lapozás után ellenőrizd, ugyanazt kaptad-e, mint én.
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Mint korábban a rácshálónál, X irányba megsokszoroztad 
az alapobjektumot. Most vigyázz:  uegyanerre a néegyzetlapra 
egy másik módosítót is alkalmazunk. Ez a Curve (görbe). 

Nem történik semmi. Miért? Mert nem tudja a program, 
melyik az a görbe típusú objektum, amivel módosítani, tor-
zítani akarod az alaptestet. Üres az egyik mező. Az Object 
mezőben kell ugyanis rámutatnod arra a görbére, ami létre-
hozza azt a módosítást. Kétféleképpen is megteheted: Bele-
katintva a szövegbeviteli mezőbe, ot név alapján kijelölöd, 
vagy a kis pipetával megkeresed a görbét (BézierCircle).

Íme. A négyzetek sorozata követi a görbe vonalát.

Nos,  alkotunk egy egyszerű,  de  látványosan animálható 
síkidomot. Nézzük meg gyorsan a tulajdonságait! A jobb 
oldalon, a módosítók listájában először az Array (sor) módo-
sítót paraméterezzük. A másolatok számával (Count) a kör-
ív  hosszát  tudod  növelni  –  azaz,  hogy  mennyire  fusson 
körbe a sok kis négyzet a kör mentén.
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A  Relative  Ofset (viszonylagos  eltolás)  értékével  pedig  a 
négyzetek közöt fx távolságot adhatsz meg. 

Ennek a panelnak van még néhány érdekes tulajdonsága, 
de most nincs időnk a paraméterekkel játszadozni. Nézzük 
inkább, mi történik, ha a négyzetekből álló ívnek megmoz-
gatjuk a mozgásvezérlő manipulátorait. 

Y irányba mozgatva  (zöld nyíl)  a tárgyat,  sugár irányban 
nagyíthatóvá válik. X irányban mozgatva (piros nyíl) pedig 
a kör középpontja körül forog. Mindketővel nagyon érde-
kes animációkat lehet készíteni.

Hasonló,  érdekes  mozgásokra  számíthatsz  akkor  is,  ha  a 
kört kijelölve,  azt  mozgatod ugyanezekkel  a manipuláto-
rokkal.  A körrel  együt halad és változtatja  a  nagyságát,  
vagy halad és pörög a négyzetobjektumok sorozata.

Érdemes még egy kört futni a test vagy a körvonal nagyí-
tásával is – ez egy újabb animációs lehetőség. 

Persze vigyázz, a sok próbálgatás után ne torzuljon az így 
felépítet rendszered. (CTRL+Z)-vel vond vissza eredeti for-
májába  állítva  a  rendszert.  Ha  túlszaladnál  ezen, 
(SHIFT+CTRL+Z)-vel visszaléphetsz.

Talán látszik, hogy a módosítók alkalmazásával, kombiná-
cióival  olyan,  a  látványanimációban  gyakorta  használt 
rendszereket lehet felépíteni, melyeknek véletlenszerű pa-
raméterezésével vagy mozgatásával érdekes animációs ha-
tásokat érhetünk el.
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Színezd a korábban beállítot „Rács” színűre a körívet. Je -
löld ki a két objektumot (a görbét és a módosítókkal létre-
hozot körívet), és (M) billentyűvel rakd át a kilencedik ré-
tegre ezt a szerkezetet. SHIFT-tel bekapcsolgathatod azokat 
a rétegeket, melyeken objektumokat találsz. Ha több réteg 
is aktív, akkor az újonnan létrehozot tárgyakat a legutoljá-
ra kijelölt rétegre helyezi a program. 

Ne felejtsd el menteni a munkádat! Most egy másik néven: 
modositok002.blend. 

Mire jó ez? Nem sok helyet foglalnak a mentet változatok 
a  hátértáron,  viszont látod a  munkád mérföldköveit.  Ha 
valahova vissza kell térned, mert elrontotál valamit, it lesz 
az összes verzió…
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Hengerpalást-minta

Az előző körív logikáját követve hozzuk létre a fenti objek-
tumot. (SHIFT+C)-vel tedd a 3D kurzort a középpontba. It 
hozz létre egy körvonalat (Add > Curve > Circle). 

Most egy másik módszert mutatok a pontos nagyítására: A 
3D  ablak jobb  oldalán  bűvöld  elő  az  ablakhoz  tartozó
Tulajdonságpanelt (N), s ennek keresd ki a Scale (Méretezés) 
mezőit.  Nagyon  bajos  mindhárom  mezőbe  külön-külön 
adatokat írni, de van a Blendernek egy gyorsabb módszere. 
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Bal egérgombbal katints rá az első szövegbeviteli mezőre, 
és az egér gombját benyomva mozogj lefele, együt kijelöl-
ve mindhárom mezőt. Ezek elszürkülnek, balra ugrik min-
den szám,  és  elég  az  egyikbe  beírnod  a  2-es értéket,  az 
megjelenik a többin is. Gyakoroljuk ezt a módszert a követ-
kező négyzetel is!

Az origóban hozz létre egy síklapot (Add > Mesh > Plane), 
majd a 3D ablak jobb oldalán a Tulajdonság-panel Scale me-
zőit bal egérgombbal jelöld végig, és 0.1-re a méretezd.

Használd az előzőhöz hasonlóan az Array (sor) módosítót a 
négyzetre úgy, hogy egy kis távolságot állíts be az egyes 
elemek közé. 

Most forgasd el 90°-kal az X-tengelyhez képest.  Gyorsbil-
lentyűvel: (R > X > 90 > ENTER). Vagy a Tulajdonságpanel 
Rotation (forgatás) első mezőjébe beírva az értéket.

Ha készen vagy, hívd elő a  Curve (görbe) módosítót is, és 
annak  Object mezőjében  jelöld  be  a  jelenlegi  görbét,
(BezierCircle.001).  Az  elkészült  hengerpalástra  csavarodó 
körívet színezd egyelőre „Rács” színűre,  majd (M) billen-
tyűvel küldd a 8. rétegre a körvonalat és az így elkészítet 
objektumot. Mentsd a munkádat modositok003.blend néven.
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Pöttyös henger

Készítsd el a görbületet biztosító körvonalat (Add > Curve >  
Circle). Növeld a kétszeresére. 

Alaptárgynak  most  nem síklapot,  hanem még  egy  ilyen 
kört hozunk létre. Korábban tapasztaltad, hogy ezek a ren-
derelés során nem látszanak. Ez igaz is, amíg 3D objektum-
ként kezeli a Blender. 

Keresd meg a Tulajdonságok-ablak görbe-ikonját, és az így 
láthatóvá váló panelen jelöld be a  Shape (alak) mezőben a 
2D gombot. 

Tömör árnyalásnál rögtön látszik a különbség.
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Most kicsinyítsd le ezt a kört 0.004-szeresére. Alkalmazd az 
Array, majd a Curve módosítókat. A pötyök közti távolság 
legyen 2 egység. Semmi mást nem teszünk tehát, mint az 
első,  köríves feladatunkat megismételjük,  négyzet helyet 
körrel,  s  némi  „távolságtartással”  a  körvonal  objektumai 
közöt.

Forgasd  el  ezt  a  körlapot  az  X-tengely  mentén  90°-kal. 
Gyorsbillentyűvel: (R > X > 90 ENTER). Vagy a Tulajdon-
ságpanel Rotation mezőjébe írd be a 90-es értéket.

Az eredmény nagyon hasonló, mint az előző hengerpalást-
minta volt, csak most pötyökkel. Fejeljük meg ezt néhány 
réteggel! 

Kérj még egy Array módosítót, ahogy a rácshálónál teted.

A program persze nem tudja kitalálni, milyen irányba sze-
retnéd sokszorozni a kört. A Blender az X irányt választot-
ta, míg mi inkább Y irányban terveznénk. 

Nullázd le az első szövegbeviteli mezőt, a másodikba meg 
írj 2-es értéket, hogy ugyanolyan távolságba kerüljenek a 
rétegek, mint korábban a pötyök. Legyen 4 rétegünk.
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Amikor elkészült a rendszer, körülbelül ilyennek fog látsza-
ni. Hozz létre egy új anyagot „Pötyös” néven, mely fényki-
bocsátó tulajdonságú, és világos türkiz színű.

Tedd mindkét tárgyat a 7. rétegre, majd kapcsold be ezeket 
a rétegeket (SHIFT), és nézd meg, hol is tartunk.

Összefoglalva, módszerünk a következő volt:  Array módo-
sítóval  sokszoroztunk egy tárgyat,  majd  azt  egy görbére 
futatuk. Az eljárásnak sok előnye van, de néhány hátrá-
nya is akad.
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Előnye a rugalmasság ???: Folytonos és „szaggatot” tárgyakat  
is létrehozhatsz, s biztosítani tudod ezek egymásba való át-
alakulását egy animáció során. 

Minden hátrányát viszont egy ősokra lehet visszavezetni – 
sok tárgyból felépülő a bonyolult alakzat. Ennek két követ-
kezménye lehet: Ha nem vigyázol, az ív mentén körbefutó 
síkidomok kissé  darabossá,  sarkossá tehetik az alakzatot. 
Ez az eredeti objektum felosztásával (Subdivide) viszonylag 
könnyen elkerülhető. 

Ha nem túl nagy a sokszorozott objektumok száma, inkább anyacsavarra ha-
sonlít az objektum, mint szép vonalú ívre.

Az igazi probléma akkor jelentkezik, ha textúrát, mintáza-
tot szeretnél az alakzaton elhelyezni. Minden másolt objek-
tum ugyanis saját magához igazítja a mintát, mint ahogy 
az alábbi képen is láthatod.

A balra látható kísérleti textúra sugarasan helyezkedik el a körgyűrű-cikken, 
mivel minden ismételt és görbített lapon egyedileg terül el.
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Ezek az alakzatok tehát  textúrázásra alkalmatlanok.  Néz-
zük, hogyan lehet áthidalni ezt a problémát egy másik mó-
dosító használatával…

Mentsd a munkádat modositok004.blend néven. Aktivizáld a 
hatos réteget, most csak ezen fogunk dolgozni! 

Srófolás

Ezzel a módszerrel szép köröket, körgyűrűket, körcikkeket, 
körgyűrű-cikkeket lehet készíteni, melyek animálhatóak és 
textúrázhatóak. Kicsit többet kell  bíbelődni az előkészítés 
során, de megéri.

A hatos rétegen egyelőre üres a tér. Helyezd vissza a  3D 
kurzort a tér közepére (SHIFT+C), felülnézetben (7). 

Már ismered a görbéket. Jó néhány körvonalat használtál 
korábban – vezérlő alakzatnak. 

Most ugyaninnen kérd az  Add > Curve > Bezier alakzatot. 
Egy ilyen kis kukac lesz az eredmény. 

Ha  dolgoztál  már  vektorgrafkus  programmal,  akkor  ez 
ugyanaz,  mint  amit  az  Inkscape  programban útvonalnak, 
vagy a CorelDraw-ban, amit Bézier görbének hívunk.

Most menj át Szerkesztőmódba (TAB) billentyűvel. Így nem 
kukacnak, hanem hernyónak látszik az alakzat…
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A halszálkás  görbe  elején  és  végén  levő  csomópontokból 
két-két  irányszakasz nő ki,  melyeknek végén  iránypontok 
vannak. Ezekkel a pontokkal tudod formálni az alakzatot. 
Jobb egérgombbal kijelölheted a bajuszkáknak a végét, azaz 
az iránypontokat, majd (G) gombbal mozgatod. De…

Egyenes szakaszra van szükségünk, amit elég nehéz egérrel 
pontosan kihajlítani. Jelöld ki a csomópontokat SHIFT-tel 
egymás után, vagy (A)-val egyszerre.

A csomópontok fajtáit jól elrejteték a 3D ablak alsó, Curve 
menüjében: Control Points > Set Handle Type > Vector. Oké, 
van rá gyorsbillentyű is (V). A vector típusú kontrollpon-
tok egyenes szakasszá alakítják eddigi görbénket. 
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S hogy mit is akarunk formázni vele? Hát egy  csuringát.  
Nem tudod, mi az? És így: tyurunga? Semmi?...

Ausztrália őslakói használnak ilyet kultikus zeneszerszám-
ként, de nagy távolságokra való üzenetátadásra is. Egy zsi-
neg végére kötöt falap,  amit a fejük fölöt pörgetek,  és  
olyan hangja van, mint egy propellernek.  Bull-roarer? Így 
megvan?… Mikor voltál utoljára az ötödik kontinensen?

Nekünk  pontosan  ilyen alakzat  kell!  Eddig  nem nagyon 
foglalkoztunk vele, de a tárgyaknak van  eegy forgatási kö-
zéppontja (Pivot Point). Egy narancssárga pöty, általában a 
test közepén, de onnan el is mozdítható. Ha így, Szerkesztő-
módban elmozdítod az egész görbét  oly módon,  hogy az 
utolsó halszálkát (balra van!) elviszed a második egységig, 
akkor a forgásközéppont az origóban marad. E körül tudjuk 
majd  forgatni  az  ábrán  hangsúlyozotan,  feketével  jelölt 
egyenes szakaszt, ami megfelel a kiegyenesítet görbédnek.

Válts vissza Táregymódba (TAB), ahol már tisztábban, szőrö-
zés nélkül látszik, hogy hol helyezkedik el térben a szakasz.

Most keresd meg a jól ismert módosítókat, és válaszd a…
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… Screw (csavar) típusút. Látható, hogy a görbékhez keve-
sebb módosítót kapcsolhatunk, de ez ne szomorítson el.

Azt ígértem, hogy egy szép ívű síkidomot kapsz.  Erre ez 
let belőle. De ne félj, egy módosítót lehet módosítani…

Értelmezzük a panel mezőit: Axis – az a tengely, ami körül 
forgatunk. Jelen esetben a Z. Angle – a szög, amivel forga-
tunk. Steps – hány lépésben tesszük ezt. Ez utóbbi növelé-
sével  egész  szép,  sima  ívelésű  síkidomot  kapunk.  Mini-
mumra  csökkentve  pedig  szabályos  háromszöget,  négy-
szöget,  stb.  40–100 körül  már  elég  tűrhető az eredmény.
De most jön a legfontosabb! A Render Steps értékkel adha-
tod meg ugyanezt a pontosságot renderelésnél.  Ezt érde-
mes 100 körül tartani, ha nem akarsz néhány száz képkoc-
kát újraszámolni, mert ot kijön ez a hiba! Mellékesen: Az  
Angle értékkel kinyithatod a gyűrűt!  Természetesen ez a 
tulajdonság is animálható…
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Mintázat ♦ S most jöjjön a fő ok, a textúra, ami miat lét -
rehoztuk ezt fajta tárgyat. Készíts egy új anyagot, melynek 
legyen a neve: „Mintás”. A típusa: fényforrás (Emission). 

Menj át a csomópontszerkesztő ablakba, s bogozd össze a 
fenti csomópont-szerkezetet: 

• SHIFT+A > Texture > Image Texture, ami betölti majd 
a képet. 

• SHIFT+A > Input > Texture Coordinate, ami vezérli a 
felületre való feszítését. 

• Az  Image Texture csomóponton töltsd be a  025_he-
xa.png képecskét. 

A fenti kép szerint ez egy varangyos békának az alfele. Bal-
ra látható az eredeti minta… Ezzel összehasonlítva inkább 
azt mondanánk, kissé túl let nagyítva. 
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A probléma megoldható egy csomópontal, ami a SHIFT+A 
> Vector > Mapping menüparanccsal jön létre. 

Ezt gyakran használjuk textúrák átméretezésére, áthelyezé-
sére,  forgatására.  Rakd a  Texture  Coordinate és  az  Image 
Texture csomópont közé.  Scale (méretezés) értéknek pedig 
írj be úgy 20-at az X és Y értékmezőkbe.

A hatos rétegen elkészült  az alakzat.  Terminátorharisnya-
mintázatal. Ha a többi réteget is bekapcsolod – nem kell 
SHIFT-tel végigkatintgatni. Elég, ha SHIFT és a bal egér-
gombnak lenyomása közben végighúzod az egeret az akti-
válandó rétegeken. Egyelőre olyan, mint egy esetlen gáz-
gyári  reklámflm egyik  kockája,  de  ne  felejtsük el,  hogy 
ezek még csak alapelemek, melyeket kiinduló objektumok-
ként használunk.

Mentsd a munkádat  modositok005.blend néven, és menj az 
ötödik rétegre. It fogjuk létrehozni a hologramot…
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Hologram

Parancsold vissza a 3D kurzort az origóba (SHIFT+C). Hozz 
létre it egy kockát, majd válts elölnézetbe (1). Ellenőrizd,  
hogy  ortografkus (5) nézetben vagy-e. Perspektivikus tor-
zulással nehezebb lenne pontosan dolgozni. Forgasd el 45°-
kal  a  tárgyat  úgy,  hogy  az  élén  álljon.  Első  módszer: 
nyomd meg  az  (R)  gombot,  és  a  CTRL-lal  kényszerítsd, 
hogy  5°-onként szaggatva forduljon. Az elegánsabb: Gon-
dold át, melyik tengely mentén kell forgatnod – a piros (X) 
nem lehet, a kék (Z) nem lehet, a harmadik, meg nem lát-
szik. Ez az, ami a monitortól a fejed felé indul: az Y. Akkor 
(R) a forgatásért, (Y)-nal megadod a tengelyt, (45)-tel pedig 
az elforgatás szögét, és zárod ENTER-rel.

Bármelyik módszert is választotad, ez látszik. Most menj 
oldalnézetbe (3). És forgasd be úgy, hogy a csúcsára álljon.

A  Z  tengely  lesz  ugyanis,  amely  mentén  megpörgetjük, 
mint hologramot. Azaz függőlegesen.
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(SHIFT+D)-vel  ketőzd az objektumot,  de ne mozdítsd el, 
hanem zárd le a műveletet egy ENTER megnyomásával.

A  másolatra  alkalmazd  a  Wireframe (drótváz)  módosítót, 
ahol a Tickness (vastagság) értéket növeld némileg.

A drótváznak hozz létre egy új anyagtulajdonságot „Drót” 
néven, mely legyen Emission (fényforrás) jellegű.

Jelöld ki a kockát. Ez a tárgy legyen „Kocka” névvel elneve-
zet anyagú,  üveg (Glass) tulajdonságú, s a  Roughness (ér-
desség) érték növelésével érd el, hogy olyan legyen, mint a 
homokfúvot üveg.

Parentolás ♦ Mivel ez a két tárgy együt fog mozogni az  
animációban, össze kell kapcsolnod őket. Jelöld ki a drótvá-
zat,  majd  SHIFT-tel  a  kockát.  Nyomd  meg  a  (CTRL+P) 
kombinációt, s válaszd az első parancsot. Ezután bármilyen 
transzformációt végzel a kockán, azt utánozza a drótváz is.

Roló-efektus ♦ Erre az összetet tárgyra kell még egy ér-
dekes  animációs  hatást  alkalmaznunk.  A  hologramnak 
alulról felfele kell felépülnie.

18. Módosítók



337

(Forrás: freedee.hu)

Manapság  a  3D-nyomtatók  alkalmazzák  ezt  a  technikát: 
Alulról felfele rétegekből építik fel a tárgyakat. 

Boolean módosító ♦ Ennek megvalósításához egy újabb 
módosítóval  kell  megismerkedned,  ez a  Boolean (halmaz-
művelet). 

Ha elkószált volna a 3D kurzorod, nyomd meg a (SHIFT+C) 
gombokat, és hozz létre egy akkora kockát, ami elnyeli a 
másik két objektumot. 

Válts át  drótváz árnyalásba (Z), hogy lásd a rejtet tárgya -
kat. Most jelöld ki  az eredeti, tömör kockát, melyet körül-
vesz a drótváz. Ezt nem is olyan könnyű, hiszen összeakad-
hatunk a másik objektummal. 
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Alkalmazd a  Boolean (halmazművelet) módosítót, a bal ol-
dalon levő beállításokkal.

Az Operation (művelet) legördülő három eleme – unió, met-
szet, különbség – közül alkalmazd az utóbbit (Diference). Az 
Object (tárgy) mezőben a pipeta segítségével jelöld meg a 
nagy, takaró kockát. Mozdítsd el ezt kicsit felfele.

A dolog kezd olyan izgalmassá válni, mint egy ábrázoló-
geometriai feladvány. A két kocka metszősíkját kiemeltem 
a fenti képen, ezt te is látod a gépeden, de csak egy vékony 
fekete vonalként. 

A nagy kocka belevágot kisebbe, de nem igazán méltózta -
tik eltakarodni a jelenetből. Kifogunk rajta! 

Jelöld  ki  a  nagy  kockát,  nyomd meg  az  (M)  gombot  és 
küldd el az ötös réteg alati 15.  rétegre. Mivel ez a réteg 
nincs bekapcsolva, ezért nem is látszik az, ami rajta van. 
Olcsó megoldás. De most megteszi. És… voilá!
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Egy  másik  nézetből  mutatom  az  eredményt.  Most  még 
olyan, mintha egy edénybe vizet öntenénk, de közel járunk 
a megoldáshoz. Jelöld ki most a drótvázat.

Alkalmazd  erre  is  a  Boolean (halmazművelet)  módosítót. 
Beállítások:  Diference,  azaz  különbség,  kivonás.  A  tárgy 
pedig legyen ugyanaz a nagy kocka. 

Mivel éppen most küldtük el a 15-ös rétegre, katints egy-
szerűen ebbe az  Object mezőbe, és a válaszd a legnagyobb 
számú kockát – hiszen ez készült utoljára. 

Ha most visszakapcsolod az alsó réteget, elmozdíthatod fel-
fele a kivonó kockát, majd újra kikapcsolva megnézheted 
az eredményt: A fedőkocka mindkét objektumból ugyan-
akkora részt csonkol. Előkészítetük az utolsó objektumot 
is az animációhoz! Minden elismerésem!

Rács, körív, hengerpalást, pötyös henger, terminátorharis-
nya-mintás körgyűrűív és hologram. Mind ot vannak a ré-
tegeken. Mentsd el az állományodat hologram.blend néven, 
mert a következő fejezetben szükséged lesz rá!
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19. 

Hologram

19. Hologram

19.
Elkészül a kisflm, amit az előző leckében 
előkészítetél. Közben megtanulsz eegy többkamerás 
rendszerrel dolgozni. Animálsz és plánokat váltasz, 
és a futurisztikus rendszered eegy reklámanimáció
háterévé válik. Végül eegy kis poént is elrejtesz a 
flmben.

 

hologram
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Mivel ez a lecke folytatása az előzőnek, fontosnak tartom, 
hogy  még  mielőt továbbmennénk,  gondoljuk  végig,  hol  
tartunk…  Korábbi  feladatunk  bevezetőjében  említetem, 
hogy a tanulás szakaszában ne várjunk még a „nagy ötlet-
re”, mert az nem magától érkezik, hanem nagyon sok isme-
retszerzés, gyakorlás, elsajátítás előzi meg. 

Andrew Morgan COMSAT irányítópult-terve a Behance-ról

A tanulás szakaszában ezért óhatatlanul másolunk, utáno-
zunk, követünk: stílusokat, ötleteket, technikai eljárásokat. 
Ha ezt tudatosan, refexív módon tesszük, lassan kialakul 
egy művészeti és technikai eszköztárunk, melyet szabadon 
kombinálva megjelennek első eegyéni ötleteink. 

Választotunk hát egy stílust, melyben megleltük az eleme-
ket, építőköveket, mik gyakorta előfordulnak. S elkezdtünk 
mi is ilyeneket gyártani: hálót, körkörös objektumokat. S 
csak it jön a technika – azzal az alázatal, hogy nem éle -
tünk fő művét fogjuk létrehozni. 

Folytatuk a felfedezését a Blender gazdag módosító esz-
köztárának, melyekkel egészen új tulajdonságú, interaktí-
van vezérelhető objektumokat hoztunk létre. A terjedelmes 
lecke végén kifejlődöt eszköztárból építünk fel most egy  
látványanimációt.
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Anyagbeállítások, változtatások

Nyisd meg korábbi leckében általad létrehozot állományt!  
(Vagy töltsd le a mellékletből:  026_hologram.blend  ). Kap-
csold be rétegkezelő első sorának utolsó öt rétegét. 

Nagyjából ezeket az elemeket  kell  látnod:  a négyzetrács, 
négy más-más formájú koncentrikus körgyűrű-cikk. A szí-
nek, az arányok, egyes paraméterek még változhatnak.

Az utolsó rétegen levő rács marad eredeti formájában. A 
kilencediken van egy vékony, lapos körgyűrű. Emlékszel? 
Az első, amit készítetünk. Négyzetekből áll, melyeket egy 
körvonalra futatál. Fogd meg ennek a zöld mozgató mani-
pulátorát, és kezdj el vele távolodni az origótól. 

A körgyűrű kitágul. Állítsd be a fenti ábra szerint.
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Színezzük is át egy melegebb a színre a Csomópontszerkesz-
tőn???! Ha  direktben narancssárgára  színezed,  az  eredmény  
kihatással lesz világegyetem másik két elemére is. 

Ehhez a gyűrűhöz rendelt anyagot ugyanis többször, más 
testekhez rendelve is alkalmazzuk. A neve „Rács”. A szag-
gatot vonalú hengerpalástnak és a keresztes alaprácsnak is 
ilyen  elnevezésű  anyagtulajdonsága  van.  (CTRL+Z)-vel 
gyorsan vond vissza! Maradjon minden kék!

Hogyan lehetne a „Rács” anyagától  független új  anyagot 
létrehozni? Abban az esetben, ha szeretnéd megörökölni a 
korábbi anyag bizonyos tulajdonságait – jelen esetben azt, 
hogy világít –, akkor a katints az ábrán megjelölt anyag-
készlet (+) gombjára. Ekkor az anyag neve  „Rács.001” lesz, 
amit illik gyorsan átnevezni bármelyik helyen, ahol látod: 
legyen a neve „Narancs”. 

Most nézd meg az anyagkészlet legördülőjében, hogy ot 
már „Rács” és „Narancs” is szerepel. Igaz, hogy mindkető-
nek ugyanaz a színe, de legalább elválasztotuk őket. 

Színezd át a „Narancs” anyagot narancssárgára!
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Mutatok egy másik módszert is! Jelöld ki a szaggatot hen-
gerpalástot a nyolcadik rétegen. 

A Tulajdonságok-ablak anyaglistája az a doboz, amivel több 
anyag is hozzárendelhető egy testhez – emlékezz csak a ci-
cavíziós leckére. A hengerpalást listájában csak egy anyag 
van. Ha kitörlöd ezt a „Rács” anyagot (–), akkor láthatóvá 
válik a New gomb, amivel egy új anyagot hozhatsz létre. 

Ilyenkor „Material”, vagy valami hasonló nevet kapsz, amit 
illik átnevezni:  legyen ő „Kék”.  Ezútal nem örökli  egyik 
anyag tulajdonságait sem a frissen létrejövő. Újra fel kell 
építened,  amit  szeretnél  látni:  Egy  Emission-típusú anya-
got, amely élénkebb kékben világít.
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Most jelöld ki a pötyös hengert. Úgy érzem, nem nyerte el 
végső formáját… Olyan Túró Rudi-szerű. Összébb kellene 
húznod a pötyöket!

(TAB) billentyűvel válts  Szerkesztőmódba, majd (S)-sel ki-
csinyítsd a le az alaptáregyat. Az egész alakzat megváltozik. 
Állíts utána az  Array  módosító paneljén úgy, hogy bezá-
ródjon a kör. Ez nem feltétlenül egyezik meg a balra kere-
tezet számértékkel.

Most változtasd meg a pötyös henger színét fehérre. Nem 
kell új anyagot létrehoznod, hiszen korábban már volt egy 
különálló anyagtulajdonsága „Pötyös” néven. 

Hogy  ne  legyen  annyira  hideg,  a  színválasztó  csúszkáin 
(RGB) vedd vissza a kék értékét valamelyest.
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Egy körre még szükségünk lesz. Ebből a mostani hengerből 
fogjuk származtatni, megketőzve azt. 

(SHIFT+D)-vel ketőzöd, majd ENTER-rel zárd le, ne moz-
dítsd el! Fogd meg a zöld mozgató fogantyúját, távolítsd az 
origótól, és ezzel a mozdulatal nagyítsd kicsit nagyobbra, 
mint az alat levő textúrás gyűrű. 

Nézd meg a módosítói közül, melyiknek a következménye, 
hogy több sorban, egymás felet helyezkednek el a  pöty-
työcskék. 

A három módosító paneljét a bal oldali ábrán összezártam. 
Ezek közül a harmadik felelős a többrétegű pötyözésért. 
Töröld ki  ezt  a  módosítót paneljének végén levő kis  „×” 
gombbal. 

19. Hologram



347

Már  csak  a  holografkus  kocka  van  hátra.  Kapcsold  be 
SHIFT-tel az ötödik réteget, a többi mellé. 

Ha a te munkádon csonkolja a drótkeretes kockát a takaró 
objektum, akkor aktiváld a 15. réteget is, majd mozgasd ezt 
a nagy kockát, melynek funkciója, hogy levágjon egy részt, 
a másik kető fölé. 

Azután jelöld ki először a drótkeretet (anyaga: „Drót”), és a 
színét változtasd narancs-vörösre. 

Majd a színezd a kockát (anyaga: „Kocka”), színébe egy kis 
kéket vigyél. Figyelj nagyon arra, hogy a kék szín szűrő ha-
tásával ne tüntesse el azokat narancsszín éleket, melyek a 
szemlélőtől távolabb vannak. 

Ha kell, méretezd a kockákat a fenti kép szerinti arányban. 
S most már animálunk.
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Időzítés a zenére

Ennek a flmnek a különlegessége az lesz, hogy ugyanab-
ban a fájlban, ahol az eddigi látványtervet létrehoztuk, a 
technikát beállítotuk, it fogjuk a zenét alákeverni, az ösz-
szes snitet elkészíteni, végül renderelni. 

Ritka gyakorlat, de az egész produkciós folyamat most egy 
állományban történik…

A flmhez vágtam egy rövid,  17 másodperces zenét.  Hasz-
nálhatod médialejátszónak a felhasználói felület felső abla-
kát – ot, ahol eddig az anyagokat szerkesztgetük.

Váltsd át ezt az ablakot Video Sequence Editorra. Menj az el-
ső képkockához, majd az Add > Sound menüpontból töltsd 
be a mellékletből az 027_On_Te_Tip.wav. hangállományt.

Keresd  meg  az  időmutatóval  a  zene  végét.  Hogy  kerek 
szám legyen, a 430-as kockához állítsd a felvétel végét.

Most már meghallgatható a zene, amire az animációnkat 
ütemezzük, de csak hang alapján elég keserves lenne ez a 
folyamat.

Tegyük láthatóvá a hangot!
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Kapcsold be a  videoszerkesztő  alsó  menüjében a  View > 
Waweform Drawing > Waveform On funkciót, ami megmu-
tatja a zene hullámformáját. 

Érdemes  még  bekapcsolni  alul,  az  Idősáv menüjében  a 
Playback > Audio Scrubbing funkciót, amivel nem csak fo-
lyamatos lejátszás közben hallod a zenét, hanem akkor is, 
ha te mozgatod az időmutatót. 

Helyezz el markereket azokra a helyekre, ahol nagy a hul-
lámforma kitérése! Gyorsbillentyűje az (M).
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Rendszerezés az Áttekintő-ablakban

Ha egy projekt elér egy bizonyos bonyolultságot, már nem 
igazán lehet  kiigazodni  rajta.  Nem árt  egy kis  címkézés, 
rendszerezés, ami megkönnyíti a későbbi animációs mun-
kát. 

Eddig is ot volt a látóterünkben, de nem nagyon foglalkoz-
tunk vele: erre szolgál az Outliner (Átekintő) ablak, a Blen-
der jobb felső sarkában.

A  flm forgatása  előt a  rácson  kívül  mindent  összecsu -
kunk,  visszabontunk,  hogy  ezek  az  ívek,  vonalak  a  sze-
münk  előt bontakozzanak  ki.  Létszükséglet  azonosítani,  
könnyen kijelölhetővé tenni őket. Most olyan rejtélyes ne-
veket látsz, mint BezierCircle, Cube, Plane, meg hasonlók. A 
nevek melleti számozás még teljesebbé teszi a káoszt. 

Mi volt az ember első tevékenysége, miután megteremtete 
Isten? Nevet adot az állatoknak. Azaz azonosítot, halma -
zokat képzet. Tegyük mi is ezt. Birkózzunk csak ezzel a kis 
világegyetemünkkel. 

Az  animációban  koncentrikusan,  kívülről  befele  haladva 
tűnnek majd fel a tárgyak. Szeretnénk, ha azok az objektu-
mok  kerülnének  a  tetejére  ennek  az  elrendezésnek,  me-
lyekkel  először lesz dolgunk.  Ez elérhető,  ha ABC- vagy 
számsorrendben nevezzük át őket. 

Érdemes a nézet árnyalását Solid-ról Material-ra változtatni, mert tömör né-
zetben már nehezebb eligazodni.
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Érintsd  meg  a  legkülső,  szaggatot kört.  Az  Átekintő-
ablakban azonosítható,  mert  fehérre  színeződik a  kijelölt 
elem. Katints rá duplán, nevezd át???: 01_fehér_szaggatottt. 

Befele haladva a következő neveket adtam: 02_terminátor-
harisnya, 03_sárgaegyűrű, 04_kékhenger, 05_pötyöshenger, 
06_holokocka, 07_holodrótváz, 08_takarókocka. 

Ha elkészültél, kezdd el alaphelyzetbe visszabontani ezeket 
a tárgyakat. 01_fehér_szaggatot kört jelöld ki az Átekintő-
ben, majd menj a módosítójára (Array), és minimalizáld az 
objektumok számát. Ez éppen 1. 

Folytasd  02_terminátorharisnyával. It egy  Screw-típusú 
módosító van, ahol a szög értékét (Angle), le kell nulláznod.

Folytasd  a  többi  tárggyal,  egészen a  05_pötyöshengerig. 
It elég lesz, ha csak az első Array módosító értékét minima-
lizálod. 

Biztosan észreveted, hogy egyik tárgyat sem tudtad töké-
letesen  eltüntetni,  mindegyikből  maradt  egy  kis  maszat. 
Mit kezdjünk ezekkel? 

Először is mérlegeljük, látszik-e ez a flmben… 

Lehet, hogy menyasszonyod nem, de ha már néhány éve 
feleséged, biztosan észre fogja venni venni. Meg a kritiku-
sok, és a szakma. Csak a vak hangmérnök lesz toleráns. 

Hogy lehetne eltüntetni? 
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Újra segít az  Átekintő-ablak. Minden objektum neve mel-
let látsz három jelet: szemet, nyilat és egy fényképezőgé -
pet. 

A szem a láthatóság jele. Próbáld ki, ha valamelyik gyűrű-
maradványt szemét lecsukod, az objektum eltűnik. Problé-
ma megoldva. Gondolnánk…

Rossz hírem van: Renderelésnél ki fog derülni, hogy amit 
már nem látsz a 3D ablakban, ot villog majd a flmen. Pró-
báld ki (F12)! Gondoltam jobb, ha előre szólok…

Állítsd is vissza a szem aktiválásával a láthatóságot!

A nyíl a szerkeszthetőség jele. Van néhány objektum – és 
ezek a vezérlőkörök és a rácsháló –, melyeknek nem adtam 
nevet. Végig ot lesznek a helyükön, jobb, ha nem nyúlunk 
hozzá. Ezeknél kapcsold ki a szerkeszthetőségét!

A fényképezőgép a renderelés jele. Helyben vagyunk. Ha ezt 
kikapcsolod, nem látszik majd a flmen semmi az objektu-
mokból. 

Álljunk meg, főnök! Hát nem az a cél, hogy a tárgyakból, 
melyekből csak egy kis darab maradt kezdetben láthatatla-
nok maradjanak, később viszont előbukkanjanak? 

Szerencsére a láthatóság, szerkeszthetőség és renderelési meg-
jelenítés tulajdonsága animálható. Amikor kikapcsolod a kis 
fényképezőgép-ikonokat,  kifakulnak.  Egereddel  állj  meg 
egy pillanatra rajtuk. Nyomd meg az (I) betűt, ezzel kulcs-
kockát állítasz a renderelés tulajdonságához.

Az első kör már nem jelenik meg a flmen, csak a 3D ablak-
ban. Ezt már kulcsoltuk. A  terminátorharisnyát még csak 
láthatatlanná  tetük.  Ne felejtsd  el  kulcskockával  ellátni! 
Ugyanígy járj el a sárgaegyűrű és kékhenger objektumokkal.

A holokockát viszont ne tüntesd el, it egy kicsit más lesz a  
munkamódszerünk…
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Ezt a hologramot ugyanis maga a takarókocka fogja látha-
tatlanná tenni. Kapcsold be a  15. réteget, és mozgasd úgy, 
hogy teljesen elfedje a holokockát.

Sötétség ül a tájra. A takarókocka eltűnik, ha a 15. rétegét 
kikapcsolod.  De a halmazművelet,  melyet létrehozot, to -
vábbra is érvényes.

Minden előkészületel  készen vagyunk,  jöhet  a  forgatás! 
Mentsd most  Save As (Mentés másként) módon a fájlodat, 
de úgy, hogy a párbeszédpanel eljötével megnyomod a (+) 
gombot, ami eggyel tovább számozza a fájlnevet. 
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Forgatás!

Egy 17 másodperces kis flm forgatása előt vagyunk. Eddig 
a  látványvilággal  foglalkoztunk,  különlegesen  viselkedő, 
összetet tárgyakat alkotunk, színeztünk, rendszereztünk.  
Most nem animatikkal, hanem egy minimál forgatókönyv-
vel szervezzük a produkciós munkálatokat.

A zene látszólag öt részből áll. Figyelmesen végighallgatva 
viszont kiderül, hogy az ötödik egy elhaló dobütés. 

Van öt körünk, és egy holokockánk. Ők a jelenet szereplői. 

Forgatókönyv öt snittre:

snitt szereplők, viselkedés kameranézet, -mozgás kamera száma

1. felépül az első és a második kör
elölnézet, döntött, 
kistotál

I.

2.
felépül a harmadik, negyedik és ötödik kör, ebből a 
sárga nem záródik, hanem tovább forog

felülnézet, 
részlet mutatása

II.

3. alulról felfele kibontakozik a holokocka, közben forog oldalnézet, kistotál III.

4. a kocka forog tovább oldalnézet, közeli IV.

5. a kocka hirtelen megáll felülnézet, nagytotál V.
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Első snitt

Menj balról a legelső markerhez. (Körülbelül a 12. képkoc-
ka). Az Átekintő ablakban keresd meg az első és második 
kört, kapcsold be a kis fényképezőgépeket, azaz  tedd ren-
derelhetővé ezeket  az  objektumokat.  Kulcsold  őket:  Állj 
meg rajuk az egér mutatójával, nyomd meg az (I) gombot.

Mi történt? A flm első képkockájától mintegy fél másod-
percig  egyik  kör  sem látható.  Aztán  megjelenik  az  első 
kető. Etől a kockától végig az egész flmben látszik majd a 
két  kör  –  nem  csak  szerkesztés  közben,  de  a  renderelt 
anyagon is.

Jelöld ki az első kört, és a módosítóján (Array) tegyél egy 
kulcskockát a  Count (Szám, példány) értékre:  Állj  meg a 
szövegbeviteli mezőn és nyomd meg az (I) gombot. A mező 
etől elsárgul, így te is tudod, hogy ot kulcs van. 

Menj a másik körre az Átekintőn (terminátorharisnya).

Ennek a módosítóján  (Screw)  keresd meg az  Angle (Szög) 
értéket, mely most nullán áll. Kulcsold be ezt is!

Menj most át a következő markerhez (nálam a 92.). Írd át 
terminátorharisnyán a szög értékét 360°-ra, és kulcsold be 
megint ezt a mezőt. 

Maradj  időben ezen a  képkockán.  Jelöld  ki  a  külső  kört
(fehér_szaggatot), és húzd addig a Count értéket a módosí-
tóján, amíg be nem záródik a kör. Kulcsold ezt az értéket is 
(I). Most nézd meg, milyen let az animációd! Ehhez érde -
mes tömör- vagy anyagnézetből futatni a felvételt.
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Két, egymással ellentétes mozgású objektum épül fel : egy 
körív és egy körgyűrű-cikk.

Első jelenet animációja kész. Állítsuk be a megfelelő képki-
vágást! Kezd felülnézetből (7). Tedd a kamerát a  3D ablak 
alsó részére, oda, ahonnan elölnézetből lát rá a tárgyakra. 
Pillants rá kameranézetből (0), milyen let a beállítás. Jelöld 
ki a kamera szélét jelző téglalapot, és döntsd be kicsit (R). 
Addig ügyeskedj, míg nagyjából ezt nem látod!

A kép steril, gépies. Hiányzik róla a mélység, ami valóságo-
sabbá teheti. 

Helyezd a  3D kurzort az origóba (SHIFT+C), majd készíts 
ot egy üres objektumot (Add > Empty). 

Az Átekintő-ablakban rögtön nevezd át ezt az üres objek-
tumot 1_fókuszpont-ra.
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A kamerát vezérlő fókuszpont elhelyezése.

Jelöld ki most a kamerát! Menj át ennek a beállításaihoz – 
jobbra, a Tulajdonságok-ablakba. Jelöld meg a Focus mező-
ben az 1_fókuszpontnak elnevezet üres objektumot, és nö-
veld a blendenyílást (Aperture) a bal oldali képen látot ér -
tékre, s állítsd be a lamellák számát hatra (Blades).

A  mélységélesség elhiteti  velünk,  hogy  egy valós  felület 
közelében, makroobjektívvel készítetük a flmet.

Tegyünk egy átélesítést is a felvételbe, ami mozgalmasab-
bá, érdekesebbé teszi azt. 
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Valós idejű renderelésnél (jobb ablak) természetesen megjelennek azok a ma-
szatkák, melyekkel indítjuk a filmet. A filmen nem látszanak majd.

Menj most az első  markerhez (12.  képkocka körül) az  Idő-
vonalon, és mozdítsd el a fókuszpontot a kamera felé felül-
nézetből (7). Az üres objektumhoz rendelj egy Location tí-
pusú  kulcsot  (I).  Mozdulj  el  az  Idővonalon a  második 
markerhez (úgy a 92. kocka körül). Tedd át az első körív ka-
merától távolabbi széléhez a fókuszt, és kulcsold azt is (I).

Érdemes ilyenkor egy rövid (1 – 92 képkocka-tartományú) 
próbarendert  generálni.  Film,  és  ne  képsor  legyen,  hogy 
hanggal  együt ellenőrizhessd,  működik-e  az  elképzelé -
sünk. 

Mielőt belekezdenél,  (F12)  enderelj  egy képkockát,  nézd  
meg, mennyi ideig tart. Számold át 92 kockára az összidőt. 
Ha kell,  vedd vissza  a  Sampling értéket  a  rendereléshez, 
hogy gyorsabban elkészülj. 
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Második csapó!

Ezen a felvételen létrejön a harmadik, neegyedik és ötödik kör.  
A sárga nem záródik, hanem tovább forog a flm végéig. 

A kamera felülről, közeliből vesz majd eegy részletet.

Képzeld azt, hogy egy koncertet kell felvenned többkame-
rás, professzionális rendszerrel.  Ha a sokféle nézőpontból 
felvet flmet a hangfelvételhez kellene vágni, talán bele is  
őrülne a vágó. Azt lesni a közeli képeken, mikor mozdul 
meg a gitáros keze, hol kell belépni egy-egy snitel… 

A gyakorlatban ilyenkor szinkronizálják a kamerák óráit, s 
ugyanazzal a  timecode-dal forgatják le minden kamerán a 
flmet.

Mivel a Blenderben több kamerát is elhelyezhetsz, lehető-
séged van ezek közöti váltásokra a felvétel során.

Helyezd vissza a 3D kurzort középre (SHIFT+C). Hozz létre 
egy új kamerát. Nevezd el kamera2-nek, majd mozdítsd el a 
kék manipulátorral felfele. 

Most már két kameránk van. A rend kedvéért az Átekintő-
ablakban az első kapja a kamera1 nevet. 
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Válaszd ki a kamera2-t a 3D ablakban. Az Idővonalon jelöld 
meg a második markert, és a vonal  alati menü  > View >  
Bind Camera to Markers  paranccsával (ami szó szerint azt 
jelenti,  hogy a kamerát hozzákötöd a markerhez) létesíts 
kapcsolatot a kető közöt. 

Olyan, mintha kulcskockát raktál volna a kamerára. Tuda-
tod a rendszerrel, hogy it lesz egy váltás.

Menj át kamera-nézetbe (0), s látod, hogy átkapcsolt a má-
sodik kamerára a program. Ha visszamész kissé az időben, 
látni fogod, ehhez a beállításhoz talán túlságosan is ragasz-
kodik a rendszer. Most csak ezt a nézetet preferálja, az elő-
ző kamera képe nem látszik. 

Gondoljuk át: csak egy markerhez rendeltünk eddig kame-
rát. Ezt aztán oda-vissza komolyan vete. Amíg nem kap-
csolsz  másik  markerhez  etől  különböző  flmfelvevő  esz-
közt, addig ezt tekinti alapértelmezet készüléknek. 

A flm elejére kell egy tennünk egy markert, ahhoz csatol-
juk az első kamerát, ez a második pedig it vált majd, a 92. 
kockánál.
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Menj az első kockához és (M) billentyűvel helyezz el egy 
markert. Jelöld ki az első kamerát, majd az  Idővonalon az 
első markert, s most is a menüből, a View > Bind Camera to  
Markers parancsával végezd el a hozzárendelést.

Állítsd be a második kamerát a fenti a nézetre, és kezdjük 
el a második jelenet animációit. 

Az  Idővonalon  menj  92.  kockánál  található  markerhez.
A harmadik, negyedik és ötödik körök renderelés-ikonját 
kapcsold be az Átekintő-ablakban, és mindegyikhez ren-
delj kulcsképkockát úgy, hogy megálsz rajtuk az egérmuta-
tóval, és megnyomod az (I) gombot. Innentől már ezek is 
láthatóak.
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Most jelöld ki a 03_sárgaegyűrűt az Átekintő ablakban, majd 
keress rá a módosítóira. Az  Array módosító  Count (elem-
szám = 1) értéket kulcsold ehhez a pillanathoz.

Ugyanezt tedd meg a kék hengerrel és a pötyös hengerrel 
is : miután kijelölöd az Átekintőben, kulcsold az Array mó-
dosító alapszámát. 

It kezdenek majd terjeszkedni ezek az objektumok. A snit 
végén pedig…

...záródni. A következő markerre ugorva mindhárom kör-
nek emeld a Count értékét úgy, hogy 

• a kék és a pötyös henger bezáródjon, 

• a sárga gyűrű viszont a képhez hasonlóan egy kis 
íven nyitva marad.

Készítsünk egy átélesítést: 

Egy új,  üres objektum legyen ennek a kamerának a  2_fó-
kuszpontja, melyet helyezz el a sík és a második kamera kö-
zé félútra.
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Miután elvégezted a  Tulajdonságok-ablakban a fókuszpont 
beállítását és kinyitotad a blendét (Aperture = 0,28), az üres 
objektum helyzetét (I) kulcsold a harmadik markerrel jelzet 
időpillanathoz, majd nagyjából a negyedik markernél – ná-
lam a 171. kockánál – tedd át a fókuszpontot a körök síkjá-
ba, és ide is kulcsolj.

Érdemes  most  is  egy  próbarendert  végezni,  ellenőrizd, 
hogy elképzeléseink szerint halad-e eddig a flm.

Átlógó animáció ♦ A jelenet végére már majdnem min-
den a helyére került. És meg is állt. De a sárga körkukac-
nak, ami soha nem tud beleharapni a saját lökhárítójába, 
még tovább kell forognia. 

Mivel a forgatásért már nem a módosító paneljének Count 
értéke felel, it a harmadik markernél jelöld ki a sárga egyű-
rűt, és (I) billentyűvel kapjon egy Location típusú kulcskoc-
kát. Menj az ötödik markerhez, és mozdítsd el a gyűrű pi-
ros manipulátorát úgy, hogy az origótól távolodva kétszer 
forduljon körbe a vezérelt objektum. 

Ehhez  bizony elég  sokat  kell  mozgatni.  A végén megint 
kulcsolj (I).

Körülbelül  így  áll  a  sárga  gyűrű felülnézetben az  ötödik 
markernél. 

Még egy dolgot érdemes beállítani: a mozgás interpoláció-
ját. 

Alapállapotban  a  Blender  szinte  mindenhez  „S”  alakú, 
gyorsul-egyenletes-lassul  típusú mozgást  rendel.  A  sárga 
gyűrűnek ezzel  ellentétben egyenletesen kellene mozgat-
nia.
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A felső ablakot alakítsd át Mozgásgörbe-szerkesztőre (Graph 
Editor). Ha valóban a sárga körön vagy, s jól állítotad be az 
animációt, remélem, már nem ijedsz meg etől a látványtól.

Mivel Y és Z (zöld, kék) irányokban nem történik elmozdu-
lás, ezeket a görbéket kikapcsoltam. Jelöld ki az „S” alakú 
görbe belépési pontját, nyomd meg a (T) gombot, és az in-
terpolációk közül válaszd a lineárisat.
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Harmadik snitt

Újabb kamerát kell elhelyezned, elnevezned, fókusszal el-
látnod,  és  a  negyedik  markerhez  kapcsolnod.  Most  már 
nem részletezem, remélem az előzőekben sikerült begyako-
rolnod. Ha nem, lapozz vissza, s annak a mintájára állítsd 
be ezt a képet is. 

A fókusz most végig legyen azon a helyen, ahol előtűnik a 
holokocka. 

Kapcsold be a 15. réteget, ahol eleddig a takarókocka lapult. 
A negyedik markernél kulcsold (I) Location típusúra abban 
a helyzetben, ahol még eltakarja teljesen a holokockát.

Most menj át a hatodik markerre, emeld meg a takarókoc-
kát, és kulcsold ezt a mozdulatot is. Ha készen vagy, kap-
csold ki a takarókocka rétegét.
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A  mozgás  interpolációja  ismét  javítható,  ha  a  Mozgás-
görbe-szerkesztőben „S”  alakú helyet lineáris  görbét  vá -
lasztasz.

Menj a negyedik markerre és jelöld ki a holokockát az Át-
tekintő-ablakban. Nem is tudnád máshol, hiszen a takaró 
kocka hatása miatt itt, ebben az időpontban láthatatlan.

A 3D ablakban kulcsold (I) most Rotation típusú kulcskoc-
kával. A cél az lesz, hogy a függőleges tengely körül forog-
jon, miközben előtűnik.

Menj át a hatodik markerre az Idővonalon. Pontosan egyet 
kell fordulnia a kockának eddig. 
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Nyisd meg a 3D ablak Tulajdonságpanelét (N), és a Z tenge-
lyű forgás mezőjében az ot talált értékhez adj 360-at. 

Nyomj egy ENTER-t,  s  a program elvégzi  az összeadást. 
Utána állj meg ezen a mezőn az egérrel, és nyomd meg az 
(I) gombot, melynek hatására kulcsot kap az érték, és a me-
zők zöldből sárgára változnak.

A Mozgásgörbe-szerkesztőn megint érdemes lineárisra állí-
tani az interpolációt. 

A  holokocka  előtűnésénél  két  jelenetet  animáltunk  egy-
szerre. A kető közöt van egy kameraváltás, amiért vissza  
kell mennünk az ötödik markerre. Ide…
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Negyedik snitt

Hozz létre elölnézetből egy újabb kamerát  (kamera4), me-
lyet közel viszel a kockához, és úgy fordítod, hogy egy ki-
csit oldalról és felülről is lássuk, ahogy felépül. 

Állíts be az Idővonal markeréhez egy kameraváltást!

Helyezz el egy üres objektumot (4_fókuszpont), majd jelöld 
ki  az  aktuális  kamerát,  állíts  mélységélességet  rajta,  de 
most vigyázz, mert nem szabad olyan nagy értékekkel dol-
gozni,  mint korábban – a blende nyílása  (Aperture) most 
csak 0,12 legyen. 

Nagyobb érték a közelség miat szinte mindent természet -
ellenesen elmosódotá tenne. 

Utolsó  képváltásra  készülve  menj  a  hatodik  markerre  az 
Idővonalon.
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Zárósnitt

Sok munka van már ebben a kis szösszenetben, pedig csak 
egy pár másodperces  darab.  Két  leckén keresztül  tervez-
tünk, állítgatunk, módosítotunk, színeztünk, ütemeztünk, 
időzítetünk. 

A futurisztikus interfész elkészült, s közben egy kicsit át-
alakult. Ha azt az irányt tartjuk, most mindenféle kis kü-
tyüt és vezérlőszervet,  toligát és feliratot kellene ráappli-
kálni, ami meghaladná erőnket, időnket.

Mivel egy kis meglepetést rejtetem el a végére, nem szól-
tam neked sem. A táblázat szerint „a kocka hirtelen megáll, 
felülnézet, nagytotál”. Oké, de mit mutatunk it. Koncentri-
kus köröket, középpontban egy kockával? Mi lenne, ha egy 
kis poént tolnánk a néző tekintetébe it az utolsó képen?

Menj a 3D kurzorral a középpontba (SHIFT+C), majd hozd 
létre it az utolsó kamerát (kamera5). Rendeld hozzá a helyi 
markerhez. Most nem kell fókuszálni, egy síkban vannak a 
tárgyak. Mögötük csak a feketeséget mosnánk el…
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Találjunk ki egy terméket, amiben van „C” betű. Computer,  
Cube, Circle, C-vitamin? 

Mi lenne, ha kihasználnánk a Csillagok háborúja franchise 
sikerét, és azzal glükózt reklámoznánk? 

HO-HO-HO? OH-OH-OH? Ne gondoljunk semmi rosszra. 
Sima szőlőcukor!

Már látom is a nevet: Solo Cukoró

Ha egy reklámanimációs üzlet beindul! Valami ilyet kép-
zeltem…

A  kamera  nézetéből  először  hozd  létre  a  második  szót 
(SHIFT+A > Text). TAB-bal válts Szerkesztőmódra, majd írd 
át a szöveget „ukor”-ra.
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A mellékletből töltsd be a betű  Tulajdonság-ablakában az 
028_expansiva.regular.otf betűtípust. 

A Blender kiváló tulajdonsága, hogy nem kell a rendszerbe 
telepíteni a betűket, elég, ha csak a programba beolvasod.

Ha készen vagy a betű beállításával, ketőzd (SHIFT+D) a 
szöveget, nyomd meg annak a tengelynek a betűjelét, ame-
lyik irányában el akarod mozdítani (nálam Y), s miután el-
helyezted a végleges helyén, Szerkesztőmódban (TAB) írd át 
a szöveget: „solo”-ra.

Már csak azt kell megoldani, hogy zavaró módon ne látsz-
szon a szöveg végig. Az Átekintő ablakkal ez csak néhány 
mozdulat.

Menj az utolsó markertől egy kockányira balra. It kulcsold 
be az  Átekintő ablakban mindkét szöveget úgy, hogy ne 
látsszon a renderelésnél.
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A billentyűzeted jobbra nyilával lépj egyet az  Idővonalon. 
Pontosan a markeren vagy. Kapcsold be az Átekintő ablak-
ban mindkét szöveg renderelését, és adj nekik kulcsot.

Ellenőrizd a flmet, végezz néhány próbarenderelést állóké-
pekkel. Ez az a szakasz, amikor az alkotó még sok hibát ta-
lál, vagy éppen új ötletekkel fnomítja az animációt. 

Én például a végső renderben kisebbre vetem terminátor-
harisnya mintázatát, lineárissá tetem a takarókocka moz-
gásgrafkonján, stb…

Számolj utána, milyen nagyságban, mintavételezéssel érde-
mes renderelned. 

Mivel nem nagyjátékflmet renderelünk, biztonsági mentés 
után  most  nem képszekvenciát,  hanem végső  flmet  ho-
zunk létre. Emiat megtörjük azt a szabályt, amit eddig kö-
vetünk.  Gyakorló  feladatunkban  a  látványterv  után  ki-
hagytuk  az  animatikot,  nincs  külön  állományunk  a 
vágásra,  amibe  beolvasnánk  a  kirenderelt  képsorozatot. 
Egyszerűen van egy jól ütemezet, a jelenetben a kamerák 
váltásával megvágot kisflmünk.

Vállaljuk a kockázatot. Rendereld H264-es, hanggal ellátot 
videoállományként! 

Köszönöm a sok munkát, amit most a tanulásra szenteltél!
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20. 

Betűanimáció

20. Betűanimáció

20.
Igazi betűanimációt készítünk.
Miközben megtudod, hoegy álmodnak-e 
az androidok elektronikus bárányokról,
megismerkedsz az Átekintő ablak 
animációs lehetőségeivel.

 

betűanimáció
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Csak egy flmet néztem meg egymás után ötször, ez a Blade 
Runner volt.  A Philip  K.  Dick regényéből  készült  alkotás 
(Ridley Scot, 1982)  sokféle módon él tovább a kulturális 
köztudatban. Hogy csak egy példát mondjak a Google tele-
fonjait Nexus-nak, operációs rendszerét Androidnak hívják, 
mindkető a könyvből és flmből vet utalás. 

2012-ben, Los Angelesben játszódik a történet – a 30 évvel 
azelőt elképzelt jövőben. A rendőrség különleges osztaga  
igyekszik megakadályozni,  hogy a Földön kívül  munkás-
ként,  katonaként,  vagy éppen utcalányként  dolgozó  gépi 
embermásolatok visszaszivárogjanak a Földre. 

A flm záró jelenetében az üldöző rendőrből üldözöt lesz.  
De az utolsó, gyilkolásra kiképzet android megkegyelmez  
az embernek. 

Halála előt halljuk a következő monológot,  melyet most  
mi is vizualizálni fogunk:

„Én látam olyan dolgokat, amiket ti, emberek, el se hinné-
tek. Lángoló csatahajókat az Orion peremén. Gyilkos sugara-
kat az éjben a Tannhäuser-kapunál. Mindezek a pillanatok  
elvesznek az időben, mint könnyek az esőben.

Az idő lejárt.”

20. Betűanimáció

Fent: Harrison Ford a 
Blade Runner c. filmben. 

Lent: Rutger Hauer.
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Egyre többször találkozunk betűanimációval – szakkifeje-
zéssel kinetic typography, lyric video –, leggyakrabban talán 
a videómegosztókon. 

Zenei klipek vagy flmrészletek szövegét vizualizáló alkotá-
sok közöt jelentős minőségi különbségek vannak. Sokan  
azt gondolják, a betűanimáció csupán arról szól, hogy kü-
lönleges efektusokkal spékelnek meg egy szöveget, hogy 
az meghökkentse, olvasásra késztesse a nézőt. Pedig a szö-
veganimáció akkor működik megfelelően, ha nem öncélú. 

(Fotó: Pixabay)

Az ember olvasó lény. Kisiskolás korunktól kezdve elolva-
sunk minden feliratot, ami a szemünk elé kerül: A cégtáb-
lákat,  a  villamos  oldalára  ragasztot reklámokat,  a  fako -
nokra, vagy a reggeli kukoricapelyhes dobozra feliratozot 
összetevőket.  Önkéntelen olvasási  hajlamunkat visszaélés 
kihasználni ebben a műfajban! A szöveg animálása nem azt 
jelenti, hogy csupán odavillantod, beúsztatod, megfutatod, 
kitekered a betűket. 

Az animáció it is :  életet vinni az életelen dolgokba,  jelen 
esetben a betűkbe. Nem csak olvasásra szánjuk a szöveget: 
valamit eljátszunk, illusztrálunk vele, apróbb vagy nagyobb 
ötletekkel gazdagítjuk a flm hallható anyagát.
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Első lépés a szöveg kiválasztása, többszöri meghallgatása, 
ízlelgetése.  Én ilyenkor beírom egy egyszerű szövegszer-
kesztőbe. Miközben hallgatom, igyekszem tömbösíteni.

Hány jelenet adódik? Melyik jelenetben mit fogunk játsza-
ni? Mert a betűanimáció színjáték a betűkkel. Belebújunk, 
azonosulunk a szöveggel: a mi ötleteink, gesztusaink, moz-
dulataink jelennek meg rajtuk. Ilyen értelemben az animá-
tor színész, az animáció pedig acting, színjátszás.

A tipográfa a szöveg megjelenítésének művészete/technikája. 
A célja, hogy segítse a szöveges kommunikációt. Olvasha-
tóvá tegye, alkalmazkodjon mondanivalójához, stílusához. 

Betűválasztás ♦ A grafkus kommunikáció sok döntéssel 
jár. A szöveganimáció tipográfája a betűválasztással kezdő-
dik. A betűknek a tartalom stílusához igazodónak, ugyan-
akkor olvashatóknak kell lenniük. 

Kerüljük el  a túl  ismert  betűtípusokat,  legyen formavilá-
gukban valami egyedi, izgalmas. 

De ne feledkezzünk el arról sem, hogy a beszélt nyelv se-
bességével mutatkozó szöveg nehezebben olvasható. A túl 
dekoratív hatású betűk gátolják a gyors az olvasást. 
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Szövegegységek ♦ A betűválasztás után  kijelöljük a szö-
vegeegységeket. A szó, mint legkisebb értelmes egység gyak-
ran kevés. It inkább tagmondatokat, mondatokat vagy rö -
videbb  bekezdéseket  animálunk.  Ha  együt látjuk  a  
szavakat, több lehetőség van közötük térbeli viszonyokat, 
hangsúlyokat kialakítani. 

Akkor működik jól eegy ilyen kiemelt gondolat animációja, ha  
önmagában, akár nyomtatásban is szép a tipográfája.

Az  előkészítő  szakaszban  nagyon  jól  jön  egy  storyboard 
(képes forgatókönyv), amelyben lejegyezhetjük, megrajzol-
hatjuk az ötleteinket, miközben a keretezés miat automati-
kusan egységeire kell bontanunk a szöveget.

A választot monológban én hat ilyen egységet találtam.
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A hangfelvétel  58 másodperces.  Összesen  30  objektumot 
kell animálni. Nem kis munka, de megfelelő szervezetség-
gel győzni lehet.

A szöveget azokban a gondolati egységekben fogjuk össze, 
amik még olvashatóvá teszik azt. 

Ez azt jelenti, hogy egy-egy képen, sniten belül körülbelül 
egy tagmondatnyi szöveg látszik,  melyet szavanként ani-
málunk majd.
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Ütemezés a zenére

Oszd meg egy új Blender-állomány munkaterületét, s a fel-
ső ablakot alakítsd át Videoszerkesztő típusúra. 

Töltsd be ide a 029_bladerunner.wav állományt a melléklet-
ből.  Kapcsold  be  a  hanghullám láthatóságát  a  Videoszer-
kesztő ablak alsó menüjében. (View > Waveform Drawing >  
Waveform On). A munkaterület alján levő Idővonalon pedig 
a  Playback  > Audio  Scrubbing  menüparancs  aktiválásával 
biztosítsd,  hogy nem csak  lejátszás,  hanem az  időmutató 
lassú mozgatása során is hallható legyen a hangfelvétel.

A  Videoszerkesztőben keresd meg azokat a pontokat, ahol 
elkezdődik egy-egy szó.  Jelöld  meg ezeket markerrel  (M) 
úgy, hogy minden jelölés után át is nevezed az adot szóra  
(CTRL+M),  megkönnyítve  ezzel  az  animálást.  Egyelőre 
csak az első snitet feliratozzuk. Ezzel szeretnélek bevezetni 
a műfajba…
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Az első jelenet előkészítése

Betűanimációnál nem szabad feleslegesen mozgatni a ka-
merát. Kell egy fx pont, ha minden mozog, változik. Mivel 
a  betűkre  megfelelően  rá  kell  látni,  legkönnyebb  síkban 
mozgatni azokat. 

A Blender térbeli alapbeállítása erre nem alkalmas. Jelöld 
ki, majd helyezd vissza az origóba a kamerát: mozgás alap-
helyzetbe (ALT+G), forgás alaphelyzetbe (ALT+G). Azután 
mozgasd felfele a kék manipulátorral.

Állítsd be a szokásos háromablakos elrendezést. Tedd visz-
sza a 3D kurzort az origóba (SHIFT+C), és készítsd el az el-
ső  szöveget  (SHIFT+A  >  Text).  Válts  Szerkesztőmódba a 
(TAB) billentyűvel, töröld ki a „Text” szót, és írd be: „én”.

Válts vissza  Táregymódra, és a  Tulajdonságok-ablak betűtu-
lajdonságainál a normál font helyére  (Regular) töltsd be a 
030_Inpacted.tf fontállományt. 
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Így a  megfelelő  betűtípussal  dolgozhatsz a továbbiakban. 
Ha nem akarod ezt a műveletet újra és újra elvégezni, ak-
kor (SHIFT+D)-vel másold le egymás alá kilencszer felülné-
zetben (7) ezt a szócskát. Írd át a szavakat a következőkre: 
láttam | olyan | dolgokat | amiket ti | emberek | el | se | hinné-
tek.  Tíz szóval még csak elboldogulnánk. De a következő 
jelenetekben ezek száma egyre csak nő, ráadásul egymás 
után válnak láthatóvá. Szükséges egy kis rendszerezés.

Miután módosítottad a  szövegeket,  fentről  lefele  haladva 
egymás után jelöld meg azokat, azonosítsd az Áttekintő ab-
lakban, majd nevezd át őket. A nevek mintája látható a fen-
ti ábrán. Most felülnézetből fogjuk létrehozni ezt a tipográ-
fiiát.
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Gyakori feladat a Blenderben a referencia alapján való mo-
dellezés. Ilyenkor hátérképeket szoktunk betölteni a prog-
ram 3D ablakába. Használjuk erre a bal alsó ablakot.

Nyomd meg az (N) gombot. A  3D ablakhoz tartozó  Tulaj-
donságpanel alján  találsz  egy  Hátérképek (Background 
Images) jelölőnégyzetet. 

Kapcsold  be,  majd  töltsd  bea  01szovegelrendezes.jpg állo-
mányt. Fontos, hogy az Axis (tengely) mező Top (felülnézet) 
beállításon legyen. Ha nem látnád a képet (7)-es nézetben, 
nyomd meg az (5) gombot, ugyanis csak ortografkus né-
zetben mutatkozik. Renderelésnél sem fog látszani…

Ha zavaróan kontrasztos  a  hátér,  az  Opacity (opálosság, 
átetszőség) értékkel halványíthatod. Most már gyorsan el 
tudod  rendezni  a  szöveget  a  (G |  R  |  S)  gyorsbillentyűk 
használatával. CTRL-gombbal kényszerítsd forgatásnál, így 
biztosan beállíthatóak a derékszögű forgások. 
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S még két jó tanács: Átméretezésnél az egér minél távolabb 
álljon a tárgytól, akkor fnomabban tudsz dolgozni. A szö-
vegek bal alsó sarkában van az objektumokra jellemző for-
gáspont  (Pivot Point).  Ezt helyezd el először,  aztán köny-
nyebb a nagyítás.

Két perc munkával minden a helyére kerül. Aztán kikap-
csolhatod a Tulajdonságpanelen a hátérképet.

Helyezz  el  a  kép  szerint  egy  üres  objektumot:  Empty  >  
Sphere. Hogy ne kapjunk remegőgörcsöt az egyenkénti ani-
málástól, ehhez az objektumhoz fogjuk az összes szót kap-
csolni. 

Elég bajos lenne a 3D ablakban egyenként kijelölni ezeket 
az objektumokat. It ugyanis fontos a sorrend: Az Empty  
legyen az utolsó. Használd az Átekintő ablakot. SHIFT-tel 
és bal egérgombbal felülről lefele egyenként jelöld ki eze-
ket a tárgyakat, utoljára az üres objektumot (Empty). 
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A 3D ablakra helyezd vissza az egérmutatót, majd nyomd 
meg a (CTRL+P) gyorsbillentyűt. Emlékszel? Ezzel az eljá-
rással lehet „szülő-gyermek” típusú, hierarchikus kapcsola-
tot létrehozni. Ha az Empty-t mozgatod, nagyítod, forgatod, 
követi a tíz szó. Ha viszont a kapcsolt „gyerekeken” változ-
tatsz, nem lesz hatással a szülő objektumra. 

Be-kikapcs, animáció

Szeretnénk elérni, hogy ezek a szavak egymás után tűnje-
nek elő, miközben mozgatjuk, forgatjuk is őket. 

Folytasd kamera-nézetből! Az  Átekintő ablak jeleit a kö-
vetkezőképpen állítsd be: Először bal egérgomb lenyomásá-
val húzd végig az egeredet az  Empty alá fűzöt szövegob -
jektumok szemecskéin. Azok becsukódnak, és eltűnnek a 
szövegek. Azután kapcsold vissza az első négyet. 

Vigyázz, ha csak ezeket kapcsoljuk ki, a láthatóságuk válto-
zik,  de renderelésnél  újra megjelennek.  A fentihez hasonló 
mozdulatal kapcsold ki  az összes szöveg renderelhetősé-
gét. Most a szövegek kis fényképezőgép-ikonjain állj meg 
egyenként,  és  az  (I)  gyorsbillentyű  megnyomásával  kul-
csold be ezt a tulajdonságot. Így az első képkockától kezdve 
egyik objektum sem renderelhető, bár a szerkesztés miat 
négy objektum az előnézetben látható.

Állítsd be a kamerát úgy, hogy nagyjából ezt lásd!
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Menj most az első, „én” feliratú markerhez. Kapcsold be en-
nek a szónak a renderelési ikonját, és kulcsold azt is (I).

Most  jöjjön a  „látam”-marker.  Told  idáig  az  időmutatót, 
majd kapcsold vissza és kulcsold a renderelhetőségét.

Ezzel az eljárással menj tovább. Egészen a „hinnétek”-mar-
kerig. Kapcsold be, és kulcsold ezt is. 

Gyakorlásként végezd el ezeket a kulcsolásokat a kis sze-
mecskékkel is. Sokkal könnyebb lesz az animálás, ha látod, 
mi kerül majd a flmre…

Nem tetünk még mást, mint szépen megjelentettük a sze-
replőinket akkor, amikor be kell lépniük a színpadra. 

De nem koreografáltuk őket. 

Most menj vissza az első markerig (én), és jelöld ki a 3D ab-
lakban az üres objektumot  (Empty).  Kulcsold it egy  Loc-
RotScale (hely-forgás-nagyság)  típusú  kulccsal,  mivel  az 
animáció során mindegyiket változtatni fogjuk.

Menj az Idővonalon a „látam”-markerre. It két dolog törté-
nik majd: Láthatóvá válik a „látam” szó. Ezt már beállí-
totad. Ahhoz, hogy könnyen olvasható legyen, át kellene 
billenteni  az  óramutató  járásával  megegyező  irányba  az 
üres objektumot. Valahogy így…

20. Betűanimáció



386

Forgasd is el az (R) billentyűvel, miközben CTRL-lal kény-
szeríted  a  pontos, 90°-os  elfordulásra.  Rendelj  hozzá  egy 
Loc-Rot-Scale típusú kulcskockát (I).

A felső ablakot alakítsd át  Graph Editor-rá (Mozgásgörbe-
szerkesztő).  Mivel  egyetlen egy mozgásgörbe változot (a  
kék Z Euler Rotation), maradjon csupán ez látható. 

Ennek  gyors  módja:  kapcsold  ki  a  LocRotScale  összegző 
csatorna láthatóságát. Ezzel együt lehunyta kilenc szemét  
minden, ami alá tartozot. Most piszkáld meg a kék Z Euler 
Rotation (függőleges elfordulás) szemecskét, így láthatóvá 
válik ennek mozgásgörbéje. Nulláról indul, s lemegy egé-
szen –90°-ig, azaz az óramutató járásával egyezően fordul.

Ha szeretnél valami izgalmasabb elfordulást, jelöld ki a gra-
fkon bal csomópontját, nyomd meg a (T) gyorsbillentyűt, 
és a felbukkanó terjedelmes interpolációs menüből válaszd 
a Bounce (patogás) opciót.

Mivel a hang is megenged it egy kis animációt, viszonylag 
szép, fzikai jellegű, felpatanó csapóajtó-szerű mozgás lesz.
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A következő marker, ahol bele kell nyúlnunk a dolgok me-
netébe az „amiket” szó megjelenése előt lesz. Ha megné -
zed, s az ötödik markerig tolod az időmutatót, látható, hogy 
nem fér rá ez a szó a képernyőre. 

Menj vissza az előző jelig („dolgokat”), és a 3D ablak felet 
rendelj az üres objektumhoz egy LocRotScale típusú kulcs-
kockát (I). Ezzel jelzed, hogy innen indul a mozgás. Most 
ugorj az ötödik, tőle jobbra levő markerre. Mozdítsd el fel-
fele  a  fogantyúként  használt  üres  objektumot  úgy,  hogy 
látható legyen a kamerában ez a szövegrész. Kulcsold ezt a 
mozgást ehhez a pillanathoz (I > LocRotScale). 

Az én szövegem éppen hogy csak elfér a kamera képkivágásában. Ha te is így 
jártál, a kék, függőleges manipulátorral emeld meg egy kicsit a kamerát. Mi-
vel ennek helyen nem volt kulcsolva, visszamenőlegesen is innen fogod látni a 
jelenetet. 

A következő nagy ugrás a „ti”-markernél lesz. Ez a legna-
gyobbra méretezet szó. Ráadásul  90°-ot balra kell fordul-
nia, szóval elég nagy kataklizma várható, ha minden előző 
szövegrésszel beörvénylik a képmezőre. Ez a nagy átmene-
tű  mozgás  kérdésessé  teszi,  hogy  egyáltalán  az  „amiket” 
szövegrész olvasható lesz-e.

Várjunk ki ezzel egy jó darabig, aztán a „ti” feliratra cserél-
jük ki az eddigi szöveget.
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Menj a „ti”-markerre, de lépj it egy kockát vissza a billen-
tyűzeted balra nyilával. A 3D ablakban kulcsold ide az üres 
objektumot, s mivel semmi változás nem történt, eddig a 
pontig kitart az összes korábbról látható szöveg. 

Most a billentyűzet jobb nyilával pöccenj vissza a „ti”-mar-
kerre, és rendezd át az üres objektum mozgatásával, forga-
tásával a tipográfát így…

Közben kapcsold ki az előző szövegek láthatóságát, és kul-
csold is ezeket. Az „emberek”- és az „el”- és a „se”-marker-
nél, ha jól állítotad be az előbukkanásokat, nincs teendőd. 

Az utolsó szóval újfent nem lesz gondod. 
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Hogyan tovább?

Az első snitben belekóstoltál a betűanimáció néhány fogá-
sába.  10  másodpercnyi  anyagot készítetünk elő.  A többi 
már rajtad áll. 

Dolgozz tovább a projekten: Lásd el markerekkel a hang-
anyag következő részeit. 

A következő snitnél érdemes átváltanod egy másik réteg-
re, s azon dolgozni. Ha megfelelő ütemezéssel kapcsolgatod 
ki-be a szövegeket, a végén, ha együt jeleníted meg a hat  
snitnek  megfelelő  hat  réteget,  nem  fog  gondot  okozni, 
hogy egy helyen vannak, hiszen időben máshol-máshol je-
lentkeznek. 

Miután készen vagy, az utolsó rétegen helyezz el egy síkot, 
amelyre a  háttér textúráját feszíted  (031_kekhater.jpg).  A 
betűkhöz pedig rendelj egy másik anyagot, egy másik tex-
túrával (032_femtextura.jpg). 

Egy egyszerű, textúrázott, fénykibocsátó anyag, melyet a betűkhöz használ-
tam. Ehhez hasonlóan épül fel a háttér is.

Minkét képet megtalálod a mellékletben.

A világnak állíts be egy Sky Texture típusú bevilágítást. 

Az elkészült, majdnem egy perces anyagot PNG szekvenci-
aként rendereld, majd vágd össze a  Mikrovilágok  leckéhez 
hasonlóan egy másik fájlban.
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Az elkészült anyagtulajdonságokat legegyszerűbb ráhúzni a még anyag nélküli 
objektumokra.

Nem kis szervezetséggel jár egy ilyen volumenű munka. 
De meghozza a gyümölcsét. A betűknek szép koreográfá-
kat lehet kitalálni, de a jeleneteket bővítheted infografka-
szerű, vagy rajzflmes elemekkel is. 

Nagyon fontos a jó ütemezés, hiszen nincs sok idő egy-egy 
szövegrészt vagy grafkus elemet sokáig mutatni.

Ha érdekel  egy egyszerűbb (habár sablanosabb)  módja a 
betűanimációnak, lapozz az „m” Függelék Sniper c. fejeze-
téhez. Ot egy bedolgozóval próbáljuk automatizálni, gyor-
sítani ezt a folyamatot.
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21. 

Anyagszimuláció

21. Anyagszimuláció

21.
Hullámok, víz, óceán, füst, tűz. 
Folyékony és légnemű anyagok szimulációja a 
Blenderben. Látványos, de korántsem eegyértelmű 
eljárások. A látványanimációk 
egyakori kellékei. A szimulációk készítése során 
eegyetlen állat sem sérült meg.

 

anyag-
szimuláció



392

Hogyan tovább?

A korábbi animációs feladatok során megismerted az eljá-
rást, hogyan vállalja át a gép a mozgásmegjelenítés nagy 
részét, kiszámítva a kulcskockák közöti fázisokat.

Igyekeztem olyan feladatokon végigvezetni, melyekkel be-
gyakoroltad  a  Blender  kezelését,  biztonsággal  mozogsz  a 
3D-térben, viszonylag tűrhető világokat tudsz felépíteni, s 
ezekben a világokban othonosan mozogsz, és mozgatsz.

Egy orosz csapat által fejlesztett kiegészítővel, a SVERCHOK-kal létrehozott la-
birintus. Forrás: Blender Sushi

Fontos  szempontom  volt  a  fokozatosság  és  a  gyakorlás, 
hogy a Blender ne halállabirintussá váljon, ahol értelmetle-
nül nyomogatod a felhasználói felület elemeit, gyorsgomb-
varázsigéket mormolsz, és minden leckében újabb halálos 
csapda vár, amit úgy sem sikerül megoldanod.

Végigvezetelek néhány projekten, ahol a tervezéstől a vá-
gásig igyekeztem mindent megmutatni, amire egy kisflm 
létrehozásánál szükséged lesz.

S igen, még ezer dolgot nem tanítotam meg, de amit tudsz, 
az már a tied, azzal – remélem – biztonsággal mozogsz a 
Blenderben.

Most kicsit begyorsítunk: Már nem komplet projekteken  
dolgozunk, hanem szeretnék feldobni egy-egy problémát, s 
megmutatni azok megoldását. Eszközöket látsz majd, ame-
lyeket szabadon kombinálhatsz saját projektjeidben.
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A szimulációról

Mi a különbség az animáció és a szimuláció közöt? Az ani-
mációban te irányítod a dolgokat,  a  szofver csak kisegít 
abban, hogy a részletek 90–95%-át átvállalja. A szimuláció-
ban viszont  csak  a  körülményeket  biztosítod,  a  program 
pedig fzikailag korrekten kiszámítja, hogyan viselkedik a 
rendszer adot paraméterek és tárgyak kölcsönhatásában. 

A produkciós munkában ezek azok a 3D efektusok, me-
lyek valósághűbbé teszik a flmet. It, a látványanimáció-
ban  kiemelt  szerepük  van.  Ha  neked  kellene  animálnod 
cserépről cserépre, vízcseppről vízcseppre a bal oldali, talán 
golyó hatására szétrobbanó poharat, azt hiszem megérted, 
mit vesz le a vállunkról ilyenkor a számítógép.

A Blender fejlesztői az utóbbi tíz évben nagyon körültekin-
tő munkával követék az iparág szimulációs trendjeit, kihí-
vásait. 

Milyen lehetőségek vannak a programban ezen a terüle-
ten? Képes  részecskerendszereket kezelni, melyekkel havat, 
esőt, szálldogáló porszemeket, gázok áramlását, molekulá-
kat  szimulálhatunk.  Ebből  a  rendszerből  fejleszteték  to-
vább a hajszimulációt, mellyel természetesen szőrmét, füvet 
is  utánozhatunk.  Ezek  azután  kölcsönhatásba  léphetnek 
erőterekkel,  széllel,  stb.  A fzikai  szimulációs lehetőségek 
közöt van a merev- és rugalmastest-szimuláció, füst, folya-
dék,  ruhaszerű  viselkedés,  a  dinamikus  festés,  robbanások,  
óceán-szimuláció.
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Kép: Blendswap



394

Óceánszimuláció a Blenderben. (Kép: TreadGaming)

Ezek közül csak néhány példát szeretnék felvillantani, s né-
hány ötletet adni a kezelésükhöz.

Víz, hullámok, szánsájn

Wave ♦ A Mikrovilágok-kisflm készítésekor már használ-
tunk egy módosítót (Wave), mellyel nagyon egyszerű hullá-
mokat, síkon vagy testen tovaterjedő fodrozódásokat lehe-
tet kelteni. Ot épen egy ebihal araszolt át a látótéren ezzel  
a mozgással. Próbáld ki egy síkkal:  Add Modifer > Wave. 
Ne felejtsd el persze az Idővonalon futatni a szimulációt! 

Nem túl izgalmas: a sík le-fel rezeg… De mi is a hullám?
A rezgés tovaterjedése az anyagban. S mivel ezt a csatolt 
rezgésállapotot némi késleltetéssel veszik át a részecskék, 
egyfajta  fáziseltolódás  jön  létre  közötük.  Mindegyik 
ugyanazzal a rezgésszámmal rezeg, de nem némi késéssel 
egymás után. 
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Ha a kijelölt síkon átmész Szerkesztőmódba (TAB), látni fo-
god, hogy elég kevés a „részecske” – vertex, csúcs, térpont – 
vesz részt a rezgésben. Szám szerint négy, azok is a csücs-
kökbe  szorítva.  Végezz  többszörös  felosztást  it a  (W)  
gyorsbillentyű Subdivide parancsával.

Menj  vissza  Táregymódba  (TAB),  és  szembeötlő  lesz a kü-
lönbség: a sík, mint egy őrült rája elkezdet hullámozni.

A módosító paneljén látható, hogy a mozgás a sík két koor-
dinátája mentén terjed, ciklikus. A kitérés függőleges.

Kapcsold ki az X vagy Y összetevőt, hogy jobban megvizs-
gálhasd a hullámokat! Ebben az esetben egy irányban ter-
jednek. 
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Ha elvesznél a panel sokféle beállítása közöt, az alsó né -
gyet ajánlom tanulmányozásra: A sebesség (Speed), hullám-
hossz (Width), amplitúdó (Heigh) és a hullámforma szélessé-
ge (Narrowness). 

A módosító fő erénye az egyszerűség, ennek megfelelő ki-
csi az erőforrás-igénye. 

Ötletek: A hullám-módosítót természetes hatású víz meg-
jelenítésére nem nagyon használható. Elvontabb, ugyanak-
kor mozgásával mégis a hullámformákra, vízre emlékeztető 
elvontabb  animációkhoz  ajánlanám.  Jól  kombinálhatod  a 
Wireframe (drótváz)  módosítóval,  ha  a  térbeli  függvény-
szerű, hullámzó alakzatokat szeretnél bemutatni. 

Alkalmas betűanimációkhoz, logóanimációkhoz is.

21. Anyagszimuláció

A szövegre alkalmazott 
Wave módosító.

Logóanimáció: 
A betűk mintha vízben állnának, 

alattuk hullámzik egy tárgy. 
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Pancsolás ♦ A Blender fegyvertárában van ennél a módo-
sítónál nagyobb kaliberű eszköz is, melyet eredetileg arra 
találtak ki, hogy érintkező tárgyak átszínezzék egymást. Az 
eljárás neve dinamikus festés (Dynamic Paint), és a Blender 
szimulációs  paneljén,  a  Tulajdonságok-ablak utolsó  fülén 
találod. Viszonylag egyszerű a logikája van: Sok lapocskára 
felosztasz egy tárgyat, majd azt kinevezed festővászonnak 
(Canvas). Erre egy másik tárggyal ráfestesz (Brush).

Használatát egy síkon szeretném bemutatni. Hozd létre te 
is, majd oszd fel többször. (Szerkesztőmód > W > Subdivide).

Térj  vissza  Táregymódba  (TAB),  és  a  Tulajdonságok-ablak 
utolsó paneljén aktiváld a  Dynamic Paint gombot. Állítsd 
be Canvas (vászon) tulajdonságúra a síkot! 

Furcsa egy vászon ez kérem! Nyomd meg az Add Cancas 
gombot, ami újabb paneleket aktivál. It a  Dinamic Paint  
Advanced panelen nézd meg a Surface Type (a felület típu-
sa) legördülő menüt. Mert ez a vászon lehet  hullámzó, sú-
lyozható, deformálható, s végül, de nem utolsósorban  fest-
hető. Nekünk most csak az elsőre lesz szükségünk, de jó, ha 
tudsz róla, hogy it lehet megoldani, hogy a tárgyak nyo -
mokat hagyjanak egymáson, átszínezzék vagy behorpasz-
szák egymást.

A négy lehetőség közül számunkra a legnagyobb ajándék a 
Waves (hullámok) opció. 

Most hozz létre egy másik objektumot, mondjuk egy koc-
kát. Ezt pedig állítsd be ecsetnek (Brush).
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Ha az „ecsetet” beleteszed a vízfelszínt alakító „vászonba”, s 
az  Idővonalon  bekapcsolod a lejátszást (ALT+A), a felszín 
megmozdul  és  hullámok kavarognak rajta.  Valós  időben, 
fzikailag korrekt hullámok. A fenti képen sajnos látszik a 
vízfelszín elégtelen felosztása. Ez gyorsan korrigálható az 
Eszköztár > Smooth gombjával. 

Nem csak valós időben, interaktívan, hanem animáció köz-
ben is mozgathatod az „ecsetet” – szörfözés, motorcsónak, 
palack, bálna, stb. 

Talán érzed, hogy az előző  Wave módosítóhoz képest rea-
lisztikusabb, interakcióra épülő eljárást használunk.

Próbáld ki a következőt: Animáld az ecsetnek használt tár-
gyat,  majd helyezd el egy másik rétegen, amit nem akti-
válsz. Annak ellenére, hogy nem látható, fzikai hatásait ér-
zékeli a „vászon”. 
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A dinamikus festésben nagyon sok lehetőség rejlik, a víz-
felszín borzolása kifejezeten látványos. Nem akkora erő-
forrás-igényű mint a többi eszköz, amit a későbbiekben be-
mutatok.

21. Anyagszimuláció



400

Hajózni pedig érdemes!

Evezzünk mélyebb vizekre! A Titanic c. flmmel kezdődően 
számos flmben alkalmaztak óceán-szimulációt. A megvaló-
sítás sokáig foglalkoztata a Blender felhasználóit és fejlesz-
tőit, így programunkba is belekerült ez a funkció. 

Nem a fzikai szimulációk közöt találod majd, mint az elő-
ző eljárást – módosító let belőle.

Az Ocean Modifer vicces eszköz, mert a szó szoros értelmé-
ben bármily térhálóból – mint a lenti képen éppen egy ma-
jom fejéből – képes óceánt előállítani. Próbáld ki!

Ha lefutatod az animációt, olyan lesz, mintha gipszet  ön-
töttél volna vízbe. Gyakori érzés: Működni kéne a Blender-
ben valaminek, de nem indul el, s nem értjük, miért… Ha 
mozgatni szeretnéd az óceánt, változtasd meg a Time (Idő) 
értéket. A legjobb megoldás, ha a jelenet elején és végén is 
kulcsolod: megállsz a  Time mezőn, és (I) gombot nyomsz. 
Indulj 1-ről és legyen a záró érték 20.
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Ha nem szeretnéd, hogy komótos indulás, viharos közép, 
majd lelassuló, megdermedő zárás legyen, alakítsd át a ten-
ger mozgásfüggvényét lineárisra a  Mozgásgörbe-szerkesztő  
ablakban. (Graph Editor)

A hullámok formáját a  Scale (méretezés) és a  Choppiness 
(fodrozódás) értékekkel állíthatod be 

Most gyorsan megmutatom, hogyan helyezhetsz el a vízfel-
színen egy tárgyat, ami a tengerrel együt mozog.

Készíts először egy síkot, amit  Szerkesztőmódban néhány-
szor ossz fel  (W).  Ezeket a  vertexeket,  térpontokat  hozzá 
kell rendelned egy vertexcsoporthoz. Oké, de mi is az a ver-
texcsoport???? Tulajdonképpen egy ponthalmaz, melyet kijelö-
léssel és hozzárendeléssel hozunk létre azért, hogy a későb-
biekben  valamilyen  okból  hivatkozhassunk  rá.  Ilyen  hi-
vatkozási alap lehet például egy bábunál, hogy egy csont 
csak a comb vertexcsoportját mozgassa, s ne az egész bá-
bút. 
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It van például egy söröskrigli. Ha szomjas vagy, igyál az  
egészségemre. Nem kell elkészítened.

Modellezését egy  hengerrel kezdtem, aztán átléptem  Szer-
kesztőmódba.  Ot kiformáltam  az  üveget,  majd  ugyanit  
hozzáillesztetem egy tórusz felét. Visszatérve  Táregymódba 
a  program egy  testnek  látja,  pedig  én  tudom,  hogy  két 
tárgyból raktam össze. 

Te már éppen írnád a számlát, de a megrendelő problémá-
zik:  „Valahoegy másképp  kellene  állnia  annak  a  fülnekó”  
„Oké, haver, de a fül már belegyógyult az üvegbe.” 89 verte-
xet kellene egyenként kijelölnöm újra olyan helyeken, ahol 
egy kicsi tévesztés, és valami másba akadok bele.

No, ilyenkor jó, ha előrelátó vagy, és az egyes részeket cso-
portokba rendelted. It például leválasztható a fül.

Ha vertexeket kijelölsz, a „+” gombocskával hozol létre cso-
portot, az Assign (hozzárendelés) gombbal kapcsolod hozzá 
az általad kijelölt pontokat. Később, ha eltűnne a kijelölés, 
a Select-tel jelölheted meg újra azokat.
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A kis kitérő után újra a tengeren járunk. It van velünk a  
felosztot síklap. A  Tulajdonságok-ablakban keresd meg a 
Data (Adat) fület, ez alat lesz a Vertex Groups mező.

Ennek jobb oldalán van egy kis „+”-jel.  Nyomd meg, s a 
Group feliratot írd át „Bravo”-ra. Most érintsd meg az  As-
sign  gombot.  A kijelölt vertexeket ezzel hozzárendelted a 
„Bravo” csoporthoz. Bravó! Vissza is mehetsz tárgymódba.

Oké, hogy mindezt megcsináltad, mint egy robot, de mit is 
készítetünk elő? Van egy nagyon vicces  módosító,  ez  a
Shrinkwrap (zsugorfólia). Kb. úgy viselkedik, mint egy ko-
torékeb, ami lekushad a földre, s azt szorosan követve cser-
készi be áldozatát. Ezzel az eszközzel fogjuk hozzálapítani a 
felosztot síkot a vízfelülethez. 
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A létrehozot ponthalmazra  (Vertex Group) nem a tenger 
felszínének  követése  miat lesz  szükséged,  mert  azt  a
Shrinkwrap módosító enélkül is teljesen korrekten leköveti. 

Mi ennél többet szeretnénk, nem csak egy vízen úszó ma-
szatot vagy papírlapot, hanem egy csatahajót. Annak pon-
tos  mozgatásához  viszont  már  szükséges  a  ponthalmaz 
minden egyes pontjának a térbeli átlaga.

Mi is a logikánk? Tenger hullámzik > ezen ot úszkál egy  
szőnyeg, ami rálapul a tenger felszínére > a szőnyeg vezérli 
a csatahajó mozgását.

A síkot kijelölve hívd be a  Shrinkwrap módosítót.  Target 
(cél) gyanánt jelöld meg a háborgó tengert. Eredetileg egy 
majomból  készítetünk  tengert,  amit  a  Blender  Suzanne-
nek nevez, így ne csodálkozzunk, hogy ez a női név jelenik 
meg a cél helyén. A Vertex Group mezőbe katintva pedig a 
megtalálod a „Bravo” ponthalmazt. Ha beállítotad, látni fo-
god, hogy a sík rálapul a tengerre, felvéve annak formáját. 
Ha akarod, tologathatod is rajta, hűen leköveti azt.

Rendben, már csak a hajó hiányzik. Mit szólnál, ha elköt-
nénk Jack Sparrow kalózkapitány híres Fekete Gyönegyét?

A  mellékletben  megtalálod  a  039_Black_Pearl.blend  állo-
mányt. Mentsd most a sajátodat tenger.blend-ként, és mellé 
nyisd meg az előbbi állományt is. Két Blender fut most.
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Egy renderelt kép a Fekete Gyöngyről, Jack Sparrow galleon típusú hajójáról. A 
17. században kereskedelmi és katonai célra is használták ezeket a hajókat.

Szabadítsd meg a hajót minden felesleges sallangtól, amit 
nem szívesen vinnél át a háborgó tengeres állományba!

Tűnjön el tenger – minek belőle kető –, töröld ki a lámpá-
kat, a kamerát. Csupán a hajó maradjon középen.

(A)-val jelöld ki minden alkatrészét, (CTRL+J)-vel egyesítsd 
ezeket egy objektummá! (CTRL+C)-vel másold, majd menj 
át a tengeres munkádba, ot illeszd be (CTRL+V).
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Valahogy rá kellene venni a kalózhajót, hogy kerüljön egy, 
ki tudja mióta vízben ázó, szőnyeg parancsnoksága alá. 

A  Blenderben  ismerünk  ilyen  kényszerítő  eszközöket 
(Constraints),  melyek nagyon jól használhatóak pl. autók 
animációjánál.  Gondolj  bele,  miközben kormányzol,  nem 
kell  külön animálni  mindkét  kerék elfordulását.  Elég,  ha 
csak az egyiket állítod, a másik követi azt. Kitalálták ezt, 
kérem, s nekünk meg éppen jókor jön. A jele a Tulajdonsá-
gok ablakban két láncszem, és van egy szép menüje imit.

Jelöld ki a hajót. Válaszd a kényszerek közül a Transform >  
Copy Location (hely másolása)  parancsot.  Célnak (Target) 
jelöld meg a síkot (Plane). Ponthalmaznak (Vertex Group) a 
„Bravo”-t. E nélkül repülni fog a hajód! Majd kapcsold be 
az Ofset (eltolás) jelölőnégyzetet, hogy ne süllyedjen el.
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Futasd az animációt. A vízszintingadozásokat követi, és a 
szőnyeget mozgatva már képes tovasiklani a hajó. De jó!

Korrektebb lesz a mozgása, ha egy másik kényszert is al-
kalmazunk  rá  –  a  forgást.  Most  már  tudod:  Add Object  
Constraint > Transform > Copy Rotation (forgás másolása). 

„Kapitány,  eegy kis  baj  van!  Ha az Ofset  (Eltolás)  funkciót  
nem kapcsoljuk be, a hajó eszelősen süllyed. Ha meg az előb-
bihez hasonlóan bekapcsoljuk,  akkor pedig meg lebegó De  
van még it valami! Ha futatjuk az animációt, akkor olyan  
szinten remeg a hajó, hoegy a fedélközben nem tudnak levelet  
írni a matrózok a naegymamájuknak. Mit csináljunk, uram?”

„Csak sorban, sorban, fam! Úegy látom, kénytelenek leszünk  
bekapcsolni az Ofset beállítást, különben mosodának néznek  
bennünket! Aztán valahoegy a vízvonalig kéne süllyesztenünk  
a hajót, ha érti, mire gondolokó”

Érti, persze – a hajó vízvonala. Az az érzésünk, hogy a hajó 
forgáspontjának (Pivot Point) valami köze lesz ehhez…
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Hogy pontosan dolgozhass, jelöld ki a vízen úszó szőnye-
get, és az (ALT+G | ALT+R) kombinációkkal töröld az ösz-
szes mozgást és forgást, amit eddig alkalmaztál rá. 

Mielőt véglegesen beállítanád a hajó középpontját, futasd 
párszor az animációt, döntsd el, milyen legyen a tenger, a 
hullámok végleges mérete a hajóhoz viszonyítva.  Drámai 
hatású, több emeletnyi magas hullámokat szeretnél, melyek 
közt a  Fekete Gyönegy mint egy játék bukdácsol, vagy kon-
szolidáltabb környezetel is beéred? Jelöld ki az óceánt, és a 
módosító Size (méret),  Spacial Size (térbeli méret),  Choppi-
ness  (fodrozódás) és  Scale (méretezés) mezőivel találd meg 
az óceánod ideális méretét. A legfelső Repeat (ismétlés) ér-
tékekkel csínján bánj, mert ezek bár növelik a tenger felszí-
nét, egyútal jelentősen megterhelik a processzort.

Válts most egy olyan nézetbe, hogy oldalról lásd a hajót. A 
forgáspontját valahol az orrában fogod megtalálni, ezt kel-
lene elmozdítani. Erre több módszer van, most megmuta-
tom a legkönnyebbet. Válts  Szerkesztőmódba (TAB) és je-
löld ki a hajó összes pontját (A). Mozgasd el úgy ezeket (G), 
hogy a forgáspont a hajó függőleges középtengelyébe es-
sen, és a víz megfelelő szintig érjen. Az animáció futatásá-
val elképzelhető, hogy ezen még fnomítanod kell…
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A másik probléma a remegés. Oka pedig az, hogy a sző-
nyeg kis területen fekszik fel a tengerre. Ha nagyítod, alko-
tó  pontjainak  helyzetátlaga  már  nem fog  olyan  gyorsan 
változni – nagyobb víztömegből eredeztethető a mozgása. 

Ha megoldotad ezt a problémát, az úszó szőnyeget a szo-
kot módszerrel tüntetheted el : kapcsold ki a láthatóságát,  
és a renderelési tulajdonságát az Átekintő ablakban.

Akkor most fessük meg a képünket! A világ hátere  Sky 
Texture,  beállítható  a Csomópontszerkesztőben  a megjelölt 
Világ gombocskánál. A vízfelület előkészítésénél az üveg és 
tükör keverékéből indulunk ki, aminek helyes arányát az 
Add > Input > Layer Weight csomópontal állítjuk be.

Az üveg (Glass) legyen sötétszürke. Ne keverj bele színt. A 
tükör (Glossy) tompítás nélküli, fényesen tükröző.
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Tajtékos habok ♦ Habár elég szép a víz, de van még egy 
lehetőségünk:  némi  tajtékot  vinni  a  hullámok éleire.  Ha 
látványos, részletes mintázatot szeretnél, emeld meg a fel-
bontását (Resolution) a hullámoknak. 10 körül még nem túl 
látványos,  30 az ideális,  ha bírja  a  géped.  Kapcsold be a
Generate Foam (hab létrehozása) jelölőnégyzetet, majd ne-
vezd el a mintázatot „tajték”-nak (Foam Data Layer Name). 
Így kell majd hivatkoznod rá a csomópontszerkesztőben. A 
Coverage értékkel befolyásolhatod a mintázat nagyságát. 

A korábbi elrendezés szerint nem látszik semmi, hiszen a 
„tajték” nevű adathalmaz nem került be az anyagunkba.

Az Add > Input > Atribute csomópontal ezt mégis megte-
heted, persze írd be ennek a névmezejébe (Name) a „tajték” 
nevet. Ezt utána kapcsold rá az üveg csomópontra.
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Rendesen  bepókhálósodot a  víz!  Igazíts  egy  kicsit  rajta  
úgy, hogy az  Add > Color > RGB Curves csomópontot az 
Atribute és az üveg anyagtípus közé teszed, majd kialakítod 
a lenti színgörbét.

Ezzel a módszerrel kissé világosabbá tetük a habot, és így 
kevesebb is elég belőle.

Ennyi  munka  után  nyugodtan  elkészítheted  első  tengeri 
animációdat… A következő részben visszamegyünk kispá-
lyára, megnézzük közelről, hogyan fröccsen a víz  – vagy a 
fröccs.

21. Anyagszimuláció
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Folyadékszimuláció

Az előző szimulációknál kisebb vagy nagyobb vízfelületek 
viselkedését  vizsgáltuk.  Monumentális  hullámhegyeken 
bukdácsoló csatahajó, víz felszínét kavaró tárgyak – ilyen 
és ehhez hasonló szimulációkat hozhatsz létre a tanult eljá-
rásokkal. Most nézzünk meg, mi történik a mikroszinten a 
folyadék cseppjeinek közelében. 

Előrebocsátom, a folyadékszimulációnak nem fogok min-
den részletébe belemenni. Aki vizet, mézet, ropogós nápo-
lyirétegre  lágyan  ráomló  csokit  szeretne  készíteni,  azaz 
reklámanimációra használná, az kap majd elég tiszteletdíjat 
a víz-, méz-, ropogós nápolyi- és csokiforgalmazóktól, hogy 
a szimulációs panelek minden kis gombját, toligáját és bil-
lencsét kiismerje. Csak az alapelvekre szorítkozom. Sorry.

A dinamikus festés  (Dynamic Paint) típusú vízfelület-szi-
mulációnál jártunk már erre – a Tulajdonságok-ablak utolsó 
fülén,  a  szimulációs  panelen.  Válaszd  a  Fluid (folyadék) 
gombot, s rögtön belefutsz abba, hogy a világ kicsiben mi-
lyen bonyolult: Egy csomó lehetőség közül választhatsz, s 
ha amúgy intuitíve nem érzel rá, hogy mindezek közül a 
Domain a legfontosabb, akkor sokáig próbálkozhatsz, míg a 
Blenderből valami kis folyadék csurran-cseppen.

A Domain ugyanis a birtok, az uradalom, a tartomány, ami-
vel lehatárolod a szimuláció terét. Erre azért van szükség, 
mert ez a szimuláció először nem fut, hanem számol. Szá-
mol, számol, számol. Nem akarlak megijeszteni, de legalább 
annyit  számol,  mint a renderelésnél.  Ezért aztán érthető, 
hogy nem mindegy, mekkora az a Wales-i tartomány…

Domain-ként általában egy kockát, téglatestet vagy hason-
lót szoktunk létrehozni, remélve, hogy a kifröcsögő folya-
dék nem éri el annak határait, s nem veszi fel formáját. 

Kivéve, ha mondjuk akváriumot, vagy medencét szeretnél, 
készíteni, mert akkor előnyös is lehet.

21. Anyagszimuláció
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Mivel a Domain-en belül megy végbe a szimuláció, ha vala-
mit  látni  akarsz  belőle,  érdemes  átállítani  ennek  az  egy 
tárgynak a megjelenítését tömör (Solid) módban drótvázra.

Hoppá! Nem önellentmondás ez? Vagy tömör vagy drót-
váz!? Nos, a Tulajdonságok-ablak Object füle alat tárgyan-
ként rögzítheted a Maximum Draw Type (maximális megje-
lenítés) mezőben a megjelenítés minőségét.

Most  már  érdemes  ehhez  a  kocka alakú  „tartományhoz” 
beállítanod a szimuláció Domain tulajdonságát. Ezzel gátat 
szabunk a határtalan fröcskölésnek. Oké, de hol a víz?

Hogy tetszik parancsolni? Csapból folyjon vagy facsarjuk 
ki egy tárgyból? Az utóbbi? Ám legyen. 

21. Anyagszimuláció
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Helyezz  el  egy  objektumot  –  mondjuk  egy  majmot  –  a
Domain belsejében. Ennek folyadékszimulációs tulajdonsá-
gát állítsd a szimulációs panelen: Fluid > Type > Fluid-ra. 

Most jelöld ki a  Domain-nek választot kockát. Ez vezérli  
ugyanis a szimulációt. Innen lehet indítani. 

De  még mielőt elindítanád,  hallgasd  meg fgyelmezteté -
sem: Célszerű a Domain panelen a Cache (gyorsítótár) he-
lyét  magadnak  beállítani,  mert  ha  a  program által  előre 
rögzítet „kitudjahovaasajátproflodonbelül” helyre menti a 
számolásainak  eredményét,  azt  kezelni  nagyon  keserves 
lesz. De mit is jelent ez a vészjóslat? 

Hogy ne kelljen „fejben tartania”, a hátértárra a program 
kiírja a számolásait. It balra mutatom, hogy mit. 

Ha legközelebb a Blendert futatod, már nem kell újra szá-
molnia ezeket. Ha például egy másik gépen rendereled en-
nek eredményét,  akkor ennek a  Cache-nek a tartalmát is 
magaddal kell vinned, és ugyanarra a helyre beállítanod. 

Előfordulhat az is, hogy a korábbi Cache-re mentet adatsor 
jelenik meg egy újabb szimulációnál. Az ember nem érti, 
miért ömlik onnan is a víz, ahonnan nem kéne, pedig csak 
a múlt kísért. Ilyen esetben tudod, honnan kell törölni az 
adatokat, hogy tiszta lappal indulj.

Most már megnyomhatod a Bake (sütés, beégetés) gombot 
a  Domain panelen,  és  a  gép  kiszámítja  a  szimulációt.  A 
majmot elkezdi facsarni…

21. Anyagszimuláció
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A  Fluidként  megadot tárgy  átalakul  folyadékká,  majd  a  
gravitáció hatására lezúdul a Domain belsejében. 

Néhány jótanács: Ha színezni akarod a vizet, a szimuláció 
után már kijelölhető. De tudd, a folyadék anyaga valójában 
a Domain-test, melynek a térfogatában legeneráltad a szi-
mulációt.  Ezt látod el ízlés szerint üveg-  (Glass) vagy hi-
ganyszerű (Glossy) anyagtulajdonságokkal.

Kezdetben elég darabos a szimuláció,  ha nem akarod na-
gyobb felbontással újraszámolni, alkalmazd az Eszköztárból 
a  Smooth tulajdonságot,  ami  simítja,  vagy  a  Subdivision 
surfaces (felületosztásos simítás) módosítót. 

Ha nem érnéd el a várt eredményt, kénytelen vagy a szi-
muláció felbontásán (Domain > Resolution) módosítani. Fi-
gyelj arra, hogy van egy Final (végső) és egy Preview (elő-
nézeti) felbontás. 

A fenti képen az előnézeti felbontás szerinti, valós idejú renderelés, míg alat-
ta a végső renderelés látható simítás és módosító nélkül.

21. Anyagszimuláció
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A szimuláció után akár el is tüntetheted azt a testet – jelen 
esetben a majmot –, amiből a folyadékot kinyertük.

Végül  egy  rövid  magyarázat  a  folyadékszimuláció  többi 
eleméhez. Már tudod a Domain és Fluid típusú tárgyak je-
lentését. A Domain körülhatárolja, levezényli a szimulációt, 
majd biztosítja a folyadék anyagtulajdonságát. A Fluid test 
térfogatában jön létre a folyadék. Ha azt szeretnéd, hogy 
ne csak egyszerűen lezúduljon, a Fluid panelon beállíthatsz 
kezdősebességet: Initial Velocity.

A folyadékforrások típusai  (Type)  közöt találsz  Infow-t,  
azaz befolyót, ami csapot, slagot utánoz. Ezzel folyamatos 
vízsugarat hozhatsz létre. 

Kép: Andrew Price – BlenderGuru.com

Az  Outfow a  kifolyó,  lefolyó.  Az  Obstacle típusú  testek 
akadályt jelentenek a víznek. Ilyen lehet egy felület, amin 
végig szeretnéd vezetni, vagy egy pohár, amibe beleöntöd a 
folyadékot.
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Füstbe ment terv

Mivel a folyadékszimulációhoz hasonló a füst-, tűzszimulá-
ció, könnyebb megérteni, ha it tárgyalom.

Indítsunk egy Domain-nel, ami lehet továbbra is egy kocka. 
Valószínű, hogy ezt a szimulációt más fejlesztő készítete, 
mert a folyadékszimulációval ellentétben it azonnal drót -
váz-nézetűvé változik a Domain.

Helyezz el egy tárgyat ennek alján. Mondjuk egy majmot. 
Ez legyen Flow típusú (szó szerint folyam, de magyarul in-
kább tüzelőanyag). 

A  Flow  Type (tüzelőtípus)  legördülőjében  választhatsz 
Smoke (füst),  Fire (tűz), ezek kombinációja,  és az  Outfow 
(füstelszívó) közöt. Maradjunk egyelőre a füstnél.

A vízszimulációval ellentétben it nem kell kisütni (Bake)  
az  animációt,  hanem rögtön  futatható,  s  elég  látványos 
eredményt is ad…
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A dohányzás  káros  az  egészségre,  és  halált  okozhat!  Mi 
előre szóltunk. Ha ugyanis átállítod Fire + Smoke-ra a tüze-
lő típusát, annak ez lesz az eredménye…

A füstszimuláció elég látványos. It az előnézetben. De ha  
rendereled, akkor már nem annyira.

21. Anyagszimuláció

A kép valós idejű rendereléssel 
készült. A kocka alatt elhelyeztem 

egy síkot, a lámpát Sun típusúra 
cseréltem, a Világ pedig Sky 
Texture-rel van bevilágítva.
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Ezzel  bizony nem vesznek fel  az etyeki  flmgyárba piro-
technikusnak… De legalább nem termel szén-monoxidot.

Ez átlátszó kifogás. A  Domain viszont nem az! Mi a baj? 
Eddig olyan anyagokkal dolgoztunk, melyeknek a felülete 
(Surface) volt látható. Most viszont a test belsejében (Volu-
me) van egy látványos efektus,  melyet eltakar az objek-
tum. Valamit a térfogatal kell kezdenünk…

Nyiss  egy  Csomópontszerkesztő  ablakot,  és  építsd  fel  az 
alábbi rendszert. Az Add Shader, amivel még nem találkoz-
tál, egymáshoz adja két anyag tulajdonságait.

Szokatlan a felső ablak megjelenítése? A jó láthatóság miatt a File > User Pre-
ferences > Themes panelen Flatty Light-ra változtattam a Blender  kinézetét.

A Volume Absorption elnyelődést jelent. Ezen beállíthatod, 
mennyire nyeli el a fényt a közeg. A Volume Scater pedig 
az anyagban való szóródást. 

A közeg már tökéletes, de még valami hiányzik… 

21. Anyagszimuláció



420

A  tengerszimulációban  találkoztál  egy Input  >  Atribute
(tulajdonság) típusú csomópontal. Ot a „tajték” generálá -
sára használtuk. 

Most a „density” szót kell beírnod, ami sűrűséget jelent. Ez 
fogja vezérelni az elnyelés és szóródás szempontjából is a 
másik két csomópontot, méghozzá úgy, hogy azok Density 
(sűrűség)  bemenetére  vezeted  az  Atribute csomópont 
Fac(tor) kimenetét.

És az eredmény szürreális.  Dalí égő zsiráfa eldobot csikk  
ehhez képest… De annak egyelőre lángol a sörénye, a mi 
majmunk meg csak füstölög. 

Mivel a tűz kiváló fényforrás, gyanakodhatunk, hogy erre-
felé kell keresnünk a megoldást.
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Újabb varázsszó, újabb Atribute csomópont, és némi ügy-
ködéssel már lángol is a tüzelő majom – illetve éghető ob-
jektum.

Az új ág olvasata: A láng leírására használt tulajdonságot a 
fénykibocsátó  csomópont  fényerősség  bemenetére  kötöd, 
melynek színét sárgára állítod. Ezt egy Add Shader csomó-
ponton keresztül hozzáadod a korábbi anyagokhoz.

Alakul, de azért egy igazi láng nem olyan lágy mint a köl-
nivíz. Be kell szerveznünk a színezésbe egy olyan csomó-
pontot, amely árnyaltabban tud színezni. 
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Ilyen színárnyalatokat,  színátmeneteket  a  Csomópontszer-
kesztő Add > Converter > ColorRamp csomópontján találsz. 
Az átmeneten levő pöcköket kijelölve színezheted azokat, a 
„+” jellel pedig újabbakat adhatsz hozzá.

Nagyon vigyázz, hogy mit hova bogozol. Bár kicsit színe-
sebb let, de nem elég erős ez a láng!

Még tovább kell ügyeskednünk. Érzed talán, hogy az Emis-
sion csomópont erősségén kellene változtatni. Talán ha va-
lami szorzót betennénk a két csomópont közé…

Igen, van ilyen, mégpedig az  Add > Converter > Math me-
nüpontnál. Ha ennek a csomópontnak lenyitod a menüjét, 
annyi műveletet találsz, hogy a matek éretségit is ezzel ír-
nád legszívesebben. Nekünk most elég a Multipy (szorzás).
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Hm, elég tűrhető. 

Igyekeztelek eljutatni odáig, ahonnan már úgy tudsz to-
vább próbálkozni, hogy tisztában vagy az anyagszimuláci-
ók működésével. Látható, hogy sokféle fejlesztés nem egé-
szen konzisztens termékei. De a látvány kárpótolni fog a 
fáradságért.

A következő fejezetben tovább szimulálunk, de a témánk 
most már a testek mozgásával kapcsolatos, tehát mechani-
kai. 

21. Anyagszimuláció
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22. 

Mechanikai 
szimulációk

22. Mechanikai szimulációk

22.
Megismerkedünk a merev és rugalmas testekkel.
A súlytalanság állapotába kerülünk, tüsilabdát 
gurítunk, hajó vitorláját dagasztjuk. 
Megegyűlik a bajunk az erőterekkel, de végül 
vidáman kóstolgatjuk a zenélő szőlőszemeket.

 

mechanikai
szimulációk
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 Merevtest-szimuláció

Ha valamit össze akarsz dönteni, szétrobbantani, vagy azt 
szeretnéd, hogy egyszerűen csak úgy viselkedjen, mint a 
valóságban… hát akkor a merevtest-szimulációt neked ta-
lálták ki. Ütközések, egymásról elpatanó tárgyak, és egy 
kis játék a gravitációval. 

Gleb Alexandrov törésszimulációja

Kezdjünk egy egyszerűbb fzikai szimulációval! Indulj egy 
új Blender állománnyal. Hozz létre egy síkot, a talajt, ami 
felet valamekkora magasságban elhelyezel egy kockát, me-
lyet térben egy kicsit forgass meg.

Keresd meg a Tulajdonságok-ablakban a fzikai szimuláció-
kat, majd jelöld ki a kockát, és alkalmazd rá a  Rigid Body 
szimulációt. Futasd az animációt!

A kocka felgyorsul, átsuhan a síkon, és eltűnik a végtelen-
ben. (ESC)-el lépj ki a szimulációból. Állíts be ugyanilyen, 
Rigid Body típusú szimulációt a síkra is!

Ahelyet, hogy  megakadályozná  a  kocka zuhanását,  vele  
együt zuhan most a sík is. Milyen tanulságot vonhatunk le 
ebből? 

22. Mechanikai szimulációk
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Először: it is minden lefele esik, mint a valóságban. Má -
sodszor: A síkkal kell valamit csinálnunk, mielőt átüti az  
íróasztalunkat. (ESC)

Fizikailag  kétféleképpen viselkedhetnek a  testek  ebben a 
szimulációban.  Amennyiben  aktívak (Active),  hat  rájuk a 
gravitáció.  A  passzív (Passive)  testeket pedig mintha oda 
szegezték volna a tér adot pontjához, szilárdan tartják ma-
gukat. Nincs más dolgod, mint a sík státusát aktívról pasz-
szívra állítani. A kocka most megáll a talajon.

Figyeld meg, hogy azok a tárgyak, melyekre merevtest-szi-
mulációt  alkalmaztál,  kijelöléskor  nem narancssárga,  ha-
nem zöld  sziluetel  rendelkeznek.  A  program ezzel  jelzi, 
hogy egy szimulációs csoportba kerültek. 

Végezzünk egy kísérletet! Hozz létre még egy tárgyat, tedd 
aktívvá fzikailag, majd helyezd egy helyre a kockát és az 
új tárgyat. Mi történik?

Amit látsz, fontos flozófai kapcsolatban van a „térfogat” 
fogalmával.  Mi a  térfogatom ???? Az a térrész,  amit elfoglal -
tam, ahol én vagyok az úr. Más ot nem lehet. Ha mégis ide 
szeretne férkőzni, akkor balhé van. 

Igen, a konfiktus létrejön, a két test összeveszik az adot 
hely birtoklásáért,  és a kocsmai verekedés vége az,  hogy 
mindkető elszáll valahova. 

Most próbáld ki, mi van, ha ezeket a testeket külön-külön a 
talajjal metszed, azaz leereszted őket addig, hogy mondjuk 
az alsó harmaduk belelógjon a síkba.
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Az efektus most is létrejön, de a talaj  (passzív test) szilár-
dan tartja magát, így a másik kető felrepül.

Játsszunk tovább a  fzikai  szimulációkkal.  Hozz létre  né-
hány dobozból egy „falat”, melyet a golyóval fel kell dönte-
ni. Ezek aktív, míg a talaj passzív objektumok legyenek. 

Mivel  a  golyó magától  meg se  moccan mindaddig,  amíg 
kölcsönhatásba nem lép valamivel, hozz létre egy „ütőt” (a 
képen éppen ez van kijelölve), melyet passzívra állítasz. A 
panelen jelölheted még, hogy animálni szeretnéd. 

Nos, azzal, hogy animálod, te viszel be a rendszerbe kívül-
ről energiát. 

Ha nem sikerül feldönteni a dobozokat, növeld a gömb tö-
megét, így nagyobb lesz a tehetetlensége.

22. Mechanikai szimulációk
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Néhány játékötlet még: 

• Készíts gurítórámpát a golyónak! A gravitációs mező 
biztosítja az energiát, amivel eltolja a dobozokat. 

• Készíts dominósort, amit a guruló golyó indít el.

Ha tetszik a szimuláció, biztos sok ötlet eszedbe jut még. 
Ezekből szép látványanimációkat készíthetsz. 

Egy idő után lehet,  hogy kevésnek bizonyul  majd,  hogy 
minden úgy viselkedik, mint a valóságban – vagy mint egy 
óvodás építőkocka-játékában. 

Vigyünk a szimulációnkba egy kis meghökkentés-faktort! 
De előte meghívnálak egy csésze teára…

Teásbögre cukorral ♦ Egy új Blender állományból tün-
tesd el a kezdő kockát, rakj a helyére egy síkot! Az óceán-
szimuláció során már volt rá példa, hogy a jelenetünkbe kí-
vülről, más állományból hoztunk be tárgyat – akkor éppen 
egy hajót a vágólapon keresztül. Most a File > Append (hoz-
záfűz)  paranccsal  keressük  ki  a  040_teakeszlet.blend  állo-
mányt a mellékletből. Amikor rákatintasz erre, valami fur-
csa  dolog  történik.  A  belsejében  mintha  újabb  mappák 
nyílnának meg. Hasonlóan ahhoz, mint amikor egy tömörí-
tet állományba  belenézel.  A  Blender  ugyanígy,  szépen  
rendszerezve  tárolja  egy  virtuális  világ  összetevőit,  s  ha 
egy másik állományba később fel szeretnéd használni azo-
kat – textúrákat, anyagokat, világ-tulajdonságokat vaegy ob-
jektumokat –, akkor az Append paranccsal innen, a fájl bel-
sejéből beemelheted. Most bújj be az Object mappába, ahol 
megtalálod a teásbögrét.
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A síkot és a csészét is állítsd be passzívra, és felülről próbálj 
beledobni egy aktív kockacukrot – azaz aktív tulajdonságú-
ra állítot kockát.  Valami furcsa dolog történik:  A cukor  
megáll a csésze tetején, és képtelen lejjebb menni!

De mi lehet ennek az oka? Mivel it is egyfajta ütközés zaj-
lot le, joggal kereshetjük az ütközések  (Rigid Body Colli-
sions) panelen a megoldást. 

A  Shape  mezőben sokféle  alakzatot  találsz,  melyek mind 
ütközési alakzatok, befoglaló formák működnek.

Alapbeállítás a Convex Hull (konvex test, héj), ami csak tel-
jes egészében  konvex,  azaz mindenhol domború testekkel 
működik. 

Ennek a pohárkának a szája homorú. Ilyenkor érdemesebb 
a  Mesh (háló)  tulajdonságot  választani,  ami a  test  valódi 
alakjával dolgozik. Mivel nem absztrakció, több munkát ró 
a processzorra. Nem kell az égvilágon minden testet Mesh-
típusúra állítani. De most megoldódik a probléma, és a koc-
kacukor a pohár alján landol. 

Bevallom, ez csak egy kis kitérő volt, de fontos kitérő. 

Szeretelek volna számos későbbi bosszúságtól megkímél-
ni… Most vedd ki a cukrot. Kösd be magad, ugyanis mind-
járt repülünk!
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Kép: Zero Gravity Corporation (gozerog.com)

Teáskészlet zéró gravitáción ♦ A kifejezés a súlytalan-
ságra – zéró gravitáció – meglehetősen pontatlan. Súlyta-
lanság közben ugyanis csak a gravitációs erő hat ránk, sem-
mi más. Az pedig nem zéró. 

Nem kell nagyon távol menni a Földtől, hogy a súlytalan-
ság  állapotába  kerülj.  Elég  csak  leugranod  a  hokedliről, 
megtapasztalod egy pillanatra, hogy megszűnik a súlyod. 
Az az erő, amivel az alátámasztást nyomod vagy a felfüg-
gesztést húzod. A tömeged marad, de súlyod nem lesz. 

Szóval ezzel nem lehet fogyózni. Szabadesés közben ugyan-
is a mérleg a tárggyal együt esik, így a tárgy nem nyomja  
az alátámasztást. Az űrhajók is „körbeesik” a Földet, így ér-
zik súlytalannak az űrhajósok magukat. 

Hol lehet ipari méretben előállítani a Föld közelében súly-
talanságot? Hát például egy zuhanó repülőben! Van olyan 
légitársaság, kik ezzel foglalkoznak… 

De vajon a Blender-ben létre lehet-e hozni súlytalanságot? 
Igen, sőt igazi zéró gravitációt ???! 

Készítsük elő a jelenetünket…
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A File > Append paranccsal korábbi 040_teakeszlet.blend ál-
lományból helyezz el egy kiskanalat és egy tányérkát a je-
lenetben.  Ha  SHIFT-tel  rámutatsz  mindketőre,  együt is  
betölthetőek! Ha nem látnád rögtön ezeket,  előfordulhat, 
hogy  a  sík  alá  kerültek.  Némi  keresgélés  után  biztosan 
megtalálod.  Állítsd mindketőt aktívra.  Végezz rajtuk né-
hány dobástesztet. Eltörni nem fognak. Csak…

A síkon átüt a kanál és a tálka… Ha rendellenes viselkedést 
tapasztalsz az ütközések során, ameddig lehet, tartsd meg a 
Convex Hull alakbeállítást. Az ütközési távolság  (Collision 
Margin) fnom  változtatásával  ez  a  probléma  többnyire 
megoldható.

Repülő csészealjak márpedig vannak!

Amire fgyelj még, az a táregyak tömege. Amíg lefele potyog-
nak, addig nincs baj, hiszen Galilei óta tudjuk, hogy min-
den  tárgy  tömegétől  és  anyagától  függetlenül  ugyanúgy 
esik. De ütközés közben furcsa dolgok adódnak abból, ha a 
tálkának és a kanálnak is ugyanakkora a tömege. A súrló-
dás értékkel is eljátszhatsz (Friction). 
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Ha ezekkel a beállításokkal készen vagy, mind a négy test-
nek – sík és a teáskészlet három eleme – töröld az eddig 
mozgási és forgási jellemzőit (ALT+G | ALT+R).

Kicsit furán néznek ki egymás személyes terébe süppedve, 
de ez most nekünk éppen kapóra jön. Ennek ugyanis rob-
banás lesz a vége… 

Futasd az animációt, s a tárgyak szétrepülnek.

S most jön a trükk: a Blender  jelenetbeállításaiban (Scene 
fül a  Tulajdonságok-ablakban) találod a jelenet gravitációs 
(Gravity)  gyorsulását. Tüntesd el a kis pipát a jelölőnégy-
zetből, és futasd újra az animációt!

A szimuláció  aktív  szereplői  azzal  a  sebességgel,  mellyel 
szétdobják egymást, az idők végezetéig repülnek.
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S most jöjjön egy kis ravaszkodás. Nyilvánvaló, ha flmben 
szeretnéd  alkalmazni  ezt  a  jelenetet,  nem  lehet  derékig 
egymásba bujtatni a tárgyakat. 

Elég egy pici  közös  rész,  az  már szépen szétveti  azokat. 
Arra is fgyelj, hogy mindegyiket egy kissé forgasd el a tér-
ben, akkor nem csak repülnek, hanem pörögnek is!

Néhány ötlet érdekes animációk készítéséhez:

• Helyezz el több tárgyat egy csendéletként, többségé-
nek legyen egy kis szabálytalan metszete a talajjal. 
Kapcsold  ki  a  gravitációt.  Az  animáció  indításával 
mindegyik kap valamilyen kezdő sebességet. Ha túl 
nagy lenne, a tömeg (Mass) értékének növelésével fo-
kozod a test tehetetlenségét,  azaz csökken a sebes-
ség, amire adot erővel felgyorsítható. 

• A Gravity jelölőnégyzet animálható. Elég csak felete 
megnyomni az (I) gombot. Ez azt jelenti, hogy ki/be 
kapcsolhatod a nehézkedést, mintha egy zuhanó re-
pülőgépben éppen súlytalan, vagy – a pálya korrek-
ciójával – súlyos állapotok váltakoznának.

• Próbálj  elérni  szépen sodródó állapotokat.  Ilyenkor 
elég, ha néhány tárgy indítja be a dinamikát, a többi 
közé elhelyezve.
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• A mozgás, mint ahogy korábban látad, indítható egy 
aktív testel, amikor az Animated (animált) kapcsolót 
is aktiválod. 

A legcselesebb megoldás ♦  Hogyan lehet szépen rende-
zet, egymásba nem érő tárgyakat szabálytalan mozgásokra 
késztetni  úgy,  hogy  láthatatlan  maradjon  az  „elsődleges 
mozgató”? 

Tedd át egy másik dimenzióba – rétegre –, ahol nem lát-
szik. Ha kikapcsolt rétegen  aktív, animált test mozog, an-
nak ellenére, hogy nem látszik, más testeket mégis mozgás-
ba hoz. 

Ugyanez elérhető az Átekintő ablakban is, ha kikapcsolod 
az aktív test  láthatóságát/renderelhetőségét.  Lehet egy ho-
mogén test, vagy egy olyan síkforma, melynek erőteljesen 
változik a topológiája. Ha egy példásan rendezet tárgyhal-
mazt  szabálytalan  mozgással  szeretnél  indítani,  tégy  alá 
egy felosztot, de pontjaival deformált síkot.

A sík felosztását Szerkesztőmódban (TAB) végezheted a (W) 
gyorsbillentyű  Subdivide parancsával.  A  vertexeket
külön-külön mozgathatod. Ha nem szeretnél éles csúcso-
kat, hanem lankás domborzatot, kapcsold be az alsó menü-
ben a Proportional Editing (arányos szerkesztés) opciót. En-
nek  hatósugara  mozgatás  közben  az  egér  görgőjével 
változtatható.
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Mivel a sodródó mozgásoknál szinte minden mozog, a ka-
merának állnia kell. Nagyon izgalmas lehet, ha több kame-
rás rendszerrel dolgozol, és ugyanazt a jelenetet több szem-
szögből  is  megmutatod.  A  kamera  fele  szálló,  perspek-
tivikusan egyre növekvő testek pedig igazán izgalmasak, 
sokszor alkalmazzák ezt a hatást 3D flmekben!

Rugalmasság

Az  előző  szimuláció  a  testeket  egy  rendszerként  kezeli. 
Csakhogy nem számol a deformációval. Márpedig vannak 
olyan  anyagok,  melyek  kölcsönhatás  közben  jelentősen 
megváltoztatják  alakjukat.  Ilyen  a  legtöbb  műanyag,  fa, 
gumi, de még a fémek is, gondolj csak a rugóra.

A Blenderben kétféle – jellegtől függő – szimulációt hasz-
nálhatsz ilyen esetben: a rugalmasság- (Sof Body) és a ru-
haszimulációt (Cloth). Kezdjük az előbbivel.

Sünilabdák a lejtőn ♦ Ismered a tüsilabdákat???? Talán így, 
hogy masszázslabda ???? 

Tudod,  amolyan  rücskös  felületű,  teniszlabda-nagyságú 
labdacsok.  Ha  ezzel  dögönyözöd,  stimulálod  az  arcodat, 
akár  18  évet  is  fatalodhatsz  öt  perc  alat. Kiskorúaknak  
emiat használata tilos! Én is kipróbáltam, de belegabalyo-
dot a szakállamba. Az ügyeleten, míg leszedték, majdnem  
hatvan évet öregedtem, és a kórusban ezután csak kolora-
túr szopránt énekelhetek.
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Egy ilyen sünilabdát már animáltunk a Mikrovilágok fejezet-
ben. Szaladj vissza oda, hogy el tudd készíteni!

Sikerült? Oké, folytassuk! A labda egy síkon fog legurulni 
– azaz ledöcögni –, melyet enyhén dönts meg. A sík legyen 
passzív merev  test.  Enyhén  karcos  tüköranyag  (Glossy), 
melyre felvihetsz egy sakkmintát (Checker Texture). 

A süni Ambient Occlusion (szórt fényű) shadert, anyagtulaj-
donságot kap, ami előnyösen kiemeli plasztikusságát, a raj-
ta levő árnyékok hangsúlyozásával. Kezdetben rakd egy ki-
csit feljebb, mint a sík, hogy ráessen arra. Kapcsold be a 
Sof Body tulajdonságot a fzikai panelen. 

Mivel  a  rugalmasságszimuláció  csupán az anyag belsejé-
ben, vagy ütközés során fellépő felületi mozgásokra fgyel, 
kezdetben  egy  helyben  oszcillál  a  főszereplőnk.  Hogy  a 
gravitációs mezővel kapcsolatba lépjen, rendelj hozzá Rigid 
Body szimulációt is! A labda leesik, majd kis tüskéivel ru-
ganyosan végigmászik a síkon, míg a mélybe veti magát…
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Dagadó vitorlák ♦ Most egy hajó vitorláját tesszük alkal-
massá arra, hogy belekapjon a szél.

Töltsd  be  a  041_vitorlás.blend állományt,  majd  vizsgáld 
meg, hány részből áll a hajó. Mivel a vitorla elkülöníthető, 
nyert ügyünk lesz: Csak ez az, amit ruhaszimulációval kell 
mozgatnunk. Jelöld ki a vitorlát, és alkalmazd rá a  Cloth  
szimulációs gombot a fzika panelen. Futasd a szimulációt… 
Mit tapasztaltál?

A vitorla mint egy guillotine, hosszában átvágja a hajót. Fél 
siker: Kiderült, hogy a rugalmasság-szimulációval ellentét-
ben a ruhákra hat a gravitáció. A vitorlát ennél lelkiismere-
tesebben kell rögzíteni, kis kadét!

A felbukkanó ruhaszimulációs panelen találsz egy Pinning 
(rögzítés)  jelölőnégyzetet.  Ezt  bekapcsolva azt  kéri  majd, 
hogy jelölj ki a tárgyon egy  ponthalmazt  (Vertex Group), 
amit erre fel tud használni.

Kiválasztani  nem  lehet  semmit, 
mert még nem hoztuk létre ezt a 
csoportot. Nosza, lépj át  Szerkesz-
tőmódba (TAB), és jelöld ki a jobb 
oldali  ábrának megfelelő  éleket  a 
SHIFT  gomb segítségével,  egyen-
ként.  Menj a  Tulajdonságok-ablak 
adat  paneljára (Data),  ahol  a  Ver-
tex  Groups mező  mellet a  „+”  
gombbal kérj egy új ponthalmazt. 
Nevezd  el  „rögzítésnek”.  Végül 
rendeld  hozzá  a  kijelölt  élekhez 
tartozó pontokat az  Assign gomb-
bal.  Erre  már  tudsz  hivatkozni  a 
ruhaszimulációs  panelen,  a  Pin-
ning mezőben. Menj vissza (TAB)-
bal tárgymódba. 
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Futasd a szimulációt! A vitorla saját súlyánál fogva leom-
lik, de a rögzítések megtartják! Győzelem!

Már  csak  a  szél  hiányzik… A  Blender  Add  menüjéből 
(SHIFT+A) hívhatod elő az erőtereket (Force Field). Sokféle, 
nem látható, de hatásaiból érzékelhető mezőt, és erőt vá-
laszthatsz innen. Van, ami úgy működik, mint egy valósá-
gos erőtér (Force), örvény (Vortex), s it van a szél is (Wind), 
amire éppen szükségünk lesz.

Fordítsd a vitorla fele a szelet, és indítsd el az animációt. 
Nem túl meggyőző. Gyakorlatilag semmi változás.

Ha kijelölöd a szél erőteret, a fzikai szimulációs panelen 
látod, milyen értékekkel dolgozol. A Strength  (erősség) ér-
ték 1. Állítsd 500-ra, és fogd meg a kalapod!
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A szél belekap a vitorlába. Azt hiszem, készen vagyunk…

A vitorla hozzáparentolható (CTRL+P) az árbochoz, az ár-
boc a hajóhoz, stb. Gyakorlásként végezd el ezeket a műve-
leteket, színezd ki a hajót anyagtulajdonságokkal, alakítsd 
ki  a  környezetét.  Akár  tengerszimulációval  is  gyakorol-
hatsz.  Ha  a  modellt  Szerkesztőmódban  nézed,  ne  lepődj 
meg, mindig csak a fele látszik. Mivel szimmetrikus alak-
zat, alkalmaztak rá egy Mirror (tükröző) módosítót. Teljes 
hajótestet kapsz, ha megnyomod az Apply (végrehajt) gom-
bot. A módosító eltűnik, de a hatása beépül a tárgyba.

Kép: Zakarias Reinhardt 

A ruhaszimulációval nagyon szép drapériákat, szélben lo-
bogó zászlókat, sőt, valódi, térbeli modelleken viselhető ru-
hákat is készíthetsz. 
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Részecskerendszerek

Animációs  programokban  nagyon  régóta  található  egy 
olyan alrendszer, amivel nagy számú tárgyat lehet egyszer-
re animálni.  Gondolj it egy hal-,  madár- vagy méhrajra,  
részecskék áramlására, esőcseppekre vagy hópihékre. Ezek 
a részecskék aztán mindenféle erőtérrel vagy tárggyal köl-
csönhatásba léphetnek, ami egy csomó izgalmas lehetősé-
get rejt magában. Mi például hangvizualizációra használjuk 
majd. 

Egy új állomány közepén álljon egy gömb. Ő lesz a részecs-
kéket kibocsátó  emiter???: olyan mint esőnél a felhő. A tár-
gyat úgy készítheted fel erre, hogy a  Tulajdonságok-ablak 
utolsó  előti Particles (részecskék)  fülére  mész,  és  a  New 
gombbal egy új rendszert hozol létre. Futasd az animációt!

A gömb elkezdi szórni magából a részecskéket. Ezek még 
nem látszanak renderelésnél, de valami elkezdődöt. 

Ha megnézed a részecskék-panelt, kissé ijesztő. Ha a vető-
gépet  kezelő  traktorosnak is  ennyi  beállítás  lenne a mű-
szerfalán, sose ennénk kenyeret.

Szelídítsük meg a részecskerendszerünket!

22. Mechanikai szimulációk



441

Lenyomot bal egérgombbal, ha az Emission-tól kezdve vé-
gigsimítasz a paneleken, azok kinyílnak, vagy bezárulnak. 

Nézzük  először,  hogyan  lehetne  a  részecskékből  valamit 
látni a renderelésnél. Érintsd meg a Render panelt, és az ki-
nyílik.

Korábban említetem, hogy a Blender alapesetben háromfé-
le renderelő motort használ, ezek: a  Cycles, a régi  Blender  
Render (Internal),  és az OpenGL alapú játékmotor. A fenti 
panel  gombjainak többsége it maradt  a  múltból,  amikor  
még az ezredfordulón varázscsillámokat és egyéb, ma már 
mosolyt fakasztó dolgokat vezéreltek a részecskeredszerek. 

Az általunk preferált Cycles esetében vagy Object-et válasz-
tasz, vagy nem látsz semmit. Tiszta üzlet…

A részecskeszóró gömbtől távol hozz létre egy Add > Sur-
face > Nurbs Sphere típusú gömböt. 

Jelöld ki a korábbi részecskekibocsátó tárgyat, és a részecs-
kék Render > Dupli  Object   paneljén mutasd meg az új 
gömböt. Futasd újra az animációt! 

Pirinyó gömbök kezdenek potyogni, s ez már a renderelé-
sen is látszik!
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Most nyisd meg a részecskék Field Weights (térerő) panel-
jét, és a gravitáció mezőt nullázd le. Az objektumok sugár 
irányban hagyják el a gömböt. Nincs, ami lehúzza őket. 

Menj át a  Physics panelra (ez a részecskékhez tartozó fzi-
ka),  és  próbáld ki,  hogyan mozognak a  gömböcskéid,  ha 
Newton-i, Boids vagy Fluid típusú a mozgást állítasz be ne-
kik. Játssz egy kicsit a  Size (részecskeméret), és a Random 
Size (véletlen méretezés) csúszkákkal.

A nagy tülekedésben talán látható, hogy egyes részecskék 
egy idő után eltűnnek, mert lejár az életartamuk. 

Próbáljunk ezen változtatni, hogy könnyebb legyen tanul-
mányozni a mozgásukat! 

A legfelső panel vezérli a kibocsátást (Emission). Az élettar-
tam (Lifetime) képkockánkért értendő. Ezt állítsd  5000-re. 
Ez elég nagy ahhoz, hogy ne haljanak meg. 
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A Start/End értékkel megadhatod, hogy hányadik képkoc-
kától induljon a kibocsátás, és mikor érjen véget. Ez utóbbi 
legyen most 50, azaz nagyjából két másodperc alat dobja  
ki magából az összes labdacsot a nagy gömb.

Térj vissza a részecskefzikai tanulmányaidhoz (Physics), és 
próbáld újra a három fajta mozgást.

A  Newton-i  (balra)  olyan,  mint  a  jelenlegi  világegyetem-
modellünk: gömbhéjszerűen, egyenletesen szerterepülő re-
peszdarabok. A boidák (középen) mozgása a gázokéhoz ha-
sonlóan  ütköző,  egymáson  elpatanó.  A  folyadék-típusú 
(jobbra) dinamikusan szétlövell, de nagy a vonzóereje a ré-
szecskéknek, és elkezdenek csomósodni, tömörödni. 

Válaszd a boidákat (Boids), mint mozgásrendszert. Most az 
Add > Force Field > Force menüparanccsal készíts egy erőte-
ret  a  részecskeszóró  gömb ölét.  Ugyanonnan hívjuk  elő, 
mint az előző, hajós feladatban a szelet.

Ha lefutatod az animációt, olyan érzésed lesz, mintha visz-
szakapcsolták  volna  a  gravitációt,  a  gömbök  elkezdenek 
lassan lefele esni. De ha a gömb alá viszed az erőteret, fel-
fele szállnak. Tehát  ez az erőtér taszító hatást fejt ki a ré-
szecskékre. 

Persze meg lehet fordítani – és mi éppen ezt szeretnénk. 
Egy helyre gyűjteni a kis gazfckókat…

22. Mechanikai szimulációk



444

Jelöld ki az erőteret, majd a Tulajdonságok-ablak utolsó, ed-
dig  szimulációra  használt  panelján  állítsd  át  negatívba  a 
Strenght (erősség) értékét. 

Futasd az animációt! Az erőtér szinte felszippantja a boi-
dákat.

Hangvizualizáció ♦ Korábban látad, hogy szinte minden 
animálható a Blenderben. Ha el tudjuk érni, hogy valame-
lyik látható tulajdonságot a hang erőssége vezéreljen, ak-
kor láthatóvá tetük, vizualizáltuk a hangot.

A frekvenciasávokra bontott hang adott sávon való erősségét hisztogramon 
ábrázolták.

Mi a boidák méretét fogjuk a hangerő függvényében vál-
toztatni.
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Térj vissza a tér közepén buborékokat eregető gömbhöz, és 
jelöld ki azt. Az időben tekerj hátra az első képkockához.

A  részecskerendszerek  Physics paneljén  a  Size mezőben 
nyomd meg az (I)  gombot,  ezzel  elhelyeztél  egy kulcsot.
A mező besárgul.

Hozz létre a munkaterületed tetején egy ablakot, amit ala-
kíts át Mozgásgörbe-szerkesztővé (Graph Editor). 

Ha ennek bal oldalán lenyitod, hogy milyen csatornákon 
jöt létre változásgörbe, akkor egy  Size (méret) értéket ta-
lálsz, a hozzá tartozó lapos, sárga egyenessel.

Jelöld ki a grafkon kezdőpontját. Most a Key > Bake Soud 
to F-Curves (hang görbére való égetése) paranccsal töltsd be 
a melléklet 042_bensound-dubstep.wav hangfájlját.

Ezzel elértük, hogy a korábbi lapos görbére írt hangerő-vál-
tozások vezéreljék a boidák nagyságát. 

Nézd meg az animációt!

22. Mechanikai szimulációk



446

Változtasd meg a kamera állását „rajzflmesre”, azaz a he-
lyezd el a tárgyak felet. Ebben segít az (ALT+G | ALT+ R),  
mely visszahelyezi a kamerát az origóba, lefele néző állás-
ban. Neked csak felfele kell húznod a kék manipulátorral.

Innen nézve hangvizualizációnk hasonlít egy, a zene üte-
mére  agresszívan  terjeszkedő  tumorra.  Kissé  túlzásnak 
érezzük, hogy ezer gömb a képünkbe oszcillál. 

Csökkentsd le a számukat 50-re  a részecskerendszer első, 
Emission panelén, s mindjárt átláthatóbb minden.
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Még két animációs fogással dobjuk fel a rendszerünket. Ne 
csak a részecskék nagyságát változtasd a zene függvényé-
ben, hanem a köztük levő különbségeket is a zene vezérel-
je. Magyarul: pulzáljanak a részecskék, de ne legyen mind-
egyik ugyanakkora, legyen ebben is egy kis változatosság.

Menj vissza az első képkockára. A részecskerendszer  Phy-
sics  paneljén kulcsold be a  Random Size (véletlen méret) 
mezőt (I).

Jelöld meg a grafkon kezdőpontját! Süsd bele ide is a ko-
rábbi hangfájlt. Segít, ha közben a Size csatorna láthatósá-
gát kikapcsolod az előte levő szemecske becsukásával. 
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Az aprónak tűnő változás,  a  végső megjelenésben fontos 
szerepet játszik, majd meglátod. 

S ha már ennyire belejötél a hangok beégetésébe, vezérel-
jük az erőtér helyét is zenével. 

Jelöld ki az erőteret. Menj vissza az első képkockához az 
Idővonalon. Nyomd meg az (N) gombot, és a 3D ablak jobb 
oldalán  felnyíló  Tulajdonság-panel tetején  kulcsold  be  az 
erőtér X-tengely szerinti helyzetét (I).

Nézzünk rá a mozgásgörbékre!
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Csak az X Location csatorna maradjon látható. Jelöld ki a 
kezdőpontját, s égesd rá a hangot. Futasd az animációt. Az 
erőtér mozgása újabb változatosságot visz az animációba. 

Kár,  hogy közben nem halljuk, milyen zene fut a jelenet 
alat. A hang háromszor is mozgássá, változássá alakult, de 
közben elveszet. Ha most renderelnél, némaflmet kapnál.

Szuszakolj be még a munkaterület tetejére egy  Videoszer-
kesztő ablakot, s töltsd be a hangfájlt : Add > Sound.

Ebben az ablakban az is látszik, hogy a hangfájlunk terje-
delme 356 kocka. Ennek megfelelően állítsd be az animáció 
hosszát is erre az értékre.

Most már megnézheted, s hangot is fogsz hallani. Oké, nem 
lakodalmas zene.  Dub-step.  Ezzel jobban lehet pumpálni a 
labdákat…
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Színezés ♦ Minden a helyén, csak még szürke. A felső két 
ablakot  vond össze,  és  alakítsd  át  az  így  keletkezet na -
gyobb területet csomópontszerkesztővé. Jelöld ki a már ré-
gen  félretet gömböt,  melyet  forrásként  használtál  a  ré -
szecskerendszer  bubijaihoz.  Ezt  sokszorozta  meg  az 
Emiter, a másik, középen levő gömb. 

Hozz létre egy új anyagtulajdonságot, nevezd „bubi”-nak. 

A difúz és a tükröződő felület egyértelmű. Az utóbbinak az 
érdességét növeld maximumra, és a kető arányát vezérelje 
egy  Fresnel típusú  csomópont  (Add  >  Input  >  Fresnel).
Ez lesz a felelős azért, hogy más-más betekintési szögekkel 
másképp lássuk a test felszínének részleteit. 

Zavaró, hogy a boidák mögöt látszik az emiter gömb. Ha 
az Átekintő ablakban kikapcsolod ennek láthatóságát, a ki-
bocsátot a részecskék sem látszanak majd. Más módszerrel 
kell eltüntetnünk.

Jelöld ki a részecskekibocsátó gömböt, és keresd meg a ré-
szecskerendszer beállításainál a Render panelt, s it kapcsold 
ki az Emiter jelölőnégyzetét. 

Ekkor valóban eltűnik a gömb.
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Hozz létre Area típusú lámpákkal egy szép bevilágítást. 

Ha ennek fényében megvizsgálod a boidákat, belefutsz egy 
NURBS alakzatokra jellemző hibába. Ez abból adódik, hogy 
generálásuk gyors, matematikai absztrakciókra épülő felü-
letek, de emiat kicsit elnagyoltak.

A gömbök sziluetje  sarkos,  darabos.  Jelöld  ki  a  félretet 
gömböcskét. Növeld a felbontását a bal oldali ábra szerint.

Így tökéletesen jelenik meg az előnézetben és a renderelés 
végeztével is.
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Egészítsd ki ugyanennek a gömbnek az anyagtulajdonságát 
még egy csomópontal (Add > Input > Particle Info). Ennek 
az lesz az értelme, hogy a részecskék mérete határozza meg 
majd a színüket. Egyelőre ez még csak árnyalatban látszik.

Az Add > Converter > ColorRamp (színátmenet) csomópont 
színezésével elérheted, hogy a gömbök méret a színskála 
szerint színeződjenek el. 

S az eredmény…
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Tessék választani! Van, akinek a hamvas szőlőszem jön be, 
másnak meg a lakkozot drazsé. 

A rendereléshez minimális értékek is elegendőek. Mintavé-
tel 50–100 közöt. Sugárkövetés a lehető legkisebb. 

– – – 

Elég hosszan foglalkoztunk a szimulációs  lehetőségekkel, 
persze így is marad még megismerni való. Mivel a látvá-
nyanimációk  jelentős  hányada  ilyen  szimulációkból  építi 
fel a világát, talán nem volt elvesztegetet idő. 
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23. 

Utómunka

23. Utómunka

23.
Kompozitálás és flmvágás – a flmes 
munkafolyamat vége. Elkötünk eegy harci helikoptert 
Kecskemétről, tökéletlenségeket viszünk eegy flm 
megjelenésébe, amitől valóságosabbnak látszik, és 
kipróbáljuk a videoszerkesztőt. 
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A könyvnek – s a flmes munkafolyamatnak is – a végén 
járunk. Mióta a speciális efektusok domináns szereplői a 
flmgyártásnak, felértékelődöt az utómunka szerepe. S ne  
gondoljuk, hogy csak a fantasztikus flmekben vagy a szu-
perprodukciókban! Ma már teljesen természetes, hogy egy-
egy jelenet háterét, díszleteit CGI elemekkel helyetesítik.

Az utómunkának két fontos eleme: a kompozitálás és a vá-
gás. Az első egy vertikális (függőleges) folyamat, ahol réte-
genként  egymásba mossuk a  rendereléseink eredményét. 
Közben  az  egyes  rétegeknek  változtathatunk  a  fényein, 
élességén, s egyéb efektusokkal is elláthatjuk azokat. 

A vágás horizontális, it egymás után illesztjük a flm jele -
neteit, megfelelő értelmezéssel és ritmussal látva el a végső 
produkciót. 

Kompozitálás

Jelentése szerint társítás, több összetevőből történő összeil-
lesztés. Nagyobb flmes projekteknél azok a 2D efektek tar-
toznak ide, ahol élő felvételeket, 3D animációkat és speciális  
efektusokat összemosnak, egy képkockára komponálnak.

Bár ritkábban fordul elő a gyakorlatban, de a Blender alkal-
mas  arra,  hogy  a  teljes  flmes  munkafolyamatot  átfogja. 
Gyakoribb,  hogy másokkal együt kell  dolgoznunk,  tőlük  
megfelelő bemeneti állományokat kapva, vagy nekik szabá-
lyos kimenetet biztosítva. 

A kompozitálás szakaszában már korábban leforgatot, il -
letve renderelt elemek kerülnek egymásra. A mi kimene-
tünk ilyenkor egy képsor, képkocka-szekvencia. Miben kü-
lönbözik ez egy normál flmtől? Nem lenne logikusabb egy 
videóba  összefogni  az  elkészült  képkockáinkat?  Abban, 
hogy hátér nélkül kell renderelnünk, hogy aztán könnyen 
illeszthető legyen egy másik képsorra. 
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Nincs olyan flmformátum, ami átlátszó háteret tudna ke-
zelni, ezért kénytelenek leszünk képsorozatként létrehozni 
a munkánkat, majd azt egy másik képsorra vagy flmfelvé-
telre másolni.

A  későbbiekben  persze  még  sokféle  problémába  belefu-
tunk, amíg egészen hihetővé, valóságszerűvé válik a kom-
pozíció: megfelelő megvilágítás, a hátér és a réteg színei-
nek  egyeztetése,  élesség,  stb.  De  haladjunk  csak  szépen, 
sorjában.

Hogyan animáljunk? ♦ Az első problémával még a pro-
dukciós szakasz közepén szembesülünk: Miként lehet úgy 
mozgatni egy tárgyat a hátérrel összhangban, ha a hátér-
felvétel nem is látható? 

A fenti példából kiindulva: 

• Költséghatékonyabb-e  leforgatni  egy tíz  másodper-
ces jelenetet, melyben egy harci helikopter egy erdő 
felet repül, 

• vagy modellezzük, animáljuk a helikoptert, s helyez-
zük egy drónnal készült az élő felvételre? 

A válasz, az utóbbi tíz-tizenöt év gyakorlatában az utóbbi.
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Az animációhoz használt hátér elhelyezhető a Blenderben 
referenciaként, de tudj róla, ez a kép vagy képsor nem ke-
rül  rá a renderelt  felvételre,  csupán segítség a mozgások 
beállításához!

Nézzünk rá egy példát. Nyisd meg a 043_Mi_24.blend állo-
mányt, melyben egy – a magyar légierőben is rendszeresí-
tet – harci helikoptert találsz.

A Tulajdonságpanelen (N) kapcsold be a Background Images 
(hátérképek) mezőt. Nézőpontnak jelöld meg a kamerát a 
panelen  (Axis > Camera).  Majd nyomd meg a  Movie Clip 
(videó) gombot. Ha külső felvételt szeretnél vetíteni, kap-
csold ki a Camera Clip jelölőt, s utána betölthetővé válik a 
hátérvideó. Ez legyen a 043_Forest.mp4 flmállomány.

Az animációt futatva mozog a hátér és a gép rotorja is.
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Ha egy állóképes próbarendert készítesz (F12), látni fogod, 
hogy a pozicionáláson kívül az égvilágon semmi más sze-
rephez nem jut ez a hátér. Animációhoz, vagy különböző 
nézőpontokhoz beállítot műszaki rajzokkal modellezéshez  
viszont kitűnően használható.

Forgasd el most térben a helikoptert az őt körülvevő üres 
alakzatal, ami egy nagy téglalap. 

Az előző renderelésnél látad, hogy a hátérrel együt szá -
molta ki a program a helikopter képkockáját, ami egy ég-
gömb bevilágítása volt. Tüntessük el ezt a háteret, hogy a 
kompozitáláshoz megfelelően előkészítsük a képkockát!

Átlátszó hátterű kép ♦ A Tulajdonságok-ablak renderelé-
si paneljein találod a megoldást. Ennek jócskán az alján ta-
lálod a Fim mezőt, ahol kapcsold be a Transparent (átlát-
szó) négyzetet. Végezz egy képkockán próbarendert.

A csempemintázatal az Alpha-csatornát, azaz az átlátszó-
ságot jelöli a program.
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Még egy kis fnomítást hajtsunk végre a kompozitálás előt. 
Ugyanit, a renderelési beállításoknál találod a Motion Blur 
(mozgáselmosódás) mezőt. Kapcsold be, és a zársebességet 
(Shuter) állítsd 2-re. Ez azt jelenti majd, hogy amíg a virtu-
ális kamera lefényképezi a jelenetet, hosszabb idő telik el. S 
akárcsak a valós életben, a flmen is elmosódik az alakzat.

Minden készen van, hogy belekezdjünk a kompozitálásba.

Kompozitálás a Blenderben

Amennyiben  rögtön  neki  szeretnél  állni  a  kompozitálás-
nak, azaz nem használsz más programot, s nincs munkatár-
sad, akinek továbbküldhetnéd, a következőképpen járj el.

A  képernyőelrendezések  közül  válaszd  a  Composite-ot. 
Kapcsold be a Use Nodes jelölőnégyzetet!
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Ezt  látod  kezdetben:  Egy  átlátszó  háterű  renderréteg 
(Render Layer) kapcsolódik egy Composite csomóponthoz. 

Ez utóbbi a renderelés végső nézetéért felel.  Amit ehhez 
hozzákötsz, az látszik majd a végső képen.

A Csomópontszerkesztő Add > Input > Movie Clip parancsá-
val  keletkezet flmmegjelenítő  csomópontba  töltsd  be  a  
043_Forest.mp4 videóállományt.

Kacsold be az ablak alján a Backdrop (hátérvetítés) lehető-
séget, majd az Add > Output > Viewer csomóponthoz kösd 
hozzá a Movie Clip csomó kimenetét. 
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A  Viewer csupán megjeleníti a szerkesztés egyes lépéseit, 
nélküle a hátérvetítés sem működne, de rajta nem a ren-
derelt képet látod. Próbáld ki (F12)! A  Composite csomó a 
renderelésért felelős. Most cseréld meg a kettőt. Míg a Cso-
mópontszerkesztőben a Viewer csomó miatt a helikopter lát-
szik, addig a renderelésnél (F12) a fiilmes háttér.

A Viewer csomók (mert lehet több is) kitűnően használha-
tók a kompozíció szerkesztéséhez, ugyanis nem kell újra-
renderelni az egész képet, egy előnézeten láthatod, mi tör-
ténik  majd.  Bogozzuk  most  össze  a  két  bemenetet  egy 
képpé! Használd az Add > Color > Alpha Over csomót!

Ennek feladata, hogy ott, ahol az Alpha-csatorna kilyukasz-
totta a képet, felülírja a másikkal.
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Színegyeztetés,  élesség ♦  Legtöbbünk  az  eredménnyel 
már elégedet is lenne. De ne felejtsük el, milyen fényviszo-
nyok közöt készült a flmfelvétel, és hogyan a helikopter.  
Bár az előzetes beállításoknál igyekeztem jól bevilágítani, 
de ez köszönő viszonyban sincs a környezetel. 

Ha a súroló  napfény,  ami rózsásra színezi  a  havat  hat  a 
környezetre, akkor ennek valahogyan meg kell jelennie a 
helikopteren is. Nézzünk egy elrontot kísérletet!Az Add > 
Color > RGB Curves csomópontal kitűnően lehet színeket 
korrigálni.  Szándékosan rossz  helyre  tetem,  majd  ennek 
vörös görbéjét (R), kicsit túlhúztam. Rögtön málnafagyi te-
lepedet a tájra, jelezve, hogy az Alpha Overrel való keve -
rés előt a videofelvételből származó színeket tudja korri -
gálni. 

Hangsúlyozom, szándékosan tévesztetem, hogy megtanul-
juk ezt is : 

• Vagy a bemenetekből  húzkodod ki  a  drótokat,  s  a 
szabadban elengedve eltűnnek (hosszadalmas, mace-
rás), 

• vagy a CTRL gombot lenyomva egy kis késsel elvág-
hatod azokat (gyors, halálos).
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Ha ezután egyszerűen rárakod a csomópontot arra a sza-
kaszra,  ahova kapcsolnád,  a  drótok automatikusan a  he-
lyükre csatognak.

Miután az alsó ágat visszabogoztad, így néz ki a kép. Kicsit 
pirosabb let helikopter, persze nem cél, hogy annyira, mint 
egy katicabogár. 

Sőt, a valós életben ritka, hogy valaminek tiszta, telítet szí-
nei  legyenek,  ezért  vegyünk vissza egy kicsit  a gép telí-
tetségén: Add > Color > Hue Saturation Value.

Ebből az első a színezet, a második a telítetség, a harmadik 
a fényerő.

A flmfelvétel nagyon szép, éles. De gondolj arra, távoliak a 
tájelemek, s a kamerához közel van a helikopter. Ha a tájra 
élesít, a forgószárnyas gép kicsit homályosabb.
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Helyezz el egy homályosító csomópontot  (Add > Filter  >  
Blur). Rövid próbálkozás után én a 3-as értéknél maradtam.

A rendszeren még azt is látod, hogy a renderelés miat a  
Composite csomópontot is hozzákapcsoltam a rendszer vé-
géhez, így a flmen megjelenik a teljes kompozíció. Immár 
renderelhetően.

Kompozit-trükkök

A kompozitálás külön szakma, melybe éppen csak belekós-
tolunk. Ennek a rendszernek nagy előnye, hogy még a cso-
mópontok tulajdonságait is lehet animálni, azaz a paramé-
tereket az időben változtatni. A fenti példában mondjuk a 
helikopter élességét vagy fényerejét.

Saját  munkafolyamatomban az  elkészült  jelenetet  mindig 
képsorként renderelem. Habár lehetne a fenti példához ha-
sonlóan a renderelés előti lépésben utómunkát végezni, de 
ki tudja még, hogy a végső flmben, az összképet, a többi 
jelenetet is látva, mit kell a színeken változtatni…

Tehát jobb, ha van egy „nyers” renderelésed, átlátszó  hát-
térrel,  képsorként,  amit  később elővehetsz  az  utómunká-
hoz. A következő példákban mi is így teszünk.
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Megvilágítási, légköri efektusok ♦ A következő trük-
köt korábbi munkánk egy képével végezzük el. Természete-
sen működik szekvenciával is, de most csupán az elvet te-
kintjük át.

Nyiss egy új Blender munkát, és váltsd át a 3D ablakot Cso-
mópontszerkesztővé,  vagy  kérj  egy  Composite  képernyőel-
rendezést. Kapcsold be a Use Nodes jelölőnégyzetet!

Húzd be ebbe az ablakba „fogd és vidd” módszerrel a mel-
lékletben szereplő 044_alapkep.png képet. Ezzel kikerültünk 
egy kis menüben bogarászást.

Kapcsold össze a képet a kompozit csomópontal, és ellen-
őrizd le, hogy megfelelően renderel-e…

Takarékossági okokból a Blender render panelján, a Tulaj-
donságok-ablakban  50%-osra  van  beállítva  képméret,  így 
nem ugyanaz lesz a képkivágás, mint az eredetin.

23. Utómunka

Ugyanez szekvenciával: 
Add > Import > Image. 

Majd a képsort az (A) 
billentyűvel jelölheted ki.
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Javítsd ki ezt a hibát, állítsd 100%-ra a kép felbontását!

Mit jelent a kompozitálás akkor, ha csak egy tökéletesen 
renderelt 3D képsorod van? Bármilyen furcsán is hangzik: 
Megszüntetni a tökéletességét.  A szemünk, s a fényképező-
gép  tökéletlenebb  képet  alkot  a  valóságról,  mint  ami  a 
Blender vegytiszta virtuális terében keletkezik.

A levegő részecskéin és a benne levő szennyeződéseken el-
hajlik, szóródik a fény. Ha a képen egy tárgy fényforrásként 
világít – konkrétan most a sárga körív –, akkor azt valami-
féle fényudvar, glória, raegyogás veszi körül. 

Helyezz el egy Viewer csomópontot, majd a menüből, vagy 
a (V) gyorsbillentyűvel kicsinyítsd a hátérképet.

Helyezz a kép csomópont után egy  Glare  (ragyogás) cso-
mót a bal oldalon található értékekkel. Add > Filter > Glare.

23. Utómunka
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Ennek többféle beállítása is létezik: A  Steaks a pontszerű 
fényforrások  becsillanását,  a  Ghost kamerába  csillanó 
Flare-efektust, a Fog Glow ködös levegőt, a Star pedig csil-
lagszerű, négyirányú mintázatot eredményez.

Ezzel a fényjelenséggel mindig számoljunk, ha fényforrás 
vagy fényes felületről visszavert foltszerű csillogás van a 
jelenetben. 

A  képen  látható  értékekkel  állítsd  be  ködben  megjelenő 
fényudvart! A következő oldalon egy trükkel tovább me-
gyünk, de ot is ellenőrizheted az elért hatást. 

23. Utómunka
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Lencsehibák ♦ A  kromatikus aberráció nem valami pszi-
chológiai elhajlás, hanem a fénytörés eredménye. 

Az olcsóbb lencserendszerek nem csak megtörik a fényt, 
hanem főleg a széleken vagy fényesebb területeken színek-
re is bontják azt. Kissé eltúlozva így néz ki. 

Figyeld meg a széleken a színbontást, a szivárvány színeit! 
Csomópontja: Add > Distort > Lens Distortion.

Vignettálás ♦ Új feladathoz új fájl, melybe az előzőhöz ha-
sonlóan  töltsd  be  a  045_vigneta.png  képet.  A  következő 
trükk a vignetálás,  amikor az objektíven bejövő kör alakú 
képet egy téglalapra képezzük le. A széleken emiat kisebb 
lesz a fényerő. 

Egy ravaszabb trükkel létrehozhatod azt az oválist, amit rá-
vetítve az eredeti képre eléred a kívánt hatást.

23. Utómunka
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Ha nem gondoltad volna, hogy ennyire ravasz, részletezve:

Add  >  Distort  >  Lens  Distortion (lencsetorzítás) :  Már 
használtad  az  előző  feladatban,  de  ot a  színbontáshoz.  
Most valódi lencsetorzulással oválissá teszed a képet.

Erre az oválisra alakzatra lesz szükségünk. Ha meg szeret-
néd nézni a saját csomópontrendszeren, akkor a kivezeté-
sébe csatlakoztass  egy  Viewer csomópontot,  és  ezt  fogod 
látni.  Esztétikailag inkább rémisztő,  de e mutáns is bizo-
nyíthatja, hogy a cél fele haladunk.

23. Utómunka
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Add > Converter > Math: Így, hogy Greather Tan nem ta-
lálod. Ez egy matematikai csomópont (Math), ami saját me-
nüjében tartalmaz 19 műveletet. Válaszd a „nagyobb mint” 
relációt, és az értékét állítsd nullára. 

Ot, ahol nagyobb mint nulla, befehéríti a képet, ahol pedig 
zéró, ot fekete lesz. Ez a matematikai művelet egy átlátszó 
képet, mely ovális formájú, alakít át megjelenítet fekete-
fehér Alpha-csatornává. A fekete területek egyébként telje-
sen átlátszóak, a fehérek pedig tökéletesen átlátszatlanok. 
Ha lenne szürke, az átetsző lehetne…

Add > Filter > Blur: Ez a csomópont elhomályosítja, szét-
keni a belefűzöt képet. 

Használtuk már korábban a helikopternél…

23. Utómunka
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Add > Distort > Scale: Egy kis kísérletezéssel, át lehet mé-
retezni a képet. It éppen nagyítotuk.

Add > Color  > Mix: Ezt  sem fogod megtalálni  Multiply 
(szorzás)  néven,  hiszen az eredeti  neve  Mix,  és színekkel 
végez műveleteket. 

Két kép pontjainak színét szorozza páronként. Gyakorlati-
lag összemossa a képeket,  ahol  fehér volt  az alakzat,  ot 
eredeti tisztaságában marad a másik, ahol fekete, sötétedik.

Így a végén eljutotál ahhoz a képhez, melyet a feladat ele-
jén  mutatam.  Láthatod,  hogy  egy  kis  logikával  egészen 
szép hatásokat érhetünk el a nyers képeken.

Ebben a rendszerben szoktak színkorrekciót végezni,  kék 
vagy  zöld  háteret  eltüntetni.  Mindenhez  találsz  oktató-
anyagot az interneten.

23. Utómunka
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Filmszerkesztés, vágás

Mivel a könyv több feladatában is használtad a videovágó 
alrendszert  (Video Sequence Editor),  némi gyakorlatra szert 
tetél, átlátod annak működését. A flmkészítés utolsó fázi-
sában nem kell improvizálnod. Az animációban nincsenek 
sokszorosan túlforgatot jelenetek.  Ha jól  tervezted a fl -
met, hamar elkészülsz a vágásával is – szinte csak annyi, 
hogy  az  animatikban  lecseréled  a  helyfoglaló  képeket  a 
végleges, renderelt képsorokra. 

Más kérdés, ha igényesebb, sokrétűbb munkába fogsz. Elő-
ször is beszéljünk a környezet kialakításáról. Vannak olyan 
feladatok, ahol érdemes a Blender kinézetét, témáját meg-
változtatni. Ezek a témaváltások sokat segítenek, hogy job-
ban látható legyen az, amin éppen dolgozol – mozgásgör-
bék,  flmsávok,  stb.  Ezen  beállításokról  a  Függelékben 
olvashatsz részletesebben. 

A Blender Graph témájával  átszabott felhasználói  felület.  Elérhető a File > 
User Preferences > Themes párbeszédpanelen.

23. Utómunka
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A  Blender  Video  Editing beépítet képernyő-elrendezését  
érdemes felhasználni a vágás során, a program felső menü-
jéből. 

Ebből az elrendezésből nekem egy dolog hiányzik, a Tulaj-
donságok-ablak,  és azt  mindig be  is  préselem valamelyik 
sarokba. Az előző oldalon éppen jobb oldalon szorítotam 
neki helyet.

Nélküle  mindig alapnézetbe  (Default)  kellene váltanom a 
rendereléshez, ami kényelmetlen és logikátlan. 

Ha flmet vágok, semmi értelme a 3D nézetben egy kockát 
bámulni…

Fokozatos áttűnés (Fade-in/out)  ♦ Látványanimációnál 
sem lehet minden átmenet nélkül kezdeni vagy lezárni egy 
flmet. Ilyenkor jól jön, ha egy egy színből keverünk rá a 
vágot anyagra. 

Az egyik renderelt képsorom alá töltötem egy zenesávot, 
majd  fölöte elhelyeztem egy  fekete  színsávot  az  Add  >
Efect  Strip  >  Color menüből.  Ugyanúgy  lehet  nyújtani, 
mozgatni, mint egy flmfelvételt, és lefedi a teljes képme-
zőt. 

A sávszerkesztő jobb oldalán it is van  Tulajdonságpanel.  
Megváltoztatható a szín, ha éppen nem feketéből szeretnéd 
indítani az átmenetet. Az Opacity érték kulcsolásával elér-
tő, hogy változzon az átetszőség. Nagyon egyszerűen: Az 
Opacity csúszkán állítsd be a megfelelő időpillanathoz tar-
tozó átlátszóságértéket, majd nyomd meg az (I) gombot.

23. Utómunka
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Az elrendezésbe építet mozgásgörbe-szerkesztőn nyomon  
követhető az átmenet, s szerkeszteni is tudod azt.

A Blender flmvágója még sok lehetőséget tartogat a fordí-
tások feliratozásától a tévés átmenetek szerkesztéséig. 

Néhány egyszerű trükkel már elkészítheted az első flmjei-
det, melyek nem lesznek rosszabb minőségűek, mintha más 
professzionális programban vágtad volna ezeket. 

Utómunka-panel ♦ A Tulajdonságok-ablak render panel-
jeinek  alján  találod  az  utómunkáért  felelős  kapcsolókat. 
Ahhoz,  hogy  a  szofver  el  tudja  dönteni,  hogy  mit  kell 
renderelnie,  nem  árt  tudnod  ezeknek  a  prioritását.  Ve-
gyünk egy ilyen szélsőségesnek tűnő, de mindennapi pél-
dát:  A  3D ablakban egy animációval  dolgozol,  közben a 
Csomópontszerkesztőben  kompozitálsz  egy  anyagot,  de  a 
Videoszerkesztőben már éppen egy másik flmet is vágsz. 
Igen,  jó  lenne  elkülöníteni  ezeket  a  folyamatokat,  de  ha 
nem tennéd:

• Ha mindkét  kapcsoló  (Compositing  /  Sequencer) be 
van kapcsolva, akkor a  Sequencer, azaz a  Videovágó 
kap elsőbbséget.

• Ha csak a Compositing, akkor a Csomópontszerkesztő-
ben levő kompozit.

• Ha egyik sem, akkor a 3D ablakban futó animáció.

A vágással nem csak első flmjeidet, de ezt a könyvet is be-
fejeztük…

23. Utómunka
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Függelék

Függelék

.
Véget ér a könyv. Ajánlok némi 
olvasnivalót unalmas időkre.
Aztán meggondolom magam, s elárasztalak
eegy csomó érdekes Függelékkel.

Függelék
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Hát elérkeztünk e terjedelmes kötet végére. Nagyon köszö-
nöm, hogy velem együt végigjártad ezt a hosszú utat. 

Ez a könyv nem jöhetet volna létre, ha nem áll mögöte a  
Free Sofware Foundation Hungary Alapítvány – a Szabad  
Szoftverek Maegyarországi Népszerűsítéséért és Honosításáért.  
Nekik köszönheted, hogy ingyenesen hozzáférhető, másol-
ható, megosztható szabadszofveres tudásanyag.

Sokat  köszönhetek  tanítványaimnak,  a  Pápai  Református  
Kollégium és Művészeti Szakgimnázium diákjainak, akik ki-
próbálták, észrevételeikkel tanácsolták az alkotói folyama-
tot. Név szerint:  Albert Dóra Lili, Csonka Johanna, Dunai  
Virág,  Hujter  Valentina,  Kulifai  Boldizsár,  Molnár  Eszter,  
Naegy Betina, Punk Gabriella, Simon Vanda, Tihanyi Boglár-
ka, Vajda Bálint.

Köszönöm Szabó Istvánnak (stewet), hogy szakmai lektor-
ként segítete e kötet gondozását!

*

Hogyan tovább? A Függelékben találsz jó néhány érdekes-
séget, fusd át, próbáld ki, ami megtetszik.

Tűzz ki célokat magadnak, próbálj beszállni éles projektek-
be. Akkor fejlődsz leginkább, ha valóságos problémákat kell 
megoldanod.

Hogy honnan kaphatsz segítséget? A következő oldalakon 
a folytatáshoz egy szubjektív szakirodalomjeegyzék.

Függelék
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Pont hu

blender.fsf.hu

E könyvhöz tartozó hivatalos oldal. It találod a kötetet és a 
mellékleteket.

blender.hu

A magyarországi  felhasználók portálja  a  Blenderkuckó.  A 
legnagyobb  nemzetközi  oldalról  közöl  híreket,  magyarul 
tananyagokat, leírásokat. Van fórum, ahol megoszthatod a 
problémáidat, s ha nem találsz rájuk megoldást, a szerkesz-
tőkkel személyesen is felveheted a kapcsolatot. Főszerkesz-
tő stewet, aki ennek a könyvnek a szakmai lektora volt.

blender3d.hu

Hírportál a Blenderről és 3D-s programokról általában.

meshmag.hu

Általános, érdekes hírek a 3D világából, néhány új Blender 
tananyaggal.

graft.netpositive.hu

Saját szakmai blogom. 

Függelék
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Pont org/com

blender.org

A Blender hivatalos oldala. It találod a legfrissebb verziót,  
híreket, leírásokat, tanagyagokat. A  Blender Cloud,  egy fii-
zetős támogatási rendszer, amivel professzionális tananya-
gokhoz és megoldásokhoz férhetsz hozzá. 

blendernation.com

A legnagyobb Blenderes hírportál, naponta többször frissü-
lő hírekkel, tananyagokkal. Évek alat hatalmas tudásbázist 
halmozot fel. 

blenderart.org

A BlenderArt c. PDF fanzinok összessége, melyeket 2015-ig 
szerkesztetek. 

blenderartist.org

Fórum, amelyben szinte mindenre segítséget kaphatsz.

blender.stackexchange.com

A  Stack Exchange kérdés-válasz honlap Blender rovata. A 
legfrissebb tudásbázis.

graphicall.org

Új Blender-változatok, kísérleti verziók.

blendswap.com

A legnagyobb ingyenes Blender modelltár. Havi 20 letöltés-
sel limitálva. Fizetős verzióban korlátlan. A könyv sok mo-
dellje innen származik.

blenderguru.com

Andrew Price oktatási és híroldala. Sok remek oktatóanyag-
gal, kezdők támogatásával. 

Függelék
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creativeshrimp.com

Gleb Alexandrov oktatási oldala. A fehérorosz srác nagyon 
tud a világítás, anyagok, textúrák világában mindent. Idő-
ről időre kiváló videoanyagai jelennek meg.

zachariasreinhardt.com

Zacharias Reinhardt, fatal német oktató. Az előző ketőhöz 
hasonlóan érdemes fgyelni rá, nagyon tud.

blenderdiplom.com

Gotfried Hofmann oldala, tele oktatóanyagokkal. 

youtube.com

Rengeteg, különböző színvonalú videooktatóanyag. 

motiongraphics.nu

Látványanimációk.  Ha kihívásokat vagy inspirációt  kere-
sel, innen indulhatsz. 

vimeo.com

Rengeteg, különböző színvonalú videó. Sok inspiráció lát-
ványanimáció-témában.

Függelék
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Könyvek magyarul

Ádám István: Blender Kódex I–II.

magánkiadás, elektronikus

A  két  kötet  több  mint  500  oldalas  átfogó  bemutatása  a 
Blender lehetőségeinek. Anyaghasználatában a Blender ré-
gi  renderelőjéhez  kötődik.  Referenciaanyag,  ha  valamire 
mélyebben kíváncsi lennél.

Könyvek angolul

Andy Beane: 
3D Animation Essentials
Sybex, 2012

Az egyik legjobb, átfogó bemutatása a modern animációs 
flmkészítésnek. Szemléletes, élvezetes, tanulságos.

Enrico Valenza: 
Blender Cycles: Materials and Textures Cookbook – 
Tird Edition, Packt, 2015

Valenza  olasz  grafkus,  igazi  nagy  öreg a  Blenderben.  A 
könyve egy receptkönyv, sok példával azoknak, akik ma-
guk szeretnék csomópontokból összeépíteni anyagaikat.

Bernardo Iraci: 
Blender Cycles: Lighting and Rendering Cookbook
Packt, 2013

Rengeteg segítséget, gyakorlatias tippet adot a könyvem -
hez világításról, renderelésről. Nagyon jó könyv.

Függelék
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Sam Vila: 
Blender for Visual Efects
CRC Press, 2015

Zöld hátér, kompozitálás, maszkolás, mozgáskövetés, Blen-
der professzionális környezetben. Projekt alapú, bár egy ki-
csit bénácska – de macsó – projektel. Jó kitekintés azok-
nak, akik a VFX-ben folytatják útjukat. 

Mythravarun Vepakomma: 
Blender Compositing and Post Processing
Packt, 2014

Nem egy hosszú könyv, de a kompozitálás megérthető be-
lőle. Igaz, egy kicsit csapong a lehetőségek közöt, kevésbé 
gyakorlatias. 

Arnold Gallardo: 
3D Lighting: History, Concepts, and Techniques
Charles River Media, Rockland, 2001

Jó alap a bevilágításhoz, a virtuális kamera működéséhez.

Richard Williams: 
Te Animator's Survival Kit
Faber & faber, 2002

Aki karakteranimáció irányában szeretné továbbképezni 
magát, annak kötelező olvasmány – rajzkönyv – a Roger 
nyúl a pácban rendezőjétől. 

Függelék
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a. 

Telepítés

a. Telepítés

a.
Javaslatok a Blender telepítéséhez
a három naegy operációs rendszerre. 
Közben megtudjuk, melyik változat
kompatibilis a könyvünkkel.

 

telepítés
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Minden fejlődik, változik, s ez különösen igaz a Blenderre. 
Ami örvendetes annak, aki ismeri a programot, bosszantó 
akadály  lehet  a  kezdőknek.  A  könyv  mellékletei  közöt 
megtalálható és letölthető a  Blender 2.78a verzió, melyet a 
kötetel való tanuláshoz ajánlok. Mivel a programot gyor-
san fejlesztik,  fontos,  hogy  ezt  használd,  ha nem akarod, 
hogy  gyakorlás  közben  az  időd  azzal  teljen,  hogy  nem, 
vagy nem ot találod a könyvben leírt funkciókat. 

Tanuláshoz tehát használd a könyv honlapjáról letölthető 
állományokat. Később fejleszd tovább tudásodat a legújabb 
verzióval. (blender.fsf.hu)

Windows

A könyv mellékletében és a Blender hivatalos letöltőolda-
lán  (blender.org  >  Download) kétféle  Windows  változatot 
találsz. 

Az Installer (.msi) a telepíthető változat. Ha ezt letöltöd, az 
operációs rendszerbe integrálódó program lesz a Blender, 
ami  azt  jelenti,  hogy  a  .blend fájlokat  alapértelmezeten 
megnyitja, a Start menüben megtalálható az ikonja, stb. Ez 
az ajánlot letöltés, teljes funkcionalitással.

Ha a  .ZIP állományt  választod,  egy tömörítet állományt  
kapsz,  amit bárhova kicsomagolhatsz. Kicsit kényelmetle-
nebb a használata, hiszen a rendszer nem rendeli hozzá a 
.blend fájlokhoz.  A Windows  Start  menüjében sem fogod 

a. Telepítés
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megtalálni,  így  minden  indításnál  el  kell  zarándokolnod 
oda, ahova kicsomagoltad, s megkeresni a mappában az in-
dítófájlt. Utána már bármely .blend fájl az elindítot Blender 
programból elérhető a File > Open menüparanccsal. 

Mi akkor az előnye a .ZIP állománynak? Pendrive-ra tehe-
tő a program, így máshol is tudod használni. Vagy ha több 
változatot ki akarsz próbálni a Blenderből, ezek összeaka-
dás és  felülírás  nélkül  elférnek egymás melleti mappák -
ban.

Figyelj arra, hogy 64 bites vagy 32 bites operációs rendsze-
red van-e. A program 32 bites változata elfut minden kör-
nyezetben, főleg a régebbi gépeken. Ha egy nagyobb me-
móriával  rendelkező,  modernebb  géped  van,  mindenkép-
pen a 64 bites verziót telepítsd. 

A Windows Rendszer párbeszédpanelén ellenőrizhető, hogy hány bites operá-
ciós rendszered van.

a. Telepítés
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Linux

A Linux kismillió disztribúcióban létezik.  Az elterjedtebb 
változatok  tartalmaznak  valamilyen  csomagkezelő  rend-
szert vagy szofverközpontot, ahonnan telepíthető a prog-
ram.  Ha  nem  sikerül  másképp  telepíteni,  a  mellékletből 
töltsd le, a Linuxhoz használható állományt. 

A Blender oldaláról Tarball (.bz2) tömörítéssel tölthető le az aktuális verzió. 

It ugyanaz  a  dolgod,  mint  Windows-nál:  kicsomagolod,  
megkeresed az indító állományt, s már megy is a program.

Könyvünkben csak az  egyik legelterjedtebb,  legkönnyeb-
ben kezelhető disztribúció, az Ubuntu Linux telepítési le-
hetőségeivel tudunk részletesebben foglalkozni.

Ha azt szeretnéd, hogy a Ubuntu rendszerébe integrálódjon 
a szofver – azaz automatikusan ezt nyissa meg a .blend fáj-
loknál, kövesd az alábbi leírásokat….

a. Telepítés
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Az Ubuntu alatt használható Szoftverek program, mellyel a rendszer interne-
tes tárolóját használjuk a telepítésre.

Az Ubuntu Szofverek (régebben Szofverközpont) működé-
se nagyon hasonlít az okostelefonok áruházaihoz. A Blen-
der szempontjából egyetlen hátránya, hogy szinte sosem a 
legfrissebb verzió van a szofvertárolóban. Ellenőrizd, me-
lyik változat telepíthető a rendszeredbe. Ha nem a 2.78a, 
akkor töltsd le a könyv honlapjáról, vagy a (download.blen-
der.org/release/Blender2.78) weboldalról.

Legfrissebb verzió telepítése Ubuntu alatt   ♦ Ha már 
tapasztaltabb Blender-felhasználó vagy, és a legújabb válto-
zatra  lenne szükséged,  akkor használj  egy másik tárolót: 
Tomas Schiex-nek köszönhetően a legújabb Blender verzi-
ót is telepíthetjük Ubuntu rendszerünk alá. Internetkapcso-
latal rendelkező gépünkön nyissuk meg a terminált és gé-
peljük be, vagy másoljuk át innen a következő sort:

sudo add-apt-repository ppa:thomas-schiex/blender

Ezzel  kapcsolatot  teremtetünk az említet úr tárolójával.  
Frissítsük az Ubuntu információit: 

sudo apt-get update

Ekkor  a  rendszer  a  tárolóinformációkat  összevetve  kivá-
lasztja a legfrissebb változatot.

a. Telepítés



487

Majd a következő sorral installáljuk a programot:

sudo apt-get install blender

Mac OS X

Hasonlóan a Linux disztribúciókhoz, a Blender elérhető hi-
vatalosan az  App Store-ból,  az  Apple szofverboltjából.  A 
blender.org oldalról viszont letölthető .ZIP állományként is.

Ezt  kicsomagolva kapunk egy mappát,  melynek tartalma 
hasonló lesz a fentihez. A blender.app állomány indításával 
már fut is programunk. Ez a mappa elhelyezhető az Appli-
cations mappában is, ahonnan már alkalmazásként futat-
ható.

a. Telepítés
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Más változatok telepítése

Ha valami oknál fogva egy régebbi változatot szeretnél te-
lepíteni, a (download.blender.org/release) oldalról lehet.

Kísérleti verziókkal pedig it tudsz próbálkozni:

(graphicall.org)

a. Telepítés
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b. 

Laptopon

b. Laptopon

b.
Ha laptopon tanulod a Blendert, 
és nem akartál akkora példányt venni,
mint eegy egyúródeszka, könnyen előfordulhat,
hoegy nincs különálló számbillentyűzeted.
Márpedig a Blenderen ez kötelező elemó
Oké, van eegy kiskapu. Csak neked.

 

laptopon
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A Blender funkcionalitásában nagy mértékben támaszko-
dik a teljes billentyűzetre és a klasszikus, három gombos 
egérre. Ez utóbbi viszonylag olcsón pótolható. De a szám-
billentyűzet  hiánya  rengeteg  bosszúságot  okoz  kompakt 
laptopokon, a Blender használata során. A modellezés és az 
animáció kínlódássá válik, ha nem tudod használni a klasz-
szikus nézeteket: (1) – elölnézet, (3) – oldalnézet, (7) – fe-
lülnézet.  Ha  ugyanis  a  szöveges  billentyűzet  számsorát 
nyomogatod, nem a nézeteket váloznak, hanem a rétegek 
közöt ugrálsz.

E problémán sajnos az sem segít, hogy rengeteg gyorsbil-
lentyű funkciója elérhető a Blender menüjéből. A 3D ablak 
alján, az Idővonal felet találod ezt a menüt, melynek View 
(Nézet) menüpontjából az ábra szerint elővarázsolhatóak a 
nézetek.  Menükben  keresgélni  nem a  leggyorsabb  dolog 
Éppen azt a tulajdonságát veszítjük el a Blendernek, ami 
rendkívül hatékonnyá teszi – a sebességét.

Ennél jobb megoldás, ha a Blender beállításaiban rávesszük 
a programot, hogy tekintse a szöveges billentyűzet számso-
rát valódi számbillentyűzetnek. A File > User Preferences pa-
ranccsal nyisd meg a program beállításait, s it az Input fül 
Emulate Numpad jelölőnégyzetét pipáld ki. 

Ennyi!

b. Laptopon
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c. A 

felhasználói 
felület témái

c. A felhasználói felület témái

c.
Van, amikor a szemünknek segít, hoegy más 
színezésű a Blender felülete. Mutatok néhány 
vizuális tuningolási trükköt.

 

a felhasználói  
   felület témái



492

Habár rendkívül  trendi  a  grafkai  programok közöt ma -
napság a Blender sötétszürke ruhája – gondoljunk csak az 
Adobe Photoshopra vagy a Premiere vágóprogramra, melyek 
hasonló színekbe öltöztek az évek során –, néha kipotyog 
az ember szeme animáció vagy utómunka közben. Ilyenkor 
jó, ha igényeinknek megfelelően cserélgethetjük a Blender 
témáit. Azok is jobban érezhetik magukat, akik más prog-
ramot használtak eddig, de át szeretnének térni a Blender-
re. Természetesen erre is van lehetőség a Blender beállítá-
saiban:  File  >  User  Preferences  (Felhasználói  beállítások), 
majd a párbeszédpanel Temes füle.

A választható témák közöt található olyan klasszikus, mint 
a 3D Studio Max, a Maya, a Sofimage. Linux alat több mint 
20, Windows alat kb. a fele téma közül választhatsz, s ha  
nem volna elég, magad is átállíthatod a felhasználói felület 
színeit. Vagy az interneten is kereshetsz témákat. 

Megtetszet valamelyik? Nyomd meg a  Save User Setings 
gombot. Nem jön be egyik sem? A panel alján levő Reset to  
Default Teme gombbal visszaáll a Blender eredeti témája.

A következő oldalon néhány képernyőkép ezekről…

c. A felhasználói felület témái
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Flatty Light

Maya

Hexagon

c. A felhasználói felület témái
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Természetesen atól, hogy valaminek megváltoztatjuk a fel-
használói felületét, még nem változik Maya-vá vagy MAX-
szé. Csak a kezelése lesz ahhoz hasonló.

A  Blender  kezdőképén  (Splash  Screen)  beállítható,  hogy 
Autodesk Maya vagy 3D Studio MAX programhoz hasonló-
an viselkedjen. A másik lehetőség a felhasználói beállítások.

A File > User Preferences > Input oldalán tudod a használatot 
és a gyorsbillentyűket átállítani. Kitűnő lehetőség sokprog-
ramos munkafolyamatban.

c. A felhasználói felület témái
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d. 
A 

Blender ablakai

d. A Blender ablakai

d.
A Blender ablakai kissé másként működnek, 
mint ahoegy eegyéb programokban megszoktuk. 
Kezdő korunkban sokat szenvedünk velük,
de eegy kis egyakorlással hamar megszelidíthetők.

 

a Blender   
  ablakai
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Az ablakok felosztása

Olyan ablakrendszerrel dolgozunk, ahol a képernyőn meg-
jelenő ablakok nem fedik el egymást, eltakarva a fontos in-
formációkat előlünk. Ilyen rendszert használ számos pro-
fesszionális  flmvágó  és  kompozitáló  program is,  mint  a 
Premiere vagy az Afer Efects. A Blender a legnagyobb ru-
galmasságot és testreszabhatóságot biztosítja, ami hatalmas 
előny  egy  professzionális  felhasználónak,  de  a  kezdőket 
rendesen  összezavarja.  Ennek  a  kiegészítésnek  a  célja, 
hogy eligazodj a Blender felhasználói felületén.

Általános szabály, hogy minden Blender-ablak jobb felső és  
bal  alsó  sarkában találsz  egy  fotósarokhoz  hasonló  kis 
csücsköt. Ezek mutatják egy-egy ablak sarkait.

Ha két ablak közöti határvonalra érkezel, az egérkurzor át-
alakul egy oda-vissza nyíllá. Ezzel egyszerre két ablak mé-
retét befolyásolhatod – tolóajtó-szerűen. Próbáld ki a kö-
vetkező oldal ábrája alapján!

d. A Blender ablakai
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Az Idővonal (alsó) ablakának magasságát növelve a 3D ab-
lak (felső) magassága csökken. 

Ha bármely ablak jobb felső vagy bal alsó csücskét függőle-
gesen vagy vízszintesen elmozdítod, az adot ablakot fel -
osztod,  s  a  keletkezet két  ablak  a  szülő  tulajdonságait  
örökli – azaz ugyanolyan típusú lesz. Készíts te is a fenti 
ábrához hasonló őrült elrendezést! 

d. A Blender ablakai
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Oké, de hogy lehet ezt visszavonni? A szokásos (CTRL+Z) 
kombinációval csak műveleteket vonhatsz vissza. Ezt nem.

Az ablakok egyesítése

Első szabály, hogy csak ot tudsz ablakokat összeforraszta -
ni, ahol azok érintkező oldala a hozzá tapadó téglalap meg-
felelő oldalával teljes hosszában kölcsönösen érintkezik. 

Ahol  nincs  meg  ez  a  kölcsönösség,  ahol  adot irányban  
több téglalap, ablak is csatlakozik, ot nem tudod egyesíteni 
az ablakokat. Kis gyakorlással megtalálod, melyek ezek.

Kétféle módszerrel lehet lehet egyesíteni az ablakokat:

Ot, ahol érintkeznek, ahol egyébként bal egérgombbal el-
mozdíthatóak, katints most jobb egérgombbal, és a felbuk-
kanó helyi menüből válaszd a Join Area (terület egyesítése) 
parancsot.

d. A Blender ablakai
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A parancs kiadása után egy nagy nyíllal megmutathatod, 
melyik ablakot összeforrasztani a szomszédjával. Íme…

A másik módszer:

Az érintkező oldalakra illeszkedő fülek egyikét  bal  egér-
gombbal megfogva az érintkező oldal felé mozdítod, majd 
át a másik ablak területére.  Ezzel ugyanúgy aktiválod az 
egyesítésért felelős nyilat.

d. A Blender ablakai



500

Panelek és mezők

Az ablakok nagy többségében bal és jobb oldalon megjele-
níthető egy-egy panel:  Balról  az  Eszköztár  (T),  jobbról  a 
Tulajdonságpanel (N).

Ha egy-egy ilyen területre túl sok panel jutna, fülekkel ren-
dezik  ezeket.  Egy  panelen  belül  összetartozó  vezérlőele-
mekből  szervezet halmazokat  könyvemben  „mezőknek”  
nevezem. 

A mezőnevek előti kis  három-
szöggel lehet nyitni/csukni eze-
ket a halmazokat. Ha mindet be 
egyszerre  szeretnéd  becsukni, 
húzd végig rajtuk lenyomot bal 
egérgombbal az egeret. A mezők 
jobb oldalán levő kis fogantyúk-
kal átrendezheted őket. 

Kezdőként persze örülünk, hogy 
valamelyest átlátjuk ezt a kaval-
kádot. 

d. A Blender ablakai
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e. 

Blender 
magyarul

e. Blender magyarul

e.
A Blender ablakai kissé másként működnek, 
mint ahoegy eegyéb programokban megszoktuk. 
Kezdő korunkban sokat szenvedünk velük,
de eegy kis egyakorlással hamar megszelidíthetőek.

 

Blender 
maegyarul
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A Blender honosítására tudomásom szerint két kísérlet is 
volt. Az elsőt még én kezdeményeztem, abban a remény-
ben, hogy a Blender lesz az első magyarul tudó 3D szofver. 

Nagyon izgalmas  munka volt.  Járatlan úton éreztük ma-
gunkat,  mintha a nyelvújítás  korában lennénk.  Az akkor 
még  sokkal  kisebb  funkcionalitású  program fordításában 
30%-ig jutotunk el, aztán egyéb tennivalóink mellet elfo -
gyot a lendület. 

2012-ben egy másik csapat, a  maegyarblender.hu közössége 
újrakezdte. 2015-ben sajnos ez a kezdeményezés is elakadt, 
26%-on. Minden tiszteletem munkájuknak, hiszen erőfeszí-
téseikkel  a  magyar  nyelv  végre  választható  opció  let a  
Blenderben. A fordítás hiányosságai ellenére előcsalogatha-
tó…

Keresd meg a menüben a File > User Preferences (Felhaszná-
lói  beállítások)  parancsot.  A  megjelenő  párbeszédpanel 
System (Rendszer) lapján jól eldugva találsz egy Internatio-
nal  Fonts (Nemzetközi  betűkészletek)  jelölőnégyzetet. 
Őszintén:  Komolyan gondolták,  hogy erről  bárkinek is  a 
nyelvi beállítások jutnak majd eszébe? 

e. Blender magyarul
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A Blender fejlesztői mindent megtetek, hogy jól elrejtsék 
ezt az opciót, és sikerült is nekik… Oké, aktiváljuk.

Láthatod, hogy a választható nyelvek közöt a japánoknak,  
az oroszoknak és az ukránoknak is teljes fordításuk van, a 
cseheknek és törököknek folyamatban, a lengyel s magyar 
– két jó barát – pedig még csak kezdő pozícióban.

A nyelv a kijelölés után nem változik meg, míg meg nem 
nyomjuk az  Interface,  Tooltips és  a  New Data gombokat. 
Ezekkel  részben magyaríthatod a  kezelőfelületet,  a  súgó-
címkéket, stb. Ha meg akarod tartani, nyomd meg a már 
magyarul beszélő Felhasználói beállítások mentése gombot a 
panel bal alsó sarkában.

e. Blender magyarul
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f. 
Mi 
a 

CUDA?

f. Mi a CUDA?

f.
Van eegy jó videokártyád? 
Szeretnéd bevonni a renderelés körüli 
rabszolgamunkába? 
Segítség NVIDIA-tulajdonosoknakó

 

mi a CUDA?
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Drágaság...

Mi a legdrágább alkatrésze a számítógépnek? Régebben a 
válasz egyértelműen a CPU, azaz a központi processzor volt, 
melynek sebessége meghatározta a gép működését. 

A processzorok gyorsaságát hosszú ideig órajelük felsrófo-
lásával tudták növelni.  A gyorsabb ütemezés (frekvencia) 
ugyanis lehetőséget adot arra, hogy több számítást végez-
zenek,  így  egy-egy  alkalmazás  gyorsabban  futot, vagy  
több folyamat is indítható volt, látszólag párhuzamosan. 

Az ütemező munkáját úgy képzeljük el, mint egy kisven-
déglőben dolgozó pincért.  Mi kell  ahhoz,  hogy mindenki 
úgy érezze, hogy a kedves, előzékeny legény csak vele fog-
lalkozik? A főnök szerint a pincér sebességének növelése.

Az órajel növelésével egy darabig szépen túllicitálták egy-
mást a processzorgyártók, de szegény pincért sem lehetet 
fénysebességig gyorsítani – bizonyos fzikai korlátokba üt-
köztek.

Az Intel asztali számítógépekbe szánt csúcsprocesszora. 4 maggal 8 szálon.

Ekkor jöt az ötlet, hogy  több pincért alkalmazzanak, azaz 
párhuzamosítsák a munkát. A technológia készen volt, hi-
szen a szerverekben már régóta több processzor dolgozot. 
Az új irány nem a processzorok számának növelése volt, 
hanem – mint annyiszor a technológia fejlődése során – a 
miniatürizálással több mag került a központi egységbe.

f. Mi a CUDA?

A processzor számolási teljesítményével
kiszolgálja a rendszeren futó programokat

(Forrás: openclipart.org)
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Mi  ma  a  legdrágább  alkatrésze  ma  a  számítógépnek?  A 
CPU mellet, sőt sokszor megelőzve azt – a videokártya! 

Az NVIDIA cég egyik grafikus processzora. (Forrás: NVIDIA)

Graphics Processing Unit (GPU)

A videovezérlő manapság a számítógépen belüli „állam az 
államban”.  Saját  processzorral,  memóriával  rendelkezik, 
ezeket  a  nagy  teljesítménnyel  járó  hőcserélő  rendszerrel 
hűti.  Legtöbben  csak  a  számítógépes  játékokhoz  kötik  e 
részegységeket, pedig az önálló kis számítógépnek tekint-
hető  alkatrész  központi  egysége  akár  több  száz  szálon 
(magban) is futathat számításigényes feladatokat. Az ipar-
ág csúcskártyáit ennek megfelelően számítógépes tervezés-
ben (CAD), flmkészítésben, 3D animációban is használják.

Nem csoda, hogy a grafkus programok fejlesztői is rájöt-
tek,  hogy a  CPU-t  tehermentesíteni  lehet  a  videóvezérlő 
számításaival.  Nemsokára  olyan  programoknak,  mint  a 
Photoshop képszerkesztő vagy az  Illustrator vektorgrafkus 
alkalmazás ugyancsak megugrot a sebessége a videokártya 
magjainak hasznosításával. 

Később megjelentek a videovezérlőkre optimalizált rende-
relő programok –  Octane Render,  az  Arion,  a  FurryBall és 
társaik  –,  melletük  pedig  a  hagyományos  renderelőkbe, 
mint a V-Ray, is implementálták ezt a lehetőséget.

f. Mi a CUDA?

Videóvezérlő kategóriák magszám szerinti 
összehasonlítása (Forrás: Nvidia)
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Az  Otoy  Octane  Render  demója,  melyet  kipróbálhatunk  a  cég  honlapján 
(otoy.com)

Ma még kísérleti szakaszban levő, de nemsokára utakra ke-
rülő önvezető járművek irányítását is ezekre a gyors pro-
cesszorokra bízzák.

Nagy a verseny a gamerek kegyeiért. Az AMD Radeon vezérlői küzdenek az 
NVIDIA Geforce kártyái ellen. Technológiai megoldások és szabványok feszül-
nek egymásnak mindkét oldalon, melyekre fel kell készülnie a játékiparnak.

f. Mi a CUDA?
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GPU-render a Blenderben

2011-ben került a programba egy új renderelő alrendszer, 
mely a  Cycles nevet  kapta.  Mint  sok más  3D alkalmazás 
esetén,  a  Blenderben  is  igény  volt  az  optikailag  korrekt 
megjelenítésre, amit a régebbi renderelő motor csak sokféle 
kerülő  árán  tudot megoldani.  A  Cycles  nagy  újdonsága, 
hogy  a  valósághű  megjelenítést  GPU-gyorsítással,  közel 
valós időben is el tudja végezni a 3D ablakban. 

A Blenderben az NVIDIA (GeForce, Qadro, Titan) kártyák 
támogatása  hagyományosan  jobb,  mint  az  AMD  Radeon 
vonalé. Az előbbi a CUDA (Compute Unifed Device Archi-
tecture – eegységes számolási eszköz architektúra) szofverré-
teget használja a párhuzamos magok eléréséhez, az utóbbi 
az OpenCL-t (Open Computing Language – nyílt számolási  
nyelv). 

Habár a Blender fejlesztői igyekeztek az AMD kártyáit is 
támogatni, általános tapasztalat, hogy egy új NVIDIA kár-
tyával,  viszonylag  nagy  memóriával  (4 GB-tól  felfele), 
CUDA támogatással és sok CUDA maggal nagyon könnyen 
konfgurálható, és gyors GPU-renderelésre bírható a Blen-
der, míg ugyanez Radeonnal nem mindig jön össze.

CUDA életre keltése Linuxban

Windows alat viszonylag  egyszerű  az  életünk,  hiszen  a  
elég  csak  az  NVIDIA kártya  driverét  telepíteni,  utána  a 
Blender már kapcsolatba tud lépni a kártya számolóegysé-
geivel. 

Linuxban  sajnos  több  frusztráció  is  ér  majd  bennünket. 
Minden pozitív reklámja ellenére a Linux igazi buherátor 
rendszer.  Leginkább  felhasználóbarát  változatában,  az 
Ubuntuban is  kemény fejtörést okozot elérnem a CUDA  
támogatást. Ennek menetét szeretném most megosztani.

f. Mi a CUDA?
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Mivel  processzoros  renderidőben  10–20  másodpercet  is 
tudtam spórolni képkockánként, ha nem Windows, hanem 
Linux alat rendereltem (ami pár száz képkockánál jelentős  
időmegtakarítás), szeretem volna, ha teljes funkcionalitás-
sal működik a rendszerem.

A Blender GPU-render beállítása bármely rendszerben:

1. telepítsük a kártya driverét,
2. kapcsoljuk be a Blender User Preferences (Felhaszná-

lói  beállítások)  párbeszédpanelén  a  CUDA  (vagy 
AMD kártyán az OpenCL) lehetőséget,

3. váltsunk át Cycles Renderre,
4. majd a Blender Render paneljén a Device (Eszköz) be-

állításnál  válasszuk  a  GPU  Compute  (videokártyás 
számolás) lehetőséget.

A folyamat Linuxban a második pontnál elakad: A rend-
szer ugyanis nem érzékeli a kártya párhuzamos számolási 
rétegét. Magyarul nem tudunk a frissen megvet százezer  
forintos kártyánkkal renderelni.

f. Mi a CUDA?
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Egy Ubuntu rendszeren szeretném bemutatni a megoldást. 
Először is telepítsd az NVIDIA kártya meghajtóját! 

(Rendszerbeállítások > Szofver és frissítések > További illesz-
tőprogramok)

Rendben,  ezzel  meg  is  vagyunk.  Gondolnánk.  Aztán,  ha 
visszamész a Blenderbe, megint nem engedi a GPU-s ren-
derelést. 

It elakadunk, mert a CUDA bizonyos elemei sajnos nem  
letek bedrótozva a rendszerbe. Az Ubuntu Szoftverek prog-
ramja, ami egy általános, magas szintű telepítő nem tud se-
gíteni, mintha nem is tudna a CUDA-ról. 

Van egy másik lehetőségünk: a Synaptic csomagkezelő. Ez 
nincs alapértelmezeten a rendszerbe telepítve, de a  Szoft-
verek telepítővel felrakható. 

A következő oldalon látod a Synaptic grafkus felületét. Ke-
ress rá a CUDA szóra.

f. Mi a CUDA?
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Két elemet kell it telepíteni: a libcuda1 legnagyobb verzió-
számú változatát és az NVIDIA-cuda-toolkit-et.

Ez utóbbi majd hozza a barátait is, ne ijedjünk meg a füg-
gőségektől.  Innentől már minden olyan egyszerű,  mint a 
Windowsban.

f. Mi a CUDA?
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CUDA-beállítás Windowsban és Linuxban

Most már elérhető a File > User Preferences menüparancsból 
a Felhasználói beállítások párbeszédpanel.

Kapcsoljuk be a CUDA opciót. Majd a Blender felső menü-
sorában  állítsuk  a  renderelő  motort  Blender  Renderről
Cycles Renderre.

Mivel a Cycles alapbeállítása szerint a számítógép központi 
processzorát használná rendereléshez (ugyanis  ez bárme-
lyik gépen működik), a videokártyás rendereléshez át kell 
állítanunk  a  Blender  Tulajdonságok-ablakának  Render  >
Device mezőjében CPU-ról GPU Compute-ra. 

Ezután vígan renderelhetünk a hagyományos módon vagy 
akár valós időben is, a 3D ablakban. 

f. Mi a CUDA?
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g. 

Extra 
objektumok

g. Extra objektumok

g.
Kevésnek érzed a Blender alapmodelljeit?  
Kiegészítők (Add-ons) közöt találsz 
még néhány érdekességetó

 

extra 
objektumok
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Többet akarok!

ANT Landscape ♦  Ezzel  a  kis  bővítménnyel  a  Blender 
Add menüjébe21 egy új elem kerül, mellyel bonyolult dom-
borzatokat vagy akár aszteroidákat is  tervezhetsz.  Keresd 
meg a program File menüjében a User Preferences (felhasz-
nálói beállítások) menüpontot, majd a megnyíló párbeszéd-
panelen keresd meg az Add-ons fület.

It válaszd a baloldali kategóriák közül  Add Mesh (térháló 
hozzáadása) lehetőséget. Kapcsold be az ANT Landscape je-
lölőnégyzetet, s fgyeld meg a leírásban, hol találod majd az 
új testet. Ha később folyamatosan szeretnéd használni, ér-
demes a  Save User Setings gombot is megnyomni a panel 
bal alsó sarkában, s elmenti a program ezt a változást. 

Varázsold elő az Add (Hozzáadás) menüt a (SHIFT+A) bil-
lentyűkombinációval, és a Mesh menüpont alat megtalálod 
a Landscape parancsot. 

Egy kis konnektor jelzi, hogy nem alaptest, hanem az előbb 
telepítet kiegészítőkből származik.

21 Vigyázat: Az ANT landscape nem érhető el az Eszköztárból, csak az Add me-
nüt gazdagítja. Ugyanez igaz ebben a részben a többi kiegészítőre is.

g. Extra objektumok
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A  domborzatot  kicsit  plasztikusabbá  tettem  a  Matcap  (formázó  anyagok) 
egyik beállításával. 

Nagyon fgyelj arra, hogy a létrehozot test csak most para-
méterezhető!  Rögtön  az  elején  válassz:  egy  síkon,  vagy 
gömbfelületen hozod létre a domborzatot!

A Sphere jelölőnégyzetet bekapcsolva, sík helyett gömbfelületű lesz dombor-
zat. Megfelelő paraméterezéssel a Kis Herceg egyik bolygóját is elkészítheted.

g. Extra objektumok
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Bolt Factory – avagy anya csak egy van ♦ A következő 
kiegészítővel csavarokat gyárthatunk. Hogy minek? Röpke 
két óra alat létrehozhatsz olyan tárgyakat ezzel az eljárás -
sal – és egy 3D nyomtatóval –, amelyekért fél óra alat le -
ugorhatál volna a vasboltba. Persze virtuális tárgyainkba 
is kellenek néha csavarok…

A kiegészítő telepítése hasonló, mint az előző példánál. Az 
Add  >  Mesh  >  Bolt menüparancson  keresztül  készíthetsz 
mindenféle menetes tárgyat.

A Model > Bolt/Nut beállítással csavart és csavaranyát hoz-
hatsz létre. A sokféle paraméter közül a  Head a csavarfej 
fajtáját, a  Shank a formáját, a  Tread pedig a menetet vál-
toztatja. 

g. Extra objektumok
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Extra Objects  ♦ Végre valami, aminek nem csak a lelkes 
földrajztanárok vagy a megrögzöt csavargók örülhetnek!  
Valóban  extra  mennyiségű  tárgy  kerül  a  szerszámos  lá-
dánkba ezzel a kiegészítővel!

Csak néhány példa, a teljesség igénye nélkül: 

A Round Cube (lekerekített kocka) néhány beállítása: kapszula, agyagtömb, 
gömb, oktaéder, dobókocka…

A Torus objects lehetőségeivel akár gordiuszi csomót is készíthetünk. Az Extra 
almenüben pedig megtalálható a híres Utah Teepot is, melyet 3D referencia-
objektumként használnak.

g. Extra objektumok
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Archimesh  ♦ Különösebb magyarázat  nélkül:  Egyszerű, 
jól paraméterezhető építészeti elemek – a nyílászáróktól a 
reluxán át a mediterrán tetőcserépig. Sosem volt ilyen ol-
csó az építkezés.

g. Extra objektumok
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h. 

Modellezés

h. Modellezés

h.
A poligon-, organikus, és szobrászat alapú
modellezés néhány fogásával tovább tudsz 
lépni a térbeli formázás területén.

 

modellezés
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A  könyv  terjedelme  sajnos  nem  adot lehetőséget  arra,  
hogy komolyabban elmélyedjünk a modellezés témájában. 
Legtöbbször alaptesteket használtunk, néha módosítókkal, 
ritkábban a  Szerkesztőmódban változtatunk magán a geo-
metriában.  A mindennapi életben ennél  azért  többet kell 
tudnunk….

Az alábbiakban néhány ötletet szeretnék csak feldobni, re-
mélve azt, hogy az alkotásnak ezen a szép területén önálló, 
vagy más oktatóanyagokból való tanulással már magad is 
előbbre jutsz.

Poligon alapú modellezés

A sokszög/térháló alapú modellezés során egy alaptestből 
indulsz  ki,  melyet  a  szerkesztés  során  módosítasz.  Más 
programokkal ellentétben a Blender munkaterületén min-
dig van eegy táregy – az unalomig ismert kocka. Mintha egy 
agyagtömböt raktak volna eléd: It van, tessék, formázd! Ha 
a  geometriai  szerkezetét  szeretnéd  megváltoztatni  a  tár-
gyaknak,  Edit  Mode-ba  (Szerkesztőmód)  kell  váltanod.
Útravalóul  csak  néhány  eszközt  szeretnék  megmutatni, 
melyekkel egész komoly munkákat végezhetsz.

Kihúzás (Extrude)  ♦ Gyakran alkalmaztuk a könyvben. 
Gyorsbillentyűje az (E),  de ha komolyabb munkát akarsz 
végezni,  inkább az (ALT+E) kombinációt  tanuld meg,  hi-
szen azzal egyedi alakzatokat is kihúzhatsz. Ilyenek lehet-
nek a  térpontok (vertexek),  élek és  lapok is.  A kihúzás az 
egyik legtöbbször használt művelet.

Berakás (Inset) ♦ Többször előfordult ez a művelet is, me-
lyet  Szerkesztőmódban  az  (I)  gyorsbillentyűvel,  vagy  a 
(CTRL+F) kombinációval, az oldallapokhoz tartozó menü-
ből varázsolhatsz elő. 

Az elve ugyanaz, mint a bútoroknál az intarzia. It úgy mű-
ködik, hogy egy kicsinyítet, eredeti laphoz hasonló sok -
szöget helyez el a szofver a lap felületén.

h. Modellezés



521

Sarok (Bevel)  ♦ Az élekhez  tartozó  menüből  (CTRL+E) 
vagy a (CTRL+B) kombinációval érheted el. 

A sarkítás mértékét az egérrel, egyéb paramétereit az Esz-
köztár alján állíthatod be.

Körbevágás és csúsztatás (Loop Cut and Slide) ♦ Csak 
gyorsbillentyűvel (CTRL+R) vagy az  Eszköztárból  érheted 
el ezt a parancsot.

Hatása:  Egy  élhurokkal  átvágja  a  testet,  s  miután  a  bal 
egérgombbal rákatintotál, a felület mentén elcsúsztatha-
tod azt. Nem csak egy hurkot, hanem több ilyen vágást is 
ejthetsz, ha katintás előt mozgatod az egér görgőjét. A vá-
gások száma az ablak alján, a bal alsó sarokban ellenőrizhe-
tő, s van it egy másik lehetőség is. Ugyanebben a fázisban  
az ALT gomb megnyomásával kidomboríthatod a modellt.

h. Modellezés
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Ennek mértékét sajnos addig nem érzed, amíg nem katin-
tasz a bal egérgombbal, de utána nagyon látványos.

Kés (Knife) ♦ A felületen végezhetsz bevágásokat, sokszö-
gek kijelölésével. Legjobb példa talán az, amikor egy ház 
falán utólag ablakot vagy ajtót szeretnének létrehozni.

Gyorsbillentyűje a (K),  de megtalálod az  Eszköztárban is. 
Ehhez  az  eszközhöz  is  sok  ötletet  találsz  az  ablak  alján, 
ugyanis használata közben eltűnik az alsó menü, és kapsz 
egy csomó tippet. A kialakítot sokszöget ENTER-rel vagy  
SPACE-szel zárhatod le.

h. Modellezés
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Specials menü (W) ♦ It elérhetsz egy halom modellezés-
nél használt parancsot: Subdivide, Inset, Bevel, stb.

Eszköztár  ♦  S  ha  nem  vagy  gyorsbillentyű-rajongó,  az 
Eszköztárban mindig magad előt látod a modellezés leg -
fontosabb formázóeszközeit.

Szelektív simítás ♦ Az elkészült modellek az Eszköztárból 
Táregymódban (Object Mode) simíthatóak. Ha ennél intelli-
gensebb megoldásra vágysz, a  Tulajdonságok-ablakban be-
állíthatod azt is, hogy csak bizonyos szöghatártól simítson, 
magyarul  legyenek lapos  és  simítot részek is  a  tárgyon  
(Auto Smooth).

Legtöbbször viszont ez sem elég, akkor jön az…

h. Modellezés
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Organikus modellezés

A technikai  modellek többsége szögletes,  sarkos.  Poligon 
alapú  modellezéssel  szinte  minden  modellezési  feladatot 
megoldhatnánk, ha nem lennének görbe felületek. Gondolj 
egy  autó  karosszériája,  egy  repülőgép  szárnyprofljára, 
vagy akár  a  saját  arcodra.  Organikus modellezésnél  már 
kevés a játékokhoz kifejlesztet, elnagyolt simítás (Smooth).

It jön a képbe a  Subdivision Surface (felületfelosztásos si-
mítás)  módosító. Az eredeti formát csak befoglaló alakzat-
nak tekinti,  melynek oldalait felosztva a „felületi  feszült-
ség” a középpont fele összehúzza a tárgyat.

Ha természetellenesnek érzed ezt a ketrecszerű megjelení-
tést, az éleket hozzásimíthatod a felülethez.

A Subsurf-modellezés nagyon jó játék, főleg, ha egy kis ki-
húzással kombinálod. Egy idő után viszont it is felmerül a  
korábban feltet kérdés fordítotja: Hogyan tudunk a tár -
gyon kialakítani éleket, vagy síklapokat, ha minden részük 
görbült, simítot felület?

Van erre is megoldás a Blenderben…

h. Modellezés
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Válaszd az  Edge Crease  (élhez gyűrés, ráncolás) parancsot 
az  élszerkesztés  menüjéből  (CTRL+E).  Az  Edge  Crease  
gyorsbillentyűje ehhez közel van: (SHIFT+E). Az egér moz-
gatásával hozzágyűrheted, hozzásimíthatod a lapokat vagy 
az éleket az eredeti formához. Gyakran szokták ezt a tech-
nikát kombinálni a körbevágás és csúsztatás (Loop Cut and 
Slide | CTRL+R) már korábban alkalmazot eljárásával. Pró-
báld ki te is, ha a csúsztatási szakaszban az egyik lap felé 
mozgatod az élhurkot, hasonló hatást érhetsz el.

Szép topológiát subsurf modelleken négyszöglapokkal lehet 
kialakítani. 

A  poligon  alapú modellezés  viszonylag  kis  erőforrás-
igényű, a subsurf modellek már jócskán belassíthatják a vi-
deokártyát és a renderelést is, de szép eredményt lehet ve-
lük elérni. Ahogy fejlődtek a számítógépek, megjelentek az 
olyan speciális szofverek, melyekkel digitális formázással, 
szobrászatal  nagyszámú poligont tudnak egészen termé-
szetes módon kezelni. S olyan programok mint a  Zbrush, 
Mudbox szobrászképességei bekerültek a Blenderbe is. 

Pillantsunk be ebbe a modellezési technikába…

h. Modellezés

A Zbrush gyártójának, a Pixologicnak 
ingyenes szobrászeszköze a Sculptris.



526

Szobrászkodás

A Blender szobrászeszközeit a 3D-ablak alsó menüjéből ér-
heted el : ot, ahol a Tárgymód és Szerkesztőmód is találha-
tó. Keresd a  Sculpt Mode opciót.  

Kiinduló formául a kockát szoktam választani, de Szerkesz-
tőmódban a Special menüből (W) alkalmazom rá a Subdivi-
de Smooth (simítot felosztás) parancsot. Olyan gombócot  
kapsz, aminek jó a geometriája, hiszen négyzetlapokból áll.

Van  a  Blendernek  egy  Multiresolution nevű  módosítója, 
mellyel több fokozatban tovább lehet osztani a test felszí-
nét. Ezt kell használnod, mivel ebben beállítható a modell 
részletessége. 

Valójában a szobrászkodás miat került be a Matcap árnya-
lási  funkció  a  Blenderbe.  Most  veszed  látod  majd  igazi 
hasznát.  A művelet  minden paraméterét  az  Eszköztárban 
találod. 

A  szobrászkodás  nem öncélú  eljárás.  Az elkészült  forma 
részletei a program Render > Bake paneljén kiírhatóak egy 
domborzati adatokat tartalmazó képre, melyet játékokban 
az alaphálóra lehet húzni, s ezzel a trükkel részletessé tehe-
tők az alacsony poligonszámú modellek.

h. Modellezés
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i. 

Anyagok, 
faktúrák, 
textúrák

i. Anyagok, faktúrák, textúrák

i.
Gyors átekintés az anyagok Blenderben beállítható
optikai tulajdonságairól, a felületen alkalmazható 
domborzatról, és a textúrázásról.
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Cycles anyagkezelése lényegesen különbözik a Blenderben 
korábban megszokot eljárásoktól. A régebbi renderelő mo-
tor  (Blender Internal,  Blender Render) ugyanis  úgy műkö-
döt, hogy megadtál  egy anyagnevet,  aztán végtelen sok  
beállítással paraméterezted azt. Neked kellet tudni, hogy a 
kívánt anyag hogyan veri vissza a fényt, hogyan töri meg, 
bocsát-e ki közben fényt, stb. 

Most, a  Cycles-ben már a kezdéshez kapsz egy támpontot, 
amilyen optikai anyagtulajdonsággal elindulhatsz. 

Ezek lehetnek: 

• plasztikusan árnyékolt (Ambient Occlusion), 

• szálcsiszolt fém (Anisotropic BSDF22), 

• általános diffúz (Diffuse BSDF), 

• fényforrás jellegű (Emission), 

• üveg (Glass BSDF), 

• haj (Hair BSDF), 

• maszk (Holdout), 

• fénytörés (Refraction BSDF), 

• porcelán (Subsurface Scattering), 

• rajzfiilmes (Toon BSDF),

• áttetsző (Translucent BSDF), 

• átlátszó (Transparent BSDF),

• bársony (Velvet BSDF),

• térfogatában fényelnyelő (Volume Absorption),

• térfogatában fényt szóró (Volume Scatter).

A következő oldalakon egy gyors áttekintést találsz.  Elő-
ször a  felületi  (Surface), majd a  térfogati  (Volume) optikai 
tulajdonságokkal foglalkozunk.

22 A BSDF (Bidirectional scatering distribution function) egy matematikai függ-
vényen alapuló eljárás a fény felületekről való szóródására.

i. Anyagok, faktúrák, textúrák
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Felületi anyagtulajdonságok

Ambinient Occlusion ♦ Környezeti fénnyel bevilágítot, 
fnoman  árnyékolt  anyagtípus.  Akkor  alkalmazzuk,  ha  a 
test önárnyékait szeretnénk kiemelni.

Elsősorban  modellek,  szobrok  plasztikus  megjelenítésére 
használják.

Anisotropic ♦ Térbeli iránytól függő visszatükröződés. A 
szálcsiszolt fémekre jellemző anyagtulajdonság.

Ilyen eszközöket találsz a konyhában, ipari környezetben 
vagy éppen mobil informatikai eszközök borításán.

Difuse ♦ Difúz, szórt visszaverődés. A mikroszinten sza-
bálytalan  felületekre  jellemző.  Az  egyik  legáltalánosabb 
anyagtulajdonság.

Emission ♦ Fényforrás, világító test. A  Cycles-ben alkal-
mazható természetes fényforrás,  mely nem csak a testek 
tükröződése révén látható, mint a Blender virtuális lámpái.

i. Anyagok, faktúrák, textúrák
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Glass ♦ Üvegszerű anyag. Átlátszó, átetsző szilárd és fo-
lyékony anyagokhoz. A fénytörés miat lencseszerű hatá -
sok jönnek létre, melyek a hátér torzítot képét, és a kör -
nyezetre  rávetítet fényfoltokat  eredményeznek.  Ha  a  
felszín egyenetlenségeit is bekapcsolod  (Roughness), akkor 
átetsző,  homokfúvot üveghez hasonló hatásokat érhetsz  
el. 

Néhány anyag törésmutatója  (IOR – Index of Refraction) :

Alkohol 1,329
Ametiszt 1,544
Benzol 1,501
Borostyán 1,546
Emberi szem – csarnokvíz 1,33
Emberi szem – szaruhártya 1,38
Emberi szem – szemlencse 1,41
Glicerin 1,473
Gyémánt 2,417
Jég 1,31
Konyhasó 1,54
Kristály 2
Kvarc 1,544
Kvarcüveg 1,459
Műanyag 1,46
Nejlon 1,53
Obszidián 1,5
Opál (fekete, fehér) 1,44–1,46
Plexiüveg (műanyag) 1,5
Polisztirol 1,55–1,59
Rubin 1,76
Smaragd 1,576
Szilikon 4,01
Topáz 1,62
Türkiz 1,61
Üveg 1,51714
Víz 1,33335
Zafír 1,77

Hair ♦ Haj és szőr megjelenését utánzó anyag. Háromféle 
anyagtulajdonság keveréke: difúz, átetsző és anizotróp.

Hajat egyébként részecskerendszerrel lehet létrehozni.

i. Anyagok, faktúrák, textúrák
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Holdout ♦ Maszk, kivágot anyag. Ha a renderelési tulaj -
donságoknál  bekapcsolod  a  Film  >  Transparent  opciót,  a 
renderelésnél átlátszóvá válik a képnek az a része, ahol az 
ilyen tulajdonságú test van. A fenti beállítás nélkül korom-
fekete lesz. 

Refraction  ♦ Fénytörés.  Nagyon hasonló a  Glass (üveg) 
anyaghoz, kivéve, hogy a hátérből csak az eltérítet fények 
jelennek meg benne,  az anyag belső  felületén tükröződő 
fénysugarak nem.

Az Intersellar c. flm óta előszeretetel használják csilla-
gászati vizualizációkban, a fekete lyukak által keltet gravi-
tációs lencsék szimulálására.

Subsurface Scattering  ♦ Felszín alati szóródás. Vannak  
olyan anyagok, mint a porcelán, a márvány vagy az emberi 
bőr, melyekbe behatol a fény, a felszín közelében szóródik, 
majd ennek egy része visszajut a szemünkbe. Ennek megfe-
lelően jellegzetes, némileg átetsző anyagot kapunk.

Toon ♦ Rajzflmes árnyalás. Speciális, nem fotorealisztikus 
anyagtulajdonság,  melyet akkor használnak,  ha a hagyo-
mányos rajzflmek színezését szeretnék utánozni.

i. Anyagok, faktúrák, textúrák
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Translucent  ♦ Vékony testeknél, például ruháknál alkal-
mazható átetsző anyag, melyen átdereng a fény. 

Trasparent ♦ Olyan átlátszó felület, mely nem töri meg a 
fényt, nem torzítja el a mögöte levő tárgyak képét. Önma-
gában legfeljebb színszűrőként alkalmazható (balra).

Gyakoribb alkalmazása: Átlátszó háterű képeknél. A fenti 
ábrán egy fénykibocsátó és egy transzparens anyag keveré-
kéből jön létre a hölgyet ábrázoló PNG kép kivágot hatása.

Velvet  ♦ Bársony,  ruházat  megjelenítésére  használható 
anyag.  Jellegzetessége  a  puha,  feketés  árnyalás,  ami  az 
alakzatok közepén jelenik meg.

i. Anyagok, faktúrák, textúrák
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Térfogati anyagtulajdonságok

Vannak olyan anyagok, ahol nem csak a felületről visszave-
rődő, de a rajta átmenő fény is szerepet játszik az objektum 
megjelenítésében. Ilyen az üveg, a haj, valamint az átetsző, 
vagy porcelánszerű anyagok.

Hogy a következő  kettő anyagtulajdonságot jobban meg-
értsd, nem testet, hanem az egész Világot hatjuk át ezekkel. 
Mindkető közeg-szerűen viselkedik, ezért szemléletesebb.

Előte pillants rá a Világ anyagtulajdonságaira. Két helyen 
is megtalálod: a  Tulajdonságok-ablakban és a  Csomópont-
szerkesztőben. Ez utóbbi menüjéből az Add > Shader > Volu-
me Scater paranccsal kapcsold az új csomót a a World Out-
put Volume (térfogat) bemenetére.

Volume Scatter  ♦ Ez az optikai tulajdonság az anyagok-
ban való szóródást  szimulálja.  Emiat tárgyakban vagy a  
Világ tulajdonságaiban gyakran használjuk köd, pára, füst 
vagy tűz megjelenítésére.

i. Anyagok, faktúrák, textúrák

A Volume Scatter árnyalóval 
előállított ködöt egy 

fényforrással világítjuk be.
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De hogyan működik, ha egy testre alkalmazzuk? It is köd-
szerű az eredmény,  melyet  nem önmagában,  hanem más 
testekkel való kölcsönhatásban érdemes alkalmazni.

Volume Absorption  ♦ Míg az előző optikai tulajdonság 
sem önmagában, hanem más testekkel való kölcsönhatásá-
ban  izgalmas,  a  térfogati  fényelnyelésre  ez  még  inkább 
igaz. Korábbi, tűz és füstszimulációs feladatunkban mind-
ketőt használtuk már. 

It legyen egy másik példa, hogy lásd nem csak vagylago -
san köthetőek be a felületi és térfogati csomópontok.

i. Anyagok, faktúrák, textúrák
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Anyagok keverése

Kétféle keverő csomópontot is találsz az anyagtulajdonsá-
gok  (Shaders) közöt. Ezekkel  olyan  kombinációkat  hoz -
hatsz létre, melyek érdekesebbé vagy valósághűbbé teszik a 
tárgyakat.

Add Shader  ♦ Két  anyag tulajdonságát  úgy  adja  össze, 
hogy mindkető teljes egészében érvényesül. Mit is jelet az, 
ha valami 100%-ban tükröző, ugyanakkor 100%-ban átlát-
szó üveg? A valóságban nincs ilyen. Ami mégis kikísérle-
tezhető, arról különleges autófestékek jutnak eszembe.

Van egy terület, ahol gyakran alkalmazzák, ez pedig a disz-
perzió, azaz az üvegek, lencsék prizmaszerű színbontása. A 
Cycles renderelőre  azt  szoktuk  mondani,  hogy  unbiased, 
azaz  előfeltevésektől mentes (fzikai elvű). A színbontás je-
lenségét viszont csak némi trükközéssel tudjuk megoldani.

A fenti ábrán látható, hogy az  összeadó színkeverés három 
alapszínét (RGB) különféle törésmutatókkal (IOR) összead-
tuk két Add típusú csomópontal. 

i. Anyagok, faktúrák, textúrák

100%-ban tükröző és 100%-ban 
átlátszó anyag kombinációja.

Valódi diszperzió szimulálása.
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Mix Shader ♦ A fenti összeadó csomópontnál általánosab-
ban és valószerűbben használható anyagtulajdonságok ke-
verésére, melyek a fzikailag korrektebb megjelenítést szol-
gálják. Az üveg például nem teljes egészében töri meg a rá 
eső fénysugarakat, hanem kisebb részben visszaveri.

A bal oldalon levő képen például a fehéres-zöldes tükröző-
dések a környezetből jövő fények visszaverődései, a kékes 
színek pedig az üveg fénytörésének eredményei.

i. Anyagok, faktúrák, textúrák
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Felületi egyenetlenségek

A felületek a valóságban nem ideálisan simák vagy szépen 
polírozotak, mint ahogy ezt az anyagtulajdonságok nagy 
részénél  beállítotuk.  Sőt,  talán  az  okozná  a  legnagyobb 
gondot, ha minden ennyire „tökéletes” lenne. 

Hogyan közlekednénk ideálisan sima utakon és járdákon? 
Milyen lenne egy fa a parkban, ha tökéletesen lenne a tör-
zse? Biztosan gyanakodnál, hogy egy mesterséges valóság-
ban  vagy,  ahonnan  kifelejteték  a  faktúrákat,  a  felületek  
természetes domborzatát, eegyenetlenségeit.

A Blender egyrészt felületi térképekkel (Bump Map, Normal 
Map),  másrészt  valós  domborzatal valósítja  meg  ezeket.
Az első módszer a fény-árnyék hatások utánzásával éri el, 
hogy érdesnek, felületileg tagoltnak lásd az anyag felszínét. 
Valójában nem változtatja meg azt. Az utóbbi valóságos ki-
emelkedéseket-bemélyedéseket hoz létre. A különbség ak-
kor látható igazán, amikor a széleket, kontúrokat nézed.

Vegyünk egy példát. Készíts egy rézszínű felületet, melyre 
a csomópontok  Add > Texture > Voronoi tulajdonságát kö-
tötem a Displacement (domborzat, faktúra) bemenetre.

i. Anyagok, faktúrák, textúrák
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Ha felületi térképként helyezem fel, gyönyörű a dombor-
zat, de a széleken érezhetően nem változtatja meg a  topo-
lógiát (balra).

A jobb oldali képen viszont annyira meggyűri, hogy az éle-
ken még szét is  szakad.  Ahhoz,  hogy a valós domborzat 
ennyire részletes legyen,  Szerkesztőmódban fel  kell  oszta-
nod (Subdivide) a test hálóját.

A  Displacement  (valós 
domborzat) nemrég let ki -
fejlesztve, így a Blenderben 
be kell hozzá kapcsolnod a 
renderelés  panel  Feature  
Set > Experimental (kísérle-
ti) tulajdonságát.

Ahhoz, hogy láss is valamit, az  Anyagtulajdonságok pane-
len a Setings > Displacement Method mezőben állítsd:

• Bump-ra, ha csak egy felületi domborzatérképet sze-
retnél a tárgyra tenni.

• True-ra, ha valódi domborításra vágysz.

• Both-ra, ha a legszebb eredményt szeretnéd. Ilyenkor 
mindkét metódust bekapcsolja. 

i. Anyagok, faktúrák, textúrák
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Domborzatként  alkalmazhatóak  a  Blender  procedurális 
(matematikai alapút) textúrái, vagy akár képeket is.

Ezek közül a Bump Map szürkeárnyalatos képként tölthető 
be, ahol a fehérhez közeli árnyalatok kiemelkedést, az ár-
nyékok pedig bemélyedést eredményeznek. 

A  színes  Normal  Map-et  inkább  játékokhoz  használják, 
ahol az alacsony lapszámú modellek részleteit ezzel az eljá-
rással szimulálják.

A fenti domborzat csomópontjai.

i. Anyagok, faktúrák, textúrák

Bump Map 
alkalmazása 

a felületre.
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Valódi textúrák a felületen

A faktúrák a tárgyak domborzatát befolyásolják, természe-
tes felületérzetet  adva nekik.  A textúrák mintázatok,  me-
lyekkel még valósághűbbé tehető az objektum.

Voltak feladatok, melyekben képet vagy flmet tetünk tár-
gyakra. Csomópontrendszerrel így nézni:

A leképezést a program generálja  (Input > Texture Coordi-
nate > Generated), majd betölti a képet (Texture> Image Tex-
ture), ezt hozzákapcsolja az anyagtulajdonsághoz (Shader > 
Difuse), majd elküldi a tárgyra.

Módosítsuk egy kicsit ezt az elrendezést! A Texture Coordi-
nate csomó kimenetét változtasd UV-re. 

Az UV rövidítés nem „utóvizsgára” utal. Mivel a térbeli ko-
ordináta-rendszer már lefoglalta az XYZ tengelyeket, már 
csak az U és V maradt a tárgyakra feszítet textúrák koordi-
nátáinak megkülönböztetésére.

i. Anyagok, faktúrák, textúrák

A program által generált 
leképezéssel egy kocka (Box) 

felületét fedjük be.
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Hogyan boríthatod be képpel a kiválasztot objektumot? 

1. Az UV/Image Editorban (jobb felső ablak) képet hozol 
létre, vagy betöltöd azt a gépedről.

2. Szerkesztőmódban kijelölöd a test összes lapját (jobb 
alsó 3D-ablak), majd a  Mesh > UV Unwrap menüvel, 
vagy az (U) gyorsbillentyűvel eldöntöd, melyik pro-
jekciót, rávetítést választod. Miután kiterítete a há-
lót, az UV/Image Editorban megfelelően elhelyezed a 
lapokat.

3. A Csomópontszerkesztőben a fenti elrendezéssel ráve-
títed mindezt a választot anyagra.

Az  „UV-zás”  vagy  textúrázás  a  3D-modellezés  speciális 
szakterülete. Ha el szeretnél mélyedni a témában, sok okta-
tóanyagot találsz az interneten.

i. Anyagok, faktúrák, textúrák
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j. 

Kamera

j. Kamera

j.
Dolgoztál már valódi kamerával? Amit azzal 
nem lehet megoldani a valóságos életben, 
a virtuális térben is természetellenesnek hat.

 

kamera
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Tipikus hibák

Milyen hibákat lehetne elkövetni egy ilyen ártatlan eszköz-
zel?  Talán nem is  gondolnád,  hogy a  kamera az amatőr 
animátorok által  talán leginkább elhanyagolt  eszköz.  Két 
dologból  lehet  azonnal  kiszúrni  a  kontár  munkát.  Ha az 
animáció darabos  –  erről  nem a  kamera  tehet,  hanem a 
gyakorlatlan „művész”. S ha a a kamerát idétlenül használja 
az animátor.

Legtöbb korábbi látványanimációnkat álló kamerával, vagy 
álló  kamerák  váltogatásával  forgatuk,  hogy  ne  fussunk 
bele ezekbe a tipikus hibákba.

Amikor egy flmet nézel, akkor érzed valóságosnak, termé-
szetesnek,  ha  összevethető  mindennapi  tapasztalataiddal. 
Ahogy nap mint nap látunk, mozgunk. 

Természetes az a mozgás, ha körbenézünk, azaz függőleges 
vagy vízszintes  tengely  mentén forgatjuk  a  fejünket.  Ha 
ugyanezt  tesszük a  kamerával,  azt  pásztázásnak,  panorá-
mázásnak, vagy német kifejezéssel svenkelésnek hívjuk. 

Közeledhetünk vagy távolodhatunk valamihez képest, vala-
milyen útvonalon, vagy oldalirányban, ez a mozgás a kocsi-
zás, szakkifejezéssel fártolás. 

Nem szoktunk össze-vissza repkedni. A madarak igen, de 
mi emberek csak megfelelő eszközzel vagyunk képesek re-
pülni. Ne használj természetellenes mozdulatokkal repkedő 
kamerát akkor, ha nem egy repülő mozgást akarsz kifejezni 
a flmen. 

Ugyanez igaz a zoomolásra is. Amióta kamerákban lencse-
rendszereket használnak, egy mozdulatal meg tudják vál-
toztatni a fókusztávolságot. Annak az érzetét keltve, mint-
ha  közelebb  vagy  távolabb  mennél  a  felvétel  tárgyához 
viszonyítva. De ez nem azonos érzés,  mintha ugyanezt a 
mozgást tényleg megtennénk. 

j. Kamera
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Természetellenes mozgás, ha hirtelen 10–20 méterrel odébb 
találjuk magunkat. Ez egy másodpercre 30–70 km/h sebes-
séget jelentene. Nem vagyunk csigák sem, akik ilyen távol-
ról csak odatolják a szemüket a témára.

Töltsd be a  050_kamera_rig.blend állományt, és próbáld ki 
ezeket a mozgásokat az adot beállításon. 

Ez egy elég jól  megszerkesztet rendszer,  mely gondosan  
szimulálja  egy  valódi  készülék  viselkedését,  lehetőségeit. 
Ritkán lesz ilyesmire szükséged, ha helyesen megtanulod a 
valóságos kameramozgásokat.

j. Kamera



545

A Blender kamerabeállításai

Egy új állományon vizsgáljuk meg a program beépítet ka-
merájának tulajdonságait!

Az objektív ♦ Háromféle kamera közül választhatsz.  Az 
első kető hasonló a virtuális térben használt perspektivi -
kus és ortografkus nézethez. A panoráma-kamera hatását 
valós idejű renderelésnél láthatod: különleges, torzító opti-
kák hatását utánozza (pl. halszem).

A fókusztávolság  (Focal  Lenght) segítségével  állítható  be, 
hogy nagylátószögű (f < 50 mm) vagy normál (f = 50 mm), 
esetleg  teleobjektívet  (f  >  50  mm)  használsz.  A  Blender 
alapbeállítása egy 35 mm-es, nagylátószögű objektív – ta-
lán az okostelefonod hátlapján van hasonló. A fókusztávol-
ság időben való változtatásával lehet zoomolni.

A láthatár ♦  A  Clipping (vágás) értékkel lehet beállítani, 
hogy metől-meddig lásson a kamera. Ha felvétel közben 
valami  eltűnik,  gyanakodj,  hogy  a  látótávolságon  kívül 
van. Ez a tengely, illetve a kamera fókuszpontja beállítható 
a Display panel Limits négyzetével.

Élesség ♦  Az élesség középpontja nem csak tárggyal, ha-
nem manuálisan is befolyásolható a  Depth of Field (Mély-
ségélesség) panel Distance (távolság) mezőjében.

j. Kamera
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Sínfárt 

Van a kocsizásnak (fártolás) egy olyan fajtája, amikor a ka-
merát előre lefektetet sínen mozgatod. A Blenderben eh -
hez nem vassíneket, hanem segédgörbét használunk.

Készíts  görbét  az  Add  >  Curve  >  Path  menüparanccsal. 
Szerkesztőmódban  jelöld  ki  az  egyik  végét,  majd  az  (E) 
gombbal extrudált, húzd ki a következő pontot. A vezérlő-
pontok térbeli elmozgatásával nagyon szép hullámvasutat 
is  készíthetsz.  Helyezd  el  a  kezdőpontjához  a  kamerát, 
majd parentold hozzá a görbéhez.

j. Kamera
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Ennek gyorsbillentyűje a (CTRL+P), de fgyelj arra, hogy 
ne csak kapcsolja, hanem a Follow Path parancssal le is kö-
vesse a görbét. 

Ha elindítod az animációt, a 100. képkockáig egyenletes se-
bességgel  végigszánkázik  a  sínen.  Azt,  hogy  mennyi  idő 
alat teszi meg az utat, a görbe tulajdonságai közöt a Path 
Animation panel Frames mezőjében állíthatod be. Egyenle-
tes sebességben kell gondolkodnod, ahol a pálya menti se-
besség nem egzaktan,  hanem a képkockák számával van 
megadva, de kulcsolható is.

j. Kamera
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k. 

Képek a térben

k. Képek a térben

k.
Speciális efektekhez, stílusos rajzflmes animációhoz,
vaegy eegyszerűen csak a munka egyorsítására 
egyakran alkalmazunk síkbeli képeket, vaegy 
képre helyezet flmrétegeket.

 

képek a térben
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2D elemek a térben

A többi térbeli tervező programhoz hasonlóan a Blendert is 
felkészíteték arra, hogy képeket importáljon, s helyezzen 
el a térben. Ezekkel kivágásos (Cutout) síkanimációt készít-
hetünk23,  különleges  térbeli  hatásokat  érhetünk  el  (2.5D, 
parallax), hátereket vagy távol levő objektumokat jelenít-
hetünk  meg  modellezés  nélkül.  Emellet ez  a  technika  
olyan VFX efektusokhoz is megfelelő, mint a köd, füst, tűz 
–  ha  nem  állóképeket,  hanem  átetsző  háterű  flmeket 
használunk.

Képek beviteléhez  a  Blender  beépülő  moduljai  (Add-ons) 
közül fogunk telepíteni egyet.

Telepítés  ♦ File > User Preferences > Add-ons, s it az  Im-
port-Export szekcióban  keresheted  az  Import  Images  as  
Planes kiegészítőt.

Már it érdemes megnézned, hogy hova épül be:

• A File menü > Import > Images az Planes menüpontjá-
ban. 

• Vagy az  Add menü (SHIFT+A) >  Mesh > Images as  
Planes parancsához.

Kipróbálásra két átlátszó háterű képet kell majd így beil-
lesztened. (048_felhocske.png; 049_napocska.png)

23 Cutout animation – legjellegzetesebb példa a South Park c. rajzflmsorozat.

k. Képek a térben
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A Blender fájlkezelő ablaka képes előnézeti képeket is mutatni bitképekről, 
betűkészletekről. Ehhez próbáld ki az ábrán zölddel jelölt gombokat.

Egyszerre több állományt is kiválaszthatsz. De vigyázz, át-
látszó háterű képeknél fontos, hogy aktiváld a  Use Alpha 
(használj átlátszóságot) négyzetet. Érdemes is megjelölni a 
képet hordozó síklap anyagtulajdonságát is, ami esetünk-
ben legyen Emission (fényforrás). Nem kell megijedni. Etől 
még nem kerülnek radioaktív felhők a jelenetbe. Csak nem 
kell bajlódnod a bevilágítással, ha a kép maga is fényforrás.

A Blender Csomópontkezelőjében megnézheted, milyen anyagtulajdonságok 
kombinációjával állítja elő a program az átlátszó hátteret. Balra lent valós ide-
jű rendereléssel, jobbra lent pedig Material árnyalással tehetők szerkesztés 
közben is láthatóvá ezek a képek.

k. Képek a térben

A felhő Alpha csatornája.
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Bár kegyes csalás, a képek elhelyezését előszeretetel alkal-
mazzák a  produkciós  munka során.  Rengeteg munkát  és 
erőforrást takaríthatunk meg velük.

Rajzflmes megjelenítésnél nem csak gyorsabb, de stíluso-
sabb is ez a módszer. Ha a képek síkjait egymás felet he -
lyezed el, oldalra mozgatot kamerával nagyon szép térbeli  
hatás (parallax efektus) érhető el. 

Ha síkbeli  elrendezést  alkalmazol,  a  kamerát  érdemes az 
(ALT+R, ALT+G) billentyűkkel az origóba vinni, majd felfe-
le elmozdítani. 

Ez a klasszikus,  Walt Disney által megvalósítot multiplán  
kameraállás. Ebben egymás fölé tet plexilemezekre helyez-
ték a síkbeli szereplőket vagy tárgyakat, s így adtak a kép-
nek mélységérzetet. 

k. Képek a térben

A multiplán kameraállás
jól kombinálható a 
mélységélességgel.
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l. 

Renderelés

l. Renderelés

l.
Volt-e élet a Cycles előt, s lesz-e azon túl?
Pár oldal bevezetés, amelyben megtudhatod,
hol használható a Blender régi renderelője. 
Megismerkedsz az ipari standard RenderMan-nel,
majd a Luxrender-rel. 

 

renderelés
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Blender Render vagy Cycles?

A digitális képalkotás az egyik legnehezebb területe a 3D 
grafkának. Hja, melyik területe könnyű?… De komolyan: 
Minden mindennel összefügg:  anyagok, textúrák, fények, 
hátér – s ha valami már jól összejön, akkor izzadó procesz-
szor és telik az idő, idő, idő…

Akárcsak más 3D-s programoknál, a Blenderben is többféle 
renderelési eljárás közöl választhatsz, melyek köszönő vi-
szonyban  sincsenek  egymással.  Az  alábbi  kép  például
Cyclesben készült.

Ugyanez a program régebbi  Blender Internal (belső rende-
relő),  vagy  ahogy  manapság  a  menüben  találod Blender  
Render képalkotó motorjával így néz ki:

Csak a tárgyak maradtak meg, de elveszet az összes, szé -
pen beállítot optikai tulajdonságuk.

l. Renderelés
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Munkád kezdete előt tehát már tudnod kell, milyen képal -
kotó eljárással fogod leszámoltatni a jeleneteket, különben 
újra végig kell járnod az anyagok és fények beállításait – 
sok erőfeszítéssel és egész más gondolatmenetel.

Könyvemben a Blender legmodernebb, folyamatosan fejlő-
dő renderelő eljárásával, a Cycles-szel foglalkoztunk. Ennek 
több oka is van. 

• A Blender régebbi renderelőjét már nem nagyon fej-
lesztik. Bizonyára még évekig benn marad a szofver 
következő kiadásaiban, és vitathatatlan érdemei van-
nak a gyorsaság, illetve nem fotorealisztikus megje-
lenés tekintetében. De nagyon sok ügyeskedéssel le-
het hasonló szintű képeket létrehozni vele, mint az 
új eljárással.

• A  Cycles nagyságrendekkel közelebb áll a fzikailag 
korrekt megjelenítéshez, sokkal könnyebb kezelni. 

• A  Cycles támogatja egyedül a modern videokártyá-
kon való számolást, a GPU renderinget. Ez többszörö-
sére gyorsítot képalkotással jár úgy, hogy közben az 
eredmény sokkal, de sokkal valósághűbb. 

Alapesetben  háromféle  renderelés  közül  választhatsz  a 
Blenderben. A klasszikus renderelő motor (Blender Render), 
a játékmegjelenítő motor (Blender Game) és a legújabb, fzi-
kailag korrekt (Cycles Render) motor közöt.

Van-e  értelme  visszatérni  a  klasszikus  renderelő  eljárás-
hoz? 

l. Renderelés
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Amiben a Blender Render jobb

A korábbi renderelő úgynevezet „biased” 24 típusú. Ezeknél 
sokkal hosszabb úton jutsz el a valósághű megjelenésig, de 
ha nem ez a célod, akkor nagyon gyors, és néha stílusos 
eredményt kaphatsz.

Drótváz  ◆ Pillanatok alat lehet pl. drótvázas modelleket  
megjeleníteni. Ehhez nyomd be az anyagtulajdonságok pa-
nelen  a  Wire  (Drótváz)  gombot.  Ha  egységes  árnyalatot 
szeretnél, jelöld még hozzá a Shadeless négyzetet is.

Homogén szín ◆ Rajzflm- vagy 
árnyjáték-szerű, nagyon gyorsan 
renderelhető  képeket  is  készít-
hetsz  hasonló  beállításokkal,  it 
persze nem a Wire (drótváz), ha-
nem  a  Surface (felület)  gombot 
kell bekapcsolni.

E két egyszerű példán is látható, 
hogy ahol a stílus és a gyorsaság 
is  fontos,  érdemes  visszatérni  a 
Blender jó öreg renderelőjéhez. 

Én jól megvoltam nélküle…

24 A szó  előítéletet,  előfeltevést jelent. Az ilyen típusú renderelőknél neked kell 
sokféle előfeltevést alkalmaznod, hogy a tárgy úgy nézzen ki, ahogy szeretnéd 
Ezek lehetnek fzikailag  egészen extrémek  is.  Tehát  te  határozod  meg,  mit  
akarsz adot helyen látni, és nem a fzikai körülmények.

l. Renderelés
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Ha többet szeretnél tudni a régi renderelő beállításáról, a 
szakirodalom-jegyzékben  találsz  majd  magyar  könyvet, 
ami a témával nagyon részletesen foglalkozik.

Külső renderelők

Kísérletező  kedvű  olvasóimnak  szeretném  felcsillantani, 
hogy a Blenderbe még sokféle külső renderelő integrálható. 
Ezek közül talán leghíresebb a Pixar RenderMan.

A RenderMan nem csak a Pixar flmjeiben, de az egész spe-
ciális efektus iparban meghatározó flmipari szofver. 

A szofver nem üzleti felhasználásra letölthető a Blender-
hez, egy Add-onnal egyetemben, amivel utána a Blenderből 
tudsz RenderMan motorral képet, animációt generálni. 

Használatának megvannak persze az előnyei és hátrányai 
is. Az ipari nagyágyú renderfarmokhoz szokot, ezért nem 

l. Renderelés
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támogatja a videokártyás renderelést. Szépen renderel pro-
cesszoron, de inkább akkor ajánlom, ha a flmipar fele ka-
csintgatsz – ot jól jön a RenderMan ismerete.

Ha viszont az ipari formatervezés vagy a fzikailag korrekt, 
fotorealisztikus megjelenítés vonz, válaszd a Luxrendert.

Ennek motorja videokártyákon is renderel. Ne csodálkozz, 
ha egy-egy jó kép renderideje néha órákban mérhető. Ez a 
fajta, fzikailag korrekt megjelenítés ezzel jár. 

Mindegyik rendermotorra igaz,  hogy használatukkal  újra 
kell tanulni a rá jellemző anyag-, fény- és renderelési beál-
lításokat. Ennek megfelelően sokféle változásra számíthatsz 
a Material, Lamp és Render paneleken.

l. Renderelés
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m. 

Sniper

m. Sniper

m.
Lusta betűanimátorok látványos 
és hatékony eszköze a Sniper 
bővítmény. Megér eegy próbát. 

 

Sniper



559

Betűanimáció egyszerűen

Jacques  Lucke a  húszas  évei  elején  jár,  de  már  is  több 
olyan bővítménnyel ajándékozta meg a közösséget, mint a 
Sniper kiegészítő, mellyel nagyon könnyű betűanimációkat 
létrehozni. Ha nincs elég időd, hogy nagy koncepciók men-
tén  végiggondolj  egy  betűanimációt,  csak  egyszerűen  a 
szavak bemutatása, és a köztük mozgó kamera elég, akkor 
mindenképpen vedd fel eszköztáradba ezt a darabot!

A telepítés  ♦ A melléklet  047_Sniper.zip állományát tele-
pítsd a File > User Preferences > Add-ons párbeszédpanelban.

Használat  ♦ A Blender kiegészítői  már az  előző  párbe-
szédpanelen jelzik,  hova fognak beépülni.  A  Sniper nem 
feltűnősködik: létrehoz egy fület az Eszköztáron „Animati-
on” néven. 

Első feladatod, hogy beírd a szöveget, s tördeld több sorba, 
ahogy majd az elemeit látni szeretnéd az animáció során. 
Ilyenkor  még nem szükséges  formáznod,  mivel  a  szöveg 
szétszedése során a betűtípus visszavált az eredeti formájá-
ba. A Seperate Text gombbal lehet szétválasztani a sorokat. 
Ezután jelöld ki az összeset, majd nyomd meg az Add Tar-
get Camera gombot a panelon, mellyel egy új, aktív kamera 
kerül a jelenetbe, feleslegessé téve az eredetit. 

Közben több változás is történt…

m. Sniper

Részlet Arany János:
Intés c. verséből.
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Az első, hogy minden általad választot szövegrészhez tar -
tozik egy üres objektum (Empty), melyeknek helyzetét kö-
veti majd a kamera.

A második:  új  fül  jelent  meg „Sniper”  néven az  Eszköz-
táron. Ebben találsz egy táblázatot, ahol megváltoztatható a 
kijelölt elemek sorrendje, új elemek adhatóak hozzá, vagy 
ki is törölhetők a korábbiak.

Válts  most  kameranézetbe,  és  nézd  végig  az  animációt. 
Legtöbbször azt fogod tapasztalni, hogy a szövegek jó része 
kilóg a kamera látómezejéből. It lesz szerepe az  Emptyk-
nek: Ezeket kijelölve és átméretezve (S) hozzáigazítja a ka-
merát, megfelelő távolságra rakva azt. De még mielőt ezt  
megtennéd,  minden  szövegegység  betűtípusát  cseréld  le, 
hiszen ez adja majd meg a végleges méretet.

Kövesd végig az animációt, és állítsd be a szövegelemekhez 
tartozó üres objektumok méretezésével a kameraállásokat.

Közben, ha kifutnál az Idővonalon a flm idejéből, természe-
tesen bővítheted azt.

m. Sniper
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Időzítés  ♦ Amennyiben zenéhez,  szöveghez  vagy egyéb 
hangállományhoz kell igazítanod az animációt, nyomd meg 
a  Sniper fülön a  Manipulate Timing gombot, mellyel meg-
nyílik a  Kulcstábla (Dope Sheet). It a kulcskockák átmoz -
gatásával változtatható az animáció ritmusa, időzítése.

Ezzel, és a  Videovágó ablakba (Video Sequence Editor) be-
hozot hangsávval tökéletesen időzítheted az animációt. 

Néhány fnomítás  ♦ Ha dinamikusabb mozgásokat sze-
retnél,  érdemes térben áthelyezni,  átforgatni, méretezni a 
szövegeket. Fontos, hogy ilyenkor a szöveget jelöld ki, ne a 
hozzá tartozó üres objektumot, hiszen ezek követik majd a 
szöveg változásait, s nem fordítva.

Ha bizonytalanabb, kézikamera-szerű mozgást akarsz vinni 
az animációba, a Sniper fül alján találsz egy Camera Wiggle 
(kamera-remegés) mezőt, ezzel beállíthatod ezt az efektust.

Egy kis mélységélességgel, megfelelő Világ-hátérrel, eset-
leg a szövegek közöt elhelyezet tárgyakkal nagyon izgal -
massá teheted az ilyesfajta betűanimációt…

m. Sniper
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n. 

Animation Nodes

n. Animation Nodes

n.
Ez a kiegészítő igazi csodafeegyver
a látványanimátorok kezében.
Vizuális programozással a szó szoros értelmében
bármit megvalósíthatsz. 

 

Animation 
Nodes
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Vizuális programozás

Az Animation Nodes egy olyan kiegészítő (Add-on), mellyel 
halandók  számára  is  érthető  programozási  folyamatként 
készíthetünk animációkat. 

Eddig kétféle animáció-típust tanulmányoztunk: 

• A klasszikus animációban mindent te mozgatsz. Meg-
adod a kulcsmozdulatokat,  a  gép pedig kiszámolja, 
ami közötük van. Ez egy általad irányítot lineáris  
folyamat.

• A fzikai szimulációban elhelyezed a tárgyakat, meg-
mondod, hogyan viselkedjenek. Mint egy óvodás fú-
csapat, akiket szüleik othagynak a nappaliban. Elin-
dul a szimuláció, s rejtet kamerával végignézed, mi  
lesz az eredménye. Kiszámítható kaotikus folyamat.

Ha programozásról hallasz, talán neked is valami szemüve-
ges, testes, gondozatlan szakállú kóder képe ugrik be vala-
melyik flmből, aki mellet tornyokban állnak a kiürült piz-
zás dobozok. Úgy zongorázik a billentyűzeten, mint Kocsis 
Zoltán, és néhány programsorral fel tudja törni a Nemzet-
közi Űrállomás védelmi rendszerét. De képtelen megküzde-
ni egy automata mosógép kezelésével… 

Vannak ilyen sztereotípiáink. A programozás az átlagem-
bernek varázsszavak írogatása fekete képernyőre, melynek 
valami rémisztő köze van a matematikához.

Mint oly sok más grafkai szofver, a Blender is programoz-
ható. Erre a Python nyelvet használhatod, ami egy logikus, 
jól felépítet, modern, szép, satöbbi-satöbbi nyelv. Csak hát 
írni kell, és megtanulni. Mint minden más nyelvet. Erre jön 
egy srác, Jacques Lucke, és ír egy csomópont alapú rend-
szert,  ami ugyanennek a  nyelvnek a  logikáját  követi,  de 
nem kell hozzá parancsszavakat, adatszerkezeteket magol-
ni, csak objektumokat kapcsolgatni egymáshoz, majd ösz-
szekötni ezeket, s kész a „program”.

n. Animation Nodes

Jacques Lucke
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Telepítés  ♦ A  File menü  User Preferences menüpontjából 
varázsoljuk elő a Blender beállítóközpontját. A Blenderrel 
együt csomagolva nagyon sok kiegészítő érkezik, melye -
ket igazi kóderek Python nyelven írtak a programhoz. 

Ez az alrendszer egyelőre nem integráns része a Blender-
nek, az Add-ons fül alat található Install from File gombbal 
telepíthetjük a mellékletből: 046_animation_nodes.zip

Pipáld ki, engedélyezd, majd a párbeszédpanel alján talál-
ható  Save User Seting gombbal véglegesítsd, így nem kell 
minden programindításnál újratelepíteni.

A  következő  példában  e  rendszer  egyik  beépítet példa -
programját  fogjuk  életre  kelteni,  miközben  igyekszünk 
vagy hetvenötezer forintot25 megspórolni némi kreativitás-
sal.

25 Az Adobe After Effects látványanimációs program egyik kiegészítő szofve-
re a Rowbyte cég által gyártot Plexus részecskerendszer, melynek egyik eljá-
rását fogjuk megvalósítani ingyen.

n. Animation Nodes
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Plexus effekt

A hálózatok idejét éljük. Nem véletlen, hogy napjainkban a 
látványanimációs stúdiók munkáiban szinte kötelező elem-
ként jelennek meg a mindent mindennel összekapcsoló há-
lók, rendszerek. 

Miután telepíteted az Animaton Nodes rendszert, a Csomó-
pontszerkesztőben új alrendszert fogsz találni.

A felajánlot példaprogramok  (Templates) közül válaszd a 
Network from Particles rendszert. Ebben a csomópontrend-
szerben ugyanúgy kell építkezni, mint az anyagtulajdonsá-
goknál, vagy az utómunka során, de most egy sablont fogsz 
használni. Milyen típusú kapcsolatokat szeretnél építeni? – 
kérdezi  a  rendszer.  Mivel  az  éleket  (Edge) önmagukban 
nem tudod renderelni, a görbék (Spline) több macerával jár-
nak, válaszd a sokszögeket (Polygon). 

n. Animation Nodes
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Egy impozáns kis csomópont-hálózat kerül a Csomópont-
szerkesztőbe.  Ennek  az  eleje  egy  részecskerendszer  (1), 
melynek kiszűri az éppen aktív, élő elemeit (2), meghatá-
rozza ezeknek a helyzetét (3), leméri, hogy milyen mesze 
vannak  egymástól  (4),  s  adot intervallumban  összeköti  
őket (5). Az utolsó csomópont egy testhálót kér, amit átala-
kíthat összekötetésekké. 

Ennél többet most nem is kell tudnod. Állítsd be a sablon-
kockát úgy, hogy részecskerendszert bocsásson ki magából. 
Hivatkozz erre a kockára a  Csomópontszerkesztő első cso-
móján.

Hozz létre egy gömböt, simítsd le, majd tedd félre, a kame-
rától távol, hogy az ne láthassa. Anyagtulajdonsága legyen 
Emission (fényforrás) típusú.

A részecskerendszer Render paneljén kapcsold ki az Emit-
ter tulajdonságot. Az eredeti kocka innentől már nem kerül 
rá a renderelt képre, flmre. Ugyanit állítsd be azt is, hogy 
a részecskék objektum-típusúak legyenek, s alakjuk vegye 
át a korábban létrehozot gömb alakját. Ezek méretét is tu-
dod a panelen befolyásolni.

n. Animation Nodes
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Ha minden rendben volt, most már gömböcskék potyognak 
a kockából. Valós idejű renderelésnél csak ezek fognak lát-
szani – kocka nélkül.

Most már csak egy térháló alapú másik testre lesz szüksé-
ged, melynek az anyagából a csomópontrendszer a kapcso-
latokat előállítja.

Én erre egy majmot használtam, fényforrás anyagtípussal. 
Az animációt futatva elkezdenek potyogni a labdácskák, a 
kapcsolatok is, de nem egy helyen.

A majom helyén aktív állapotban levő pálcikák középpont-
ba helyezéséhez nyomd meg az (ALT+G) billentyűkombi-
nációt, ami visszaviszi a rendszert az origóba.

n. Animation Nodes
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A rendszerünk  elkészült.  Most  már  jöhet  a  fnomítás.  A 
kapcsolatok  számát,  hosszát  befolyásolhatod  Find  Close  
Vertices csomó paraméterezésével.

A  részecskerendszernél  kísérletezhetsz  a  kibocsátot ré -
szecskék számával,  a kibocsátás időtartamával,  a részecs-
kék életkorával, véletlenszerűségével.

A mozgások fzikájánál érdemes a Boids és Fluid gombokat 
kipróbálnod, valamint ezek paramétereit.

Az erőtereknél állítsd vissza nullára a gravitációt!

n. Animation Nodes
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Befejezés, de most már igazán...

Hoegyan tovább? Nem gondolom, hoegy a látványanimáció a  
non plus ultra az animáció műfajai közöt. 

Mivel minden kezdő PIXAR-stílusú flmekről ábrándozik, ke-
vesen látják, hoegy mennyit kell tanulni rajzolni, látni, moz-
gatni ahhoz, hoegy eegy képsor megelevenedjen, észrevehetetle -
nül is szép leegyen. 

Az amatőr animációs flmek egyakran érthetetlenek, tele rosz-
szul  megvalósítot, csoszogós  animációval,  stílustalan  kör -
nyezetekkel, és ellenszenves karakterekkel.

Ha meguntad a Motion Graphics műfaját, tanulj építészetet,  
anatómiát, rajzolj, modellezz, szobrászkodj, flmezz sokat!

A Blender kitűnő eszköz lesz, ha karakteranimációt tanulsz,  
de lehet benne játékot fejleszteni, flmekhez speciális efektu-
sokat egyártani, 3D nyomtatóra vaegy akár a webre modellezni,  
interaktív bemutatókat animálni. 

Ha a programozás vonz, az Animation Nodes vaegy a Sver-
chok bővítménnyel, a Python szriptnyelvvel ismerkedhetsz. 

Ha a WebGL – azaz 3D tartalmak böngészőben való megjele-
nítése –, akkor a Blend4Web a te irányod. 

De ne feledd, a technika nem öncélú dolog. A Blender elsősor-
ban a fantázia, a művészi önkifejezés eszköze. Íegy legalább  
annyit kell tudnod az emberről, mint a technikáról, hoegy jó  
modellező vaegy animátor váljék belőled.

Ehhez kívánok sok erőt, örömet és lelkesedést.

S.D.G.  | Kisantal Tibor | 2017 tavaszán

n. Animation Nodes
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A szerzőről

Szabadúszó grafkus és tanár. Vektorgrafkáról jelent meg 
az első könyve. 

Az utóbbi években grafkai munkái mellet televíziós műso-
rokhoz intrókat, reklámflmhez 3D-s animációkat is készí-
tet. 

Középiskolában számítógépes grafkát tanít, általános isko-
lában informatikát, fzikát. 

Az FSF.hu Alapítvány aktivistája: grafkai szofverekről szí-
vesen tart előadásokat, vezet gyakorlatokat.

Nagycsaládos édesapa. Felnőt gyerekei közöt mérnök, pe-
dagógus, művész és informatikus is van. Feleségével a Ba-
laton közelében élnek egy kis faluban. 
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Blender – látvány és animáció
FSF.hu Alapítvány 2017

Tankönyvet szerettem volna írni 
azoknak, akiket vonz a látvány, az 
első három és a negyedik dimenzió. 
Akik szívesen foglalkoznak a 
mozgókép határaival, akik világokat 
teremtenének saját örömükre. 
Nem könnyű út, tíz éve tanulom ezt a 
táncot, de talán tudtam segíteni az 
első lépésekben.
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